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ソニーソリッドステートメモリーカムコー
ダー PXW-X500をお買い上げ後、タイム
ゾーン、内蔵時計の日付と時刻および使用
言語の設定が必要です。
◆設定のしかたについて詳しくは「本機を初め
て使用するとき」（40ページ）をご覧くださ
い。

ご注意
PXW-X500（以下、「本機」）に対して周辺機器やア
クセサリーの取り付け／取り外しを行うときは、
必ず本機の電源をオフにしてください。

ご使用の前に
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2/3型Power HAD FX CCD回路を
採用

フルHD（1920×1080）の220万画素で構成
されている2/3型ITプログレッシブのイメー
ジセンサーを採用し、新開発の信号処理LSI
を搭載することで、F11（1080/59.94i）、
F12（1080/50i）の高感度を実現し、高画質
な映像の撮影が可能になりました。

マルチフォーマット対応

従来のMPEG HD、MPEG IMX、DVCAM
フォーマットに加え、高精細な階調表現で
の高画質記録が可能なXAVC HDフォーマッ
ト、HDCAM SRに採用されているMPEG-4 
SStPフォーマット、Apple ProRes、Avid 
DNxHD®フォーマットにも対応し、本機で
記録した素材を様々な用途で幅広く活用で
きます（51ページ参照）。
* Apple ProRes、Avid DNxHD®フォーマットは
それぞれ有償オプションのPXWK-501 Codec 
Option、PXWK-502 Codec Option キーをイン
ストールする必要があります。

スロー＆クイックモーション機能

特殊記録機能として、スロー＆クイック
モーション撮影に対応。低速と高速の動き
に対して特殊な映像効果を得ることができ
ます。撮影はフル解像度1920×1080の高解
像度で行うことができ、最高フレームレー
トは1080/120Pです（86ページ参照）。

デジタルエクステンダー機能

最大4倍のデジタルエクステンダー機能を搭
載。電気的な拡大処理のため、レンズのエ
クステンダーで発生する感度の落ち込み（F
ドロップ）を防ぎます。レンズのエクステ
ンダーと組み合わせて使用することも可能
です。

ピクチャーキャッシュレック機能

本機では、内蔵の大容量メモリーに、本機
で撮影している映像／音声データを常時数
秒間（最大15秒間）分蓄えておくことによ
り、記録を開始したとき、その数秒前から
の映像を記録することができます。

間欠記録（インターバルレック）
機能

本機能を使用して動きの遅い被写体を撮影
すると、被写体が動く様子を、時間を短縮
してみることができます。植物の成長観察
映像や建物を建設する際の記録映像など、
さまざまな用途に利用できます。

同時記録機能

同時記録機能で、同じ映像を2枚のSxSメモ
リーカードに同時に記録することができま
す。撮影を行いながら映像のバックアップ
を取る場合などに使用します（89ページ参
照）。

ネットワーク機能

ワイヤレスLAN接続機能と付属のUSBワイ
ヤレスLANモジュールIFU-WLM3を使用し

1章 概要

特長
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て、スマートフォンやタブレットから本機
の操作・設定を行うことができます（104
ページ参照）。
また、ワイヤレスLAN アダプター CBK-
WA02（別売、5GHz）、ネットワークアダ
プター CBK-NA1（別売）を使用した有線
LAN接続にも対応しています。

カムコーダー撮影／収録システム
の構築

50ピンインターフェースを標準装備し、HD
カメラアダプター CA-FB70/TX70を本機に
マウントしてCCUと接続することにより、
撮影／収録システムを構築できます（210
ページ参照）。

GPS機能

内蔵のGPSモジュールで、撮影した動画の
位置情報や測位時刻を本機に記録すること
により、ポストプロダクション作業で撮影
場所のトレースを行うことができます
（103ページ参照）。

外部入力信号の記録とリターン表
示機能

外部入力記録機能を標準装備し、SDI入力信
号を記録することができます（213ページ
参照）。
また、ビューファインダーとLCDモニター
に外部入力をリターン信号として表示する
ことができます（213ページ参照）。

その他の機能

• ALAC (自動レンズ収差補正)機能により、
レンズ起因の色収差の特定パターンを大
幅に減少させることができます（177ペー
ジ参照）。

• Power HAD CCDセンサーのダイナミック
レンジを使用したガンマ補正機能により、

映像のコントラストを適切に調整するこ
とができます（167ページ参照）。また
ユーザーガンマでガンマカーブをカスタ
マイズして作成することもできます（203
ページ参照）。

• フォーカスアシスト機能により焦点合わ
せを簡単に行うことができます（31ペー
ジ参照）。

ソフトウェアのダウンロードにつ
いて

本機をPCと接続して使用する際は、必要に
応じてデバイスドライバーや各種プラグイ
ンソフトウェア、アプリケーションソフト
ウェアを下記サイトからダウンロードして
お使いください。

ソニープロフェッショナル/業務用製品サイ
トホームページ：
アメリカ合衆国 http://pro.sony.com
カナダ http://www.sonybiz.ca
ラテンアメリカ http://sonypro-latin.com
ヨーロッパ http://www.pro.sony.eu/pro
中東、アフリカ http://sony-psmea.com
ロシア http://sony.ru/pro/
ブラジル http://sonypro.com.br
オーストラリア http://pro.sony.com.au
ニュージーランド http://pro.sony.co.nz
日本 http://www.sonybsc.com
アジア http://pro.sony-asia.com
韓国 http://bp.sony.co.kr
中国 http://pro.sony.com.cn
インド http://pro.sony.co.in

Sony Creative Software社のソフトウェアダ
ウンロードページ
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment
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a LIGHT（ビデオライト動作モード切り換
え）スイッチ

LIGHT端子（14ページ参照）に接続したビ
デオライトのオン／オフのしかたを選択し
ます。
AUTO：ビデオライトのPOWERスイッチを

ONにしておくと、本機で記録している
ときにライトが点灯する。

MANUAL：ビデオライトのPOWERスイッ
チでライトをオン／オフする。

ご注意
ピクチャーキャッシュレックモードでの記録時
は、記録開始の操作をする前（メモリーにデータ
を蓄積している期間）にライトを点灯させること
はできません。

b POWER（電源）スイッチ
主電源をオン（?）／オフ（1）します。

c DC IN（DC電源入力）端子（XLR 4ピ
ン、凸）

本機をAC電源で動作させるとき、この端子に
別売のDC電源コードを差し込み、バッテリー
チャージャー BC-L70、BC-L70A、BC-L160、
BC-L500などのDC出力端子に接続します。

d DC OUT 12V（DC電源出力）端子
（4ピン、凹）

UHFシンセサイザーダイバーシティー
チューナーWRR-855S/860C/861/862（別
売）およびHDVF-L750/L770用の電源を供
給します（最大1.8A）。

e バッテリー取り付け部
バッテリーパックBP-FLX75を取り付けま
す。また、ACアダプター AC-DN2B/DN10
を取り付けて、AC電源で本機を動作させる
こともできます。
◆「電源の準備」（35ページ）
◆「ポータブルワイヤレスチューナーを取り付
ける（ワイヤレスマイクロホン使用時）」
（45ページ）

ご注意
本機を安全かつ正常な動作状態でお使いいただく
ために、バッテリーパックBP-FLX75の使用を推奨
します。

f カメラアダプター接続端子
カバーを外してHDカメラアダプター
CA-TX70/FB70を接続できます。

各部の名称と働き

電源部
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a ショルダーベルト取り付け金具
付属のショルダーベルトを取り付けます
（49ページ参照）。

b アクセサリーシュー
ビデオライトなどを取り付けます（48ペー
ジ参照）。

c ビューファインダー前後位置固定レ
バー

ビューファインダーの位置を前後方向に調
整します（38ページ参照）。

d ビューファインダー左右位置固定リン
グ

ビューファインダーの位置を左右方向に調
整するときゆるめます（38ページ参照）。

e ビューファインダー取り付けシュー
ビューファインダーを取り付けます（37
ページ参照）。

f VF（ビューファインダー）端子（角型
26ピンおよび丸型20ピン）

HDVFシリーズビューファインダー用のア
ナログインターフェース端子（20ピン）と、
HDビューファインダー CBK-VF02用のデジ
タルインターフェース端子（26ピン）です。
使用するビューファインダーに対応する端
子に、ビューファインダーに接続ケーブル
を接続します。

ご注意
• 両方の端子に同時にビューファインダーを接続
しないでください。

• 本機にインターフェースケーブルの接続／取り
外しを行うときは、本機の電源を切ってから
行ってください。

g レンズマウントゆるみ止めゴム
レンズ固定レバーでレンズを固定した後に、
このゴムを2つある突起の下側の突起にはめ
込みます。レンズマウントが固定され、レ
ンズマウントがゆるむのを防ぎます。

h ビューファインダー前後位置LOCKつ
まみ

ビューファインダーの位置を前後方向に調
整するときゆるめます（38ページ参照）。

i 別売マイクホルダー取り付け部
別売のマイクホルダー CAC-12を取り付け
ます（43ページ参照）。 

j ショルダーパッド
ショルダーパッド固定レバーを持ち上げる
と、前後方向に位置を調節できます。本機
を肩にのせたとき操作しやすくなるように、
適当な位置に調節します（50ページ参照）。

k LIGHT（ライト）端子（2ピン、凹）
アントンバウアー社製のウルトラライト2ま
たは同等品で、50W以下のビデオライトを
接続します（48ページ参照）。

l レンズケーブルクランプ
レンズケーブルを固定します。

アクセサリー取り付け部
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m MIC IN（マイク入力）（＋48V）端子
（XLR型、5ピン、凹）

ステレオマイクを接続する端子です。マイ
ク用の電源（＋48V）はこの端子から供給
されます。

n LENS（レンズ接続用）端子（12ピン）
レンズケーブルを接続します。

ご注意
本機にレンズケーブルの接続／取り外しを行うと
きは、本機の電源を切ってから行ってください。

o 三脚マウント
本機を三脚に固定するとき、三脚アタッチ
メント（別売）を取り付けます。

p レンズマウント（特殊バヨネット型）
レンズを取り付けます。
◆使用できるレンズについては、ソニーのサー
ビス担当者、または営業担当者にお問い合わ
せください。

q レンズ固定レバー
レンズをレンズマウントに差し込んだ後、
このレバーでレンズマウントリングを回し
てレンズを固定します。
レンズを固定した後は、必ずレンズマウン
トゆるみ止めゴムを使用してください。

r レンズマウントキャップ
レンズ固定レバーを押し上げると取り外せ
ます。レンズを取り付けていないときは、
はめ込んでおきます。

前面

a REC START（記録開始）ボタン
押すと記録が始まり、もう一度押すと止ま
ります。レンズにあるRECボタンと同じ動
作をします。

b SHUTTER（シャッター）スイッチ
電子シャッターを使うときにONにします。
SELECT側に押すと、シャッタースピード
とシャッターモードの表示が切り替わりま
す。スイッチの設定を切り換えると、新し
い設定がビューファインダー画面に約3秒間
表示されます。
◆「電子シャッターの設定」（59ページ）

操作・端子部
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c FILTER（フィルター切り換え）つまみ
本機に内蔵されている4種類のNDフィル
ターを切り換えるためのつまみです。

このつまみの設定を切り換えると、新しい
設定がビューファインダー画面に約3秒間表
示されます。

Maintenanceメニューの設定を変更するこ
とにより、つまみの各位置にホワイトバラ
ンスの設定値を個別に記憶させておくこと
ができるため、フィルターの切り換えに連
動して、撮影条件に応じた最適なホワイト
バランスが得られます。
◆「ホワイトバランスを調整する」（57ページ）

d MENUつまみ
各メニュー内の項目選択や設定値の変更を
するときに使います（146ページ参照）。

e AUTO W/B BAL（ホワイトバランス／
ブラックバランス自動調整）スイッチ

次のようにホワイトバランスやブラックバ
ランスを自動調整します。
WHITE：ホワイトバランスを自動調整す
る。このとき WHITE BALスイッチ（18
ページ参照）をAまたはBにしておくと、
調整された値がメモリー AまたはBに記
憶される。WHITE BALスイッチがPRST
のときは動作しない。

BLACK：ブラックセットとブラックバラン
スを自動調整する。

自動追尾ホワイトバランス（ATW）時も動
作します。
オートホワイトバランス実行中に再度
WHITE側に倒すと、オートホワイトバラン
スは中止され、元のホワイトバランス状態
に戻ります。
オートブラックバランス実行中に再度
BLACK側に倒すと、オートブラックバラン
スは中止され、元のブラックバランス状態
に戻ります。

f MIC LEVEL（マイクレベル）つまみ
音声チャンネル1/2/3/4の入力レベルを調整
します（63ページ参照）。

右側面（前部）

FILTERつ
まみの設定

NDフィルターの種類

1 CLEAR（素通し）
2 1/4 ND（光を約1/4に減衰させる）
3 1/16 ND（光を約1/16に減衰させ

る）
4 1/64 ND（光を約1/64に減衰させ

る）
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a ASSIGN.（アサイナブル）1/2/3スイッチ
メニューのOperation >Assignable Switch
で機能を割り当てます（189ページ参照）。
工場出荷時には、ASSIGN. 1/2/3にOffが割
り当てられています。
ASSIGN. 1/3スイッチには、オン／オフが
確認できるインジケーターが付いています。

b COLOR TEMP.（色温度切り換え）ボ
タン

押すと点灯し、撮影するときの色温度を変
更できます（工場出荷時）。また、アサイナ
ブルスイッチとして使用することができま
す（190ページ参照）。

c ALARM（警告音量調節）つまみ
内蔵スピーカーやイヤホンから聞こえる警
告音の音量を調節します。最小にすると、
警告音は聞こえなくなります。
ただし、メニューのMaintenance >Audio 
>Min Alarm VolumeをSetに変更すると、こ
のつまみが最小の位置でも警告音が聞こえ
るようになります。

d MONITOR（音量調節）つまみ
内蔵スピーカーやイヤホンから聞こえる警
告音以外の音声の音量を調節します。最小
にすると、音声は聞こえなくなります。

e MONITOR（オーディオモニター選択）
スイッチ

2つのスイッチの組み合わせによって、内蔵
スピーカーやイヤホンから聞こえる音声を
以下のように選択します。
下側のスイッチ：CH-1/2

下側のスイッチ：CH-3/4

a)EARPHONE端子にステレオヘッドホンを接続
すると、音声をステレオで聞くことができま
す。（メニューのMaintenance >Audio 
>Headphone OutをStereoに設定する必要があ
ります。）

f ASSIGN.（アサイナブル）0スイッチ
メニューのOperation >Assignable Switch
で機能を割り当てます（189ページ参照）。
工場出荷時には、Offが割り当てられていま
す。
押すたびに動作が切り替わるモーメンタ
リータイプのスイッチです。

g GAIN（ゲイン切り換え）スイッチ
撮影時の照明状態に合わせて、映像アンプ
のゲイン（利得）を切り換えます。L、M、
H の設定に対応するゲイン値は、あらかじ
めメニューのOperation >Gain Switchで
（159ページ参照）指定します（工場出荷時
の設定は、L=0dB、M=6dB、H=12dB）。
このスイッチの設定を切り換えると、新し
い設定がビューファインダー画面に約3秒間
表示されます。

h OUTPUT（出力信号切り換え）／DCC
（ダイナミックコントラストコントロー
ル機能切り換え）スイッチ

カメラ部から出力する信号を以下の2つから
選択します。
BARS：カラーバー信号を出力する。
CAM：撮影中の映像信号を出力し、DCC 
機能1)のオン／オフを切り換えることが
できる。

1)DCC（Dynamic Contrast Control）機能：
高輝度の背景で人物や風景などにレベルを合わ
せて撮影すると、背景が白くつぶれ、背景にあ
る建物や風景がぼやける。このようなときに 
DCC 機能を動作させると、高輝度部分を自動

上側のスイッチ 音声出力
CH-1/CH-3 チャンネル1の音声
MIX チャンネル1と2の混合音声

（ステレオ）a)

CH-2/CH-4 チャンネル2の音声

ALARM

最小 最大

上側のスイッチ 音声出力
CH-1/CH-3 チャンネル3の音声
MIX チャンネル3と4の混合音声

（ステレオ）a)

CH-2/CH-4 チャンネル4の音声
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的に抑え、背景をくっきりと再現できる。次の
ような場面の撮影に効果を発揮する。
• 晴天時に日陰の人物を撮るとき
• 車内または屋内の人物と窓越しの屋外の風景
を同時に撮影したいとき

• コントラストの強い場面を撮るとき

i WHITE BAL（ホワイトバランスメモ
リー切り換え）スイッチ

以下のようにホワイトバランスの調整方法
を切り換えます。
PRST：色温度をプリセット値（工場出荷
時の設定は3200K）に調整する。ホワ
イトバランスを調整する時間がないと
きなどに合わせる。

AまたはB：あらかじめAまたはBに保存し
ておいたホワイトバランスの調整値を
呼び出す。AUTO W/B BALスイッチ
（16ページ参照）をWHITE側に押すと、
ホワイトバランスを自動的に調整し、
調整値をメモリー Aまたはメモリー Bに
記憶する。

B（ATW 1)）：OperationメニューのWhite 
SettingでWhite Switch <B>をATWに設
定しておくと、ATWが動作する。
なお、ATWが動作中でも、AUTO W/B 
BALスイッチは機能する。

このスイッチの設定を切り換えると、新し
い設定がビューファインダー画面に約3秒間
表示されます。
1)ATW（Auto Tracing White balance）：照明条
件の変化に応じて画像のホワイトバランスを自
動的に追従させる機能

ご注意
照明や被写体の条件によっては、ATWを使用して
も適切な色に調整できないことがあります。
例：
• 空、海、地面、草花など単一色の被写体が大部
分を占める場合 

• 色温度が非常に高い／非常に低い光源下の被写
体 

 

ATWの自動追従の時間が遅かったり、適切な効果
が得られない場合は、AWBを実行してください。

j MENU ON/OFF（メニュー表示オン／
オフ）スイッチ

スイッチカバーを開けると使用できるよう
になります。
ビューファインダー画面やテスト出力画面
上に設定メニューを表示するときに使用し
ます。スイッチを押し下げるたびに、メ
ニューの表示／非表示が切り替わります。サ
ムネイル画面操作部のMENUボタンも同じ
働きです。

ご注意
スイッチカバーを閉じても、メニューは非表示に
はなりません。

k MENU CANCEL/PRST/ESCAPE（メ
ニュー設定取消し／プリセット／戻る）
スイッチ

スイッチカバーを開けると使用できるよう
になります。
メニューが表示されている場合と表示され
ていない場合で機能が異なります。

メニューが表示されているときは、次のよ
うに使用します。
CANCEL/PRST：メニューの設定変更後に
この位置へ押し上げると、変更した設
定を取り消すかどうかを確認する表示
が出る。再度押し上げると設定が取り
消される。
メニューの設定変更前または設定変更
を取り消した後にこの位置へ押し上げ
ると、現在の設定を標準設定（初期設
定値）にリセットするかどうかを確認
する表示が出る。再度押し上げると現
在の設定が標準設定にリセットされる。

ESCAPE：階層構造を持つメニューを開い
ているときに使用する。この位置に押
し下げるたびに、現在の階層から1つ上
の階層に戻る。
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メニューが表示されてないときは、次のよ
うに使用します。
CANCEL/PRST：この位置に押し上げる
と、本機の各種設定や状態を確認する
ための画面がビューファインダーに表
示される（68ページ参照）。この画面は
8ページあり、押し上げるごとに、ペー
ジが変わる。

ESCAPE：画面を消したいとき、この位置
に押し下げる。

l UTILITY SDカードスロット
本機の設定データ保存用SDカードを挿入し
ます。

m ACCESS（アクセス）ランプ
SDカードアクセス中にオレンジ色で点灯し
ます。

n スイッチカバー
MENU ON/OFFスイッチ、またはMENU 
CANCEL/PRST/ESCAPEスイッチを操作す
るとき、このカバーを開けます。

右側面（後部）
 

a 内蔵スピーカー
記録中はE-E音 1)を、再生中は再生音をモニ
ターできます。警告ランプや警告表示の点
滅・点灯に合わせて警告音も聞こえます
（218ページ参照）。
なお、EARPHONE端子にイヤホンをつなぐ
と、内蔵スピーカーからは音が聞こえなく
なります。
1)E-E：「Electric to Electric」の略。本機に入力さ
れ、本機内部の電気回路のみを通って出力端子
から出てくる映像信号または音声信号のこと。
これによって入力信号を確認できる。
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b LCDモニター
バッテリー残量、メディア残量、音声レベ
ル、タイムデータなどを表示します。また、
カメラ画や再生画を確認できます（27ペー
ジ参照）。
LCDモニターは位置や角度を調整すること
ができます。

c WARNING（警告）ランプ
異常が発生すると、点滅または点灯します
（218ページ参照）。

d ACCESS（アクセス）ランプ
記録メディアに書き込みや読み出しが行わ
れているときに青で点灯します。

e オーディオ調整部の保護カバー
開くとオーディオ調整部が現れます（22
ページ参照）。

f サムネイル画面操作部の保護カバー
開くとサムネイル画面の操作部が現れます
（22ページ参照）。

g F REV（逆高速再生）ボタンとランプ
逆方向に高速再生します。再生速度は、ボ
タンを押すたびに約4倍速→約15倍速→約
24倍速の順に切り替わります。逆方向高速
再生中はランプが点灯します。

h PLAY/PAUSE（再生／一時停止）ボタ
ンとランプ

再生するときに押します。再生中はランプ
が点灯します。
再生中に再度このボタンを押すと一時停止
状態となり、静止画が出力されます。この
とき、ランプが毎秒1回の速さで点滅しま
す。
再生／一時停止中にF REVボタンまたはF 
FWDボタンを押すと、逆方向または順方向
の高速再生になります。

i F FWD（高速再生）ボタンとランプ
順方向に高速再生します。再生速度は、ボ
タンを押すたびに約4倍速→約15倍速→約
24倍速の順に切り替わります。順方向高速
再生中はランプが点灯します。

j PREV（逆方向クリップジャンプ）ボタ
ン

現在のクリップの先頭にジャンプします。
F REVボタンと同時に押すと、記録メディ
ア内で最初に記録されたクリップの先頭画
にジャンプします。
このボタンをすばやく2回押すと、直前のク
リップ（存在しない場合は現在のクリップ）
の先頭画にジャンプします。

k STOP（停止）ボタン
再生をやめるときに押します。

l NEXT（順方向クリップジャンプ）ボタ
ン

次のクリップの先頭にジャンプします。
F FWDボタンと同時に押すと、記録メディ
ア内の最後に記録されたクリップの最終画
にジャンプします。
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m DISP SEL/EXPAND（表示選択／エク
スパンド）ボタン

ボタンを押すごとに、LCDモニターの表示
内容が次表のように切り替わります。

また将来のバージョンアップでEXPAND
（エクスパンド）ボタンとしても使用できる
ようになります。

n HOLD（データ表示保持）ボタン
押した瞬間に、LCDモニターのタイムデー
タの表示が保持されます。（ただし、タイム
コードジェネレーターは歩進し続けます。）
もう一度押すと、保持状態が解除されます。
◆タイムデータ表示について詳しくは、27 
ページをご覧ください。

o RESET/RETURN（リセット／リター
ン）ボタン

LCDモニターのタイムデータ表示部に表示
されている値をリセットします。PRESET/
REGEN/CLOCKスイッチ（23ページ参照）
とF-RUN/SET/R-RUNスイッチ（22ページ
参照）の設定に応じて、次のように働きま
す。

a)メディアに記録されるタイムコードビットのう
ち、ユーザーが必要な情報を記録するために使
うことのできるビット。
◆「タイムデータの設定」（66ページ）

エッセンスマークサムネイル画面の表示中
に押すと、1つ前の画面に戻ります。

p DISPLAY（タイムデータ表示切り換
え）スイッチ

LCDモニターのタイムデータ表示部の表示
をCOUNTER、TC、U-BITの順に切り換え
ます（27ページ参照）。
COUNTER：記録・再生経過時間のカウン
ターを表示する。

TC：タイムコードを表示する。
U-BIT：ユーザービットを表示する。

q BRIGHT（明るさ設定）ボタン
LCDモニターのバックライトの明るさを切
り換えます。
ボタンを押すたびに、次表の順番で明るさ
が切り替わります。LCDモニターの消灯時
にこのボタンを押すと、Hの状態でLCDの
バックライトが点灯します。

表示内容 説明
文字情報付きの映像
（CHAR）

ビューファインダー画面と
同様の文字情報が表示され
る。

文字情報なしの映像
（MONI）

映像のみ表示される。

ステータス表示
（STATUS）
（27ページ）

カウンター、各種の警告、
音声レベルなどが表示され
る。映像は表示されない。

スイッチの設定 RESET/RETURNボタ
ンの働き

DISPLAYスイッチ：
COUNTER

カウンターを
00：00：00：00にリ
セットする。

DISPLAYスイッチ：
TC
PRESET/REGEN/
CLOCKスイッチ：
PRESET
F-RUN/SET/R-RUNス
イッチ：SET

タイムコードを
00：00：00：00にリ
セットする。

DISPLAYスイッチ：
U-BIT
PRESET/REGEN/
CLOCKスイッチ：
PRESET
F-RUN/SET/R-RUNス
イッチ：SET

ユーザービットa) データ
を00 00 00 00にリセッ
トする。

設定 LCDモニターのバックライト
H 高輝度（日中の屋外でLCDモニターの表

示をみるときに選択する）
M HとLの中間の明るさ
L 低輝度（室内または夜間の屋外でLCDモ

ニターの表示をみるときに選択する）
OFF 消灯（表示も消える）

スイッチの設定 RESET/RETURNボタ
ンの働き
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サムネイル画面操作部とオーディオ調
整部

a サムネイルインジケーター
サムネイル画面が表示されているときに点
灯します。

b THUMBNAIL（サムネイル）ボタン
サムネイル操作を行うとき、このボタンを
押してサムネイル画面（133ページ参照）
を表示します。
もう一度押すと、元の画面に戻ります。

c SET（設定）ボタンと矢印ボタン
タイムコードやユーザービットの数値の設
定、およびサムネイル画面での操作に使用
します（136ページ参照）。
セットアップメニューを表示しているとき
は、このボタンを押して項目の選択や設定
変更を確定します。

d MENU（メニュー）ボタン
押すたびに、セットアップメニューの表示／
非表示が切り替わります。
MENU ON/OFFスイッチと同じ働きです。

e F-RUN/SET/R-RUN（フリーラン／
セット／レックラン切り換え）スイッ
チ

内蔵タイムコードジェネレーターの歩進
モードを選択します。スイッチの位置に
よって、歩進モードは以下のように変わり
ます。

F-RUN：連続してタイムコードが歩進す
る。タイムコードを外部ロックさせる
ときなどに合わせる。

SET：タイムコードやユーザービットを設
定する。

R-RUN：記録中のみタイムコードが歩進す
る。記録メディア上のタイムコードを、
連続して記録する。

◆「タイムコードを設定する」（66ページ）
◆「ユーザービットを設定する」（66ページ）

f LEVEL CH1/CH2/CH3/CH4（音声チャ
ンネル1/2/3/4録音レベル調整）つまみ

AUDIO SELECT CH1/CH2スイッチ、およ
びAUDIO SELECT CH 3-4スイッチを
MANUALにすると、音声チャンネル1、2、
3、4に記録する音声レベルを調整できます。

g AUDIO SELECT CH 3-4（音声チャン
ネル3-4自動／手動レベル調整切り換
え）スイッチ

音声チャンネル3と4の音声レベル調整方法
を個別に選択します。
AUTO：自動
MANUAL：手動

h ESSENCE MARK（エッセンスマーク）
ボタン

サムネイル画面表示中に押すと、リストの
選択項目に応じて、選択したクリップの
エッセンスマークサムネイル画面を表示す
ることができます。
All：エッセンスマークが打たれたすべての
フレームの一覧を表示する。

Rec Start： レックスタートマークが打たれ
たフレームおよび、先頭フレームに
レックスタートマークが付いていない
クリップがある場合は、その先頭フ
レームも加えて一覧を表示する。

Shot Mark1：ショットマーク1が設定され
たフレームの一覧

Shot Mark2：ショットマーク2が設定され
たフレームの一覧
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Shot Mark0とShot Mark3～Shot Mark9も選
択できます。
ショットマーク0～ショットマーク9の名前
を定義したプランニングメタデータを使用
してクリップを記録した場合は、リストの
選択項目が定義した名前になります。

i SHIFT（シフト）ボタン
各種のボタンと組み合わせて使用します。

j PRESET/REGEN/CLOCK（プリセッ
ト／リジェネレート／クロック）ス
イッチ

タイムコードを記録する方法を選択します。
PRESET：新たに設定されたタイムコード
をメディアに記録する。

REGEN：メディアに記録されたタイムコー
ドを読み取り、その値に連続するよう
にタイムコードを記録する。F-RUN/
SET/R-RUN スイッチの設定に関わら
ず、本機はR-RUNモードで歩進する。

CLOCK：タイムコードを内蔵の時計と合わ
せる。F-RUN/SET/R-RUN スイッチの
設定に関わらず、本機はF-RUNモード
で歩進する。

k AUDIO SELECT CH1/CH2（音声チャ
ンネル1/2自動／手動レベル調整切り換
え）スイッチ

音声チャンネル1と2の音声レベル調整方法
を個別に選択します。
AUTO：自動
MANUAL：手動

l AUDIO IN CH1/CH2/CH3/CH4 （音声
入力切り換えチャンネル1/2/3/4）ス
イッチ

音声チャンネル1、2、3、4に記録する入力
信号を選択します。
FRONT：MIC IN端子に接続したマイクか
らの音声入力信号

REAR：AUDIO IN CH-1/CH-2端子に接続
したオーディオ機器からの音声入力信
号

WIRELESS：本機にスロットインポータブ
ルワイヤレスチューナーを装着したと
きの音声入力信号

左側面と上部
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a ASSIGNABLE（アサイナブル）4/5 ス
イッチ

メニューのOperation >Assignable Switch
で機能を割り当てます（190ページ参照）。
工場出荷時には、Offが割り当てられていま
す。

b GPSモジュール
この部分にGPSモジュールが内蔵されてい
ます。
◆「測位情報の取得（GPS）」（103ページ）

ご注意
GPS機能使用中は、この部分を握らないでくださ
い。

c PC接続端子
本機をUSB接続モードに切り換えてコン
ピューターの外部記憶装置として使用するた
めの端子です。ExpressCardスロットを持た
ないコンピューターとこの端子を接続する
と、本機に挿入されたメモリーカードが、
カードごとにドライブとして認識されます。

d 外部機器接続端子
ポータブルストレージHDD PSZ-HA/HB/HC
シリーズ（別売）、ポータブルストレージ
SSD PSZ-SA25（別売）、汎用の外付けUSB 
HDD、およびUSBメモリーを接続すると、
本機のSxSカードスロットに挿入された記
録メディア内のクリップをUSBメディアに
コピーすることができます。

ご注意
この端子は、上記の機器の接続にだけ使用してく
ださい。USBハブなどほかの機器を接続して使用
することはできません。

e USBワイヤレスLANモジュール用端子
USBワイヤレスLANモジュールIFU-WLM3
（付属）、ネットワークアダプター CBK-NA1
（別売）、ワイヤレスLANアダプター CBK-
WA02（別売）、またはモデム（別売）を接
続することにより、無線LAN機器やネット
ワークとの無線通信が可能になります。

また、ネットワークアダプター CBK-NA1
（別売）とLANケーブル（別売）を接続する
ことにより、ネットワークとの有線通信も可
能になります。
◆「本機とデバイスのワイヤレスLAN接続」
（104ページ）
◆「インターネット接続」（110ページ）

f SxSメモリーカードスロット
上下に2つのスロット（AとB）があり、
SxSメモリーカードなどの記録メディアを
挿入します（73ページ参照）。

g ACCESS（アクセス）ランプ
スロットA/Bの状態を示します（74ページ
参照）。ランプの点灯状態はスロットカバー
を閉めていても確認できます。

h EJECT（SxSメモリーカード取り出し）
ボタン

一度押してロックを解除し、再度押し込む
と記録メディアが手前に引き出されます
（74ページ参照）。

i スロットカバー
左右にスライドして開閉します。

j PROXY SDカードスロット
プロキシデータ記録用SDカードを挿入しま
す。

k ACCESS（アクセス）ランプ
SDカードアクセス中にオレンジ色で点灯し
ます。

l SLOT SELECT（SxSメモリーカード
選択）ボタン

スロットAとBの両方に記録メディアが装着
されているとき、使用する記録メディアを
切り換えます（74ページ参照）。

m HDMI端子
HDMIモニターやレコーダーなどを接続し、
HDまたはSD HDMIによる映像・音声信号
を出力します。
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n GENLOCK IN（ゲンロック用入力）端
子（BNC型）

カメラ部にゲンロックをかけるとき、また
はタイムコードを外部ロックさせるとき、
基準信号を入力します。入力できる基準信
号は、設定されているシステム周波数に
よって次表のように異なります。

o TC IN（タイムコード入力）端子（BNC
型）

タイムコードを外部ロックさせるとき、基
準となるタイムコードを入力します。
◆「タイムコードを設定する」（66ページ）

p VIDEO OUT（ビデオ出力）端子（BNC
型）

ビデオモニター用のビデオ信号を出力しま
す。

q TC OUT（タイムコード出力）端子
（BNC型）

外部VTRのタイムコードを本機のタイム
コードにロックさせるとき、外部VTRのタ
イムコードロック用TC IN（タイムコード入
力）端子と接続します。

後面

a TALLY（バックタリー）ランプ（赤）
記録中に点灯します。ただし、TALLYス
イッチがOFFになっていると点灯しません。
WARNINGランプ（20ページ参照）が動作
しているときは点滅します。なお、ビュー
ファインダー前面のタリーランプ、ビュー
ファインダー画面のREC表示も同様に点灯
／点滅します。
◆「エラー／警告システム」（218ページ）

b TALLY（タリー） スイッチ
TALLYランプを使用するとき、ONに設定し
ます。

システム周波数 入力できる基準信号
59.94i 1080/59.94i、480/59.94i
59.94P 1080/59.94i、480/59.94i
50i 1080/50i、576/50i
50P 1080/50i、576/50i
29.97P 1080/59.94i、480/59.94i
25P 1080/50i、576/50i
23.98P 1080/23.98PsF
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c EARPHONE（イヤホン）端子（ステレ
オ、ミニジャック）

イヤホンを接続すると、記録中はE-E音を、
再生中は再生音をモニターできます。警告
ランプや警告表示の点滅・点灯に合わせて
警告音も聞こえます。内蔵スピーカーから
の音は自動的に聞こえなくなります。
メニューのMaintenance >Audio 
>Headphone Outでモノラル／ステレオを
切り換えることができます。

ご注意
イヤホンはモノラル（2極）またはステレオ（3極）
タイプを使用してください。それ以外を使用する
と本機が故障することがあります。

d AUDIO IN（音声入力）切り換えスイッ
チ

AUDIO IN CH-1/CH-2端子に入力される音
声の音源を切り換えます。
LINE：ステレオアンプなど、外部のオー
ディオ信号源を接続する場合

AES/EBU：外部のデジタルオーディオ信号
源を接続する場合

MIC：マイクを接続する場合

e +48V/OFF（+48V外部電力供給オン／
オフ）スイッチ

音声入力に使用するマイクによって、以下
のように切り換えます。
+48V：外部電源供給方式のマイク
OFF：内部電源供給方式のマイク

f SDI IN（SDI入力端子）（BNC型）
外部からのHD SDI信号を本機に入力すると
きに使用する端子です。

g AUDIO IN CH-1/CH-2（音声入力チャ
ンネル1/2）端子（XLR型、3ピン、凹）

オーディオ機器やマイクを接続します。

h ボトムカバー
後面の端子に接続するケーブル類を保護す
るためのパーツです。
カムコーダー底面の取り付けネジをゆるめ
ると、接続するマイクケーブルまたはオー

ディオケーブルのプラグの形状に応じて、
ボトムカバーの位置を調整することができ
ます。調整後は、ネジを締めてカバーを固
定してください。

i AUDIO OUT（音声出力）端子（XLR
型、5ピン、凸）

オーディオチャンネル1、2または、オー
ディオチャンネル3、4に記録された音声信
号を出力します。
出力する音声信号は、MONITORスイッチ
で選択します。

j REMOTE（リモートコントロール）端
子（8ピン）

本機の遠隔操作が可能なリモートコント
ロールユニットを接続します。

ご注意
本機にリモートコントロールユニットの接続／取
り外しを行うときは、本機の電源を切ってから
行ってください。

k SDI OUT 1/2端子（BNC型）
HD SDI信号（エンベデッドオーディオ）ま
たはSD SDI信号（エンベデッドオーディ
オ）を出力します。本端子からの出力信号
は、メニューのOperation >Input/Output 
>SDI Out1 Output、または>SDI Out2 
Outputでオン、オフを切り換えることがで
きます。
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LCDモニター情報画面は、DISP SEL/
EXPAND（表示選択/エクスパンド）ボタン
を押して表示します（21ページ）。

a 解像度表示
出力映像の解像度が表示されます。

b 記録フォーマット表示
記録フォーマットまたは再生中のクリップ
の記録フォーマットが表示されます。

c ファイルシステム表示

d ファイルフォーマット表示

e 状態表示
PB：メディアを再生しているとき表示され
ます。

NDF：タイムコードがノンドロップフレー
ムモードのとき表示されます。

EXT-LK：内蔵のタイムコードジェネレー
ターがTC IN端子に接続した外部信号に
ロックしているとき表示されます。

HOLD：タイムコードジェネレーターの歩
進モードがレックランで、歩進が止
まっているとき表示されます。

f システム周波数表示
記録時のシステム周波数または再生中のク
リップのシステム周波数が表示されます。

g 音声フォーマット表示
記録時の音声フォーマットまたは再生中の
クリップの音声フォーマットが表示されま
す。

h 音声レベルメーター
音声記録レベルまたは再生レベルが表示さ
れます。「1」～「4」は音声チャンネル1～
4を示します。

i タイムデータ表示
DISPLAYスイッチのポジションにより、
デュレーション、タイムコード、ユーザー
ビットを切り換えて表示します。
タイムデータに現在表示しているデータの
種類は、次のように表示されます。
TCG：記録タイムコード
TCR：再生タイムコード
UBG：記録ユーザービット
UBR：再生ユーザービット
CNT：カウンター
DUR：デュレーション
CLK：時刻表示（PRESET/REGEN/CLOCK
スイッチがCLOCKに設定されている）

画面表示

LCDモニター情報画面（ステー
タス表示）

dB

表示 記録フォーマット
16bit • HD420 HQ

• DVCAM
• MPEG IMX 50

24bit • HD422 50
• MPEG IMX 50
• XAVC Intra
• XAVC Long
• SStP
• DNxHD
• ProRes
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タイムコード表示中にHOLDボタンが押さ
れたときは、次のフォーマットで表示され
ます。HOLDボタンを再度押して保持状態
を解除すると、通常の表示に戻ります。

j クリップ名表示
記録中は、記録中のクリップに付けられる
クリップ名、記録待機中は、次に記録され
るクリップに付けられるクリップ名が表示
されます。

k 警告表示エリア
記録異常や結露が発生したときに内容を表
示します。
◆詳しくは、「エラー／警告システム」（218
ページ）をご覧ください。

l メディア残量表示
記録メディアの残量がスロットごとにバー
グラフで表示されます。

m バッテリー残量表示
バッテリー残量がアイコンと記録可能な残
り時間で表示されます。

撮影中（記録中／記録待機中）および再生
中、ビューファインダー画面には本機の情
報が映像に重ねて表示されます。
情報の表示／非表示はビューファインダー
のDISPLAYスイッチで切り換えます。
表示する情報はメニューのOperation 
>Super Imposeの設定や、関連するスイッ
チでの設定に連動しています。

表示情報（画面上部）

a エクステンダー表示
本機のデジタルエクステンダー機能および
レンズのエクステンダー機能の設定状態が
表示されます。
EX：レンズのエクステンダーがONのとき
X2D：本機のデジタルエクステンダー機能
（2倍）がONのとき

X3D：本機のデジタルエクステンダー機能
（3倍）がONのとき

X4D：本機のデジタルエクステンダー機能
（4倍）がONのとき

EX2D：レンズのエクステンダーおよび本機
のデジタルエクステンダー機能（2倍）
の両方がONのとき

EX3D：レンズのエクステンダーおよび本機
のデジタルエクステンダー機能（3倍）
の両方がONのとき

EX4D：レンズのエクステンダーおよび本機
のデジタルエクステンダー機能（4倍）
の両方がONのとき

デジタルエクステンダーはDigital Extender
機能を割り付けたアサイナブルスイッチで
オン／オフします。

ご注意
スロー＆クイックモーションを有効にする
と、デジタルエクステンダーをオンにする
ことはできません。

ビューファインダー画面

カウンター歩進が保持状態であることを3つの
ドットで表す

SxSA SxSB Proxy
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b ホワイトバランスモード表示
現在選択されているホワイトバランスの自
動調整メモリーが表示されます。
ATW：ATW（自動追尾ホワイトバランス）
モード

W:A：メモリー Aモード
W:B：メモリー Bモード
W:C：メモリー Cモード
W:P：プリセットモード
3200K：Color Temp SW 3200Kを割り当て
たアサイナブルスイッチがオンのとき

4300K：Color Temp SW 4300Kを割り当て
たアサイナブルスイッチがオンのとき

5600K：Color Temp SW 5600Kを割り当て
たアサイナブルスイッチがオンのとき

6300K：Color Temp SW 6300Kを割り当て
たアサイナブルスイッチがオンのとき

c ズームポジション表示（レンズ装着時
のみ）

ズームレンズのズームポジションが0～99
の範囲で表示されます。

d 色温度表示
ホワイトバランスの色温度が表示されます。

e フォーカスポジション表示（レンズ装
着時のみ）

フォーカスポジションが被写体までの距離
（単位：m）で表示されます。

f 電気色温度フィルター表示
CC5600K機能がオンのとき表示されます。

g アイリスポジション表示（レンズ装着
時のみ）

アイリスポジションの設定状態が表示され
ます。

h 記録動作状態表示
本機の記録動作状態が次のように表示され
ます。

グリーンタリー表示
本機が次の状態のときに表示されます。
• メニューのMaintenance >Camera 

Config >HD-SDI Remote I/FがGreen 
Tallyに設定されており、SDI OUT端子か
ら記録の制御信号が出力されているとき

• グリーンタリー信号を受信したとき（本
機にカメラアダプターを取り付けて、カ
メラエクステンションユニットと接続し
ている場合）

i ワイヤレスレシーバー機能表示
本機にスロットインレシーバーが装着され
ているとき「W」が表示され、レシーバー
が使用できるチャンネル数（1ch、2ch、ま
たは4ch）に応じて、各チャンネルの受信
レベルがアイコンで表示されます。
通常：白色セグメントの表示数で受信レベ
ルの強度を示す

表示 意味
●Rec 記録中
Stby 記録待機中
●Cont Rec クリップコンティニュアスレッ

ク記録中
Cont Stby クリップコンティニュアスレッ

ク時に記録待機中
●S&Q Rec スロー &クイックモーション

モードで記録中
S&Q Stby スロー &クイックモーション

モードで記録待機中
●Rec ピクチャーキャッシュレック

モードで記録中
●Cache ピクチャーキャッシュレック

モード時に記録待機中（●は緑
色）

●Int Rec インターバルレックで記録中
Int Stby インターバルレックで記録待機

中
●Int Stby インターバルレックで記録一時

停止中（インターバル期間中）
●Sml Rec 同時記録モードで記録中
Sml Stby 同時記録モードで記録待機中
CALL（赤字） 外部接続機器からのコール時
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アナログレシーバーのミューティング時／
デジタルレシーバーのエラーレート悪
化時：灰色セグメントの表示数で受信
レベルの強度を示す

受信レベルがピークを越えたとき：インジ
ケーターの代わりに「P」と表示される1)

送信機がパワーセーブ中：「S」が表示され
る

送信機のバッテリー消耗時：該当するチャ
ンネル番号とインジケーターが点滅す
る1)

1)別売のDWR-S02D使用時のみ

j S&Q Motion（スロー &クイック）撮影
フレームレート設定表示

本機がスロー＆クイックモーション記録
モードに設定されている場合、撮影フレー
ムレートが表示されます。

k バッテリー残量／電圧表示
本機を駆動している電源の種類に応じて次
のように表示されます。

l NDフィルター表示
現在選択されているNDフィルターのポジ
ション番号が表示されます。（16ページ参
照）。
Electrical CCをアサイナブルスイッチに割
り当てているときは、NDフィルター表示
（1～4）の右側に電気的CCフィルターのポ
ジション（A/B/C/D）が表示されます。

m ゲイン表示
GAINスイッチによる映像アンプのゲイン設
定値（dB）が表示されます。

n シャッターモード／シャッタースピー
ド表示

シャッタースピードまたはシャッターモー
ドが表示されます。

◆「電子シャッターの設定」（59ページ）

o 被写界深度表示（シリアルレンズ装着
時のみ）

被写界深度がバーで表示されます。表示の
単位は、メニューのOperation >Display 
On/Off >Lens Infoの設定により、メートル
またはフィートを選択できます。

p GPS状態表示
GPSの状態が表示されます。
◆「測位情報の取得（GPS）」（103ページ）

q 記録フォーマット（画サイズ）表示
SxSメモリーカードに記録される画サイズ
が表示されます。

r 記録フォーマット（システム周波数と
スキャン方式）表示

現在設定されている本機のシステム周波数
と、記録フォーマットのスキャン方式が表
示されます。

s 記録フォーマット（コーデック）表示
SxSメモリーカードに記録されるフォー
マット名称が表示されます。

表示情報（画面下部）

a AE（オートアイリス）モード表示
現在のオートアイリス機能の動作モードを
アイコンとオートアイリスのオーバーライ
ド量で表示します。

電源の種類 表示
インフォバッテリー バッテリー残量アイコン

と記録可能な残り時間
アントンバウアー社製
バッテリー

バッテリー残量（%表示）

その他の電源 入力電圧

SxSA SxSB Proxy
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b ALAC状態表示
ALAC（倍率色収差補正）が自動的に実行
される状態になっていると、「ALAC」が表
示されます。
ALACが自動的に実行されるのは、ALACに
対応しているレンズが取り付けられ、かつ
ALACの機能が有効になっており、メ
ニューのMaintenance >Camera Config 
>ALACが「Auto」に設定されている場合で
す。

c SDI出力RECトリガー表示
SDI端子出力への記録コマンドの重畳状態が
表示されます。
メニューのMaintenance >Camera Config 
>HD SDI Remote I/Fが「Characters」に設
定されている場合に表示されます。

d フォーカスアシスト表示
フォーカスの合焦度を検出する領域を示す
検出枠（Focus Area Marker）と、検出枠
内のフォーカス合焦度を示すレベルバー
（Focus Assist Indicator）を表示します。

e プロキシ状態表示
プロキシ記録がオン（メニューのOperation 
>Proxy Recording Mode >SettingがOn）
のときに“Proxy”と表示されます。準備中
は“Proxy”表示が点滅します。プロキシ記
録中は“Proxy Rec”と表示されます。プロ
キシファイル転送中は、 と転送率（%）が
表示されます。転送が完了すると が消
え、100%と表示されます。

f ネットワーククライアントモード状態
表示

ネットワーククライアントモードをオンに
すると、CCM（ネットワークRXステーショ
ンのConnection Control Manager）への接
続状態がアイコン表示されます。

g ストリーミング状態表示
ストリーミングの状態がアイコン表示され
ます。

アイコン 意味

 

バックライトモード

 

標準モード

 

スポットライトモード

条件 アイコン
メニューの
Operation 
>Display On/
Off >NW 
Client Mode 
Status

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

状態

Off – – –

On Off – –

On CCM接続
済
CCM接続
中（切断
中） （点滅表示）
CCM接続
待機中

–

CCM接続
エラー

エラー内容
については
「69 ペー
ジ」参照。

条件 ストリーミ
ング状態／
アイコン表
示

メニューの
Operation 
>Display On/
Off 
>Streaming 
Status

メニューの
Maintenance 
>Streaming 
>Setting

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

Off – – –

On Off Off –

On Off 未配信

映像配信中

エラー
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CCMからのストリーミング操作中の場合の
アイコン表示は次のようになります。

ご注意
ストリーミング開始前、アイコンは表示さ
れません。

h タイムコード外部ロック状態表示
タイムコードが外部から入力されていると
きに表示されます。

i ガンマ表示
ガンマ設定値が表示されます。

j 有線LAN／モデム接続状態表示
有線LANネットワーク、またはモデムの設
定／接続状態がアイコン表示されます。

有線LANの設定／接続状態

条件 ストリーミ
ング状態／
アイコン表
示

メニューの
Operation 
>Display On/
Off 
>Streaming 
Status

メニューの
Maintenance 
>Streaming 
>Setting

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

On Off On 未配信

映像配信中

メニュー設定 表示
Operation 
>Display 
On/Off 
>Gamma

Paint >Gammaの設定
Gamma Gamma 

Category
Gamma 
Select

Off – – – –

On Off – – Gamma 
Off

On STD STD1 
DVW

STD1

STD2 
x4.5

STD2

STD3 
x3.5

STD3

STD4 
240M

STD4

STD5 
R709

STD5

STD6 
x5.0

STD6

On On HG HG1 
3250G36

HG1

HG2 
4600G30

HG2

HG3 
3259G40

HG3

HG4 
4609G33

HG4

User User 1 User 1

User 2 User 2

User 3 User 3

User 4 User 4

User 5 User 5

条件 ネットワーク
接続状態／
アイコン表示

メニューの
Operation 
>Display On/
Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wired LAN

Off – – –

On Off – –

On – –

Disable –

Enable LAN準備中

 

（点滅表示）
LAN接続中

LAN接続エ
ラー 

メニュー設定 表示
Operation 
>Display 
On/Off 
>Gamma

Paint >Gammaの設定
Gamma Gamma 

Category
Gamma 
Select
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3G/4Gモデムの設定／接続状態

k Wi-Fiモード状態表示
ネットワークの設定／接続状態がアイコン
表示されます。

l 設定データ保存用SDカード状態表示
UTILITY SDカードスロットに挿入された設
定データ保存用SDカードの状態が表示され
ます。

条件 ネットワーク
接続状態／
アイコン表示

メニューの
Operation 
>Display On/
Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Modem

Off – – –

On Off – –

On – –

Off –

On 3G/4G準備
中 

 

（点滅表示）
3G/4G接続
中 

3G/4G接続
エラー 

条件 ネットワーク
接続状態／
アイコン表示

メニューの
Operation 
>Display On/
Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wi-Fi Mode

Off – – –

On Off – –

On Wi-Fi 
Access 
Point

Wi-Fi準備
中

（点滅表示）
Wi-Fiスタ
ンバイ中
（接続中）

On On Wi-Fi 
Station

Wi-Fi準備
中

 

（点滅表示）
アクセス
ポイント
探索中

 

アクセス
ポイント
接続中

電波強度に
よりアイコ
ンが変化
アクセスポ
イント接続
エラー 

Off –

アイコン メディア状態
– SDカードが挿入されていない、ま

たはマウントされていない
SDカードがマウントされている

マウントされているSDカードがプ
ロテクトされている

（点滅表示）

SDカードのマウント処理中

条件 ネットワーク
接続状態／
アイコン表示

メニューの
Operation 
>Display On/
Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wi-Fi Mode
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m タイムデータ表示
DISPLAYスイッチ（21ページ参照）の設定
に応じて、記録・再生経過時間、タイム
コード、ユーザービットなどが表示されま
す。

n クリップ名表示
記録中は、記録中のクリップに付けられる
クリップ名、記録待機中は、次に記録され
るクリップに付けられるクリップ名が表示
されます。

o オーディオレベルメーター表示
音声チャンネル1、2のレベルが表示されま
す。

p 各メディアスロットの記録メディア状
態／残量表示

SxSスロットA、SxSスロットBおよび
PROXY SDカードスロット内のメディアの
状態と残量が表示されます。
カードスロットAとBの両方にSxSメモリー
カードが装着されている場合、記録中の
SxSメモリーカードの記録可能時間が60秒
以下になると、該当スロットの残量表示が
点滅し、間もなく使用するSxSメモリー
カードが切り換わることを知らせます。

SxSスロットアイコン表示
※SxS スロットAの例です。SxS スロットBはアイ
コンのAがBに変わります。

プロキシデータ記録用SDカードアイコン表
示

残量は記録可能時間が数値で表示されます。

q ビデオ信号表示
出力映像信号の状態をウェーブフォーム、
ベクトルスコープ、ヒストグラム化してリ
アルタイムで表示されます。

アイコン メディア状態
表示なし メディアが挿入されていない／マウ

ントされていない

 

メディアがマウントされている

 

（点滅）
メディアマウント処理中

（オレンジ色
バー点灯）

記録アクティブ

（緑色ランプ
点灯）

再生アクティブ

（オレンジ色
バー +緑色
ランプ点灯）

記録／再生アクティブ

アイコン メディア状態
表示なし メディアが挿入されていない／マウ

ントされていない
メディアがマウントされている

（点滅）
メディアマウント処理中

（オレンジ色
バー点灯）

記録アクティブ
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安全のため、下記ソニー純正以外のバッテ
リーを使用しないでください。
• リチウムイオンバッテリーパック：

BP-FLX75

バッテリーパックBP-FLX75を使った場合、
連続記録での動作時間は約110分です。

直射日光の下や火気の近くなど、高温のと
ころにバッテリーを置かないでください。

ご注意
バッテリーパックの動作時間は、バッテリーパッ
クの使用頻度や使用時の周囲温度によって変化し
ます。

ご使用になる前に、各バッテリーパックに
適したバッテリーチャージャーで充電して
ください。
◆充電方法について詳しくは、バッテリー
チャージャーの取扱説明書をご覧ください。

バッテリーパック使用上のご注意
使用直後、バッテリーパックの温度が上昇
した状態で充電すると、完全に充電されな
いことがあります。

バッテリーパックを取り付けるに
は

1 バッテリーパックの側面のラインを本
体のラインに合わせて、バッテリー
パックを本体の後面に押し当てる。

2 バッテリーパックを押し下げて、
バッテリーパックの「LOCK」表示
部の矢印を本体のラインに合わせる。

2章 準備

電源の準備

バッテリーパックを使用する

1 バッテリーパック
2 本体／バッテリーパックのライン

1「LOCK」表示部の矢印
2 本体のライン
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ご注意
バッテリーパックは、正しく取り付けないと端子
を破損することがあります。

バッテリーパックを取り外すには

解除ボタンを押し込んだままバッテリー
パックを押し上げます。

ご注意
• 記録・再生が行われているときは（右側面の

ACCESSランプが青で点灯、カードスロット部
のACCESSランプがオレンジで点灯）、絶対に
バッテリーパックを抜かないでください。
メモリーカード内のデータが壊れることがあり
ます。

• バッテリーは、必ず本機の電源をオフにしてか
ら交換してください。

ACアダプター AC-DN2B/DN10をバッテ
リーと同様に本体に装着し、AC電源に接続
します。

解除ボタン

AC電源を使用する

コンセントへ
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ビューファインダーを取り付けたあと、接眼レン
ズを太陽に向けて放置しないでください。
太陽光が接眼レンズを通して焦点を結び、火災の
原因になることがあります。

ご注意
ビューファインダーは別売です。

ここでは、HDVF-20Aを取り付ける場合の
例を示します。
◆各ビューファインダーの取り付けかたについ
ては、使用するビューファインダーのマニュ
アルをご覧ください。

ご注意
ビューファインダーを取り付けるときは、以下の
点にご注意ください。
• 必ず本機の電源をオフにしてから、ビューファ
インダーコネクターを本機のVF端子（20ピン）
に差し込んでください。電源がオンの状態でコ
ネクターを差し込むと、ビューファインダーが
正常に動作しないことがあります。

• ビューファインダーコネクターを本機のVF端子
の奥まで確実に差し込んでください。コネク
ターが確実に接続されていないと、画像が乱れ
たり、タリーランプが正常に点灯しないことが
あります。
◆詳しくは、ソニーのサービス担当者にお問い
合わせください。

1 1左右位置固定リングをゆるめる。2
ビューファインダー取り付けシューに
ビューファインダーを取り付け、3左
右位置固定リングを締める。

2 ビューファインダーコネクターをVF
端子（20ピン）に接続する。

ビューファインダーを取り外すに
は

取り付けと逆の手順で行います。ただし、
ビューファインダーを取り付けシューから
取り外すときに、スライドストッパーを引
き上げてください。

ビューファインダーの
取り付け

ビューファインダーを取り付け
る

ビューファインダー左右位置固定リング

スライドストッパー

VF端子（20ピン）
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左右位置を調整するときはビューファイン
ダー左右位置固定リングを、前後位置を調
整するときはビューファインダー前後位置
LOCKつまみを、それぞれゆるめます。

ビューファインダー回転収納機構BKW-401
（別売）を取り付けると、ビューファイン
ダーを垂直位置まで回転させることができ
ます。ビューファインダーをこの位置にし
ておけば、本機のグリップを持ったときに
ビューファインダーが脚に当たらないため、
速やかに移動できます。

1 ビューファインダー前後位置固定レ
バーとビューファインダー前後位置
LOCKつまみをゆるめ、ビューファイ
ンダースライドAssyを手前に引き出
す。

2 対辺2.5ミリの六角レンチを使用し
て、ビューファインダースライド
Assyを取り外す。

3 BKW-401を付属のボルトで取り付け
る。

4 BKW-401のアームを跳ね上げたと
き、ハンドルと干渉しないように前
後位置を調整する。

位置を調整する

ビューファインダー回転収納機
構BKW-401を取り付ける

ビューファインダー左右位置固定リング

ビューファインダー前後位置LOCKつまみ

六角穴付き
ボルト

ビューファインダースライドAssy

BKW-401に付属のボルト

ハンドルと干渉しない位置に調整する
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アイピース部を取り外すと、ビューファイ
ンダーから目を離して撮影する場合にも、
画面がぼやけることなく、全体がよく見え
ます。また、ビューファインダー画面やミ
ラーにほこりが付着した場合にも容易に取
り除くことができます。

1 ロックリングを反時計方向にいっぱい
回して、ロックリングとビューファイ
ンダー筒部のそれぞれの合いマークを
合わせる。

2 アイピース部を抜き取る。

市販の口径52mmのプロテクトフィル
ターやクローズアップレンズなどを取
り付けることができます。

再び取り付けるには

1 ロックリング合いマークをビューファ
インダー筒部の合いマークに合わせ
る。

2 アイピース部先端の合いマークを
ロックリングおよび筒部の合いマー
クに合わせて、アイピース部を筒部
に差し込む。

3 ロックリングを時計方向にいっぱい
に回して、ロックリングの「LOCK」
表示部の矢印をビューファインダー
筒部の合いマークに合わせる。

アイカップが消耗した場合は、交換部品を
お買い求めください。
◆交換部品について詳しくは、ソニーのサービ
ス担当者にお問い合わせください。

視度を調整するには

視度調整リングを回して、ビューファイン
ダー内の画像がはっきり見えるように調整
します。

アイピース部を取り外す

1ロックリング
2ロックリングの合いマーク
3筒部の合いマーク

アイピース部先端の合いマーク

視度と画面を調整する

視度調整リング
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画面を調整するには

ビューファインダー画面の状態を、次の項
目について調整できます。
輪郭：PEAKINGつまみで調整する。
濃淡：CONTRASTつまみで調整する。
明るさ：BRIGHTつまみで調整する。 本機を初めて使用するときは、メニューで

次の設定を行ってください。
◆メニューの操作については、「セットアップ
メニューの基本操作」 （146ページ）をご覧
ください。

タイムゾーンの設定

タイムゾーンを設定します。工場出荷時は
「UTC Greenwich」です。

1 メニューのOperation >Time Zone 
>Time Zoneを選択する。

2 使用するタイムゾーンを選択する。

内蔵時計の日付と時刻の設定

内蔵時計の年、月、日、および時刻を設定
します。

1 メニューのMaintenance >Clock Set 
>Dateを選択する。
Date画面が表示されます。

2 MENUつまみを回して年、月または
日を選択し、つまみを押す。
年、月または日が変更できる状態になり
ます。

3 つまみを回して、年、月または日を
設定して、つまみを押す。

1PEAKINGつまみ
2CONTRASTつまみ
3BRIGHTつまみ

本機を初めて使用する
とき
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4 手順2、3を繰り返して残りの設定を
行う。

5 SETボタンを押す。
手順2～4で設定した日付が内蔵時計に反
映されます。
次に時刻を設定します。

6 メニューのMaintenance >Clock Set 
>Timeを選択する。
Time画面が表示されます。

7 日付の場合と同様の操作で時刻を設
定する。

8 SETボタンを押す。
時刻が内蔵時計に反映されます。

設定を取り消すには
画面の「Cancel」を選択します。

ご注意
レンズの取り付け／取り外しは、必ず電源をオフ
にしてから行ってください。
◆レンズの取り扱いについては、レンズの取扱
説明書をご覧ください。

ご注意
レンズは別売です。

1 レンズ固定レバーを押し上げて、レン
ズマウントからレンズマウントキャッ
プを外す。

2 レンズマウント上部中央の凹部にレ
ンズのセンターピンを合わせ、レン
ズをマウントに差し込む。

3 レンズを支えながら、レンズ固定レ
バーを押し下げてレンズを固定する。

レンズの取り付けと調
整

レンズマウント
ゆるみ止めゴム
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レンズがしっかり固定されていないと、
本機の使用中にレンズが外れて、大きな
事故につながることがあります。レンズ
が固定されているか充分に確認してくだ
さい。前図のように、レンズマウントゆ
るみ止めゴムをはめ込んで使用すること
をおすすめします。

4 レンズケーブルをLENS端子に接続
する。

5 レンズケーブルをケーブルクランプ
に押し込む。

収差補正対応レンズを取り付けたとき
は
自動的に収差補正機能が働きます1)。本機
の起動時にデータ読み込みを行うため、起
動に時間がかかることがあります。
収差補正対応レンズについては、ソニーの
サービス担当者、または営業担当者にお問
い合わせください。
1)メニューのMaintenance >Camera Config 

>ALACをOffに設定していると、収差補正機能
は働きません。

ズーム操作の際に望遠・広角の両方で
フォーカスがきちんと合わない場合は、フ
ランジバック（レンズ取り付け面から結像
面までの距離）の調整を行います。
一度調整すれば、レンズを交換しない限り
再調整の必要はありません。
調整を行うときは、フランジバック調整用
チャートを被写体として使用してください。

調整する

1 レンズの絞りを手動にする。

2 絞りを開き、付属のフランジバック
調整用チャートを約3m離れた位置に
置き、適正な映像出力が得られるよ
うに照明する。

3 F.fまたはF.B（フランジバック調整）
リング固定ネジをゆるめる。

4 手動または電動でズームリングを望
遠位置にする。

5 フランジバック調整用チャートを写
し、フォーカスリングを回して焦点
を合わせる。

6 ズームリングを広角位置にする。

7 F.fまたはF.Bリングを回し、チャー
トに焦点を合わせる。このとき
フォーカスリングは動かさないよう
に注意する。

8 望遠と広角の両方で焦点が合うよう
になるまで、手順4～7の操作を繰り
返す。

9 F.fまたはF.Bリング固定ネジをしっ
かり締める。

フランジバックの調整

約3m
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ビューファインダー（別売）のマイクホル
ダーにステレオマイクロホンECM-680S
（別売）を取り付けることができます。
ここでは、HDVF-20Aに取り付ける場合の
例を示します。
◆各ビューファインダーへの取り付けかたにつ
いては、使用するビューファインダーのマ
ニュアルをご覧ください。

1 ネジをゆるめてマイクホルダーのクラ
ンパーを開く。

2 マイクロホンをマイクホルダーに取
り付ける。
1「UP」の文字を上に向けてマイクを入
れる。

2マイクホルダーを閉める。
3ネジを締める。

◆ 取り付けかたについては、マイクロホ
ンに付属の取扱説明書をご覧ください。

3 マイクケーブルをMIC IN端子に接続
し、このマイクロホンの音声を記録
したいチャンネルのAUDIO INスイッ
チをFRONTに設定する。

4 マイクケーブルをケーブルクランプ
に固定する。

マイクホルダー CAC-12（別売）でAUDIO 
IN CH-1/CH-2端子に、モノラルのマイクロ
ホンを2本まで接続できます。

音声入力の準備

MIC IN端子にマイクロホンを接
続する

マイクホルダーのクランパー

AUDIO IN端子にマイクロホンを
接続する
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ここでは、エレクトレットコンデンサーマ
イクロホンECM-674/678などを取り付ける
ときの例を説明します。
◆CAC-12の取り付けかたについて詳しくは、

CAC-12の取扱説明書をご覧ください。

1 エレクトレットコンデンサーマイクロ
ホンを取り付ける。
1ボールジョイント固定レバーをゆるめ
ておく。

2「UP」の文字を上に向けてマイクを入
れる。

3マイクホルダーを閉める。
4ネジを締める。
5マイクロホンがビューファインダーと
干渉しない位置でボールジョイント固
定レバーを締める。

2 マイクケーブルを本機のAUDIO IN 
CH-1またはCH-2端子に接続する。

3 スイッチを以下のように設定する。
• AUDIO IN切り換えスイッチをMICに
設定する。

• 使用するマイクロホンによって、
+48V/OFFスイッチを以下のように設
定する。
内部電源供給式マイクロホンを使用
する場合：OFF
外部電源供給式マイクロホンを使用
する場合：＋48V

• マイクロホンを接続したチャンネル
に該当するAUDIO IN CH1/CH2ス
イッチをREARに設定する。

4 使用するマイクロホンの感度に合わ
せて、入力レベルを切り換える。
◆ 入力レベルの切り換えは、メニューの

Maintenance >Audio >Rear MIC 

>CH1/CH2 Refの設定値（工場出荷時
は－60dB）を変更することによって行
います。詳しくは、173 ページをご覧
ください。

ご注意
• マイクロホンの感度に対して本機の入力レベル
が適切に設定されていない場合、音が大きく歪
んだり、S/Nが悪化することがあります。

• 本機のAUDIO IN CH-1またはCH-2端子は、
ファントム方式の48V電源を供給できるように
するため、凹のXLRコネクター（3ピン）を装備
しています。マイクケーブルのコネクターが凹
の場合は、変換アダプターをご用意ください。

マイクロホン

1AUDIO IN切り換えスイッチ
2モノラルマイク
3AUDIO IN CH1/CH2スイッチ
4AUDIO IN CH-1またはCH-2端子へ
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• マイクホルダー CAC-12を外す場合は、取り付
けに使ったネジを元の位置に必ず取り付けてく
ださい。

ワイヤレスマイクロホンを使用するときは、
本機の電源をオフにしてから次のいずれか
のポータブルワイヤレスチューナーを取り
付けます。
• デジタルワイヤレスレシーバー DWR-

S02D
• UHFシンセサイザーチューナーユニット

WRR-855S
• UHFシンセサイザーダイバーシティー
チューナーWRR-860A/861/862/URX-
S03D
◆ポータブルワイヤレスチューナーの取扱説明
書も併せてご覧ください。

ご注意
WRR-862を取り付けるには、別売のWRR取り付け
金具（サービスパーツ番号：A-8278-057-B）が必
要です。
詳しくは、ソニーのサービス担当者、または営業
担当者にお問い合わせください。

DWR-S02D/WRR-855S/URX-
S03Dを取り付けるには

1 挿入口のカバーを固定している4本の
ネジをゆるめ、カバーを取り外す。

2 DWR-S02D、WRR-855Sまたは
URX-S03Dを挿入し、4本のネジを締
めて固定する。

3 入力したいチャンネルのAUDIO INス
イッチ（23ページ参照）を
WIRELESSに設定する。

WRR-862を取り付けるには（バッ
テリーパックBP-L80S使用時）

1 別売のWRR取り付け金具（サービス
パーツ番号：A-8278-057-B）を本機
の後部に取り付ける。
1次図のように、プラスドライバーを
使って取り付け金具に付いているネ
ジ（4本）を締める。

ご注意
4本のネジが確実に締められていることを確
認してください。

2取り付け金具の調整ネジをゆるめる。
3バッテリーパックBP-L80Sの厚みに
応じて取り付け金具の位置を調整し
てから、調整ネジを締めて位置を固
定する。

4WRR-862に付属のマウントプレート
を取り付ける。

◆ WRR取り付け金具（サービスパーツ番
号：A-8278-057-B）については、ソ
ニーのサービス担当者または営業担当
者にお問い合わせください。

ポータブルワイヤレスチュー
ナーを取り付ける（ワイヤレス
マイクロホン使用時）

DWR-S02D、WRR-855SまたはURX-S03D
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2 バッテリーパックを取り付ける。
◆ バッテリーパックの取り付けかたにつ
いては、「バッテリーパックを取り付け
るには」 （35ページ）をご覧ください。

3 チューナーを取り付け金具に取り付
ける。

4 チューナーの電源コードを本機のDC 
OUT端子に、音声出力ケーブルを
AUDIO IN CH-1またはCH-2端子に接
続する。

5 スイッチを以下のように設定する。
• 音声出力ケーブルをつないだチャン
ネルに対応するAUIDO IN 切り換えス
イッチをMICに設定する。

• 音声出力ケーブルをつないだチャン
ネルに該当するAUDIO IN CH1/CH2/
CH3/CH4スイッチをREARに設定す
る。
ただし、XLR接続自動検出機能がON
になっている場合は、記録音声が自
動で選択されるため、この操作は不
要です。

ライン入力信号源として使うオーディオ機
器の音声出力端子を、本機のAUDIO IN CH-
1またはCH-2端子に接続します。

スイッチを設定する
音声信号源を接続したチャンネルに対応す
るAUDIO IN切り換えスイッチをLINEに設
定します。

記録する音声入力の選択について
• XLR接続自動検出機能がOFFの場合（工場
出荷時）は、オーディオ機器をつないだ
チャンネルに該当するAUDIO IN CH1/
CH2スイッチをREARに設定します。

• XLR接続自動検出機能をON にすると、
AUDIO IN CH-1またはCH-2 端子への
ケーブル接続時、AUDIO IN CH1/CH2ス
イッチの設定に関わらず、記録音声とし
てこれらの端子からの入力が自動的に選
ばれるようになります。

BP-L80S

調整ネジ

マウントプレート
（WRR-862に付属）

プラスドライバー

WRR-862

ライン入力用オーディオ機器を
接続する

1AUDIO IN CH1/CH2スイッチ
2DC OUT端子へ
3AUDIO IN CH-1またはCH-2端子へ
4AUDIO IN切り換えスイッチ
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XLR接続自動検出機能のON/OFFは、メ
ニューのMaintenance >Audio >Rear XLR 
Autoで切り換えることができます。

1 三脚アタッチメントVCT-14/U14（別
売）を雲台に取り付ける。

2 本機を三脚アタッチメントに取り付
ける。

3 カメラを前後に動かして、外れない
ことを確認する。

1AUDIO IN CH1/CH2スイッチ
2AUDIO IN CH-1またはCH-2端子へ
3オーディオ機器
4AUDIO IN切り換えスイッチ

三脚への取り付け

三脚アタッチメント

雲台

アタッチメントの溝に沿って、カ
チッと音がするまで本機を前方へ
スライドさせる
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三脚アタッチメントから本機を取
り外すには

赤いボタンを押したまま、レバーを矢印の
方向へ動かします。

ご注意
本機を取り外した後、三脚アタッチメントのピン
が元の位置に戻らないときは、赤いボタンを押し
たままレバーを矢印の方向へ動かして、ピンを元
の位置に戻します。ピンが残ったままでは、取り
付けができません。

本機には、アントンバウアー社製のウルト
ラライト2または同等品のビデオライト（電
源電圧12V、最大消費電力50W）を取り付
けて使用できます。
• ビデオライトのコネクターを本機の

LIGHT端子に接続した場合は、LIGHTス
イッチをAUTO側に設定すると、本機のス
タート／ストップに連動して、ライトを
点灯／消灯できます。

• 本機のLIGHT端子は、入力電圧（DC入力
またはバッテリー電圧）が12V以上の場合
は12Vに安定化されるため、バッテリー電
圧の変化によってライトの明るさや色温
度が変化することはありません。

ご注意
• 消費電力が50Wより大きいビデオライトを接続
しないでください。

• 入力電圧（DC入力またはバッテリー電圧）が
12V以下になった場合は、入力電圧の変化に
よってライトの明るさや色温度が変化します。

ビデオライトを取り付けるには

ビデオライトを取っ手のアクセサリー
シューに取り付け、ビデオライトコネク
ターをLIGHT端子に接続します。

ご注意
アクセサリーシューは1/4型ネジタイプです。スラ
イドシュータイプに変更する場合は、本機に付属
のコールドシューキットを使用してください。

レバー

赤いボタン

ビデオライトの接続
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ショルダーベルトを取り付けるに
は

1 片方のクリップをショルダーベルト取
り付け金具に取り付ける。

2 同様にもう一方のクリップを、反対
側のショルダーベルト取り付け金具
に取り付ける。

ショルダーベルトを取り外すにはショルダーベルトの取
り付け

ベルトを上に引っ張ってきちんと固定する

クリップ

ここを押したまま矢印の方向へ引く
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ショルダーパッドは、前後に40mmの範囲
でスライドさせることができます。本機を
肩にのせた状態で操作しやすくなるように、
ショルダーパッドの位置を調整してくださ
い。

1 ショルダーパッドの中央のレバーを引
き上げてロックを外す。

2 前後方向にスライドして、適当な位
置を選ぶ。

3 レバーを倒して固定する。

ショルダーパッドの位
置調整

ショルダーパッド
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◆メニューの操作について詳しくは、「セットアップメニューの基本操作」（146ページ）をご覧くだ
さい。

3章 撮影のための調整と設定

ビデオフォーマットの設定

システム周波数
メニューの Operation 
>Format >Frequency

ファイルシステム
メニューの Operation 
>Format >File System

ビデオフォーマット
メニューの Operation 
>Format >Rec Format

画サイズ

exFAT UDF FAT
59.94/50 ○ – – XAVC-I 1080P 1920×1080

○ – – XAVC-I 1080i

○ – – XAVC-I 720P 1280×720

○ – – XAVC-L 50 1080P 1920×1080

○ – – XAVC-L 50 1080i

○ – – XAVC-L 50 720P 1280×720

○ – – XAVC-L 35 1080P 1920×1080

○ – – XAVC-L 35 1080i

○ – – XAVC-L 25 1080i

○ ○ – HD422 50 1080i 1920×1080

○ ○ – HD422 50 720P 1280×720

○ ○ ○ HQ 1920×1080i 1920×1080

○ ○ ○ HQ 1440×1080i 1440×1080

○ ○ ○ HQ 1280×720P 1280×720
– – ○ SP 1440×1080i 1440×1080

○ – – SStP SR-Lite 422 c) 1920×1080

○ – – DNxHD 220x 1080i a) c) 1920×1080

○ – – DNxHD 145 1080i a) c)

○ – – ProRes 422 HQ 1080i b) c) 1920×1080

○ – – ProRes 422 1080i b) c)

○ ○ – MPEG IMX 50 720×486/720×576

○ ○ – DVCAM 720×480/720×576
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a)PXWK-502 Codec Option適用時
b)PXWK-501 Codec Option適用時
c)プロキシ記録およびワイヤレスLAN接続機能には対応していません。

SDI OUT端子、HDMI出力端子、VIDEO OUT端子の出力フォーマット

SDI OUT端子、HDMI出力端子、およびVIDEO OUT端子からの出力信号は、メニューのOperation
>Formatの設定に応じて下表のように出力されます。

29.97/25/23.98 ○ – – XAVC-I 1080P 1920×1080

○ – – XAVC-L 50 1080P 1920×1080

○ – – XAVC-L 35 1080P

○ ○ – HD422 50 1080P 1920×1080

○ ○ – HD422 50 720P 1280×720

○ ○ ○ HQ 1920×1080P 1920×1080

○ – – SStP SR-Lite 422 c) 1920×1080

○ – – DNxHD 220x 1080P a) c) 1920×1080

○ – – DNxHD 145 1080P a) c)

○ – – ProRes 422 HQ 1080P b) c) 1920×1080

○ – – ProRes 422 1080P b) c)

メニューの Operation VIDEO OUT信号
フォーマットFormat Input/Output

Frequency Rec Format
（コーデックは省略）

Output Format プロキシ記録／ワイヤレス
LAN接続機能

SDI HDMI OFF ON

59.94 1920×1080 P 1920×1080P
（Level A）

1920×1080P HD-Y HD-Y

1920×1080P
（Level B）

無信号 HD-Y HD-Y

1920×1080i 1920×1080i HD-Y HD-Y

720×486i 720×480i Composite f) g) Composite d)

1920×1080 i 1920×1080i 1920×1080i HD-Y HD-Y

720×486i 720×480i Composite f) g) Composite d)

1440×1080 i 1920×1080i 1920×1080i HD-Y HD-Y

720×486i c) 720×480i c) Composite f) g) －

1280×720 P 1280×720P 1280×720P HD Sync a) HD Sync a)

720×486i 720×480i Composite f) g) Composite d)

720×480 i 720×486i 720×480i Composite f) g) Composite d)

無信号 720×480P Composite f) g) HD-Y

システム周波数
メニューの Operation 
>Format >Frequency

ファイルシステム
メニューの Operation 
>Format >File System

ビデオフォーマット
メニューの Operation 
>Format >Rec Format

画サイズ

exFAT UDF FAT
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a) 1080i Sync信号を出力します。
b) 1080PsF信号を出力します。
c) プロキシ記録、およびワイヤレスLAN接続機能がオンのときは1920×1080iに切り換わります。
d) 文字情報（スーパーインポーズ）はSDI OUT2/HDMIの文字情報表示オン／オフに連動します。
e) Apple ProRes/Avid DNxHD®選択時はHD Syncになります。
f) SStP/Apple ProRes/Avid DNxHD®選択時には、文字情報（スーパーインポーズ）はSDI OUT2端子の出力
オン／オフに連動します。

g) SStP選択時には、文字情報（スーパーインポーズ）はSDI OUT2端子の出力オン／オフに連動します。

29.97 1920×1080 P 1920×1080PsF 1920×1080i HD-Y f) HD-Y f)

720×486i 720×480i Composite f) g) Composite d)

1280×720 P 1280×720P 1280×720P HD-Y b) f) HD-Y b) f)

720×486i 720×480i Composite f) g) Composite d)

23.98 1920×1080 P 1920×1080PsF 無信号 HD-Y f) HD-Y f)

1920×1080i
(2-3PD)

1920×1080i
(2-3PD)

HD-Y e) f) g) HD-Y f) g)

720×486i 
(2-3PD)

720×480i
(2-3PD)

Composite f) g) Composite d)

1280×720 P 1280×720P
(2-3PD)

1280×720P
(2-3PD)

HD-Y b) f) HD-Y b) f)

720×486i
(2-3PD)

720×480i
(2-3PD)

Composite f) g) Composite d)

50 1920×1080 P 1920×1080P 
(Level A)

1920×1080P HD-Y HD-Y

1920×1080P 
(Level B)

無信号 HD-Y HD-Y

1920×1080i 1920×1080i HD-Y HD-Y

720×576i 720×576i Composite f) g) Composite d)

1920×1080 i 1920×1080i 1920×1080i HD-Y HD-Y

720×576i 720×576i Composite f) g) Composite d)

1440×1080 i 1920×1080i 1920×1080i HD-Y HD-Y

720×576i c) 720×576i c) Composite f) g) －

1280×720 P 1280×720P 1280×720P HD Sync a) HD Sync a)

720×576i 720×576i Composite f) g) Composite d)

720×576 i 720×576i 720×576i Composite f) g) Composite d)

無信号 720×576P Composite f) g) HD-Y

25 1920×1080 P 1920×1080PsF 1920×1080i HD-Y f) HD-Y f)

720×576i 720×576i Composite f) g) Composite d)

1280×720 P 1280×720P 1280×720P HD-Y b) f) HD-Y b) f)

720×576i 720×576i Composite f) g) Composite d)

メニューの Operation VIDEO OUT信号
フォーマットFormat Input/Output

Frequency Rec Format
（コーデックは省略）

Output Format プロキシ記録／ワイヤレス
LAN接続機能

SDI HDMI OFF ON
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ご注意
記録フォーマットがXAVC-Lで1080/59.94Pおよび50Pを選択した場合は以下に注意してください。
• ピクチャーキャッシュレック機能を有効にすると、SDI出力のLevel Aとその他の出力フォーマットの相
互切り換えは行えません。

• Level Aを選択した場合にSDI Out OutputのOn/Off 切り換えが行えない場合があります。変更する場合
は、一度ピクチャーキャッシュレック機能を無効にしてから、変更操作を行ってください。
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ファイルシステムを選択します。

1 メニューのOperation >Format 
>File Systemを選択する。

2 MENUつまみを回して、ファイルシ
ステムを選択し、つまみを押す。
確認画面が表示されます。

3 実行するにはExecuteを、中止する
にはCancelを選択し、MENUつまみ
を押す。
Execute実行後、本機は自動的に再起動
します。

ご注意
記録・再生中またはサムネイル画面表示中にファ
イルシステムを切り換えることはできません。

必要に応じてシステム周波数を切り換えま
す。

1 メニューのOperation >Format 
>Frequencyを選択する。

2 MENUつまみを回してシステム周波
数を選択し、つまみを押す。
確認画面が表示されます。

3 実行するにはExecuteを、中止する
にはCancelを選択し、MENUつまみ
を押す。
Execute実行後、本機は自動的に再起動
します。

ご注意
• 記録・再生中またはサムネイル画面表示中にシ
ステム周波数を切り換えることはできません。

• 周波数29.97と59.94間、および25と50間での切
り換え後は、自動的には再起動されません。

前記の表を参照し、必要に応じてビデオ
フォーマットを切り換えます。

1 メニューのOperation >Format >Rec 
Formatを選択する。

2 MENUつまみを回してビデオフォー
マットを選択し、つまみを押す。
確認画面が表示されます。

3 実行するにはExecuteを、中止する
にはCancelを選択し、MENUつまみ
を押す。

ファイルシステムを選択する

システム周波数を切り換える

ビデオフォーマットを切り換え
る
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本機を使用し、常に高画質の映像を得るた
めには、状況に応じたブラックバランスと
ホワイトバランスの調整が必要です。
本機で自動調整される調整値や各設定値は、
本機のメモリーに記憶され、電源を切って
も保持されます。

次のような場合に調整が必要です。
• 本機を初めて使用するとき
• 長時間使用しなかった後に使用するとき
• 周囲の温度が大幅に変化した状況で使用
するとき

• メニューのOperation >Gain Switchで
GAINスイッチ（L/M/H/Turbo）に設定し
ているゲイン値を変更したとき
通常は、電源を再び入れた場合でも調整し
直す必要はありません。

ブラックバランスの自動調整は、ブラック
セット、ブラックバランスの順に実行され
ます。ブラックバランスは、設定メニュー
の操作によって手動調整することもできま
す。

以下の場合は、ブラックバランスの自動調
整ができません。
• 記録中
• 特殊記録モード時
• シャッターモードがSLSモードの場合

1 OUTPUT/DCCスイッチをCAMにす
る。

2 AUTO W/B BALスイッチをBLACK側
に押して、指を離す。
調整中は「Executing...」と表示され、
「OK」に変われば終了です。
調整値は自動的にメモリーに記憶され
ます。

ご注意
• ブラックバランス調整中、絞りは自動的に遮光
状態になります。

• ブラックバランス調整中、ゲイン切り換え回路
が自動的に働き、ビューファインダー画面上に
フリッカーが数回現れますが、故障ではありま
せん。

ブラックバランスの自動調整がで
きないときは

ブラックバランスの調整が正常に終了しな
かったときは、ビューファインダー画面に
約3秒間エラーメッセージが表示されます。
表示されるエラーメッセージは次のとおり
です。

上記のエラーメッセージが表示されたら、
再度ブラックバランスの調整を試みてくだ
さい。
繰り返し調整を試みてもエラーメッセージ
が表示されるときは、内部点検をする必要
があります。
◆内部点検については、メンテナンスマニュア
ル（別売）をご覧ください。

ご注意
レンズの接続ケーブルがLENS端子にしっかり接
続されていないと、レンズの絞りが遮光状態にな
らず、ブラックバランスはエラーになります。

ブラックバランス／ホ
ワイトバランスの調整

ブラックバランスを調整する

エラーメッセージ 意味
NG: Iris not Closed レンズの絞りが閉まらな

かったため、調整できな
かった。

NG: Timeout 規定された調整回数以内で
調整が終了しなかった。

NG: Out of Range 現在値と基準値の差が大き
く、調整範囲を超えていた
ため、調整できなかった。
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照明条件が変わったときには、必ず調整し
直してください。

1 以下のようにスイッチを設定する。
• GAINスイッチ：L（できるだけ小さ
いゲイン値に設定）

• OUTPUT/DCCスイッチ：CAM
• WHITE BALスイッチ：AまたはB 1)

1)メモリー Bに設定値が記憶されるのは、メ
ニューのOperation >White Setting >White 
Switch<B>がMemoryに設定されていると
きのみです。

2 照明条件に合わせて、FILTERつまみ
の設定を切り換える。

3 被写体の照明光源と同じ条件のとこ
ろにホワイトパターンを置き、ズー
ムアップして画面に白を映す。
被写体の近くの白いもの（白布、白壁）
で代用することもできます。
最小限必要な白の面積は、図のとおり
です。

ご注意
長方形内に高輝度スポットを入れないように
してください。

4 レンズの絞りを調整する。
手動調整レンズの場合：絞りを適正値
に合わせる。

自動絞り調整機能付きレンズの場合：
レンズ側の絞り自動／手動切換ス
イッチを自動に設定する。

5 AUTO W/B BALスイッチをWHITE側
に押して、指を離す。
調整中は「Executing...」と表示され、
「OK: （被写体の色温度）」と表示され
れば終了です。
調整値は、手順1で選択したメモリー (A
またはB)に自動的に記憶されます。

ご注意
自動絞り機能付きズームレンズを使用した場
合、絞りがハンチング 1) を起こすことがあり
ます。このような場合は、レンズに付いてい
る絞りのゲインつまみ（IG、IS、Sなどと表
示されている）を調整してください。
◆詳しくは、レンズの取扱説明書をご覧
ください。

1)ハンチング：オートアイリスの応答を繰り
返し、映像が暗くなったり明るくなったり
すること。

ホワイトバランスの自動調整がで
きないときは

ホワイトバランスの調整が正常に終了しな
かったときは、ビューファインダー画面に
約3秒間エラーメッセージが表示されます。
表示されるエラーメッセージは次のとおり
です。

ホワイトバランスを調整する

画面センターを中心とする長方形
各辺の長さは、画面の高さ、または幅の70%
この長方形内に、画面面積の10%以上の画面
の白が必要

エラーメッセージ 意味
NG: Low Light 白の映像レベルが低すぎ

る。レンズの絞りを開け
るか、ゲインを上げる。

NG: Timeout 規定された調整回数以内
で調整が終了しなかった。

NG: High Light 白の映像レベルが高すぎ
る。レンズを絞るか、ND
フィルターを変える。

NG: Color Temp. 
High

被写体照明の色温度が高
すぎて調整できなかった。
照明の色温度を調整して、
メモリーを更新する。

NG: Color Temp. 
Low

被写体照明の色温度が低
すぎて調整できなかった。
照明の色温度を調整して、
メモリーを更新する。

NG: Out of Range 現在値と基準値の差が大
きく、調整範囲を超えて
いたため、調整できな
かった。
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エラーメッセージが表示されたら、再度ホ
ワイトバランスの調整を試みてください。
繰り返し調整を試みてもエラーメッセージ
が表示されるときは、内部点検をする必要
があります。
◆内部点検については、メンテナンスマニュア
ルをご覧ください。

ホワイトバランスを調整する時間
がないときは

WHITE BALスイッチをPRSTにします。

NDフィルターの切り換えに合わせ
て色温度を変更するには

電気的CC（色補正）フィルターをNDフィ
ルター（16ページ参照）に割り当てること
によって、NDフィルターの切り換えに合わ
せて色温度を変更することができます。

1 メニューのMaintenance >White 
Filter >ND Filter C.TempをOnに設定
する（178ページ参照）。

2 電気的CCフィルターをFILTERつま
みのポジション番号1に割り当てると
きはND FLT C.Temp<1>を、ポジ
ション番号2～4に割り当てるときは
ND FLT C.Temp<2-4>を選択する。

3 MENUつまみを回して希望の色温度
を選択する。

4 必要に応じて、手順2と3を繰り返す。

電気的CCフィルターをアサイナブ
ルスイッチで切り換えるには

電気的CCフィルターの切り換え機能をアサ
イナブルスイッチに割り当てることによっ
て、アサイナブルスイッチを押すたびに最
大で4つのポジション（A～D）に設定され
た色温度（3200K/4300K/5600K/6300K）
を切り換えることができます。

1 メニューのMaintenance >White 
Filterを選択する。

2 CCフィルターを設定したいポジショ
ンElectrical CC<A>～<D>を選択し、
MENUつまみを回して希望の色温度
を選択する。

色温度を設定しないときは
Electrical CC<C>、<D>の設定時に「-
----」を選択します。
アサイナブルスイッチを押しても、そ
のポジションの設定は表示されません。
たとえば、1つのポジションに「-----」
を設定したときは、3つのポジションの
切り換えになります。

3 必要に応じて、手順2を繰り返す。

4 アサイナブルスイッチに電気的CC
フィルターの切り換え機能
（ELECTRICAL CC）を割り当てる
（189ページ参照）。

NG: Poor White Area 被写体の白の面積が狭す
ぎて調整できなかった。

エラーメッセージ 意味
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ホワイトバランスのメモリーにつ
いて

メモリーに記憶された値は、本機の電源を
切った状態でも、再度ホワイトバランスを
調整するまで保存されます。
ホワイトバランスのメモリーは、A、Bの2
系統があり、WHITE BALスイッチの設定
（AまたはB）に対応するメモリーに、ND
フィルターごとの調整値を自動的に記憶さ
せることができます。本機は4つのNDフィ
ルターを内蔵しているので、合計8個（4×
2）の調整値を記憶できます。ただし、次の
場合、メモリーの内容はNDフィルターに連
動しません。
• メニューのOperation >White Setting 

>Filter White MemoryをOffに設定するこ
とによって、A、B両系統のメモリー数を
1個に限定したとき
また、メニューのOperation >White Setting 
>White Switch<B>をATWに設定すると、
WHITE BALスイッチがBの位置でATW（自
動追尾ホワイトバランス）が動作し、照明
条件の変化に応じて画像のホワイトバラン
スが自動追従します。

本機の電子シャッターで使用できるシャッ
ターモードと、選択できるシャッタース
ピードは次のとおりです。

ご注意
RM-B170などのリモートコントロールユニット接
続時は、標準モード（Speed）のみ選択できます。

標準モード

動きの速い被写体を鮮明に撮影したい場合
などに使用します。
秒数でシャッター速度を設定するSpeed
（スピード）モードと開角度でシャッター速
度を設定するAngle（角度）モードを選択
できます。

Speedモード

a)スロー＆クイックモーション撮影時、メニュー
のOperation >Rec Function >Frame Rateをシ
ステム周波数より大きい値に設定している場合
は選択できません。

電子シャッターの設定

シャッターモードについて

システム
周波数

シャッタースピード（単位：秒）

59.94i
59.94P
50i
50P

1/60、1/100、1/120、1/125、1/250、
1/500、1/1000、1/2000

29.97P 1/40
 a)、1/50

 a)、1/60、1/100、1/120、
1/125、1/250、1/500、1/1000、1/2000

25P 1/33
 a)、1/50

 a)、1/60、1/100、1/120、
1/125、1/250、1/500、1/1000、1/2000

23.98P 1/32
 a)、1/48

 a)、1/50
 a)、1/60、1/96、

1/100、1/120、1/125、1/250、1/500、
1/1000、1/2000
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Angleモード
180°、90°、45°、22.5°、11.25°

ECS（拡張クリアスキャン）モー
ド

モニター画面を、水平方向の縞模様が出な
いように走査したい場合などに使用します。
設定可能なシャッタースピードの範囲は、
スロー＆クイックモーション（S&Q）機能
のオフ／オンによって、次表のように変わ
ります。

SLS（スロースピードシャッター）
モード

低照度の被写体を撮影したいときに使用し
ます。スロースピードシャッター機能の蓄
積フレーム数は、メニューのOperation 
>Slow Shutter >Number of Framesで2、3、
4、5、6、7、8、16から選択します。

ご注意
• スロー＆クイックモーション撮影時は、SLS
モードを使用することができません。

• 記録中にSLSモードをオン／オフしたり、蓄積
フレーム数を変更することができません。

ご注意
• 絞りが自動のときは、シャッタースピードが速
くなるにつれ、絞りが開き、被写界深度も浅く
なります。

• 選択できるシャッタースピードは、設定されて
いるシステム周波数によって異なります。

SpeedモードとAngleモードを切
り換えるには

1 メニューのOperation >Shutter 
>Modeを選択する。

2 MENUつまみを回して、Speedまた
はAngleを選択し、つまみを押す。

シャッターモードおよびシャッ
タースピード（標準モード）を設
定するには

一度選択したシャッタースピードは、本機
の電源を切った状態でも保持されます。

1 SHUTTERスイッチを、ONの位置か
らSELECT側に押す。
シャッターの現在の設定がビューファ
インダー画面に約3秒間表示されます。

2 手順1の表示が消える前に、もう一度
SHUTTERスイッチをSELECT側に
押す。希望のモードまたはスピード
が表示されるまで、この操作を繰り
返す。
すべてのモードとスピードが表示され
る場合は、以下の順序で表示が切り替
わります。

 

システム
周波数

シャッタースピード（単位：Hz）
S&Q：オフ S&Q：オン

59.94i 60.00～7000 ―
59.94P 60.00～8000 60.00～8000
29.97P 30.00～8000 30.00～8000
23.98P 23.99～6000 30.03～6000
50i 50.00～7000 ―
50P 50.00～7000 50.00～7000
25P 25.02～7000 30.00～7000

シャッターモード／シャッター
スピードを設定する

Speedモード（システム周波数：
59.94iの場合）の表示例

ECSモード
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ご注意
スロー＆クイックモーションモード時のフレーム
レートの設定によっては（87ページ参照）、特定
のシャッタースピードが選択できなくなることが
あります。選択できないシャッタースピードは、
選択可能な最も遅いシャッタースピードに置き換
わります。

例：XAVC-I 1080P/29.97P、フレームレート60で
スロー＆クイックモーション撮影を行う場合
シャッタースピードは次のように表示されます。
スロー＆クイックモーションモード：オフ
1/40t1/50t1/60t1/100t...

スロー＆クイックモーションモード：オン
1/60t1/100t...

シャッタースピード（ECSモード）
を設定するには

1 シャッターモードをECSに設定する
（前項参照）。

2 MENUつまみを回して、希望の周波
数を表示させる。

シャッタースピード（SLSモード）
を設定するには

1 メニューのOperation >Slow Shutter 
>Settingで、シャッターモードをOn
に設定する。

2 メニューのOperation >Slow Shutter 
>Number of Framesで、希望のフ
レーム数を選択する。

逆光の被写体を適正な明るさで撮るときや、
スポットライトが当てられた被写体の白つ
ぶれなどを防ぐときなど、被写体の照明条
件によってはオートアイリスの設定を変更
する必要があります。

オートアイリスの動作モードを設
定するには

オートアイリスでレベル調整するときに使
用する動作モードを設定します。

1 メニューのOperation >Auto Iris 
>Modeを選択する。

2 MENUつまみを回して動作モードを
選択し、つまみを押す。

オートアイリスでの収束目標レベ
ルを設定する

1 メニューのOperation >Auto Iris 
>Levelを選択する。

2 MENUつまみを回してレベルを－99
～+99の範囲で選択し、つまみを押
す。

オートアイリスの設定

動作モード 説明
Backlight 逆光状態の撮影に適したモー

ド
Standard 標準のモード
Spotlight 中心となる被写体にスポット

ライトがあたっているとき、
白潰れを軽減するモード

収束目標レベル 説明
－99 2絞り分以上暗めに設定す

る
±0 標準のレベル
+99 2絞り分以上明るめに設定

する
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オートアイリスのスピードを設定
する

オートアイリスでレベルを調整するときの
動作速度を設定します。

1 メニューのOperation >Auto Iris 
>Speedを選択する。

2 MENUつまみを回して動作速度を
[－99]（最も遅い）～[+99]（最も速
い）の範囲で選択し、つまみを押す。

レンズ絞りの基準値を変更するに
は

レンズ絞りの基準値は、標準値に対して次
の範囲に設定できます。
• +0.25～+1（0.25刻み）：約+0.25～+1絞
り分開きぎみになる。

• －0.25～－1（0.25刻み）：約0.25～1絞り
分閉じぎみになる。
また、オートアイリスの対象となる範囲を
設定しておくこともできます。

1 メニューのOperation >Auto Iris >Iris 
OverrideをOnに設定する。

2 MENU ON/OFFスイッチをOFFにす
る。

3 MENUつまみを回して基準値を変更
する。

ご注意
このとき、シャッターモードがECS以外の
モードになっていることを確認してくださ
い。

現在の基準値は、ビューファインダー
画面のアイリスポジション表示（28
ページ参照）で確認することができま
す。

絞りを開きぎみにする場合
MENUつまみを本機正面から見て反時
計方向に回します。
+0.25、+0.5、+0.75、+1のいずれかに
設定します。

絞りを閉じぎみにする場合
MENUつまみを本機正面から見て時計
方向に回します。
－0.25、－0.5、－0.75、－1のいずれ
かに設定します。

変更した基準値は電源を切るまで保持
されます。基準値を変更しても、電源
を入れるたびに標準値に戻ります。

オートアイリス検出ウィンドウを
設定するには

1 メニューのOperation >Auto Iris 
>Detect Window IndicationをOnに設
定する。
ビューファインダー画面上に現在選択
されているオートアイリスウィンドウ
が表示されます。
オートアイリスウィンドウを常に表示
しておく必要がない場合は、Offに設定
します。

2 メニューのOperation >Auto Iris 
>Detect Windowを選択する。

3 MENUつまみを回して希望のオート
アイリスウィンドウを選択し、つま
みを押す。

Varを選ぶと、次表の項目が有効とな
り、希望の大きさのウィンドウを作成
できます。メニューのOperation >Auto 
Iris >Iris Var Width、Iris Var Height、
Iris Var、Iris Var H Position、Iris Var V 
Positionで設定してください。

図の網掛け部で光を検出する
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メニューを終了すると、手順3で選択した
オートアイリスウィンドウが表示されます。
常に表示しておく必要がない場合は、メ
ニューのOperation >Auto Iris >Detect 
Window Indicationの設定をOffに変更しま
す。

高輝度の外乱による影響を軽減さ
せるには

高輝度の画像が入ってきたためオートアイ
リスが閉じすぎて全体的に暗くなりすぎ、
黒つぶれという状態になることがあります。
このような場合は、ハイライトクリップ機
能をONに設定すると、あるレベル以上のも
のにクリップをかけて、オートアイリスへ
の影響を低減することができます。
メニューのOperation >Auto Iris >Clip High 
LightをOnに設定します。

AUDIO SELECTスイッチをAUTOにすると、
各チャンネルに記録されるアナログ音声信
号の入力レベルは自動的に調整されます。
また、手動で調整することもできます。

ご注意
AUDIO SELECTスイッチをAUTOにしても、デジ
タル音声信号の入力レベルは自動調整されませ
ん。

手動調整時の音声レベルの目安
－20 dBを目安に調整します。
音声レベルメーターが0 dBまで表示される
ときは、入力音量が過大です。

1 AUDIO IN CH-1/CH-2端子への入力信
号を記録、調整したいチャンネルに相
当するAUDIO IN CH1/CH2スイッチ
をREARにする。
1、2チャンネルとも記録、調整する場
合は、両方のAUDIO IN CH1/CH2ス
イッチをREARにする。

項目 設定
Iris Var Width ウィンドウの幅
Iris Var Height ウィンドウの高さ
Iris Var H 
Position

ウィンドウの横方向の位置

Iris Var V 
Position

ウィンドウの縱方向の位置

音声レベルの調整

AUDIO IN CH-1/CH-2端子から
の音声レベルを手動調整する

調整の目安

過大入力
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2 手順1で選んだチャンネルのAUDIO 
SELECTスイッチをMANUALにす
る。

3 手順1で選んだチャンネルのLEVEL
つまみで、通常の入力音量のときの
音声レベルメーターが－20 dBまで表
示されるように調整する。

記録レベル調整とつまみの対応に
ついて

メニューのMaintenance >Audioで、
AUDIO IN CH-1/CH-2端子に入力される音
声の記録レベルの調整をどのつまみで行う
か、選択することができます。各メニュー
項目の設定値とつまみの対応は以下のとお
りです。

ご注意
AES/EBUデジタルオーディオ信号を入力する場合
は、本機で記録レベル調整を行うことはできませ
ん。

Rear1/WRR Level：チャンネル1の記録レ
ベル

Rear2/WRR Level：チャンネル2の記録レ
ベル

ご注意
LEVEL（CH1/CH2）つまみとMIC LEVELつまみ
の連動を選択した場合、MIC LEVELつまみが「0」
に絞られているとチャンネル1、2の音声を記録で
きません。MIC LEVELつまみの位置を確認してか
ら、LEVEL（CH1/CH2）つまみで調整してくださ
い。

1 使用するチャンネルのAUDIO INス
イッチをFRONTに設定する。

2 手順1で選んだチャンネルのAUDIO 
SELECTスイッチをMANUALに設定
する。

3 MIC LEVELつまみを回して、通常の
入力音量のとき音声レベルメーター
が－20 dBまで表示されるように調整
する。

記録レベル調整とつまみの対応に
ついて

メニューのMaintenance >Audioで、フロン
トマイクから入力する音声の記録レベルの
調整をどのつまみに割り当てるかを設定で
きます。各メニュー項目の設定値とつまみ
の対応は以下のとおりです。
MIC CH1 Level：チャンネル1の記録レベ
ル

MIC CH2 Level：チャンネル2の記録レベ
ル

設定値 つまみ
Side1 LEVEL（CH1）つまみ
Front MIC LEVELつまみ
Front+Side1 LEVEL（CH1）つまみとMIC 

LEVELつまみの連動

設定値 つまみ
Side2 LEVEL（CH2）つまみ
Front MIC LEVELつまみ
Front+Side2 LEVEL（CH2）つまみとMIC 

LEVELつまみの連動

MIC IN端子からの音声レベルを
手動調整する

設定値 つまみ
Side1 LEVEL（CH1）つまみ
Front MIC LEVELつまみ
Front+Side1 LEVEL（CH1）つまみとMIC 

LEVELつまみの連動

設定値 つまみ
Side2 LEVEL（CH2）つまみ
Front MIC LEVELつまみ
Front+Side2 LEVEL（CH2）つまみとMIC 

LEVELつまみの連動
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ご注意
MIC LEVELつまみとLEVEL（CH1/CH2）つまみ
の連動を選択した場合、LEVEL（CH1/CH2）つま
みが「0」に絞られているとチャンネル1、2の音
声が記録できません。LEVEL（CH1/CH2）つまみ
の位置を確認してから、MIC LEVELつまみで調整
してください。

記録音声の選択について

音声チャンネル3、4に記録される音声は、
AUDIO IN CH3/CH4スイッチで選ぶことが
できます。

記録音声レベルを調整するには

自動調整するには
AUDIO SELECT CH 3-4スイッチをAUTOに
します。

手動調整するには

1 AUDIO SELECT CH 3-4スイッチを
MANUALにする。

2 レベル調整を行うつまみを、メ
ニューのMaintenance >Audioの
Audio CH3 LevelおよびAudio CH4 
Levelで選択する。

Audio CH3 Level：チャンネル3の記録
レベル

Audio CH4 Level：チャンネル4の記録
レベル

音声チャンネル3、4の音声レベルが、
ここで選択したつまみで調整できるよ
うになります。

チャンネル3、4への音声の記録
について

CH3スイッチ チャンネル 3の記録対象
FRONT フロントマイクロホンの音声
REAR AUDIO IN CH-1端子に入力さ

れる音声信号
WIRELESS ワイヤレスマイクロホンの音声

CH4スイッチ チャンネル 4の記録対象
FRONT フロントマイクロホンの音声
REAR AUDIO IN CH-2端子に入力さ

れる音声信号
WIRELESS ワイヤレスマイクロホンの音声

設定値 つまみ
Side3 LEVEL（CH3）つまみ
Front MIC LEVELつまみ
Front+Side3 LEVEL（CH3）つまみと

MIC LEVELつまみの連動

設定値 つまみ
Side4 LEVEL（CH4）つまみ
Front MIC LEVELつまみ
Front+Side4 LEVEL（CH4）つまみと

MIC LEVELつまみの連動
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タイムコードの設定可能範囲は、
00:00:00:00～23:59:59:29（時：分：秒：
フレーム）です。

1 DISP SEL/EXPANDボタンを押して、
LCDモニターをステータス表示に切り
換える。

2 DISPLAYスイッチをTCにする。

3 PRESET/REGEN/CLOCKスイッチ
をPRESETにする。

4 F-RUN/SET/R-RUNスイッチをSET
にする。
タイムコードの最上桁が点滅します。

5 上下矢印ボタンで数値を変更し、左
右矢印ボタンで桁を移動して、すべ
ての桁を設定する。

数値を00:00:00:00にリセットするには
RESET/RETURNボタンを押します。

6 希望の数値に設定した後、F-RUN/
SET/R-RUNスイッチを切り換える。
F-RUN：タイムコードは常に歩進する
R-RUN：タイムコードは記録時に歩進
する

ご注意
ピクチャーキャッシュレックモードが有効なとき
は、F-RUN/SET/R-RUNスイッチをSETにしても
タイムデータの設定を行うことはできません。タ
イムデータを設定する場合は、ピクチャーキャッ
シュレックモードをオフにしてください。

DF/NDFの切り換えについて
メニューのMaintenance >Timecode >DF/
NDFで、DF（ドロップフレームモード）／

NDF（ノンドロップフレームモード）を切
り換えることができます。

タイムコードを連続させるには
F-RUN/SET/R-RUNスイッチがR-RUNに設
定されているときは、タイムコードは連続
して記録されます。ただし、途中でメディ
アを交換して記録を行うと、再び元のメ
ディアを入れてもタイムコードは連続しま
せん。
このようなときは、PRESET/REGEN/
CLOCKスイッチをREGENにするとタイム
コードを連続させることができます。

タイムコードに実時刻を入れるには
PRESET/REGEN/CLOCKスイッチを
CLOCKにすると、タイムコードに実時刻が
入ります。実時刻には本機の内蔵時計の時
刻が反映されます。
◆内蔵時計の調整について詳しくは、「内蔵時
計の日付と時刻の設定」（40ページ）をご覧
ください。

ユーザービットを設定することにより、16
進数8桁までのメモ（日付、時刻、シーン番
号）などの情報をタイムコードトラックに
記録することができます。

1 DISP SEL/EXPANDボタンを押して、
LCDモニターをステータス表示に切り
換える。

2 DISPLAYスイッチをU-BITにする。

3 F-RUN/SET/R-RUNスイッチをSET
にする。
ユーザービットの最上桁が点滅します。

4 上下矢印ボタンで数値を変更し、左
右矢印ボタンで桁を移動して、すべ
ての桁を設定する。

数値を00 00 00 00にリセットするには
RESET/RETURNボタンを押します。

5 希望の数値に設定した後、F-RUN/
SET/R-RUNスイッチを希望のタイム

タイムデータの設定

タイムコードを設定する

ユーザービットを設定する
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コードの歩進モードに応じてF-RUN
またはR-RUNにする。

ご注意
ビデオフォーマットにProResを選択した場合、
ユーザービットは設定できません。

ユーザービットのメモリー機能につい
て
ユーザービットの設定内容（実時刻以外）
は自動的にメモリーに記憶され、電源を
切った後も保持されます。

本機の内部タイムコードジェネレーターを
外部ジェネレーターにロックさせることが
できます。また、外部VTRのタイムコード
ジェネレーターを本機の内部ジェネレー
ターにロックさせることもできます。

接続例

次図のように、リファレンスビデオ信号と
基準タイムコードの両方を接続します。

例1：外部の信号にロックさせる場合

例2：本機を複数台接続し、1台をリ
ファレンスとする場合

タイムコードを外部ロックさせる
には

1 POWERスイッチをONにする。

2 PRESET/REGEN/CLOCKスイッチ
をPRESETにする。

3 F-RUN/SET/R-RUNスイッチを
F-RUNにする。

4 DISPLAYスイッチをTCにする。

5 SMPTEタイムコードの規格を満たし
た位相関係にある基準タイムコード
とリファレンスビデオ信号を、TC IN
端子とGENLOCK IN端子へそれぞれ
入力する。

タイムコードを外部ロックさせ
る

基準タイムコード

1GENLOCK IN端子
2TC IN端子

リファレンスビデオ信号

1VIDEO OUT端子
2TC OUT端子
3TC IN端子
4GENLOCK IN端子

次のカムコーダーへ
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これで内部タイムコードジェネレー
ターは、基準タイムコードにロックし
ます。ロックしてから約10秒経過した
後は、外部からの基準タイムコードの
接続を外しても、外部ロック状態は保
たれます。

ご注意
• 外部ロックの操作をすると、タイムコードは瞬
時に外部のタイムコードにロックし、外部タイ
ムコードの値と同じ値がタイムデータ表示部に
表示されますが、シンクジェネレーターが安定
するまでの数秒間は、記録を開始しないでくだ
さい。

• リファレンスビデオ信号の周波数と本機のシス
テム周波数が一致しないと、正しくゲンロック
できません。この場合、タイムコードも外部の
タイムコードに正しくロックできません。

外部ロック時のユーザービットの設定
について
タイムコードの外部ロック時は、タイム
データのみが外部からのタイムコードのタ
イムデータにロックされます。

外部ロックを解除するには
外部タイムコードの入力を停止してから、
F-RUN/SET/R-RUNスイッチをR-RUNに設
定します。

外部ロック中に、電源をバッテリー
パックから外部電源に切り換えるとき
タイムコードジェネレーターの電源の連続
性を保つため、DC IN端子に外部電源をつ
ないでから、バッテリーパックを外してく
ださい。バッテリーパックを先に外したと
きは、タイムコードの外部ロックの連続性
は保証されません。

外部ロック中のカメラ部のゲンロック
について
外部ロック中、カメラ部はGENLOCK IN端
子に入力されるリファレンスビデオ信号に
よってゲンロックがかかります。

ステータス画面では、本機の設定や状態を
確認することができます。
ステータス画面は、次の8種類の画面で構成
されています。

ステータス画面を表示するには
メニューが表示されていないとき、MENU 
CANCEL/PRST/ESCAPEスイッチを
CANCEL/PRST側に押し上げます。押し上
げるごとに、ステータス画面が前表の順番
に切り替わります。

カメラステータス画面

各種設定や状態を確認
する（ステータス画
面）

ステータス画面の種類 表示内容
カメラステータス 撮像に関する設定と状

態
オーディオステータス オーディオ入出力に関

する設定と状態
システムステータス 記録に関する設定と状

態
ビデオアウトプットス
テータス

ビデオ出力に関する設
定と状態

ネットワークステータ
ス

ネットワークの状態

アサイナブルスイッチ
ステータス

アサイナブルスイッチ
に割り当てられている
機能の名称

バッテリーステータス 装着されているバッテ
リーの状態

メディアステータス 記録メディアの状態

表示項目 説明
Gain dB単位のゲインアップ量
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オーディオステータス画面

システムステータス画面

ビデオアウトプットステータス画
面

ネットワークステータス1画面

Shutter 電子シャッターの状態
Gamma Gammaカテゴリーとカーブ
White ホワイトバランスモードの設

定
Gain Switch GAINスイッチの状態
Zebra ゼブラの状態
Iris アイリスのF値
Focal Length 焦点距離
Focus Distance フォーカス距離
Depth Of Field 被写界深度
Zoom Speed レンズのZOOMボタンに設定

されたズームスピード

表示項目 説明
CH 1/CH 2/CH 3/
CH 4

各チャンネルのオーディオレ
ベル、入力ソース、基準入力
レベル、および風音低減フィ
ルターの設定

表示項目 説明
System 
Frequency

システム周波数

Rec Format 記録フォーマット
Clip Continuous 
Rec

クリップコンティニュアス
レック機能のオン／オフ設定

Title Prefix クリップ名の前半文字部分
Picture Size 画サイズ

表示項目 説明
Simul Rec 同時記録機能のオン／オフ設

定
Rec Function Onになっている特殊記録とそ

の設定
Picture Cache ピクチャーキャッシュレック

機能のオン／オフ設定
Number クリップ名の後半数値部分の

設定
Gamma 適用されるGammaカテゴ

リー
Proxy Recording 
Mode

プロキシデータ記録機能のオ
ン／オフ設定

表示項目 説明
SDI SDI OUT端子の出力設定（出

力画サイズ、出力形態、出力
レート、スーパーインポーズ）

HDMI HDMI端子の出力設定（出力
画サイズ、出力形態、出力
レート、スーパーインポーズ）

Video VIDEO OUT端子の出力設定
（出力画サイズ、スーパーイン
ポーズ）

表示項目 説明
Setting ネットワークの設定状態
Wireless
Network

ワイヤレスネットワークの設
定状態

表示項目 説明
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ネットワークステータス2画面

ネットワーククライアントモード状態の詳細 

Device Name 装着されているUSBワイヤレ
スLANモジュール機器の名称

IP Address 
(Wireless)

ワイヤレスLAN接続のIPアド
レス

MAC Addr. 
(Wireless)

USBワイヤレスLANモジュー
ル接続端子に装着されている
機器のMACアドレス

Wireless Network モデムの設定状態
Device Name 装着されているモデム機器の

名称
IP 
Address(Modem)

装着されているモデムのIPア
ドレス

Wired LAN 有線LANネットワークの接続
状態

Device Name 装着されているネットワーク
アダプターの名称

Wired LAN 
Remote

LANケーブルを使用した接続
状態のリモート操作の有効／
無効状態表示

IP Address　
(Wired)

有線LAN接続のIPアドレス

表示項目 説明
NW Client Mode 
Status

ネットワーククライアント
モードの状態
状態の詳細説明は、「ネット
ワーククライアントモード状
態の詳細」（70ページ）を参照

CCM Name ネットワーククライアントモー
ド時に接続中のCCMの名称

Streaming Status ストリーミングの配信状態
Streaming Size 現在選択しているストリーミ

ング設定の画サイズ
Streaming Bit 
Rate

現在選択しているストリーミ
ング設定のビットレート

Streaming Type 現在選択しているストリーミ
ング設定の種別

Streaming Dest. 
Add.

ストリーミングの送信先アド
レス

Streaming Dest. 
Port

ストリーミングの送信先ポー
ト

表示項目 説明

 

 

 

Number of 
Distribution

現在配信中のストリーミング
の送信先数

File Transfer ファイル転送の転送進捗状態
Transfer to: ファイル転送先のサーバー名

状態表示 状態 説明
Off CCM非接

続状態
ネットワーククライアン
トモードがオフの状態で
す。

Connected CCM接続
済状態

ネットワーククライアン
トモードがオンでCCM
に接続しており、CCM
からの制御が可能な状態
です。

Connecting CCM接続
中（切断
中）状態

CCMへの接続（または
切断）をしようとしてい
る状態です。接続（また
は切断）完了まで、しば
らくお待ちください。
Connectingのまま状態
が変化しない場合は
CCMのアドレス設定が
間違っている可能性があ
ります。正しいアドレス
が設定されているか確認
してください。

Awaiting CCM接続
待機状態

ネットワーククライアン
トモードはオンですが
ネットワーク設定がオフ
の状態です。CCMに接続
するにはネットワーク設
定を有効にしてください。

Address 
Error

CCMアド
レスエ
ラー

接続先のCCMのホスト名
またはIPアドレスが間
違っている可能性があり
ます。正しく設定されて
いるか確認してください。

Auth. Failed CCMユー
ザー名／
パスワー
ドエラー

CCMに接続するための
ユーザー名またはパス
ワードが間違っている可
能性があります。正しく
設定されているか確認し
てください。

No Inet 
Access

インター
ネット接
続エラー

ネットワークに接続でき
ません。ネットワークの
設定が間違っている可能
性があります。ネット
ワークの設定を確認して
ください。

Cert. not 
Valid

CCM証明
書無効エ
ラー

CCMの証明書が有効で
はありません。日付設定
が不正である可能性があ
ります。日付設定を確認
してください。

表示項目 説明
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アサイナブルスイッチステータス
画面

バッテリーステータス画面

メディアステータス画面

メディアがプロテクトされている場合は、 
マークが表示されます。

表示項目 説明
Detected Battery 検出されたバッテリーの種類
Remaining 残容量（%）
Charge Count 充電を行った回数
Capacity 残容量（Ah）
Voltage 電圧
Manufacture 
Date 

バッテリー製造年月日

Power Source 電源供給源
Supplied Voltage 供給電源電圧

表示項目 説明
SxSA スロットAのメディアの残容

量（バーと残り時間表示）、メ
ディア寿命

SxSB スロットBのメディアの残容
量（バーと残り時間表示）、メ
ディア寿命

SD Proxy PROXY SDカードスロットの
メディアの残容量（バーと残
り時間表示）、メディア寿命
（取得できた場合のみ表示）

SD Utility UTILITY SDカードスロットの
メディアの残容量（バーと残
容量）、メディア寿命（取得で
きた場合のみ表示）

表示項目 説明
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本機では、撮影した映像・音声を、カード
スロット内のSxSメモリーカード（別売）
に記録します。
なお、本機ではSxSメモリーカード以外にも、
XQD ExpressCardアダプター QDA-EX1（別
売）を使用してXQDメモリーカード（別売）、
またはメディアアダプターMEAD-SD02（別
売）を使用してSDXC/SDHCカード（別売）
を使用して記録を行うことができます。
各メディアカードの対応ファイルシステム
は以下のとおりです。

SxSメモリーカード

本機では、ソニー製SxS PRO+、SxS PROま
たはSxS-1メモリーカードをご使用ください。

SxS PRO+シリーズ
SxS PROシリーズ
SxS-1シリーズ

これらのメモリーカードは、ExpressCard
規格に準拠したメモリーカードです。
• SxS、SxS PRO+、SxS PRO、および

SxS-1はソニー株式会社の商標です。

• ExpressCardワードマークとロゴは、
Personal Computer Memory Card 
International Association (PCMCIA) の所
有であり、ソニーへライセンスされてい
ます。他のトレードマークおよびトレー
ド名称については、個々の所有者に帰属
します。

SxSメモリーカード使用上のご注
意

• 下記の場合、記録したデータが破壊（消
滅）されることがあります。
- 読み込み中、書き込み中、またはフォー
マット中にSxSメモリーカードを抜いた
り、振動、衝撃を与えたり、機器の電源
を切った場合

- 静電気や電気的ノイズの影響を受ける場
所で使用した場合

• 以下のような場所でのご使用や保存はし
ないでください。
- 使用条件範囲以外の場所
- 炎天下や夏場の窓を閉め切った車の中／
直射日光のあたる場所／熱器具の近くな
ど

- 湿気の多い場所や腐食性のある場所
• ご使用の場合は、正しい挿入方向をご確
認ください。

• SxSメモリーカードの保管時および携帯時
は、専用ケースに入れて確実にロックし
てください。

• SxSメモリーカードに保存しているデータ
は、万一の故障によるデータの損失に備
えて、バックアップを取っておいてくだ
さい。SxSメモリーカードに保存したデー

4章 撮影

SxSメモリーカードの
取り扱い

メモリーカード ファイルシステム
exFAT UDF FAT

SxSメモリーカード ○ ○ ×
XQDメモリーカード ○ ○ ×
SDXCカード ○ × ×
SDHCカード × × ○

SxSメモリーカードについて
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タの損害については、当社は一切の責任
を負いかねますので、あらかじめご了承
ください。

• ラベルシートの貼り付け部以外には専用
ラベルシートを貼らないでください。専
用ラベルシートを貼るときは、所定のラ
ベルシート貼り付け部に、はみ出さない
ように貼ってください。

• 本機で使用するSxSメモリーカードは、本
機のフォーマット機能を使用してフォー
マットしてください。他の機器でフォー
マットした場合は、異なるフォーマット
とみなされ、本機で再度フォーマットす
る必要があります。
（本機の機能による「フォーマット」や
「削除」では、カード内のデータは完全に
は消去されません。譲渡／廃棄の際は、
市販のデータ消去専用ソフトを使用する
か、カードを物理的に破壊するなどお客
様の責任においてデータの処理をしてく
ださい。）

• メディア残量が少ないと、クリップを操
作できないときがあります。そのような
場合は、 コンピューター で不要なファイ
ルを削除してから再度操作を行ってくだ
さい。

• 専用ケースカードの取り出し・再挿入の
際は、専用ケースが完全に開いた状態で
行ってください。

誤消去を防止するには

SxSメモリーカードのライトプロテクトス
イッチを「WP」側にすると、記録や編集、
消去ができなくなります。

ご注意
本機に挿入したままで、SxSメモリーカードのライ
トプロテクトスイッチを操作しないでください。
本機から取り出してからスイッチを切り換えてく
ださい。

SxSメモリーカードを入れるには

1 カバーを左にスライドさせて開ける。

2 SxSメモリーカードをカードスロッ
トに差し込む。

ACCESSランプがオレンジで点灯し、
使用可能な状態になると緑で点灯しま
す。

3 カバーを閉める。

SxS PRO   8
GB

専用ラベルシート貼り付け部

SxSメモリーカードを入れる ／ 
取り出す

ライトプロテクトスイッチ

ラベルを右にして
差し込む。
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ACCESSランプによる状態表示
AとBのカードスロットの状態を示すため
に、それぞれにACCESSランプがあります。

SxSメモリーカードを取り出すに
は

1 カバーを開け、EJECTボタンを押して
ロックを解除してボタンを引き出す。

2 もう一度EJECTボタンを押し込んで
カードを抜く。

ご注意
メモリーカードへのアクセス中に本機の電源を
切ったりメモリーカードを抜いた場合、データは
保証されません。カードに記録されたすべての
データが壊れる可能性があります。電源を切った
りカードを抜くときは、必ずACCESSランプが緑
で点灯または消灯していることを確認してから操
作してください。

カードスロットAとBの両方にSxSメモリー
カードが装着されているときは、SLOT 
SELECTボタンを押して使用するカードを
切り換えることができます。
記録中のSxSメモリーカードの記録可能時
間が60秒以下になると、ビューファイン
ダー画面の該当メディアスロットの残量表
示が点滅して、間もなく使用するSxSメモ
リーカードが切り換わることを知らせます。
その後、カードがフルになったときは、自
動的にもう1枚のカードに切り換わり、記録
は継続されます。

ご注意
再生中は、SLOT SELECTボタンは無効になりま
す。ボタンを押しても切り替わりません。サムネ
イル画面（133ページ）が表示されている場合は、
ボタン操作が有効です。

フォーマットされていないSxSメモリー
カード、または別の仕様でフォーマットさ
れたSxSメモリーカードを装着すると、
ファイルシステムが異なることを知らせる
メッセージが表示されます。その場合は、
以下の操作を行ってメモリーカードを
フォーマットします。
メモリーカードは、出荷時にはFATで
フォーマットされています。

ランプ スロットの状態
オレンジで
点灯

装着されているSxSメモリーカード
にアクセス中（データの書き込み／
読み出し中）

緑で点灯 スタンバイ状態（装着されている
SxSメモリーカードを使用して記
録・再生を行います。）

消灯 • SxSメモリーカードが装着されて
いない。

• 使用できないカードが装着されて
いる。

• SxSメモリーカードは装着されて
いるが、別のスロットのカードが
選択されている。

一度ボタンを押して、
ロックを解除する。

使用するSxSメモリーカードを
切り換える

SxSメモリーカードをフォー
マット（初期化）する
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ご注意
exFATファイルシステム対応のXDCAM機器およ
び本機でフォーマットしたSxSメモリーカード以
外は使用できません。

メニュー操作でフォーマット（初
期化）するには

メニュー操作でフォーマットを実行するこ
とができます。

1 メニューのOperation >Format Media
を選択する。

2 Media(A)（スロットA）または
Media(B) （スロットB）を選択する。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットを実行するかどうかの確
認画面が表示されます。

4 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。
フォーマットが始まります。

実行中メッセージと進捗状況（%）が表示
され、ACCESSランプがオレンジで点灯し
ます。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

記録中のフォーマット
記録中でも、もう一方のカードスロットに
装着したSxSメモリーカードのフォーマッ
トが可能です。

ご注意
• Slow & Quick MotionがOn、かつFrame Rateが

72 FPS以上の場合は記録中のフォーマットはで
きません。

• 再生中およびサムネイル画面表示中にフォー
マットはできません。

• フォーマット中には、もう一方のカードスロッ
トに装着したSxSメモリーカードへの記録操作
は受け付けません。

フォーマットできなかったときは
プロテクトされたSxSメモリーカードや本
機で使用できないメモリーカードはフォー
マットされません。
警告メッセージが表示されますので、メッ
セージに従って、使用できるSxSメモリー
カードに交換してください。

ご注意
• メモリーカードをフォーマットすると、記録さ
れた映像データ、セットアップファイルなどを
含む、すべてのデータが消去されます。 

• 本機で使用するSxSメモリーカードは、本機の
フォーマット機能を使用してフォーマットして
ください。他の機器でフォーマットした場合
は、異なるフォーマットとみなされ、本機で再
度フォーマットする必要があります。

ビューファインダー画面の記録メディア残
量表示部で、各スロットに装着したSxSメ
モリーカードの残量を確認することができ
ます。
現在設定されているビデオフォーマット
（記録ビットレート）で撮影した場合に記録
可能な時間を、それぞれのスロット内のメ
ディアの残量から計算して分単位で表示し
ます。
メディアステータス画面（71ページ）を表
示させると、残量をメーター形式で確認す
ることもできます。

ご注意
メモリーカードがプロテクトされている場合は、
マークが表示されます。

SxSメモリーカードの交換時期

• 記録中に2枚のメモリーカードの残記録可
能時間の合計が5分をきると、警告メッ
セージMedia Near Fullが表示され、
WARNINGランプおよびビューファイン
ダー画面のREC表示の点滅とブザー音で
警告します。
空きのあるメディアに交換してください。

残りの記録可能時間を確認する
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• 記録を継続して、残記録可能時間の合計
が0になると、メッセージがMedia Fullに
変わり記録が停止します。

ご注意
1枚のSxSメモリーカードに約600個までのクリッ
プを記録できます。
記録できるクリップ数の上限に達すると、残時間
表示が「0」になり、 メッセージMedia Fullが表示
されます。

何らかの原因でメモリーカード内のデータ
に異常が発生した場合は、メモリーカード
の修復が必要になります。
修復が必要なSxSメモリーカードを挿入し
たときは、修復を実行するかどうかを確認
するメッセージがビューファインダー画面
に表示されます。

修復を実行するには

MENUつまみを回してExecuteを選択し、
つまみを押します。
修復が始まります。
実行中メッセージと進捗状況（％）が表示
され、ACCESSランプがオレンジで点灯し
ます。
修復が終了すると、完了メッセージが表示
されます。MENUつまみを押してメッセー
ジを消します。

修復できなかったときは
• プロテクトされたSxSメモリーカードや、
エラーが発生したSxSメモリーカードは修
復できません。警告メッセージが表示さ
れますので、メッセージに従って、プロ
テクトを解除するか、別のSxS メモリー
カードに交換してください。

• エラーが発生したSxSメモリーカードは、
フォーマットをし直すと再利用できる場
合があります。

• 一部のクリップのみが修復できない場合
もあります。修復できたクリップは再生
可能になります。

• 修復を実行しても繰り返し“Could not 
Restore Some Clips”とメッセージが表
示されるようになったSxSメモリーカード
は、以下の手順で正常に戻せる場合があ
ります。
1専用アプリケーションソフトウェア
（207ページ）を用いて、必要なクリッ
プを他のSxSメモリーカードへコピーす
る。

2問題のあるSxSメモリーカードを本機で
フォーマットする。

3必要なクリップをフォーマットしたSxS
メモリーカードにコピーして戻す。

ご注意
本機で記録されたメディアは、本機で修復してく
ださい。
本機以外で記録されたメディアや、本機と同一機
種であってもバージョンが異なる機器で記録され
たメディアは、本機では修復できない場合があり
ます。

SxSメモリーカードを修復する
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設定データ保存用に使用可能なSD
カード

SDHCメモリーカード*（Speed Class：4以
上/UHS非対応／容量：4～32 GB）
* 本書ではSDカードと表現しています。

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォー
マット機能を使用してフォーマットしてく
ださい。SDカードを装着したときに注意
メッセージが表示された場合も、フォー
マットして使用してください。

1 メニューのOperation >Format Media 
>SD Card(Utility)を選択する。
フォーマットを実行するかどうかの確
認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットが始まります。
実行中メッセージと進捗状況（%）が
表示され、ACCESSランプがオレンジ
で点灯します。
フォーマットが終了すると、完了メッ
セージが表示されます。MENUつまみ
を押してメッセージを消します。

ご注意
SDカードをフォーマットすると、すべてのデータ
が消去され、復元できません。

設定データ保存用SDカードを入れ
るには

1 スイッチカバーを開ける。

2 設定データ保存用SDカードを
UTILITY SDカードスロットに挿入す
る。

3 スイッチカバーを閉める。

設定データ保存用SDカードを取り
出すには

1 スイッチカバーを開ける。

2 設定データ保存用SDカードを軽く
1回押して取り出す。

ご注意
• SDカードにアクセス中に本機の電源を切ったり

SDカードを抜いた場合、データは保証されませ
ん。カードに記録されたすべてのデータが壊れ
る可能性があります。電源を切ったり、カード
を抜くときは、必ず使用するSDカードの
ACCESSランプが消灯していることを確認して
から操作してください。

• 出し入れ時にはSDカードの飛び出しにご注意く
ださい。

メディアステータス画面（71ページ）でSD
カードの残量を確認することができます。
本機でフォーマットしたSDカードを他の機
器のスロットで使用するにはあらかじめ
バックアップを取り、お使いになる機器で
フォーマットし直して使用してください。

設定データ保存用SD
カードの取り扱い

SDカードをフォーマット（初期
化）する

設定データ保存用SDカードを入
れる／取り出す

残容量を確認する
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ご注意
• プロフェッショナル用途のSxSメモリーカード
と同等の高い信頼性・耐久性を得られるもので
はありません。

• すべてのメモリーカードの動作を保証するもの
ではありません。動作確認済みのメモリーに関
してはお買い上げ店にお問い合わせください。

別売のXQD ExpressCardアダプター
QDA-EX1を使用することによって、XQDメ
モリーカードをSxSメモリーカードスロッ
トに入れて、記録・再生が行えます。
◆XQD ExpressCardアダプター QDA-EX1の
使いかたについて詳しくは、アダプターに付
属の取扱説明書をご覧ください。

ご注意
使用するXQDメモリーカードの種類によっては、
以下の操作を正常に行えないことがあります。
• 高速再生
• スロー＆クイックモーション撮影

フォーマット（初期化）するには

本機で初めてXQDメモリーカードを使用す
るときは、フォーマットが必要です。
本機で使用するXQDメモリーカードは、本
機のフォーマット機能を使用してフォー
マットしてください。XQDメモリーカード
を装着したときに注意メッセージが表示さ
れた場合も、フォーマットして使用してく
ださい。

フォーマットされていないXQDメモリー
カード、または別の仕様でフォーマットさ
れたXQDメモリーカードを装着すると、
フォーマット実行の確認メッセージ、また
はファイルシステムが異なることを知らせ
るメッセージが表示されます。

1 メニューのOperation >Format Media
を選択する。

2 Media(A)（スロットA）または
Media(B) （スロットB）を選択する。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットを実行するかどうかの確
認画面が表示されます。

4 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

フォーマットが始まります。
実行中メッセージと進捗状況（%）が表示
され、ACCESSランプがオレンジで点灯し
ます。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

ご注意
XQDメモリーカードをフォーマットすると、プロ
テクトされた画像も含めて、すべてのデータが消
去され、復元できません。

本機とコンピューターの接続

記録済みのXQDメモリーカードを本機側の
スロットに装着して、本機とコンピュー
ターをUSBケーブルで接続して使用してく
ださい。

メディアアダプターを
使う

XQDメモリーカード
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本機でフォーマットしたメディア
を他の機器のスロットで使用する
には

あらかじめバックアップを取り、お使いに
なる機器でフォーマットし直して使用して
ください。

本機では、別売のメディアアダプター
MEAD-SD02を使用することによってSD
カードをSxSメモリーカードスロットに入
れて、記録・再生が行えます。

ご注意
SDカードと他のメモリーカードを同時に使用した
場合、記録しているメディアがフルになっても自
動切り換えは行われず、記録は停止します。

使用可能なSDカード

SDXCメモリーカード（SDスピードクラ
ス：Class10）1)

SDHCメモリーカード（SDスピードクラ
ス：Class10）2)

1)ファイルシステムがexFATのときに使用可能で
す。

2)ファイルシステムがFATのときに使用可能です。

◆メディアアダプター MEAD-SD02の使いか
たについて詳しくは、メディアアダプター
MEAD-SD02の取扱説明書をご覧ください。

ご注意
• SDカードを使用して高速再生を行う場合、正し
く動作しないことがあります。

• SDカードを使用して、すべてのXAVC-Iフォー
マットでの記録・再生はできません。

• SDXCカードを使用してスロー＆クイックモー
ション撮影を行うときは、スローモーション撮
影はできません。

フォーマット（初期化）するには

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォー
マット機能を使用してフォーマットしてく
ださい。SDカードを装着したときに注意
メッセージが表示された場合も、フォー
マットして使用してください。
フォーマットされていないSDカード、また
は別の仕様でフォーマットされたSDカード
を装着すると、フォーマット実行の確認
メッセージ、またはファイルシステムが異
なることを知らせるメッセージが表示され
ます。
次の手順でフォーマットしてください。

1 メニューのOperation >Format Media
を選択する。

2 Media(A)（スロットA）または
Media(B) （スロットB）を選択する。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットを実行するかどうかの確
認画面が表示されます。

4 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

フォーマットが始まります。
実行中メッセージと進捗状況（%）が表示
され、ACCESSランプがオレンジで点灯し
ます。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

ご注意
SDカードをフォーマットすると、プロテクトされ
た画像も含めて、すべてのデータが消去され、復
元できません。

SDカード
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本機とコンピューターの接続

記録済みのSDカードを本機側のスロットに
装着して、本機とコンピューターをUSB
ケーブルで接続して使用してください。

本機でフォーマットしたメディア
を他の機器のスロットで使用する
には

あらかじめバックアップを取り、お使いに
なる機器でフォーマットし直して使用して
ください。

ここでは、撮影・記録の基本操作手順を説
明します。
実際に撮影に出発する際は、事前に点検を
行って、カメラシステムが正常に機能する
ことを確認してください。

1 充電したバッテリーパックを取り付け
る（35ページ参照）。

2 SxSメモリーカードを入れる（73
ページ参照）。
2枚入れておくと、1枚目がフルになっ
た時点で自動的に2枚目に切り換わりま
す。

3 本機のPOWERスイッチ（13ページ
参照）をONにする。

4 次の設定を行う。
マーカー表示：オン（158ページ参照）
アイリス：オート（61ページ参照）
ズーム：オート
カメラ出力：撮影中の映像（カメラ画）
を選択し、DCC機能オン（17ペー
ジ参照）

タイムコードの歩進：F-RUN（フリー
ラン）またはR-RUN（レックラン）
（66ページ参照）

オーディオ入力チャンネルの選択：
オート（23ページ参照）

5 AUTO W/B BALスイッチを BLK側に
押して、ブラックバランスを調整す
る（56ページ参照）。

6 照明条件に合わせてフィルターを選
び、ホワイトバランスを調整する
（57ページ参照）。

7 本機を被写体に向け、フォーカスと
ズームを調整する。

基本操作



81

8 電子シャッターを使用する場合は、
適切なシャッターモード／スピード
に設定する（59ページ参照）。

9 次のいずれかの操作を行って記録を
開始する。
- REC STARTボタン（15ページ参照）
を押す。

- レンズのVTRボタンを押す。
- Rec機能が割り当てられたアサイナブ
ルスイッチをオンにする（190ページ
参照）。

記録中は、TALLYランプ、ビューファ
インダー前面のタリーランプ、ビュー
ファインダー画面のREC表示が点灯し
ます。必要に応じて、ズームとフォー
カスを調整してください。

ご注意
• 記録中は（右側面のACCESSランプが青で
点灯、カードスロット部のACCESSランプ
がオレンジで点灯）、絶対にバッテリー
パックを取り外さないでください。もし取
り外すと、記録処理が正常に終了しないた
め、記録中断直前の数秒間のデータが失わ
れるおそれがあります。

• 記録中は、再生コントロールボタン
（EJECT、F REV、F FWD、NEXT、PREV、
PLAY/PAUSE、STOP）は働きません。

• ビデオフォーマットにXAVC、MPEG HD、
MPEG IMX、またはDVCAMを選択した場
合、本機の電源オン直後から記録を開始す
ることができます。ただし、特殊記録機能
（ピクチャーキャッシュレックモードを除
く）実行時、タイムコードをREGENに設
定した場合、およびプランニングメタデー
タ適用時には対応していません。

10 記録を停止するには、手順9のいずれ
かの操作を行う。
TALLYランプ、ビューファインダー前
面のタリーランプ、ビューファイン
ダー画面のREC表示が消えます、本機
は記録待機（Stby）状態になります。
手順9と10の間に記録した画像・音声と
付随データが、1つのクリップとして記
録されます。

記録内容を確認するには（レックレ
ビュー）
記録待機中（Stby時）に、Rec Review
機能が割り当てられたアサイナブルス
イッチを押すと、クリップの最終フ
レームの2秒前から1倍速で再生します。
Rec Review機能が割り当てられたアサ
イナブルスイッチを1秒以上押し続ける
と、クリップの最終フレームの2秒前か
ら4倍速で逆再生を開始し、スイッチを
離すとその位置から1倍速で再生しま
す。クリップの終りまで再生すると、
レックレビューは終了し、Stby状態に
戻ります。
レンズのRETボタンにRec Review機能
が割り当てられている場合は、レンズ
のRETボタンを押してレックレビュー
することもできます。

11 手順9と10を繰り返して、記録を繰り
返す。
メモリーカード上に順次クリップが作
成されます。

ご注意
• 記録を停止してから約1秒間は次の記録を再開
できません。

• 1枚のメモリーカードに記録できるクリップ数
は、最大600個です。クリップが600個記録され
ると、メモリーカードに空き容量があっても、
記録できなくなります。

• 複数のメモリーカードに渡って連続記録できる
最長時間は24時間です。24時間に達すると記録
は停止します。

クリップ名について
本機で記録されるクリップには、自動的に8
文字のクリップ名（前半4文字の英数字＋後
半4桁の番号）が生成されます。
例：ABCD0001
クリップ名の前半部分（文字の英数字）は、
メニューのOperation >Clip >Title Prefixで
設定開始前に任意の文字列（4～46文字）

クリップ1 クリップ2 クリップ3
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にすることも可能です。（記録後に変更する
ことはできません。）
クリップ名の後半部分（4桁の番号）は、記
録順に自動的にカウントアップされます。

本機が記録停止中（Stby時）の場合は、
レックレビュー機能（81ページ参照）によ
り最後に記録したクリップの全体または一
部を再生することもできます。

1 再生するSxSメモリーカードを入れる
（73ページ参照）。

2 PREVボタン（20ページ参照）また
はF REVボタン（20ページ参照）を
押して、再生したいクリップを頭出
しする。

3 PLAY/PAUSEボタンを押す。
PLAY/PAUSEインジケーターが点灯し、
ビューファインダー画面に再生画が表
示されます。

再生を一時停止するには
PLAY/PAUSEボタンを押します。
一時停止中はPLAY/PAUSEインジケーター
が点滅します。
もう一度押すと再生モードに戻ります。

高速再生するには
F FWDボタン（20ページ参照）またはF 
REVボタン（20ページ参照）を押します。
標準再生に戻るには、PLAY/PAUSEボタン
を押します。

メモリーカードを切り換えるには
メモリーカードを2枚装着しているときは、
SLOT SELECT ボタン（24ページ参照）を
押して切り換えます。
再生中にメモリーカードを切り換えること
はできません。

再生を終了するには
STOPボタンを押す：再生が停止し、本機
はE-Eモードになります。

THUMBNAILボタンを押す：再生が停止し、
ビューファインダー画面にサムネイル
画面（133ページ参照）が表示されま
す。

再生中に記録を開始したりSxSメモリー
カードを取り出した場合も、再生が停止し、
ビューファインダー画面にカメラ画が表示
されます。

記録したクリップを再生する
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本機では、記録したクリップに対して、2種
類のショットマークを任意の位置に記録で
きます。ショットマークを記録しておくと、
編集時にすばやく頭出しすることができま
す。
1つのクリップに記録できるショットマーク
の最大数は999です。
◆Thumbnailメニューを使用して、任意のク
リップにショットマークを追加／削除するこ
ともできます。詳しくは、「クリップにエッ
センスマークを付ける／削除する」（140
ページ）をご覧ください。

ショットマークを記録するには

次の2つの方法があります。
• Shot Mark 1またはShot Mark 2機能が割
り当てられたアサイナブルスイッチをオ
ンにする。

ショットマークが記録されると、ビュー
ファインダー画面のタイムコード表示付近
に「ShotMark1」または「ShotMark2」が
約3秒間表示されます。

ご注意
メディアアダプター MEAD-SD02（別売）を使用
してSxSスロットに挿入したSDカードには記録で
きません。

編集時にクリップを選別する目安として、
記録したクリップに対してクリップフラグ
を設定することができます。

設定／削除するには
Thumbnailメニューを使用して、任意のク
リップに対してクリップフラグを設定／削
除することができます。詳しくは、「クリッ
プにクリップフラグを付ける／削除する」
（140ページ）をご覧ください。

ご注意
メディアアダプター MEAD-SD02（別売）を使用
してSxSスロットに挿入したSDカードには記録で
きません。

本機では、内蔵の大容量メモリーに、本機
で撮影している映像／音声データを常時数
秒間（最大15秒間）分蓄えておくことによ
り、記録を開始したとき、その数秒前から
の映像を記録することができます。
本機能は、下記のビデオフォーマット（51
ページ）に設定されている場合に有効です。

XAVC-I
XAVC-L
MPEG HD 422
MPEG HD 420
MPEG IMX 50

ピクチャーキャッシュレックモー
ド／ピクチャーキャッシュレック
時間の設定

ピクチャーキャッシュレックモードで記録
を始めるには、あらかじめOperationメ
ニューでピクチャーキャッシュレックモー
ドおよびメモリーへの画像の蓄積時間（ピ
クチャーキャッシュレック時間）を選択し
ておく必要があります。
記録を開始したときに、記録開始操作の実
行から何秒前にさかのぼって記録できるか
は、ピクチャーキャッシュレック時間に
よって決まります。次の「ご注意」に挙げ
るような特殊な場合では、さかのぼって記
録できる時間が短くなる場合があります。

応用操作

ショットマークを記録する

クリップフラグを設定する

数秒前の映像から記録する（ピ
クチャーキャッシュレック機能）
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ご注意
• メモリーへの画像の蓄積は、ピクチャーキャッ
シュレックモードを選択してから開始されま
す。従って、選択後すぐに記録を開始した場合
は、ピクチャーキャッシュレックモード選択以
前に撮影した映像は記録されません。

• 再生、レックレビュー、およびサムネイル表示
を行っている間は、メモリーに画像を蓄えない
ため、再生やレックレビューを行っていた間の
映像をさかのぼって記録することはできませ
ん。

ピクチャーキャッシュレックモード／
ピクチャーキャッシュレック時間を設
定するには

1 メニューのOperation >Rec Function 
>Picture Cache Recを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。

3 メニューのOperation >Rec Function 
>Cache Rec Timeを選択する。

4 MENUつまみを回してピクチャー
キャッシュレック時間を選択し、つ
まみを押す。
選択値は記録フォーマット、およびシ
ステム周波数の設定により変わります。
付録の「ピクチャーキャッシュレック
モード設定」（244ページ）をご覧くだ
さい。

一度選択したピクチャーキャッシュレック
モードは、設定を変更するまで保持されま
す。
手順1、2を行う代わりに、ピクチャー
キャッシュレック機能を割り当てたアサイ
ナブルスイッチを使用して（189ページ）
ピクチャーキャッシュレックモードを選択
することもできます。

ご注意
• ピクチャーキャッシュレックなどの特殊記録機
能を複数同時に使用できません。
ピクチャーキャッシュレック使用中に他の特殊
記録機能を有効にすると、ピクチャーキャッ
シュレックは自動的に解除されます。

• ビデオフォーマットなどのシステム設定を変更
すると、メモリーに蓄えられていた画像がクリ
アされます。変更直後に記録を開始しても、変
更前に撮影した映像は記録されません。ピク
チャーキャッシュレックモードは自動的に解除
されます。

• 記録中にピクチャーキャッシュレック時間を設
定することはできません。

ピクチャーキャッシュレックモードで
記録する場合の本機の動作について
記録の手順は通常とほぼ同じですが、本機
の動作には通常と異なる点がありますので、
以下の点に充分ご注意ください。
• メディアへのアクセスが行われている間
に記録を開始した場合、実際に記録され
る映像の開始点が、設定されたピク
チャーキャッシュレック時間よりも遅く
なる場合があります。記録クリップ数が
多いほど遅くなるため、ピクチャー
キャッシュレックモードでは、すばやい
記録停止、記録開始操作はなるべく避け
てください。

• F-RUN/SET/R-RUNスイッチの設定に関わ
らず、F-RUNモードになります。

• ピクチャーキャッシュレックモードでは、
F-RUN/SET/R-RUNスイッチをSETにして
タイムデータの設定を行うことはできま
せん。
タイムデータを設定する場合は、いった
んピクチャーキャッシュレックモードを
解除してください。

• 現在選択されているスロット内のメディ
アの記録可能残量がピクチャーキャッ
シュレック時間よりも少ない場合は、選
択されていないスロット内のメディア
（充分な記録可能残量があれば）に対して
記録が行われます。
ただし、選択されていないスロット内に
メディアがない場合や、スロット内のメ
ディアの記録可能残量が不充分な場合は、
記録は行われません。（ビューファイン
ダー画面に、メディア残量が不足してい
る旨を知らせるメッセージが表示されま
す。）

• 記録開始操作前にショットマークを設定
しても、ショットマークは記録されませ
ん。
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記録中に本機の電源が切れた場合
• 本機のPOWERスイッチをOFFにした場合
は、その瞬間までメモリーに蓄えられて
いた映像を記録するため、数秒間メディ
アにアクセスしてから、自動的に電源が
切れます。

• 記録中にバッテリーを取り外したり、DC
ケーブルを引き抜いたり、ACアダプター
側の電源を切ったりした場合は、メモ
リーに蓄積されている映像／音声データ
が消滅するため、その瞬間までの映像は
記録されません。バッテリー交換の際は、
充分ご注意ください。

本機のメモリーを利用して間欠的に映像を
取り込み、記録するインターバルレック機
能は、主に動きの少ない被写体を撮影する
ときに有効です。
記録を開始すると、設定したフレーム数
（Number of Frames）分の映像を、任意の
インターバル（Interval Time）で自動記録
できます。
本機能は、下記のビデオフォーマット（51
ページ）に設定されている場合に有効です。

XAVC-I
XAVC-L
MPEG HD 422

インターバルレックを有効にしているとき
は、撮影開始前にビデオライトを自動的に
点灯させ、光量、色温度を安定させた状態
で撮影を行うことができます（プリライ
ティング機能）。

インターバルレックの設定と撮影

ご注意
• インターバルレックなどの特殊記録機能を複数
同時に使用できません。
インターバルレック使用中に他の特殊記録機能
を有効にすると、インターバルレックは自動的
に解除されます。

• 記録中にインターバルレックの設定を変更する
ことはできません。

設定するには

1 メニューのOperation >Rec Function 
>Interval Recを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。
インターバルレックモードになり、
ビューファインダー画面のREC表示位
置に「Int Stby」が表示されます。
（HDVFシリーズビューファインダー内
のグリーンタリーランプも点滅します。）

3 Number of Framesを選択し、MENU
つまみを回して1回に記録する希望の
フレーム数を選択し、つまみを押す。
フォーマットが50P、59.9Pの場合、2/
6/12から選択できます。
フォーマットが23.98P、25P、29.97P、
50i、59.94iの場合、1/3/6/9から選択で
きます。

4 Interval Timeを選択し、MENUつま
みを回して希望の録画間隔（イン
ターバル）を選択し、つまみを押す。
1～10/15/20/30/40/50 sec、1～10/15/
20/30/40/50 min、1～4/6/12/24 hourか
ら選択できます。

5 必要に応じてPre-Lightingを選択し、
MENUつまみを回して記録開始前の

間欠的に映像を記録する（イン
ターバルレック機能）

撮影の間隔（Interval Time）

1回に記録する画像フレーム数
（Number of Frames）
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ビデオライト点灯時間を選択し、つ
まみを押す。
2/5/10 sec、またはOff（点灯しない）
から選択できます。

ご注意
• ビデオライトを記録前に点灯させる場合
は、本機のLIGHTスイッチをAUTOに設定
してください。ビデオライトのスイッチも
オンにしておく必要があります。このとき
ビデオライトが自動点灯／消灯します。た
だし、消灯時間が5秒以下の場合、ビデオ
ライトは連続して点灯します。

• LIGHTスイッチをMANUALに設定し、ビ
デオライトのスイッチをオンにすると、ビ
デオライトは常時点灯します。（ビデオラ
イトは自動点灯／消灯しません。）

本機の電源を切るとインターバルレック
モードは解除されますが、Number of 
Frames、Interval Time、Pre-Lightingの設
定は保持されます。次回インターバルレッ
クモードで撮影するときに再設定する必要
はありません。

撮影するには
「基本操作」（80ページ）にしたがって、記
録のための設定や準備を行った後、本機が
動かないように固定して撮影を行います。

インターバルレックモードをOnにすると、
ビューファインダー画面のREC位置に
「Int Stby」が表示されます。記録を開始す
ると、ビューファインダー画面のREC表示
位置に「zInt Rec」と「zInt Stby」が交互
に表示されます。通常の記録時と同様に、
TALLYランプとビューファインダー前面の
タリーランプが点灯します。（HDVFシリー
ズビューファインダー内のグリーンタリー
ランプが高速で点滅します。）
プリライティング機能を使用する場合は、
記録が始まる前にビデオライトが点灯しま
す。

撮影を終了するには
記録停止の操作を行います。

撮影を終了すると、その瞬間までメモリー
に蓄えられていた映像がメディアに記録さ
れます。

インターバルレックモードを解除する
には
次のいずれかを実行します。
• POWERスイッチをOFFにする。
• 記録待機中に、メニューのOperation 

>Rec Function >Interval RecをOffに設定
する。

ご注意
本機を再起動すると、インターバルレックモード
は自動的に解除されます。

記録中の動作制限
• 内蔵タイムコードジェネレーターの歩進
モードは、F-RUN/SET/R-RUNスイッチの
設定に関わらず、R-RUNモードになりま
す。

• 音声は記録されません。
• レックレビュー操作は行えません。
• ゲンロックはかかりません。

本機の電源が切れた場合
• 本機のPOWERスイッチをOFFにした場合
は、その瞬間までメモリーに蓄えられてい
た映像を記録するため、メディアにアクセ
スしてから、自動的に電源が切れます。

• 記録中にバッテリーを取り外したり、DC
電源コードを引き抜いたり、ACアダプ
ター側の電源を切ったりした場合は、その
瞬間以前に撮影したショット（最大10秒）
が記録されないことがあります。バッテ
リー交換の際は充分ご注意ください。

記録時のフレームレートを再生時のフレー
ムレートと異なる値に設定することができ
ます。

ご注意
XAVCの記録フォーマットで撮影を行う場合、SxS
メモリーカードは、SxS Pro+を使用してください。

スロー＆クイックモーション撮
影する
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a)ビデオフォーマットがXAVCの場合は
Slow&Quick Option PXWK-503（有償オプショ
ン）が必要です。

b)exFAT、 およびUDFのファイルシステムに対応
しています。これ以外の記録フォーマットでは
exFATにのみ対応しています。

再生フレームレートと異なるフレームレー
トで撮影することによって、通常の速度で
撮影した映像を低速再生したり高速再生す
るよりも、滑らかなスローモーション、ク
イックモーション映像が得られます。

スロー＆クイックモーションの設
定と撮影

設定するには

1 メニューのOperation >Rec Function 
>Slow & Quick Motionを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。
スロー＆クイックモーションになり、
ビューファインダー画面の記録動作状態
表示部に「S&Q Stby」が表示されます。
次にフレームレートを設定します。

3 メニューのOperation >Rec Function 
>Slow & Quick Motion >Frame Rate

を選択する。

4 MENUつまみを回してフレームレー
トを選択し、つまみを押す。

設定完了後、ビューファインダー画面上部に
システム周波数とフレームレートが表示され
ます。この表示を見ながら、MENUつまみで
フレームレートを変更することもできます。
本機の電源を切ってもスロー＆クイック
モーションモードとフレームレートの設定
は保持されます。

ご注意
• ビデオフォーマットがXAVCかつ、Slow&Quick 

Option PXWK-503（有償オプション）がない場
合は、スロー＆クイックモーションは使用でき
ません。

• スロー＆クイックモーションなどの特殊記録機
能を複数同時に使用できません。

• スロー＆クイックモーション使用中に他の特殊
記録機能を有効にすると、スロー＆クイック
モーションは自動的に解除されます。

• 記録中、再生中、サムネイル表示中は、スロー
＆クイックモーションを設定できません。

• スローシャッター設定時は、スロー＆クイック
モーションを設定できません。

撮影するには
「基本操作」（80ページ）に従って撮影を行
います。

記録を開始すると、ビューファインダー画
面の「S&Q Stby」表示が「zS&Q Rec」に
なります。通常の記録時と同様に、TALLY
ランプ、ビューファインダー前面のタリー
ランプも点灯します。

撮影を終了するには
記録停止の操作を行います。

ご注意
フレームレートを小さい値（遅いフレームレート）
に設定すると、記録停止操作を行ってから記録を
停止するまでの時間が長くなります。

記録
フォーマット

システム
周波数

S&Qフレーム
レート

XAVC-I
1080P a)

59.94P/50P/
29.97P/25P/
23.98P

1FPS～60FPS
（1FPS単位）
72、75、80、
90、96、100、
110、120 FPS

XAVC-L 50 
1080P a)

59.94P/50P/
29.97P/23.98P/
25P

XAVC-L 35 
1080P a)

59.94P/50P/
29.97P/23.98P/
25P

HD422 50 
1080P b)

29.97P 1FPS～30FPS
（1FPS単位）23.98P

25P 1FPS～25FPS
（1FPS単位）
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スロー＆クイックモーションモードを
終了するには
記録待機中に、メニューのOperation >Rec 
Function >Slow & QuickをOffに設定しま
す。

記録中の動作制限
• 内蔵タイムコードジェネレーターの歩進
モードは、F-RUN/SET/RRUNスイッチの
設定に関わらず、R-RUNモードになりま
す。

• 再生フレームレートと異なる記録フレー
ムレートを選択した場合、音声は記録さ
れません。

• レックレビュー操作は行えません。
• 記録フレームレートを現在のシャッター
スピードの設定値より速い値に変更する
と、シャッタースピードは撮影可能な最
も遅い値に変更されます。
例：フレームレート32でシャッタース
ピード1/40のときに、フレームレートを55
に変更するとシャッタースピードは1/60に
変更される。
また、記録フレームレートより遅い
シャッタースピードを選択することはで
きません。

• ゲンロックはかかりません。

通常は記録開始、停止のたびに1つのクリッ
プが独立したファイルとして生成されます
が、クリップコンティニュアスレック機能
を使用すると、記録と停止を繰り返しても、
機能が停止または解除されるまで連続した
1つのクリップを生成することができます。
短いクリップを数多く生成したくないとき、
または記録できるクリップ数の上限を意識
しないで記録したいときに便利な機能です。
記録の開始点にはレックスタートマークが
記録されるため、記録開始位置の検索も容
易です。
本機能は、下記のビデオフォーマット（51
ページ）に設定されている場合に有効です。

XAVC-I
XAVC-L
MPEG HD 422

クリップコンティニュアスレック
の設定と撮影

設定するには

1 メニューのOperation >Rec Function 
>Clip Continuous Recを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。
本機はコンティニュアスレックモード
になり、ビューファインダー画面で
「Cont Stby」の表示が点灯します。

ご注意
• クリップコンティニュアスレックなどの特殊記
録機能を複数同時に使用することはできませ
ん。

• クリップコンティニュアスレック使用中に他の
特殊記録機能を有効にすると、クリップコン
ティニュアスレックは自動的に解除されます。

ASSIGN. 1/2/3スイッチ、ASSIGNABLE 4/5
スイッチとCOLOR TEMP.ボタンにクリッ
プコンティニュアスレック機能のオン／オ
フを割り当てることもできます。
◆詳しくは、「アサイナブルスイッチに機能を
割り当てる」（189ページ）をご覧ください。

撮影するには
「基本操作」（80ページ）に従って撮影を行
います。
記録を開始すると、ビューファインダー画
面の「Cont Stby」表示が「zCont Rec」表
示に変わります。
通常の記録時と同様に、TALLYランプ、
ビューファインダー前面のタリーランプも
点灯します。

ご注意
記録中または記録待機中（「Cont Stby」表示が点
灯した状態）に、メディアを取り出したりバッテ
リーや電源を抜くと、メディアの修復が必要にな

クリップコンティニュアスレッ
ク機能を使って撮影する
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ります。本機以外の機器を使ってメディアを修復
することはできません。
クリップコンティニュアスレックモードを終了し
てからメディアを取り出してください（89ページ
参照）。
なお、「Cont Stby」が点滅（1回／秒）していると
きは、メディアを取り出すことができます。

撮影を終了するには
記録停止の操作を行います。

ご注意
最低2秒間記録してから記録を停止してください。

クリップコンティニュアスレックモー
ドを終了するには
記録待機中に、メニューのOperation >Rec 
Function >Clip Continuous RecをOffに設定
します。

記録中または記録待機中の動作制限
記録中または記録待機中に以下の操作を行
うと、1つのつながったクリップが作成され
ません。（次に記録を行うと、新たなクリッ
プが生成されます。）
• クリップ操作（クリップのロック、削除、
または名前の変更）

• スロットの切り換え
• 記録フォーマットの変更
• POWERスイッチオフ
• 再生
• サムネイル画面への切り換え

ビデオフォーマット（51ページ）が下表の
いずれかに設定されているときは、同じ映
像を2枚のSxSメモリーカードに記録するこ
とができます。撮影を行いながら映像の
バックアップを取る場合などに使用する機
能です。

ご注意
• SxSメモリーカードは、使用前に両方のカード
を本機でフォーマット（初期化）することを推
奨します。

• SDカードは使用できません。

設定するには

1 メニューのOperation >Rec Function 
>Simul Recを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。

ご注意
• ファイルシステムがUDFの場合は、同期記録機
能は使用できません。

• 同時記録機能などの特殊記録機能を複数同時に
使用することはできません。

• 同時記録機能使用中に他の特殊記録機能を有効
にすると、同時記録機能は自動的に解除されま
す。

• 記録中、再生中、サムネイル表示中は、同時記
録機能を設定できません。

2枚のSxSメモリーカードに同時
に映像を記録する（同時記録機
能）

メニューの
Operation 

>Format >Rec 

Format

メニューの Operation 
>Format >Frequency

XAVC-I 1080P 59.94/50/29.97/25/23.98

XAVC-I 1080i 59.94/50

XAVC-I 720P 59.94/50

XAVC-L 50 1080P 59.94/50/29.97/25/23.98

XAVC-L 50 1080i 59.94/50

XAVC-L 50 720P 59.94/50

XAVC-L 35 1080P 59.94/50/29.97/25/23.98

XAVC-L 35 1080i 59.94/50

XAVC-L 25 1080i 59.94/50

HD 422 50 1080P 29.97/25/23.98

HD 422 50 1080i 59.94/50

HD 422 50 720P 59.94/50/29.97/25/23.98

HQ 1920x1080P 29.97/25/23.98

HQ 1920x1080i 59.94/50

HQ 1440x1080i 59.94/50

HQ 1280x720P 59.94/50
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撮影するには

1 カードスロットAとBの両方にSxSメモ
リーカードを装着する。
SxSスロットAおよびB のACCESSラン
プが点灯します。またビューファイン
ダー画面にSxSスロットAおよびBのア
イコンが表示されます（34ページ参
照）。

2 「基本操作」（80ページ）に従って撮
影を行います。

ご注意
• どちらかのメディアに不良があったり、書き込
み禁止になっていたりする場合は、同時記録を
行うことはできません。

• 同時記録中に、どちらか一方のメディアがフル
になった場合や、エラーが発生して記録を継続
できなくなったときは、そのメディアへの記録
は中止されますが、残りのメディアへの記録は
継続されます。

撮影を終了するには
記録停止の操作を行います。

同時記録機能を終了するには
記録待機中に、メニューのOperation >Rec 
Function >Simul RecをOffに設定します。

プロキシデータは、低解像度の映像データ
（H.264）と音声データ（AAC-LC）で構成
されています。オリジナルデータの代わり
に、高速転送が可能なプロキシデータを利
用することにより、編集、閲覧作業を効率
化することができます。
プロキシデータはクリップの記録時に
PROXY SDカードスロットに挿入したSD
カードに記録されます。SDカードに記録さ
れたプロキシデータをコンピューターに読
み込んで、取り急ぎ撮影内容を確認したり、
短時間でオフライン編集を行うことができ
ます。
プロキシデータの記録はSxSメモリーカー
ドと同期して行うだけでなく、SxSメモ
リーカードへの記録とは別に、単独で記録
を実行することができます。
アサイナブルスイッチにProxy Rec Start/
Stop機能を割り当てることにより、プロキ
シデータ記録の開始・停止を単独で制御す
ることができます（190、192ページ）。

• 同期記録時はSxSメモリーカードが挿入さ
れていないと、プロキシ側の記録は開始
されません。

• LCDモニター／ビューファインダー画面
に （Proxy SDスロットメディア状態
表示）および“Proxy”表示が点灯した状
態でプロキシ記録ができるようになりま
す。記録中は“Proxy Rec”と表示されま
す。

が点滅中、または消灯中に撮影を開
始した場合、プロキシデータは記録され
ません。

プロキシデータの記録

本機でのプロキシ記録について
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• SDカードを本機から抜くときは、必ず
PROXY SDカードスロットのACCESSラ
ンプが消灯していることを確認してから、
本機の電源を切るか、またはプロキシ記
録／ワイヤレスLAN接続機能をオフにし
てください。
プロキシ記録／ワイヤレスLAN接続機能
をOFFにするにはセットアップメニュー
で次の設定を行ってください。
- メニューのOperation >Proxy 

Recording Mode >SettingをOffにする。
- メニューのMaintenance >Network 

>SettingをOffにする。
- アサイナブルスイッチにProxy Rec 

Start/Stop機能を割り当てている場合、
すべて解除する。

• プロキシ記録、またはワイヤレスLAN接
続機能を有効にしている状態でSDカード
の抜き差しを行うと、まれに警告表示
（E91-1C0）が表示される場合がありま
す。記録中にこの警告が表示された場合、
SxSメモリーカードへの記録は正常に行わ
れますが、プロキシデータは記録されま
せんのでご注意ください。この警告表示
は本機の電源をオフ／オンするとクリア
されます。

• ピクチャーキャッシュレック、インター
バルレック、スロー＆クイックモーショ
ン記録を有効にすると、プロキシ記録は
開始されません。

プロキシデータ記録用に使用可能
なSDカード

• SDHCメモリーカード*（Speed Class：
4以上/UHS非対応／容量：4～32 GB）

• SDXCメモリーカード*（Speed Class：
4以上/UHS非対応／容量：64～256 GB）

* 本書ではSDカードと表現しています。

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォー
マット機能を使用してフォーマットしてく
ださい。SDカードを装着したときに注意
メッセージが表示された場合も、フォー
マットして使用してください。

1 メニューのOperation >Proxy 
Recording Mode >Settingを選択す
る。

2 MENUつまみを回してOnを選択し、
つまみを押す。

3 メニューのOperation >Format 
Media >SD Card(Proxy)を選択する。

4 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットを実行するかどうかの確
認画面が表示されます。

5 MENUつまみを回してExecuteを選
択し、つまみを押す。
フォーマットが始まります。
実行中メッセージと進捗状況（%）が
表示され、ACCESSランプがオレンジ
で点灯します。
フォーマットが終了すると、完了メッ
セージが表示されます。MENUつまみ
を押してメッセージを消します。

ご注意
SDカードをフォーマットすると、すべてのデータ
が消去され、復元できません。

メディアステータス画面（71ページ）でSD
カードの残量を確認することができます。

SDカードについて

SDカードをフォーマット（初期
化）する

残容量を確認する
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本機でフォーマットしたSDカード
を他の機器のスロットで使用する
には

あらかじめバックアップを取り、お使いに
なる機器でフォーマットし直して使用して
ください。

プロキシデータを同時記録するには
SxSメモリーカードと同期してSDカードに
プロキシデータを記録することができます。

1 メニューのOperation >Proxy 
Recording Mode >Settingを選択する。

2 MENUつまみを回してOnを選択し、
つまみを押す。

3 プロキシデータ記録用SDカードを
PROXY SDカードスロットに挿入す
る。

4 撮影を開始する。
SxSメモリーカードにオリジナルデータ
が記録されると同時に、プロキシデー
タファイルがSDカードの「/PRIVATE/
PXROOT/Clip」ディレクトリーに保存
されます。
撮影を終了すると、プロキシデータの
記録も自動的に終了します。

ご注意
• ストリーミング中（メニューのMaintenance 

>Streaming >SettingがOn）の場合、プロキシ
記録はできません。

• 以下の機能が有効になっている場合、プロキシ
記録はできません。
- ストリーミング中（メニューの

Maintenance >Streaming >Settingが On）
- Interval Rec（メニューの Operation >Rec 

Function >Interval Recが On）
- Picture Cache Rec（メニューの Operation 

>Rec Function >Picture Cache Recが On）
- Slow & Quick Motion（メニューの

Operation >Rec Function >Slow & Quick 

Motionが On）

プロキシデータをオリジナルデータと
は別に単独で記録するには
アサイナブルスイッチにProxy Rec Start/
Stop機能を割り当てることにより、SxSメ
モリーカードとは連動せずに、単独でSD
カードにプロキシデータを記録することが
できます。

ご注意
• プロキシデータ単独記録動作中にプロキシ同時
記開始操作が開始された場合は、記録中のプロ
キシデータは途切れずにそのまま記録が継続さ
れます。その後、同時記録終了操作が行われた
ときに、プロキシデータの記録が止まります。

• プロキシ同時記録中はプロキシ単独記録の終了
操作は受け付けません。

プロキシ記録の制限事項
以下の状態のときは、プロキシ記録はでき
ません。
• ストリーミング中（メニューの

Maintenance >Streaming >SettingがOn
のとき）

• Interval Rec中（メニューのOperation 
>Rec Function >Interval RecがOnのと
き）

• Picture Cache Rec中（メニューの
Operation >Rec Function >Picture 
Cache RecがOnのとき）

• Slow & Quick Motion中（メニューの
Operation >Rec Function >Slow & Quick 
MotionがOnのとき）

• ネットワーククライアントモード（メ
ニューの Maintenance >Network Client 
Mode >SettingがOnのとき）かつメ
ニューのMaintenance >Network Client 
Mode >Preset 1、Preset 2、または
Preset 3 >NCM with ProxyがDisableのと
き。

• メニューのOperation >Format 
>Frequencyが23.98P、かつOperation 
>Proxy Recording Mode >SizeがHD 
Auto(9Mbps)、またはHD Auto(6Mbps)の
とき

• 外部機器接続端子に電源を供給中（メ
ニューのOperation >USBを操作中）

プロキシデータを記録する
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記録されるファイルについて
• 拡張子は「.mp4」となります。
• タイムコードも同時に記録されます。
• 先頭フレームの静止画も同時に記録され
ます。

• GPS機能が有効な場合に、測位した情報、
およびLogファイルが同時に記録されま
す。Logファイルは「Root/PRIVATE/
SONY/GPS」に保存されます。

プロキシデータの記録設定を解除する
には
メニューのOperation >Proxy Recording 
Mode >SettingをOffに設定します。

SDカードの空き容量が不足していると
きは
空き容量の不足を知らせる警告が表示され
ます。

メニューのOperation >Proxy Recording 
ModeのSize、Audio Channelでそれぞれ、
プロキシ記録フォーマットのサイズ、プロ
キシ記録するオーディオチャンネルの設定
を変更することができます。

ご注意
メニューのOperation >Proxy Recording Mode
>SizeをHD Auto(9Mbps)またはHD Auto(6Mbps)
にして、システム周波数を29.97、25、23.98のい
ずれかにした場合は、記録ビデオフォーマットの
画サイズが1280×720であっても、プロキシデー
タの画サイズは、1920×1080になります。

メニューのOperation >Proxy Recording 
ModeのFrame Rate、Bit Rateでそれぞれ、
映像フレームレート、映像ビットレートの
設定を確認することができます。

プランニングメタデータとは、撮影・記録
の計画情報が記述されているXMLファイル
です。

プランニングメタデータファイルの例

プランニングメタデータファイルで、あら
かじめ定義したクリップ名やショットマー
ク名を使用して、撮影を行うことができま
す。
プランニングメタデータは「Content 
Browser　Mobile」アプリケーションを使
用して送受信することができます。

ご注意
• クリップ名やショットマーク名の定義には、メ
ニューのMaintenance >Languageで設定した
言語のフォントセットを使用してください。本
機の言語設定と異なる言語を使用すると、文字
が正常に表示されない場合があります。

• 日本語でクリップ名やショットマーク名を定義
すると、一部の文字が他のフォントに置き換え
られ、ビューファインダー画面に正しく表示さ
れないことがあります。LCDモニター（ステー
タス表示時）には、アルファベット、数字、記
号のみ表示できます。

プロキシ記録時の設定を変更す
る

プロキシ記録の設定を確認する

プランニングメタデー
タの操作



94

1 事前にSxSメモリーカードにプランニ
ングメタデータファイルを保存する。
プランニングメタデータファイルは
「General/Sony/Planning」のディレク
トリーに保存されています。

2 SxSメモリーカードをスロットAまた
はBに挿入する。

3 メニューのOperation >Planning 
Metadata >Load Media(A)または
Load Media(B)を選択する。
ファイルリスト画面が表示されます。
リストには最大64個のプランニングメ
タデータファイルが表示されます。

4 MENUつまみを回してファイルリス
トから読み込みたいファイルを選択
し、つまみを押す。

5 MENUつまみを回してLoadを選択
し、つまみを押してから、Execute
を選択して、つまみを押す。

ご注意
別売りのメディアアダプターMEAD-SD02を使用
してSDXCカードからプランニングメタデータ
ファイルを読み込めます。ただし、SDHC/SDカー
ドからの読み込みはできません。

読み込んだプランニングメタデー
タの詳細情報を確認するには

本機のメモリーに読み込んだプランニング
メタデータのファイル名や作成日時、タイ
トルなどの詳細情報を確認することができ
ます。

1 メニューのOperation >Planning 
Metadata >Propertiesを選択する。

2 MENUつまみを回してExecuteを選
択して、つまみを押す。

プランニングメタデータの詳細情報が
表示されます。

a)マテリアルグループ：同じプランニングメ
タデータを使用して収録したクリップ群

MENUつまみを回してリストをスク
ロールすることができます。

読み込んだプランニングメタデー
タを消去するには

1 メニューのOperation >Planning 
Metadata >Clear Memoryを選択す
る。

2 MENUつまみを回してExecuteを選
択して、つまみを押す。
消去が始まります。
消去が完了すると、「Clear Planning 
Metadata File OK」が表示されます。

プランニングメタデータには、次の2種類の
クリップ名文字列を記述することができま
す。
• ビューファインダー画面上に表示される

ASCII形式の名称

クリップ記録時にプランニング
メタデータファイルをカムコー
ダーのメモリーに読み込む

項目 情報
File Name ファイル名
Assign ID アサインID
Created ファイルの生成日時
Modified ファイルの最終更新日時
Modified by ファイルの更新者
Title ファイルで指定されたTitle1

の内容（ASCII形式のクリッ
プ名）

Title2 ファイルで指定されたTitle2
の内容（UTF-8形式のクリッ
プ名）

Material 
Group

マテリアルグループa)の数

Shot Mark0～
Shot Mark9

ファイルで定義されたショッ
トマーク0～ショットマーク9
の名前

プランニングメタデータでク
リップ名を設定する
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• 実際にクリップ名として登録されるUTF-8
形式の名称

メニューのOperation >Planning Metadata 
>Clip Name Dispでどちらのクリップ名を
表示するか選択することができます。
プランニングメタデータでクリップ名を設
定すると、クリップ名が表示されます。

ご注意
プランニングメタデータでクリップ名を設定する
ときに、ASCII形式の名称とUTF-8形式の名称が両
方とも定義されている場合はUTF-8形式の名称が
クリップ名となります。プランニングメタデータ
で、ASCII形式の名称またはUTF-8形式の名称のど
ちらか一方しか定義していない場合は、メニュー
の設定に関わらず定義されているクリップ名が表
示されます。

クリップ名文字列の記述例

テキストエディターを使用して、<Title>タ
グの内容を変更します。
網掛け部分がクリップ名文字列です。
「Typhoon」はASCII形式（44文字以下）で
記述しています。「台風東京上陸」はUTF-8
形式（44バイト以下）で記述しています。
「sp」はスペース、3は改行を表します。

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2014-09-30T17:00:00+09:00"sp

lastUpdate="
2014-10-06T17:00:00+09:00"sp

version="1.00">3

<PropertiessppropertyId="
assignment"spupdate="
2014-10-06T17:00:00+09:00"sp

modifiedBy="Chris">3

<TitlespusAscii=" "sp

xml:lang="ja">
</Title>3

</Properties>3

</PlanningMetadata>3

ご注意
• 実際にファイルを作成する場合は、改行位置で
のみ改行し、「sp」が表示されていない位置に
はスペースを入れずに1つの文として記述して
ください。

• クリップ名に使用できる有効文字数は44バイト
（または44文字）です。
UTF-8形式で44バイトを超えるクリップ名を定
義すると、44バイトまでの文字列がクリップ名
に使用されます。
ASCII形式のクリップ名のみ定義している場合
は、ASCII形式の44文字までの文字列がクリッ
プ名に使用されます。
ASCII形式で記述した文字列、UTF-8形式で記述
した文字列が、いずれもクリップ名として使用
できない場合、クリップ名は標準形式となりま
す。

クリップ名を設定するには

1 クリップ名を記述したプランニングメ
タデータファイルを本機のメモリーに
読み込む（94ページ参照）。

2 メニューのOperation >Clip >Clip 
NamingをPlanに設定する。
記録を行うたびに、プランニングメタ
データファイルに記述したクリップ名
が、アンダーバー（_）と5桁の通し番
号（00001～99999）が付加された形式
で自動生成されます。
例：台風東京上陸_00001、台風東京上
陸_00002、...

通し番号が99999に達したら、次の記
録操作で00001に戻ります。

ご注意
他のプランニングメタデータを読み込んでも、通
し番号は継続します。通し番号の変更は、メニュー
の Operation >Clip >Number Setで行ってくださ
い。

Typhoon

台風東京上陸
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クリップ名の表示形式を選択するには
ASCII形式とUTF-8形式の両方の名前を定義
しているときは、どちらの形式の名前を
LCDモニター画面またはビューファイン
ダー画面に表示するかを、メニューの
Operation >Planning Metadata >Clip 

Name Dispで選択することができます。
ASCII形式の名前を表示するときは：

Title1(ASCII)を選択します。
クリップ名は「台風東京上陸_通し番
号」となりますが、画面には
「Typhoon_通し番号」が表示されます。

UTF-8形式の名前を表示するときは：
Title2(UTF-8)を選択します。
クリップ名は「台風東京上陸_通し番
号」となり、画面に表示されます。

プランニングメタデータでショットマーク
を設定する場合、Shot Mark0～Shot Mark9
の名前を設定することができます。ショット
マークを記録するときに、プランニングメ
タデータで定義したショットマーク名文字
列を付けて記録することができます。

ご注意
ショットマーク1、2のみ本機の操作で記録できま
す。

ショットマーク名文字列の記述形
式

テキストエディターを使用して、<Meta 
name>タグの内容を変更します。
網掛け部分がショットマーク名文字列です。
ASCII形式（32文字以下）、またはUTF-8形
式（16文字以下）で記述します。

「sp」はスペース、3は改行を表します。

ご注意
ASCII形式以外の文字が1文字以上含まれていれ
ば、その文字列の最大長は16文字になります。

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2014-09-30T08:00:00Z"splastUpdate="
2014-09-30T15:00:00Z"spversion=
"1.00">3

<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2014-09-30T15:00:00Z"sp

modifiedBy="Chris">3

<TitlespusAscii="Football
Game"spxml:lang="ja">
Football Game 30/09/2014</
Title>3

<Metaspname="_ShotMark1"sp

content=" "/>3

<Metaspname="_ShotMark2"sp

content=" "/>3

<Metaspname="_ShotMark3"sp

content=" "/>3

<Metaspname="_ShotMark4"sp

content=" "/>3

<Metaspname="_ShotMark5"sp

content=" "/>3

<Metaspname="_ShotMark6"sp

content=" "/>3

<Metaspname="_ShotMark7"sp

content=" "/>3

<Metaspname="_ShotMark8"sp

content=" "/>3

<Metaspname="_ShotMark9"sp

content=" "/>3

<Metaspname="_ShotMark0"sp

content=" "/>3

</Properties>3

</PlanningMetadata>3

ご注意
実際にファイルを作成する場合は、改行位置での
み改行し、ショットマーク名文字列以外では「sp」
が表示されていない位置にスペースを入れずに
1つの文として記述してください。

プランニングメタデータで
ショットマーク名を設定する

Goal

Shoot

Corner Kick

Free Kick

Goal Kick

Foul

PK

1st Half

2nd Half

Kick Off
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リモートコントロールユニットRM-B170や
リモートコントロールパネルRCP-1001/
1501などのコントロールユニットを接続す
ると、それらの機器から本機の機能の一部
をコントロールすることが可能です。
RM-B170のMONITOR端子に接続したモニ
ター画面で、メニューを操作したり、画像
をモニターすることもできます。

接続するには

コントロールユニットに付属のリモート
ケーブル（10m）を使用して、本機の
REMOTE端子（8ピン）と、コントロール
ユニットのカメラ端子を接続します。
接続後に本機の電源を入れると、本機はリ
モートコントロールモードになります。

本機のメニュー操作や撮影操作が可能です。

ご注意
• 本機へのUSB接続が有効になっている状態で
は、リモートコントロールはできません。

• リモートコントロール中に、本機へのUSB接続
が有効になると、リモートコントロールモード
が解除されます。

• 本機の電源を入れたままコントロールユニット
を接続したり、接続を外さないでください。

• リモートコントロールパネルRCP-1001/1501に
はリモートケーブルは付属されていません。

コントロールユニットが接続されていると
きは、本機の下記スイッチ類は無効になり
ます。
• GAINスイッチ
• WHITE BALスイッチ

• AUTO W/B BALスイッチ
• SHUTTERスイッチ
• OUTPUT/DCCスイッチ
• Turbo GainまたはATW機能が割り当てら
れている場合のASSIGN. 1/3スイッチ、
ASSIGNABLE 4/5スイッチおよびCOLOR 
TEMP.ボタン

リモートコントロールモードを解
除するには

本機の電源を切り、コントロールユニット
を取り外します。
本機のスイッチ類の設定が有効になります。

RM-B170にモニターを接続するに
は

RM-B170のMONITOR端子（BNC型）から
は、VIDEO OUT端子からの出力と同じ信号
が出力されます。
RM-B170のMONITOR端子とモニターを接
続する場合は、本機のVIDEO OUT端子の設
定をComposite信号にして、RM-B170に付
属の黒いケーブルを使用してください。

RM-B170接続時の画質調整項目に
ついて

カメラの画質調整項目（ペイントデータ）
については、前回RM-B170を接続したとき
に設定したパラメーターが再現されます。

REMOTE端子を介し
て操作する

リモートコントロールユニット
から本機を調整する
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RM-B170接続時の記録開始／停止
ボタンの機能について

メニューのMaintenance >Camera Config 
>RM Rec Startで選択できます。

RM Rec Startの設定値に対するボタンの機
能

カメラ画質調整データのデータ構
造について

本機の持つカメラ画質調整データ（ペイン
トデータ）のデータ領域には、次図のよう
に、リモートコントロールユニットを接続
しないときに有効となる「単独用データ領
域」と、リモートコントロールユニットを
接続したときに有効となる「リモートコン
トロール用データ領域」があります。
RM-B170などのリモートコントロールユ
ニットの接続／非接続に応じて、「単独用
データ領域」と「リモートコントロール用
データ領域」が自動的に切り換えられて、
カメラ部に出力されます。

リモートコントロールユニットを接続する
と、ペイントデータのデータ領域は「リ
モートコントロール用データ領域」に切り
替わり、以前にリモートコントロールユ
ニットを接続していたときの状態が再現さ
れます。
ただし、リモートコントロールユニット側
で絶対値ボリューム1） や絶対値スイッチ 2）

などが設定されているときは、絶対値ボ
リュームや絶対値スイッチのポジションに
合わせて状態が変更されます。
また、リモートコントロールユニットを外
すと、「単独用データ領域」が有効となり、
リモートコントロールユニットを接続する
前の状態に戻ります。
1)絶対値ボリューム：ボリュームの回転角度（位
置）に対応したデータが出力される。これに対
して、回転（変化）量に応じたデータが出力さ
れるものを相対値ボリュームと呼ぶ。

2)絶対値スイッチ：トグルスイッチや、スライド
スイッチ（原則としてモーメンタリー型を除
く）のように、スイッチのレバー（またはつま
み）の位置とそのスイッチの機能の状態とが一
致している必要があるスイッチ

ボタン RM Rec Startの設定値
RM Camera PARA

本機のREC 
STARTボタン

無効 有効 有効

レンズのVTRボ
タン

無効 有効 有効

記録開始／停止
機能が割り当て
られている
ASSIGN. 1/3ス
イッチ、
ASSIGNABLE 
4/5スイッチ、お
よびCOLOR 
TEMP.ボタン

無効 有効 有効

RM-B170の
MEDIA START
ボタン

有効 無効 有効

単独用データ領域 リモートコントロール用
データ領域

カメラ部のハードウェア

RM-B170接続時
RM-B170非接続時

本機の設定メニュー

本機の不揮発性メモリー

RM-B170
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メニューのMaintenance >Camera Config 
>RM Common MemoryをOnに設定すると、
リモートコントロールユニットを接続して
も「リモートコントロールユニット用デー
タ領域」を無効にしたまま「単独用データ
領域」を使うことができます。この場合、
リモートコントロールユニットは「単独用
データ領域」のデータを更新することにな
り、外したときもリモートコントロールユ
ニットで調整したままの画質が維持されま
す。ただし、本機のスイッチのポジション
と状態が異なるときは、本機のスイッチが
優先されます。
また、リモートコントロールユニットを接
続したときに、接続前と比べて画質が変化
しないようにすることができます。この場
合は、リモートコントロールユニットのボ
リュームをすべて相対値ボリュームに設定
しておく必要があります。
◆詳しくは、各リモートコントロールユニット
に付属のオペレーションマニュアルをご覧く
ださい。

1 RM-B170のCHARACTERボタンを押
して点灯させてから、MENUボタンを
押す。
RM-B170のMONITOR端子に接続した
モニター画面にメニューが表示されま
す。

2 調整つまみとCANCEL/ENTERボタ
ンを使用してメニューを選択・設定
する。

3 設定が終わったら、MENUボタンを
OFFにしてメニューを抜ける。
◆RM-B170の操作について詳しくは

RM-B170のオペレーションマニュアル
をご覧ください。

RM-B170からメニューを操作す
る
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表の見かた
　操作表示の記号の意味は次のとおりです。
　○：操作できる
　－：操作できない

RCP-1001/1501、RM-B170で操作できる主な機能

項目 細目 選択肢 機能 RCP-1001 RCP-1501 RM-B170
Panel Active Panel Active On/Off パネル操作の有効を

オン／オフする
○ ○ ○

Bars Bars On/Off カラーバー出力をオ
ン／オフする

○ ○ ○

Call Call On/Off RCP/RMからカム
コーダをコールする

○ ○ ○ 1)

Standard Standard On/Off 標準モードにする ○ ○ ○ 1)

ND Filter ND Filter 1/2/3/4 選択されているND
フィルターを表示す
る

○ ○ ○

CC Filter CC Filter A/B/C/D 選択されているCC
フィルターを表示す
る

－ － －

Gain Step Gain −6/−3/0/3/6/9/
12/18/24/30/
36/42dB

マスターゲインの設
定

○ ○ ○

White 
Balance

AWB Start/Stop オートホワイトバラ
ンスを実行する
実行中に行った場合
はストップする

○ ○ ○

White 
Memory

A/B/PRESET ホワイトバランスの
メモリーを切り替え
る

○ ○ ○

ATW On/Off ATWをオン／オフす
る

○ 1) ○ ○ 1)

5600K On/Off 電気色温度変換をオ
ン／オフする

○ ○ ○ 1)

Black ABB Start/Stop ブラックバランス自
動調整を実行する
実行中に行った場合
はストップする

○ ○ ○

Knee Point 75% ～ 90% ～ 
109%

Kneeポイントを設定
する

－ ○ ○ 1)

Detail Level −99～±0～
+99

HDディテールレベル
を設定する

○ ○ ○
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Shutter Shutter 
Setting

On/Off シャッターをオン／
オフする

－ ○ ○

Shutter 
Speed

－ シャッター速度を設
定する

－ ○ ○

ECS Setting On/Off ECS モードをオン／
オフする

－ ○ ○

ECS 
Frequency

－ ECS モードの周波数
を設定する

－ ○ ○

SLS Setting On/Off SLS モードをオン／
オフする

－ ○ ○

SLS Speed － SLS モードのスピー
ド（フレーム数）を
設定する

－ ○ ○

Iris Iris Mode Auto/Manual アイリスモードを設
定する

○ ○ ○

Iris Level −99～±0～
+99

オートアイリスの目
標値レベルを調整す
る

○ ○ ○

Close On/Off アイリス強制クロー
ズのオン／オフ

○ ○ －

Switch Status Gamma On/Off ガンマ補正機能をオ
ン／オフする

－ ○ ○ 1)

Black 
Gamma

On/Off ブラックガンマ補正
機能をオン／オフす
る

○ 1) ○ ○ 1)

Matrix On/Off マトリクス機能をオ
ン／オフする

－ ○ ○ 2)

Knee On/Off ニー補正機能をオン
／オフする

－ ○ ○ 1)

White Clip On/Off ホワイトクリップ調
整機能をオン／オフ
する

－ ○ ○ 2)

Detail On/Off ディテール調整機能
をオン／オフする

－ ○ ○

Flare On/Off フレア補正機能をオ
ン／オフする

－ ○ ○ 1)

Test Saw On/Off テスト信号をオン／
オフする

－ ○ ○ 1)

White R Gain −99～±0～
+99

ホワイトバランスのR
ゲイン値を設定する

○ ○ ○

B Gain −99～±0～
+99

ホワイトバランスのB
ゲイン値を設定する

○ ○ ○

Black Master Black −99～±0～
+99

マスターブラックレ
ベルを設定する

○ ○ ○

R Black −99～±0～
+99

Rチャンネルブラック
レベルを設定する

○ ○ ○

B Black −99～±0～
+99

Bチャンネルブラック
レベルを設定する

○ ○ ○

Camcorder 
Menu

Menu On/Off 本機のメニューを操
作する

－ － ○
Cancel/
Preset

Cancel/Preset － － ○

Select/Set Select(Up/
Down)/Set

－ － ○

項目 細目 選択肢 機能 RCP-1001 RCP-1501 RM-B170
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1) RCP/RM側のアサイナブルスイッチに機能が割り当てられている場合に操作可能
2) RM側から本機のメニューを操作可能

Media Rec Start/Stop 記録を開始／停止す
る

－ － ○

Play Play/Pause 再生を開始する － － ○
FREV － 逆高速再生する － － ○
FFWD － 高速再生する － － ○
STOP － 再生を停止する － － ○
Rec Review － レックレビューを開

始する
－ － ○

PREV － 現在のクリップの先
頭にジャンプする

－ － ○

NEXT － 次のクリップの先頭
にジャンプする

－ － ○

Shot Mark Shot Mark1 － ショットマーク1を設
定する

－ － ○

Shot Mark2 － ショットマーク2を設
定する

－ － ○ 1)

ZOOM － － ズーム操作（対応レ
ンズ）

－ － ○ 1)

FOCUS － － フォーカス操作（対
応レンズ）

－ － ○ 1)

項目 細目 選択肢 機能 RCP-1001 RCP-1501 RM-B170
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測位中に撮影した動画の位置情報や測位時
刻が本機に記録されます。
工場出荷時、GPS機能はOffになっていま
す。

GPS記録対応フォーマット
XAVC-IまたはXAVC-Lの記録フォーマット
がGPS記録に対応しています。
また、対応フォーマット以外の設定されて
いる場合でもSDI出力がオン（Operation 
>Input/Output >SDI Out1 OutputまたはSDI 
Out2 OutputがOn）の場合は、SDI出力で
測位情報を取得することができます。

ご注意
フォーマットがSD SDIのときは測位情報は出力さ
れません。また、再生時も出力されません。

1 本機がスタンバイ状態であることを確
認する。

2 メニューのOperation >GPSをOnに
設定する。
ビューファインダー画面に が表示
され、測位準備が行われます。測位で
きた場合、動画の撮影時に測位情報を
記録します。

GPS受信状況
GPS衛星からの電波の受信状況によって、
画面に表示されるアイコンが変わります。

• 電源を入れてから測位を始めるまで時間
がかかることがあります。

• 数分待ってもアイコンが測位中にならな
いときは、受信困難な状態です。そのま
ま撮影を始めるか、空の開けた場所に移
動してください。そのまま撮影すると測
位情報は記録されません。

• 屋内や高い建物のそばでは電波をうまく
受信できません。空の開けた場所に移動
してください。

•「測位中」になっていても、電波の受信状
況によりGPS情報の記録が途切れること
があります。

測位情報の取得
（GPS）

測位状況 画面表示 GPS受信状況
機能切 非表示 GPSがOffになってい

る、またはエラーが起
きている。

測位困難 GPS信号を受信できな
いため、測位情報が取
れない。空の開けた場
所に移動してください。

衛星検索中 衛星を検索中です。測
位中になるまで数分か
かることがあります。

測位中 弱いGPS信号を受信中。

GPS信号を受信中。測
位情報を取得できる。
強いGPS信号を受信中。
測位情報を取得できる。

測位状況 画面表示 GPS受信状況
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本機にUSBワイヤレスLANモジュール IFU-
WLM3（付属）またはワイヤレスLANアダ
プター CBK-WA02（別売）を取り付ける
と、スマートフォンやタブレットなどのデ
バイスと本機をワイヤレスLAN接続するこ
とができます。
ワイヤレスLAN接続されたデバイスと本機
の間では、次の操作が可能です。

ご注意
IFU-WLM3またはCBK-WA02以外のUSBワイヤレ
スLANモジュール／アダプターは使用できませ
ん。

ワイヤレスLAN経由でのリモート操作
本機とワイヤレスLAN接続されたスマート
フォンやタブレット、コンピューターから
本機をリモート操作することができます。

ワイヤレスLAN経由でのファイル転送
本機のSD カードに記録されたプロキシファ
イル（低解像度）や本機で記録したオリジ
ナルファイル（高解像度）を、ワイヤレス
LAN経由でサーバーに転送することができ
ます。

ワイヤレスLAN経由で映像をモニタリ
ング
本機のカメラ映像や再生映像からストリー
ム(H.264)を作成し、ワイヤレスLAN経由で
デバイスから「Content Browser Mobile」
アプリケーションを使って映像をモニタリ
ングすることができます。

「Content Browser Mobile」アプリケー
ション
「Content Browser Mobile」アプリケーショ
ンでは上記の操作に加え、デバイスの画面
で本機をストリーミングしながらリモート
操作をしたり、本機の設定をすることがで
きます。

また、プロキシデータのイン点／アウト点
を指定し、切り出した部分を転送（117
ページ）することもできます。
「Content Browser Mobile」アプリケーショ
ンは、最新のバージョンをご確認の上ご使
用ください。

◆「Content Browser Mobile」アプリケーショ
ンについて詳しくは、お買い上げ店またはソ
ニーのサービス窓口にご確認ください。

ご注意
• 本機のSD カードに記録されたプロキシファイ
ル（低解像度）はワイヤレスLAN経由ではスト
リーミングできません。

• ビデオフォーマットがMPEG IMX、および
DVCAMの場合は、ストリーミング再生には対
応していません。

• 本機とワイヤレスLANアクセスポイント、また
は端末機器間の障害物や電波状況、壁の材質な
ど周囲の環境によって、通信可能距離が短く
なったり、接続できなくなることがあります。
本機の場所を移動したり、本機とアクセスポイ
ントまたは端末機器の距離を近づけて、接続／
通信状態を確認してください。

対応デバイスについて

本機の設定や操作にはスマートフォン、タ
ブレットまたはコンピューターを使用する
ことができます。使用できるデバイス、
OS、ブラウザーは次のとおりです。

本機とデバイスのワイ
ヤレスLAN接続

デバイス OS ブラウザー
スマートフォン Android 4.4/5.x/

6.x/7.x/8.0
Chrome

iOS 9.x/10.x/11 Safari

タブレット Android 4.4/5.x/
6.x/7.x/8.0

Chrome

iOS 9.x/10.x/11 Safari

コンピューター Windows 7/
Windows 8/
Windows 10

Chrome

Mac OS X 
10.10/10.11/
macOS 10.12/
10.13

Safari
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1 USBワイヤレスLANモジュール接続端
子のカバーを開ける。

2 IFU-WLM3に保護キャップを取り付
ける。

3 IFU-WLM3を端子に差し込む。

ご注意
• IFU-WLM3の取り付け／取り外しは、本機の電
源を切った状態で行ってください。

• ガードの取り付けについては、サービス担当者
にお問い合わせください。

IFU-WLM3を使用しない場合は

ネジ（2本）を外してガードを取り外し、端
子カバーを閉じます。

1 ハンドルの下図の位置にアタッチメン
ト金具を取り付ける。
アタッチメント金具（サービスパーツ
番号：A-2092-367-A）の取り付けは、
サービス担当者にお問い合わせくださ
い。

2 CBK-WA02（別売）に付属している
USB延長アダプターをアタッチメン
ト金具に取り付ける。

3 固定ネジを時計方向に回して、USB
延長アダプターを固定する。

USB延長アダプターは、図に示す範囲
で取り付け位置を調節することができ
ます。

IFU-WLM3を取り付ける

ガード（付属品）

CBK-WA02を取り付ける

アタッチメント金具

固定ネジ

USB延長アダプター
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4 USB延長アダプターのUSB端子に保
護キャップ（付属）を取り付ける。

5 USBワイヤレスLANモジュール接続
端子のカバーを開ける。
ガードの取り付けについては、サービ
ス担当者にお問い合わせください。

6 USB延長アダプターのUSB端子を
USBワイヤレスLANモジュール接続
端子に差し込む。

7 CBK-WA02をUSB延長アダプターの
USB端子に差し込む。

8 メニューのMaintenance >Network 
>Channelで、ワイヤレスLANチャン
ネルを設定する（180ページ）。

◆CBK-WA02の使いかたについて詳しくは、
CBK-WA02に付属の取扱説明書をご覧くだ
さい。

ご注意
• CBK-WA02の取り付け／取り外しは、本機の電
源を切った状態で行ってください。

• CBK-WA02を装着して、メニューの
Maintenance >Network >Wi-Fi ModeでWi-Fi 
Stationを選択すると、5GHz対応のアクセスポ
イントと接続できるようになります。

• Wi-Fi Access PointモードのCh設定の
Auto(5GHz)は、ご使用のCBK-WA02によって
は、メニューに表示されない場合があります。

• CBK-WA02を5GHz帯の屋外使用が禁止されて
いる国／地域でご使用の場合、Auto(5GHz)はメ
ニューに表示されません。CBK-WA02が、ご使

ガード（付属品）
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用になる国／地域に対応しているかをご確認く
ださい。詳しくは、CBK-WA02の取扱説明書を
ご覧ください。

CBK-WA02を使用しない場合は

ネジ（2本）を外してガードを取り外し、端
子カバーを閉じます。

本機をアクセスポイントとしてデバイスと
ワイヤレスLAN接続します。

WPS機能搭載のデバイスで接続す
るには

デバイスがWPSをサポートしている場合に
は、WPSでの接続が可能です。

1 メニューのMaintenance >Network 
>SettingをOnにする。

2 メニューのMaintenance >Network 
>Wi-Fi ModeをWi-Fi Access Pointに
する。

ご注意
アクセスポイントモードになるまでに時間がかか
る（30秒から1分）場合があります。LCDモニター
画面／ビューファインダー画面のネットワーク状
態表示（33ページ）が「AP」点滅から「AP」点灯
に変わるまでお待ちください。

3 メニューのMaintenance >Network 
>WPSを選択する。

4 MENUつまみを回してExecuteを選
択し、つまみを押す。

5 デバイスのNetwork設定／Wi-Fi設定
を開き、Wi-FiをOnにする。

6 Wi-Fi NetworkのSSID一覧から、本
機のSSIDを選択し、詳細Optionを表
示し、WPS Push Buttonを選択す
る。

ご注意
使用する機器によっては、操作が異なる場合があ
ります。

7 デバイスのブラウザーを起動し、
「http://192.168.1.1:8080/index.html」
にアクセスする。
ユーザー名「User name」とパスワー
ド「Password」を入力する画面が表示
されます。

8 ユーザー名とパスワードを入力して、
「OK」を選択する。
アクセス認証のユーザー名およびパス
ワードについては、メニューの
Maintenance >Basic Authentication
（179ページ）でご確認ください。

デバイスでSSID、Passwordを入
力して接続するには

デバイス側でSSIDとPasswordを入力して
接続します。

1 メニューのMaintenance >Network 
>SettingをOnにする。

ワイヤレスLANアクセスポイン
トモード（Wi-Fi Access Point
モード）で接続する

スマートフォン
／タブレット

コンピューター
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2 メニューのMaintenance >Network 
>Wi-Fi ModeをWi-Fi Access Pointに
する。

ご注意
アクセスポイントモードになるまでに時間がかか
る（30秒から1分）場合があります。LCDモニター
画面／ビューファインダー画面のネットワーク状
態表示（33ページ）が「AP」点滅から「AP」点灯
に変わるまでお待ちください。

3 デバイスのNetwork設定／Wi-Fi設定
を開き、Wi-FiをOnにする。

4 Wi-Fi NetworkのSSID一覧から、本
機のSSIDを選択し、Passwordを入
力して接続する。
本機のSSIDおよびPasswordについて
は、メニューのMaintenance >Network 
>SSID & Password（180ページ）でご
確認ください。

ご注意
使用する機器によっては、操作が異なる場合があ
ります。

5 デバイスのブラウザーを起動し、
「http://192.168.1.1:8080/index.html」
にアクセスする。
ユーザー名「User name」とパスワー
ド「Password」を入力する画面が表示
されます。

6 ユーザー名とパスワードを入力して、
「OK」を選択する。
アクセス認証のユーザー名およびパス
ワードについては、メニューの
Maintenance >Basic Authentication
（179ページ）でご確認ください。

本機をクライアントとして既存のワイヤレ
スLAN のアクセスポイントに接続します。

デバイスとはアクセスポイント経由で接続
します。
接続はセットアップメニューによる方法と
Webメニューによる方法があります。ここ
ではセットアップメニューのWPS機能を使
用する方法を示します。
Webメニューによる接続方法は「WPS機能
を使用しないステーションモードでアクセ
スポイントに接続するには」（129ページ）
をご覧ください。
ネットワーク自動検出機能、または手動入
力機能による接続方法は「セットアップメ
ニューからアクセスポイントに接続する」
（114ページ）をご覧ください。

WPS機能を使ってアクセスポイン
トに接続するには

アクセスポイントがWPS機能対応の場合
は、簡単な設定で接続することができます。

1 アクセスポイントの電源を入れる。

2 本機の電源を入れる。

3 メニューのMaintenance >Network 
>SettingをOnにする。

ワイヤレスLAN ステーション
モード（Wi-Fi Stationモード）
で接続する

アクセス
ポイント

スマートフォン
／タブレット

コンピューター
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4 メニューのMaintenance >Network 
>Wi-Fi ModeをWi-Fi Stationにする。

ご注意
ステーションモードになるまでに時間がかかる
（30秒から1分）場合があります。LCDモニター画
面／ビューファインダー画面のネットワーク状態
表示（33ページ）の電波強度アイコン表示が点滅
から点灯に変わるまでお待ちください。

5 メニューのMaintenance >Network 
>WPSを選択する。

6 MENUつまみを回してExecuteを選
択し、つまみを押す。

7 アクセスポイントのWPS ボタンを押
す。
WPS ボタンの操作については、アクセ
スポイントの取扱説明書をご覧くださ
い。
接続が完了すると、LCDモニター画面
／ビューファインダー画面のネット
ワーク状態表示（33ページ）の電波強
度アイコン表示が強度1以上で点灯しま
す。

ご注意
接続に失敗した場合は手順1からやり直してくだ
さい。

8 デバイスをアクセスポイントに接続
する。
接続のしかたについては、各機器の取
扱説明書をご覧ください。

9 デバイスのブラウザーを起動し、
「http://<アクセスポイントが本機に割
り当てたIPアドレス>:8080/
index.html」にアクセスする。
本機のIPアドレスはメニューの
Maintenance >Network >IP Addressで
ご確認ください。ユーザー名「User 
name」とパスワード「Password」を
入力する画面が表示されます。

10 ユーザー名とパスワードを入力して、
「OK」を選択する。
本機のWeb メニューが表示されます。

Web メニューについて詳しくは「Web
メニューについて」（126ページ）をご
覧ください。
アクセス認証のユーザー名およびパス
ワードについては、メニューの
Maintenance >Basic Authentication
（179ページ）でご確認ください。
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USBワイヤレスLANモジュールIFU-WLM3
（付属）、ネットワークアダプター CBK-
NA1（別売）、ワイヤレスLANアダプター
CBK-WA02（別売）、モデム（別売）、また
はLANケーブル（別売）を本機に取り付け
てインターネットに接続します。

ネットワーク接続に必要な機器

ワイヤレスネットワーク接続
• USBワイヤレスLANモジュールIFU-

WLM3（付属）
• ワイヤレスLANアダプター CBK-WA02
（別売）

• モデム（別売）
• ネットワークアダプター CBK-NA1（別
売）に同梱のUSB延長アダプター CBK-
NA1E

有線LAN接続
• LANケーブル（別売）
• ネットワークアダプター CBK-NA1（別
売）に同梱のEthernet変換アダプター
CBK-NA1R

ご注意
• ワイヤレスLAN モジュールは国・地域によって
利用できない場合があります。

• ワイヤレスLAN モジュールが使用する周波数帯
は、さまざまな機器が共有して使用する電波帯
です。使用環境によっては、他の機器の影響に
よって、通信速度や通信距離が低下すること
や、通信が切断することがあります。

• 3G/4G/LTE 回線を利用するには、携帯電話事業
者との契約が必要です。

• 本機に対応しているネットワーク接続に必要な
機器については、お買い上げ店またはソニーの
サービス窓口にお問い合わせください。

3G/4G回線経由、またはインターネット
ルーターとLANケーブル経由でインター
ネットに接続する場合は、以下の方法で、
本機にネットワークアダプター CBK-NA1
（別売）を取り付けます。

CBK-NA1のUSB延長アダプターを
本機に取り付ける

ネットワークアダプター CBK-NA1（別売）
には、USB延長アダプター CBK-NA1Eと
Ethernet変換アダプター CBK-NA1Rが同梱
されています。
ここでは、本機にUSB延長アダプター
CBK-NA1Eを取り付けます。

1 ハンドルの下図の位置にアタッチメン
ト金具を取り付ける。
アタッチメント金具（サービスパーツ
番号：A-2092-367-A）の取り付けは、
サービス担当者にお問い合わせくださ
い。

2 USB延長アダプターをアタッチメン
ト金具に取り付ける。

インターネット接続 モデムまたはLANケーブルを使
用してインターネット接続する
ための準備

アタッチメント金具
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3 固定ネジを時計方向に回して、USB
延長アダプターを固定する。

USB延長アダプターは、図に示す範囲
で取り付け位置を調節することができ
ます。

4 USB延長アダプターのUSB端子に保
護キャップ（付属）を取り付ける。

5 USBワイヤレスLANモジュール接続
端子のカバーを開ける。
ガードの取り付けについては、サービ
ス担当者にお問い合わせください。

6 USB延長アダプターのUSB端子を
USBワイヤレスLANモジュール接続
端子に差し込む。

ネットワークアダプター CBK-NA1（別売）
経由でモデム（別売）を本機に取り付ける
ことによって、3G/4G回線経由でインター
ネットに接続することができます。

固定ネジ

USB延長アダプター

モデムを使用して接続する

ガード（付属品）
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接続する

1 USB延長アダプター CBK-NA1Eの
USB端子にモデム（別売）を接続す
る。

◆モデム側の接続方法は、モデムに付属
の取扱説明書をご覧ください。

2 メニューのMaintenance >Network 
>SettingをOnにする。

3 メニューのMaintenance >Network 
>ModemをOnにする。

ご注意
• CBK-NA1およびモデムの取り付け／取り外し
は、本機の電源を切った状態で行ってくださ
い。

• モデムモードになるまでに時間がかかる（30秒
から1分）場合があります。液晶画面／ビュー
ファインダー画面のネットワーク接続状態表示
（33ページ）が「3G/4G」点滅から「3G/4G」
点灯に変わるまでお待ちください。

ネットワークアダプター CBK-NA1（別売）
を本機に取り付け、インターネットルー
ターとLANケーブルで接続することによっ
て、インターネットに接続することができ
ます。

接続する

1 CBK-NA1（別売）に同梱のEthernet
変換アダプター CBK-NA1RをUSB延
長アダプターのUSB端子に差し込む。

インターネット

CBK-NA1
＋
モデム

LANケーブルを使用して接続す
る

インター
ネット

コンピューター

ルーター



113

2 本機とルーターをLANケーブルで接
続する。

◆ルーター側の接続方法は、ルーターに
付属の取扱説明書をご覧ください。

3 メニューのMaintenance >Network 
>SettingをOnにする。

4 メニューのMaintenance >Network 
>Wired LANをEnableにする。
自動的に本機にIPアドレスが割り当て
られます。

ご注意
• CBK-NA1およびルーターの取り付け／取り外し
は、本機の電源を切った状態で行ってくださ
い。

• 有線LANモードになるまでに時間がかかる（30
秒から1分）場合があります。液晶画面／
ビューファインダー画面のネットワーク接続状
態表示（33ページ）が「LANアイコン」点滅か
ら「LANアイコン」点灯に変わるまでお待ちく
ださい。

• 本機に記録したオリジナルファイル／プロキシ
ファイルの転送、Wi-Fiリモコンの使用、Webメ
ニューの操作、「Content Browser Mobile」ア
プリケーションでの映像モニタリングをするに
は、メニューのMaintenance >Network >Wired 
LAN RemoteをOnにしてください（180ペー
ジ）。

• インターネットからの不正アクセスを防ぐた
め、LANケーブルを使用したネットワークがイ
ンターネットに接続していないときにWired 
LAN RemoteをOnにすることを推奨します。イ
ンターネットに接続する場合は、接続先がセ
キュアなネットワークであることをご確認の
上、使用してください。

USBワイヤレスLANモジュール IFU-WLM3
（付属）、またはワイヤレスLANアダプター
CBK-WA02（別売）を本機に取り付け、
3G/4G/LTE対応アクセスポイント（別売）
またはデバイスのテザリングを使用するこ
とによって、Wi-Fi ステーションモードでイ
ンターネットに接続することができます。
取り付け方法は、「IFU-WLM3を取り付け
る」（105ページ） 、または「CBK-WA02を
取り付ける」（105ページ） をご覧ください。

本機へ

LANケーブル
ルーター

ワイヤレスLAN ステーション
モード（Wi-Fi Station モード）
で接続する
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アクセスポイントまたはデバイスがWPS 機
能対応の場合は「WPS機能を使ってアクセ
スポイントに接続するには」（108ページ）、
WPS機能に対応していない場合は「WPS機
能を使用しないステーションモードでアク
セスポイントに接続するには」（129ペー
ジ）の手順で接続します。
接続の操作の前に、アクセスポイントまた
はデバイスの電源を入れ、デバイスの場合
はテザリング機能が使用できるようにして
おいてください。

セットアップメニューからアクセスポイン
トに接続できます。
接続は、ネットワーク自動検出機能を使用
するか、または手動入力で行います。

ネットワーク自動検出機能で接続
するには

1 「WPS機能を使ってアクセスポイント
に接続するには」（108ページ）の手順
1～4を行う。

2 メニューのMaintenance >Network 
>Wi-Fi Station Detail SettingsのScan 
NetworksでExecuteを選択する。
本機が接続先の検出を開始します。接
続先を検出すると、Scan Networksの
結果リストが表示されます。

3 MENUつまみで接続先を選択し、つ
まみを押す。
接続先を決定すると、Password入力画
面に遷移します。

4 Password入力画面でPasswordを設
定する。
以前に接続したことがある接続先の情
報が本機の履歴に残っていた場合、そ
のとき使用していたSSIDを選択すると、
そのSSIDのPasswordが表示されます。
Passwordを設定後、Wi-Fi Station 
Detail Settings詳細設定画面に戻りま
す。

5 Wi-Fi Station Detail Settings詳細設
定画面で以下の接続設定を行う。

デバイスを使用して接続する

アクセス
ポイント

スマートフォン
／タブレット

コンピューター

インター
ネット

インター
ネット

スマートフォン
／タブレット

セットアップメニューからアク
セスポイントに接続する

項目 内容
DHCP DHCPを設定する。

Onにすると、自動的に本機に
IPアドレスを割り当てる。
手動で本機のIPアドレスを入
力する場合は、Offにする。

IP Address 本機のIPアドレスを入力する。
DHCPがOffのときに有効
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6 設定入力が完了したらSetのExecute
を選択し、設定内容を確定する。

ご注意
• 接続設定を変更した場合、必ずSetのExecuteを
選択してください。Executeを選択しなかった
場合は設定した内容が反映されません。

• ステーションモードになるまでに時間がかかる
（30秒～1分）場合があります。LCDモニター画
面／ビューファインダー画面のネットワーク状
態表示（33ページ）の電波強度アイコン表示が
点滅から点灯に変わるまでお待ちください。

• 接続したStation設定情報は履歴として保存され
ます。この履歴はALL Reset、Network Resetで
消去されます。

手動入力で接続するには

1 「WPS機能を使ってアクセスポイント
に接続するには」（108ページ）の手順
1～4を行う。

2 メニューのMaintenance >Network 
>Wi-Fi Station Detail Settingsで、以
下の接続設定を行う。

3 設定入力が完了したらSetのExecute
を選択し、設定内容を確定する。

ご注意
• 接続設定を変更した場合、必ずSetのExecuteを
選択してください。Executeを選択しなかった
場合は設定した内容が反映されません。

• ステーションモードになるまでに時間がかかる
（30秒～1分）場合があります。LCDモニター画
面／ビューファインダー画面のネットワーク状
態表示（33ページ）の電波強度アイコン表示が
点滅から点灯に変わるまでお待ちください。

ネットワーク機能とネットワーク接続設定
（メニューのMaintenance >Network >Wi-Fi 
Mode、ModemおよびWired LANの設定）
の対応状況は以下のとおりです。
ネットワーク機能を有効にするには、メ
ニューのMaintenance >Network >Setting
をOnにしてください。

Subnet 
mask

本機のサブネットマスクを入
力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得す
る。

Primary 
DNS Server

アクセスポイントのプライマ
リー DNSサーバーを入力す
る。
DNS AutoがOffのときに有効

Secondary 
DNS Server

アクセスポイントのセカンダ
リー DNSサーバーを入力す
る。
DNS AutoがOffのときに有効

項目 内容
SSID 接続先のアクセスポイントの

SSIDを入力する。
Password 接続先のアクセスポイントの

Passwordを入力する。

項目 内容
DHCP DHCPを設定する。

Onにすると、自動的に本機に
IPアドレスを割り当てる。
手動で本機のIPアドレスを入
力する場合は、Offにする。

IP Address 本機のIPアドレスを入力する。
DHCPがOffのときに有効

Subnet 
mask

本機のサブネットマスクを入
力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得す
る。

Primary 
DNS Server

アクセスポイントのプライマ
リー DNSサーバーを入力す
る。
DNS AutoがOffのときに有効

Secondary 
DNS Server

アクセスポイントのセカンダ
リー DNSサーバーを入力す
る。
DNS AutoがOffのときに有効

ネットワーク機能とネットワー
ク接続設定の対応状況

項目 内容



116

1)プロキシ記録は、メニューのOperation >Proxy 
Recording Mode >SettingがOnで有効になりま
す。

2)本機とネットワーク接続したデバイスの機能に
対応

SDカードに記録したプロキシファイルや
SxSメモリーカードのオリジナルファイル
を3G/4G/LTE回線やアクセスポイント経由
で接続したインターネット上のサーバーへ
転送することができます。

インターネットに接続する
「本機とデバイスのワイヤレスLAN接続」
（104ページ）、および「インターネット接
続」（110ページ）の手順に従って、本機を
インターネットに接続します。

ファイルの転送先を登録する
あらかじめファイルを転送するサーバーを
登録しておきます。サーバーの登録のしか
たについては、「新しく転送先のサーバーを
登録するには」（131ページ）をご覧くださ
い。

SDカードに記録したプロキシファイル、
SxSメモリーカードのオリジナルファイル
をサーバーに転送します。

SDカードのプロキシファイルを転
送するには

1 本機とデバイスをワイヤレスLAN接続
し、デバイスのブラウザーを起動して
本機にアクセスする（104ページ）。

2 ファイルを選択するためのファイル
リスト画面を表示させる。

ネットワーク
機能

メニューの Maintenance 
>Network >Wi-Fi Mode

Wi-Fi 

Access 

Point

Wi-Fi 

Station

Off

プロキシ記録1)

（90ページ）
○ ○ ○

プロキシ再生
（126ページ）

○2) ○2) ×

ファイル転送
（116ページ）

× ○2) ×

ストリーミング
伝送
（119ページ）

× ○ ×

モニタリング
（127ページ）

○2) ○2) ×

ネットワーク
クライアント
モード
（121ページ）

× ○ ×

本機のリモート
操作
（123ページ）

○2) ○2) ×

ネットワーク
機能

メニューの
Maintenance 

>Network 

>Modem

メニューの
Maintenance 

>Network 

>Wired LAN

On Off Enable Disable

プロキシ記録1)

（90ページ）
○ ○ ○ ○

プロキシ再生
（126ページ）

× × ○2) ×

ファイル転送
（116ページ）

○2) × ○2) ×

ストリーミング
伝送
（119ページ）

○ × ○ ×

モニタリング
（127ページ）

× × ○2) ×

ネットワーク
クライアント
モード
（121ページ）

○ × ○ ×

本機のリモート
操作
（123ページ）

× × ○2) ×

ファイルの転送

準備する

ファイルを選んで転送する
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3 をタップしてMedia Infoを選択
し、SD Cardをタップする。
SD Card画面が表示されます。

「Content Browser Mobile」アプリ
ケーションを使用すると
「Content Browser Mobile」アプリケー
ションを使用すると、先頭フレームの
静止画ファイルを使用し、SD カードの
プロキシファイルのサムネイルをすば
やく表示することができます。

4 転送したいファイルを選択する。
ファイルをタップして選びます。もう
一度タップすると、キャンセルします。
ダブルタップすると、ファイルを再生
して内容を確認することができます。

5 Transferをタップする。
「新しく転送先のサーバーを登録するに
は」（131ページ）のDefault Settingで
デフォルト設定された転送先が表示さ
れます。
転送先を変更する場合は、転送先を
タップしてリストを表示させ、転送先
を選択します。必要に応じて、転送先
のディレクトリーを入力します。

6 Transferをタップする。
選択したファイルの転送が開始されま
す。転送を中止するときは、Cancelを
タップします。

記録終了時の自動転送

あらかじめメニューのMaintenance >File 
Transfer >Auto Upload(Proxy)をOnに設定
すると、プロキシ記録が完了した時点で、
設定されたサーバーにファイルが自動的に
転送されます。
オリジナルファイルの情報を継承した同一
デュレーションのプロキシファイルをプラ
ンニングメタデータに基づいて記録した場
合、このプランニングメタデータの<Title>
タグの内容で転送先のフォルダーが作成さ
れ、このフォルダーの下に転送されます。
また転送時に記録メディアのIDがプランニ
ングメタデータファイルのファイル名に自
動で付加されます。

プロキシファイルを部分転送する
には

「Content Browser Mobile」アプリケーショ
ンを使用すると、プロキシファイルのイン
点／アウト点を指定し、切り出した部分を
転送することができます。
また、ストーリーボードを使用すると、複
数ファイルから切り出した部分を転送する
ことができます。

ご注意
• 生成されるファイルには、切り出し位置の前後
に最大15 フレームのマージンが付加されます。

• ネットワーク機能ソフトウェア（V1.25）以前
で記録したプロキシファイルから切り出した場
合には、ノンリニア編集機に取り込めない場合
があります。

• ストーリーボードに基づいて部分転送を行った
場合には、ノンリニア編集機へストーリーボー
ドの情報を伝達するためのファイルがJob List
に表示されます。

• 転送時にSDカードにGeneral/Sony/tmpフォル
ダーが自動で作成されます。ファイルはこの
フォルダーに一時的に保存され、転送完了後に
自動的に削除されます。
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SxSメモリーカードのオリジナル
ファイルを転送するには

1 メニューのMaintenance >File 
Transfer >File Transferを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
ファイルの転送モードに設定されます。

3 本機とデバイスをワイヤレスLAN接
続し、デバイスのブラウザーを起動
して本機にアクセスする（104ペー
ジ）。

4 デバイスのブラウザー上でファイル
を選択するためのファイルリスト画
面を表示させる。

5  をタップしてMedia Infoを選択
し、Slot A（スロットAのメディアに
記録されているファイル）または
Slot B（スロットBのメディアに記録
されているファイル）をタップする。
Slot AまたはSlot B画面が表示されます。
例：Slot A画面

6 転送したいファイルを選択する。
ファイルをタップして選びます。もう
一度タップすると、キャンセルします。

7 Transferをタップする。
「新しく転送先のサーバーを登録するに
は」（131ページ）のDefault Settingで
デフォルト設定された転送先が表示さ
れます。
転送先を変更する場合は、転送先を
タップしてリストを表示させ、転送先
を選択します。

Directoryに転送先のディレクトリーを
入力します。

8 Transferをタップする。
選択したファイルの転送が開始されま
す。転送を中止するときは、Cancelを
タップします。
すべてのファイルの転送が完了したら、
自動的に転送モード設定が解除され、
カメラ撮像画面に切り替わります。

あらかじめメニューのMaintenance >File 
Transfer >Remote File TransferをEnableに
設定すると、手順1および2の操作を行わな
くても、自動的にファイルの転送モード設
定になります。

ご注意
次の状態のときは、ファイルの転送は行えません。
• 記録、再生、サムネイル画面表示中
• メニューのMaintenance >Network >Wi-Fi 

ModeがWi-Fi Access Point、かつWired LANが
Disableのとき

• ストリーミング機能が有効のとき
（Maintenance >Streaming >SettingがOn）

オリジナルファイルの部分転送
「Content Browser Mobile」アプリケーショ
ンのバージョン2.0以降を使用すると、本機
で記録したオリジナルファイルにイン点／
アウト点を指定し、切り出した部分を転送
することができます。
また、ストーリーボードを使用すると、複
数ファイルから切り出した部分を転送する
ことができます。
対応するオリジナルファイルのフォーマッ
トは、以下のとおりです。
• XAVC-I
• XAVC-L
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• HD422（exFAT/UDF共通）
• HD420HQ（exFAT/UDF共通）

ご注意
「Content Browser Mobile」を使用してオリジナル
ファイルを部分転送するには、オリジナルファイ
ルと同一ファイル名のプロキシファイルが必要に
なります。
あらかじめプロキシファイルを作成する設定にし
てから、記録を開始してください。
設定は以下のとおりです。
• メニューのOperation >Proxy Recording Mode 

>SettingをOnにする。
• ネットワーククライアントモードが有効のとき
は、メニューのMaintenance >Network Client 
Mode >Preset 1、Preset 2、またはPreset 3 
>NCM with ProxyをEnableにする。

ファイル転送の確認をするには

SD Card、Slot AまたはSlot B画面のJob 
Listをタップして表示されるJob List画面で
ファイル転送の状態を確認することができ
ます（132ページ）。

カムコーダーで撮像・再生している映像・
音声を、インターネットやローカルネット
ワークを通じて伝送することができます。

インターネットに接続する

「本機とデバイスのワイヤレスLAN接続」
（104ページ）、および「インターネット接
続」（110ページ）の手順に従って、本機を
インターネットに接続します。

ストリーミング伝送の伝送先を設
定する

1 メニューのMaintenance >Streaming
で、Preset1（またはPreset2、
Preset3）を選択する。
ストリーミングの接続先設定画面が表
示されます。

2 ストリーミングの接続先設定画面で
Size、Bit Rate、TypeおよびTypeに
応じた設定項目を設定する。
設定項目の詳細、制限事項などについ
ては、「ストリーミング設定」（127ペー
ジ）をご覧ください。

3 メニューのMaintenance >Streaming 
>Preset Selectで、手順1、2で設定
したPreset1（またはPreset2、
Preset3）を選択する。

1 メニューのMaintenance >Streaming 
>SettingをOnにする。

映像・音声をストリー
ミング伝送する

準備する

ストリーミングを開始する
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設定に応じてストリーミングが開始さ
れます。
Streamingはアサイナブルスイッチに割
り当てることができます。割り当て方
法については、「アサイナブルスイッチ
に機能を割り当てる」（189ページ）を
ご覧ください。

ご注意
• メニューの設定が以下の場合、ストリーミング
を開始できません。
- メニューの Maintenance >Network >Setting
が Offの場合

- メニューの Maintenance >Network Client 
Mode >Settingが Onの場合

- メニューの Maintenance >Network >Setting
は OnだがMaintenance >Network >Wi-Fi 
Modeが Off、Maintenance >Network 
>Wired LANが Disableのとき

• ストリーミングを開始してから実際に映像・音
声がストリーミングされるまでに数十秒かかる
場合があります。

• SDフォーマットのクリップの再生時はストリー
ミングを開始できません。

• ストリーミングの伝送先設定が間違っている場
合やネットワークに接続できていない場合に
は、ストリーミング状態表示に×が表示されま
す。

• ストリーミングに移行すると、ネットワークク
ライアントモードによるストリーミング（121
ページ）、モニタリング、プロキシ記録および
ファイル転送はできません。

• モニタリング中、プロキシ記録中またはファイ
ル転送中にストリーミングを開始すると、これ
らの機能は停止します。

1 メニューのMaintenance >Streaming 
>SettingをOffにする。
ストリーミングを停止します。
StreamingがOnのときに、Streamingが
アサインされたアサイナブルスイッチ
を押すことでもストリーミングを停止
できます。

デバイスとワイヤレスLAN接続している場
合（104ページ）、およびワイヤレスLANス
テーションモードでインターネット接続し

ている場合（113ページ）には、ストリー
ミング伝送先の設定、ストリーミングの開
始／停止をWebメニュー（126ページ）か
ら行うこともできます。

ストリーミングを停止する
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ネットワーククライアントモードを有効に
し、本機とソニー製ネットワークRXステー
ション（別売）のConnection Control 
Manager（以降「CCM」）またはXDCAM 
airを接続して使うことで、ソニーのQoS技
術を使った高品質なストリーミングが可能
になります。また複数のネットワークを経
由することで、より高画質で安定したスト
リーミングが行えます。

ご注意
• 複数のネットワークを使用して安定したスト
リーミングを行うには、それぞれのネットワー
クに異なるキャリアの回線を使用してくださ
い。

• 複数のネットワークを使用した場合、映像シー
ンによっては、ターゲットビットレートを超え
ることがあります。

• XDCAM air は、ソニーが提供するクラウドサー
ビスです。
このサービスをご利用になるには、別途契約が
必要です。
一部対応していない地域がありますので、サー
ビス対象地域についてXDCAM air のサイトをご
確認ください。
https://www.xdcam-air.com

また、XDCAM airのプライバシーポリシーにつ
いては、以下のサイトを参照してください。
- 利用規約

https://www.xdcam-air.com/site/tos_eu.html

- XDCAM airのプライバシーポリシー
https://sony-imaging-products-
solutions.co.jp/pp/sips/en/index.html

- プロフェッショナル IDのプライバシーポリ
シー
https://www.pro-id.sony.net/#/privacyPolicy

• 詳しくは、ソニー法人営業窓口にお問い合わせ
ください。

1 本機をネットワークに接続する。
詳しくは、「本機とデバイスのワイヤレ
スLAN接続」（104ページ）、「インター
ネット接続」（110ページ）をご覧くだ
さい。

2 メニューのMaintenance >Network 
Client Mode >Preset 1、Preset 2、
またはPreset 3で接続先のネット
ワークを設定する。
接続先のネットワーク設定はプリセッ
ト設定としてPreset 1、Preset 2、また
はPreset 3に設定できます。

ご注意
•すべての項目に値が入力されないと、ネッ
トワーククライアントモードを設定できま
せん。

•メニューのMaintenance >Network Client 
Mode >Preset 1、Preset 2、または
Preset 3 >NCM with ProxyをEnableに設定
すると、ネットワーククライアントモード
が有効な場合でも、プロキシ記録ができま
す。NCM with Proxyの設定を有効にするに
は、メニューのOperation >Proxy 
Recording Mode >SettingをOnにしてくだ
さい。

•メニューのMaintenance >Network Client 
Mode >Preset 1、Preset 2、または
Preset 3 >NCM with ProxyがDisableに設
定されている場合、記録中にネットワーク

ネットワーククライア
ントモードによる高品
質なストリーミング

ネットワーククライアントモー
ドを設定する

項目 内容
CCM Address 接続先のCCMのアドレスを

入力する。（ホスト名または
IPアドレス）

CCM Port 接続先のCCMのポート番号
を入力する。

User Name ユーザー名を入力する。
Password パスワードを入力する。
NCM With 
Proxy

CCM接続時のプロキシ記録
の有効／無効を設定する。

Camera 
Control

CCM接続時のカメラコント
ロール許可／不許可を設定
する。

Camera 
Setting

CCM接続時のAll Fileのハン
ドリング許可／不許可を設
定する。
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クライアントモードをOnにすると、プロキ
シ記録は停止します。オリジナルファイル
の記録を継続している場合、同設定をOffに
するとプロキシ記録を再開します。

•メニューのOperation >Proxy Recording 
Mode >Proxy File >SizeをHD 
Auto(9Mbps)またはHD Auto(6Mbps)に設
定している場合、NCM with Proxyは設定で
きません。
NCM with ProxyがEnableに設定済みで、
HD Auto(9Mbps)またはHD Auto(6Mbps)
に設定した場合、設定値は保持されます
が、プロキシ記録は行われません。

3 メニューのMaintenance >Network 
Client Mode >Preset Selectで手順1
で設定したプリセットのいずれか1つ
を選択する。

4 メニューのMaintenance >Network 
Client Mode >SettingをOnにする。
ネットワーククライアントモードが有
効になり、ネットワークRXステーショ
ンまたはXDCAM airと接続します。
ネットワークRXステーションの操作に
より、ライブストリーミングが開始さ
れます。
また、ネットワークRXステーションか
らの本機リモートコントロール、All
ファイルの保存/呼び出しができます。
操作について詳しくは、ネットワーク
RXステーションの取扱説明書または
XDCAM airのヘルプをご覧ください。
なお、Network Client ModeのSetting
（On/Off）は、本機のアサイナブルス
イッチに割り当てることができます。
割り当て方法については、「アサイナブ
ルスイッチに機能を割り当てる」（189
ページ）をご覧ください。

ご注意
• 通常のストリーミング（119ページ）中はネッ
トワーククライアントモードに移行できませ
ん。

• ネットワーククライアントモードに移行する
と、通常のストリーミング（119ページ）、モニ
タリングはできません。

• モニタリング中にネットワーククライアント
モードに移行すると、モニタリングは停止しま
す。

• ネットワーククライアントモードでのストリー
ミング中は、ファイルを転送できません。スト
リーミングを停止するとファイルを転送できま
す。

• ファイル転送中にネットワーククライアント
モードでのストリーミングを開始すると、ファ
イル転送は停止します。ストリーミングを停止
するとファイル転送を再開します。

• ネットワークRXステーションで設定可能なスト
リーミングのビットレートが、プロキシ記録の
フォーマットにより、以下のように制限されま
す。
- プロキシ記録のフォーマットが、1280×

720 9Mbps/6Mbpsの場合：ストリーミング
のビットレートは、Very Lowの 1Mbps以
下になります。

- プロキシ記録のフォーマットが、640× 360 
3Mbps以下の場合：ストリーミングのビッ
トレートは、Lowの 3Mbps以下になりま
す。

• ネットワーククライアントモード時は、プロキ
シのフォーマット変更はできません。変更する
場合は、一度ネットワーククライアントモード
をオフにしてください。

ネットワーククライアントモードで
ファイルを転送する
ネットワークRXステーション（別売）の
CCMと本機をネットワーククライアント
モードで接続して、CCMで設定されたサー
バーへファイル転送することができます。

1 転送したいファイルを選ぶ。
• プロキシ記録を転送する場合
「SDカードのプロキシファイルを転
送するには」の手順1～4（116ペー
ジ参照）

• オリジナルファイルを転送する場合
「SxSメモリーカードのオリジナル
ファイルを転送するには」の手順
1～6（118ページ参照）

2 Transferをタップする。
転送先に「NCM：RX Server」が表示
されます。
「NCM：RX Server」を転送先に指定し
ます。

3 Transferをタップする。
CCMで設定されたサーバーへ、選んだ
ファイルの転送を開始します。
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ご注意
ネットワーククライアントモードでないときも、
転送先を「NCM：RX Server」にできます。
この場合は、転送は保留となり、ネットワークク
ライアントモードでCCMに接続後、CCMで設定さ
れたサーバーへ転送を開始します。

ワイヤレスLAN接続時、スマートフォンや
タブレットなどのデバイスから、本機に内
蔵されたWi-Fiリモコンにアクセスすること
ができます。
Wi-Fiリモコンを使用すると遠隔から本機を
操作できます。記録の開始／停止や撮影設
定を遠隔操作で調整できるため、本機を離
れた場所に固定する場合や、本機をクレー
ンに装着して使用する場合などに有効です。

Wi-Fi Remote画面は、デバイスの画面サイ
ズに応じて自動で切り替わります。

1 本機とデバイスをワイヤレスLAN接続
（104ページ）する。

2 デバイスでブラウザーを起動し、
「http://本機のIPアドレス
（Maintenance >Network >IP 
Address）/rm.html」にアクセスす
る。
例：IPアドレスが「192.168.1.1」の場
合は、アドレスバーに「http://
192.168.1.1/rm.html」と入力します。

3 ブラウザー画面に、ユーザー名とパ
スワード（メニューのMaintenance 
>Basic Authentication（179ページ）
を入力する。
接続が完了すると、デバイスにWi-Fi 
Remote画面が表示されます。
以降は、画面表示のとおりに操作して
ください。
画面のLockつまみを右にスライドする
と、RECボタンの操作を禁止すること
ができます。

Wi-Fiリモコンについ
て

Wi-Fiリモコンを表示する
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Wi-FiリモコンはWebメニューのCam 
Remote Control（126ページ）からも
表示できます。

ご注意
• スマートフォン用のページを表示したい場合
は、アドレスの最後を「rms.html」に、タブ
レット用のページを表示したい場合は
「rmt.html」に置き換えて入力してください。通
常は「rm.html」と入力すれば、各ページに自動
的に移動します。デバイスによっては正常に動
作しない場合があります。

• 次の場合は、Wi-Fi Remote画面と本機の状態が
一致しなくなることがあります。その場合は、
ブラウザーの表示を更新してください。
- 接続中に本機を再起動した場合
- 接続中に本機を操作した場合
- デバイスを再接続した場合
- ブラウザーで進む／戻る操作した場合

• 電波状態が著しく悪い場合、Wi-Fi Remoteが機
能しなくなることがあります。

スマートフォン表示

Wi-Fi Remote画面

Main画面
• ステータス表示
• 撮影設定表示

Iris、Focus、Zoom、
S&Q FPS、Shutter、
White、Gamma、
Auto Iris、Gain、
ATW、Color Bars、
Auto Black、Auto 
White

Playback画面
• ステータス表示
• 再生操作ボタン

F Rev、Play/Pause、
F Fwd、Prev、Stop、
Next

Cursor画面
• ステータス表示
• カーソル操作ボタン、
メニュー／ステータ
ス表示
Up、Left、Set、
Right、Down、
Cancel/Back、
Menu、Status、
Thumbnail、Option 
（SHIFT+SET）

Assign画面
• ステータス表示
• アサイナブルスイッ
チ表示
アサイナブルスイッ
チ0、1、3、4、5



125

タブレット表示

Main画面

• ステータス表示
• アサイナブルスイッチ表示
アサイナブルスイッチ0、1、3、4、5

• 撮影設定表示
S&Q FPS、Shutter、White、Gamma、Auto 
Iris、Gain、ATW、Color Bars、Auto Black、
Auto White

Playback画面

• ステータス表示
• 再生操作ボタン

F Rev、Play/Pause、F Fwd、Prev、Stop、
Next

Cursor画面

• ステータス表示
• カーソル操作ボタン、メニュー／ステータス表
示
Up、Left、Set、Right、Down、Cancel/Back、
Menu、Status、Thumbnail、Option
（SHIFT+SET）

Assign画面

• アサイナブルスイッチ表示
アサイナブルスイッチ0、1、3、4、5
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ワイヤレスLAN接続したデバイスのブラウ
ザーから本機にアクセスすると、本機の
Webメニューが表示されます。Webメ
ニューでワイヤレス機能に関する各種設定
やファイルの転送操作を行うことができま
す。

設定メニューについて

デバイスでブラウザーを起動し、「http://本
機のIPアドレス（メニューのMaintenance 
>Network >IP Addressに設定したIPアドレ
ス）:8080」にアクセスすると、本機の
Media InfoのSD Card画面が表示されます。
Webメニュー画面左上の をタップすると
設定メニューが表示されます。設定したい
項目をタップします。
項目にはSettings、Media Info、Job List、
Cam Remote Controlがあります。

Settings

本機の設定を行います。本画面の項目は次
のとおりです。

Media Info
メディアの情報を表示したりメディアから
転送するファイルを選択する画面を表示し
ます。
• SD Card：本機のPROXY SDカードス
ロットに挿入されているメディア

• Slot A：本機のカードスロットAに挿入さ
れているメディア

• Slot B：本機のカードスロットBに挿入さ
れているメディア

Job List

転送中のファイルを管理するJob List画面を
表示します（132ページ）。

Cam Remote Control
Wi-Fiリモコンを表示します（123ページ）。

OSS Information

著作権情報を表示します。

デバイスでモニタリングされるストリーム
や、インターネットまたはローカルネット
を通じてストリーミング伝送するストリー
ムのフォーマットや伝送先の設定を行いま
す。

映像
• AVC/H.264 Main Profile、4 : 2 : 0 Long 

GOP
• サイズは以下の設定で選択

Webメニューについ
て

項目 内容 参照先
Wireless 
Module 
>Streaming 
Format

ストリーミン
グフォーマッ
ト設定

ストリーミング
フォーマット設定
「Streaming 
Format」（126
ページ）

Wireless 
Module 
>Proxy Format

プロキシ
フォーマット
設定

プロキシフォー
マット設定
「Proxy Format」
（128ページ）

Wireless LAN 
>Station 
Settings

ワイヤレス
LAN設定

ワイヤレスLAN 
設定「Station 
Settings」（128
ページ）

Wireless LAN 
>Status

ワイヤレス
LAN設定状態
の確認

ワイヤレスLAN 
設定を確認するに
は（129ページ）

Wired LAN 
>Wired LAN 
Settings

有線LAN設定 有線LAN設定
「Wired LAN 
Settings」（130
ページ）

Wired LAN 
>Status

有線LAN設定
状態の確認

有線LAN設定の確
認（130ページ）

Upload 
Settings

転送設定 転送設定
「Upload 
Settings」（130
ページ）

ストリーミングフォーマット設
定「Streaming Format」

項目 内容 参照先



127

音声
• AAC-LC圧縮
• サンプリング周波数：48 kHz
• ビットレート：128 kbps for Stereo

デバイスでモニタリングされるときの
フォーマットを設定します。

ご注意
• ビットレートは平均値であり、設定値を超える
場合があります。

• 映像のフレームレートは24fps に対応していま
せん。

• Monitoring sizeで640 × 360：3Mbps（VBR）
には対応していません。

ストリーミング伝送時のフォーマットや伝
送先を設定します。設定はプリセットとし
て3つまで保持できます。

ご注意
• StreamingをOnに設定した場合、モニタリング
機能が使用できません。

• インターネット経由で映像／音声データをその
まま送信します。
そのためデータが漏えいする可能性があります。
送信先がストリーミングデータを受信できてい
ることを確認してください。
アドレスの設定ミスなどにより意図しない相手
にデータを送信してしまう可能性があります。

• ネットワークの状況により、すべてのフレーム
を再生できない場合があります。

モニタリング設定

項目 内容 設定値
Monitoring 

Size
モニタリング用
の映像のサイズ
とビットレート
を設定する。

480x270(1Mbps)/
480x270(0.5Mbps)

Monitoring 
Frame 
Rate

モニタリング用
の映像のフレー
ムレートを表示
する。

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Monitoring 
Bit Rate

モニタリング用
の映像のビット
レートを表示す
る。

1Mbps(VBR)/
0.5Mbps(VBR)

ストリーミング設定

項目 内容 設定値
On/Off ストリーミング

伝送のオン／オ
フを切り換え
る。

On/Off

Preset プリセットを
Preset1～3から
選択する。
PresetはEditを
タップすると編
集できます。

Preset1/Preset2/
Preset3

Type ストリーミング
用の映像の種類
を選択する。

MPEG-2 TS/UDP/
MPEG-2 TS/RTP

Size ストリーミング
用の映像のサイ
ズを設定する。
HD Autoを選択
した場合、SxS
に記録される記
録フォーマット
の設定や再生す
るクリップの
フォーマットに
基づいて、
1920×1080か
1280×720に設
定されます。

HD Auto/
1280x720/
640x360/480x270/
320x180

Bit Rate ストリーミング
用の映像のビッ
トレートを設定
する。
選択できるビッ
トレートは、
Sizeの設定によ
り異なります。

9Mbps/6Mbps/
3Mbps/2Mbps/
1Mbps/0.5Mbps/
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

Destination 
Address

ストリーミング
データの伝送先
サーバーのアド
レスを入力す
る。

ホスト名またはIP
アドレス

Destination 
Port

伝送先サーバー
のストリーミン
グに使用する
ポート番号を入
力する。

1～65535

Audio 
Channel 
Select

ストリーミング
出力に乗せる
Audio Channel
を選択する。

Ch-1 & Ch-2
Ch-3 & Ch-4

項目 内容 設定値
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• 動きの激しいシーンの場合には、画質が悪くな
ります。

• ストリーミングを大きなサイズで小さいビット
レートに設定した場合、すべてのフレームが再
生できない場合があります。
この現象を軽減させるためにはSizeでより小さ
いサイズを選んでください。

• 500kbps以下のネットワークの帯域をご使用の
場合、SizeとBit Rateは以下のどちらかに設定
してください。
- Sizeが 480x270のときは、Bit Rateの

0.3Mbps(Mono L)、0.3Mbps(Mono R)、
0.2Mbps(Mono L)、 0.2Mbps(Mono R)のい
ずれかを設定する。

- Sizeが 320x180のときは、0.2Mbps(Mono 
L)、0.2Mbps(Mono R)のどちらかを設定す
る。

このときのビデオのフレームレートは10fps、
オーディオのサンプリング周波数は48kHz、
ビットレートは56kbps Monoに設定されます。

• Bit rateが0.3Mbps(Mono L)、または
0.2Mbps(Mono L)の場合、Audio Channel 
Selectは、Ch-1 & Ch-2のCh-1、またはCh-3 & 
Ch-4のCh-3に設定されます。
Bit rateが0.3Mbps(Mono R)、または
0.2Mbps(Mono R)の場合、Audio Channel 
Selectは、Ch-1 & Ch-2のCh-2、またはCh-3 & 
Ch-4のCh-4に設定されます。

本機のSDカードに記録されるプロキシファ
イルのフォーマット設定を行います。

映像
• XAVC Proxy （AVC/H.264 Main Profile、

4 :2 :0 Long GOP）
• サイズは以下の設定で選択

音声
• AAC-LC圧縮
• サンプリング周波数：48 kHz
• ビットレート：128 kbps for Stereo

ご注意
• ビットレートは平均値であり、設定値を超える
場合があります。

• 24fps には対応していません。
• プロキシフォーマット設定のSizeにHD Autoを
選択した場合、SxSメモリーカードへの記録
フォーマットの設定や再生するクリップの
フォーマットに基づいて、プロキシフォーマッ
トが設定されます。

• プロキシフォーマット設定のSizeをHD Autoに
設定して記録したプロキシファイルは、ブラウ
ザーやContent Browser Mobileで再生できない
場合があります。プロキシファイルを記録した
SDカードをコンピューターに直接挿入して再生
してください。

本機をワイヤレスLAN に接続するための設
定を行います。

プロキシフォーマット設定
「Proxy Format」

項目 内容 設定値
Proxy File 
recording

Size

プロキシファイ
ル用映像のサイ
ズとビットレー
トを設定する。

HD Auto(9Mbps)/
HD Auto(6Mbps)/
1280x720(9Mbps)/
1280x720(6Mbps)/
640x360(3Mbps)/
480x270(1Mbps)/
480x270(0.5Mbps)

Proxy File 
recording

Frame 
Rate

プロキシファイ
ル用映像のフ
レームレートを
表示する。

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Proxy File 
recording
のBit Rate

プロキシファイ
ル用映像のビッ
トレートを表示
する。

9Mbps(VBR)/
6Mbps(VBR)/
3Mbps(VBR)/
1Mbps(VBR)/
0.5Mbps(VBR)

Proxy File 
recording
のAudio 
Channel 
Select

プロキシファイ
ルに記録する
オーディオチャ
ンネルを設定す
る。

Ch-1 & Ch-2/
Ch-3 & Ch-4

ワイヤレスLAN 設定「Station 
Settings」
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WPS機能を使用しないステーショ
ンモードでアクセスポイントに接
続するには

1 アクセスポイントモードで本機とデバ
イスを接続する（107ページ）。

2 Station Settings画面の項目を設定す
る。

接続するアクセスポイントの設定に合
わせて設定を行います。
◆アクセスポイントの設定については、
アクセスポイントの取扱説明書をご覧
ください。

3 Submitをタップする。
設定した項目が確定します。

4 メニューのMaintenance >Network 
>W-Fi Modeを選択する。

5 MENUつまみを回してWi-Fi Station
を選択し、つまみを押す。
この操作では、本機はステーション
モードでアクセスポイントに接続する
ため、「WPS機能を使ってアクセスポイ
ントに接続するには」（108ページ）の
手順9 以降を行って、デバイスから本機
にアクセスします。

ワイヤレスLAN 設定を確認するに
は

Wireless LANのStatusでワイヤレスLAN設
定の確認画面を表示します。
本機のワイヤレスLANモードによって、表
示される内容が変わります。

アクセスポイントモード
 

項目 内容
Host Name 本機のデバイス名（変更不

可）。
SSID Access Pointで選んだSSIDを

表示する。
Key アクセスポイントのパスワー

ドを入力する。
DHCP DHCP設定する。

Onにすると、自動的に本機に
IP アドレスを割り当てる。
手動で本機のIP アドレスを入
力する場合は、Offにする。

IP Address 本機のIP アドレスを入力する。
DHCPがOffのときに有効

Subnet mask 本機のサブネットマスクを入
力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得を設定する。On
にすると、自動的にDNSサー
バーのアドレスを取得する。

Primary DNS 
Server

アクセスポイントのプライマ
リー DNSサーバーを入力す
る。
DNS AutoがOffのときに有効

Secondary DNS 
Server

アクセスポイントのセカンダ
リー DNS サーバーを入力す
る。
DNS AutoがOffのときに有効

Submit ワイヤレスLAN 設定を確定す
る。
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ステーションモード
 

USB-RJ45アダプター（別売）とLANケー
ブルを使用してネットワークに接続する場
合の設定を行います。

ご注意
「Wired LAN Settings」画面はUSB-RJ45アダプ
ター（別売）が取り付けられている場合に表示さ
れます。

ご注意
インターネットからの不正アクセスを防ぐため、
Web/Cam RemoteをOnにする場合は有線LAN 
ネットワークがインターネットに接続していない
ときを推奨します。インターネットに接続する場
合は、接続先がセキュアなネットワークであるこ
とをご確認の上ご使用ください。

有線LAN設定を確認するには

Wired LANのStatusで有線LAN設定の確認
画面を表示します。

本機に記録したプロキシファイルやオリジ
ナルファイルを転送するサーバーを登録し
たり、設定を変更します。

有線LAN設定「Wired LAN 
Settings」

項目 内容
DHCP DHCP設定する。

Onにすると、自動的に本機に
IPアドレスを割り当てる。手
動で本機のIPアドレスを入力
する場合は、Offにする。

IP Address 本機のIP アドレスを入力する。
DHCPがOffのときに有効

Subnet mask 本機のサブネットマスクを入
力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。Onに
すると、自動的にDNSサー
バーのアドレスを取得する。

Primary DNS 
Server

ルーターのプライマリー DNS
サーバーを入力する。
DNS AutoがOffのときに有効

Secondary DNS 
Server

ルーターのセカンダリー DNS
サーバーを入力する。
DNS AutoがOffのときに有効

Web/Cam 
Remote

USB-RJ45アダプターを使用し
た本機のWebメニューやWi-Fi
リモコンへのアクセスの
許可／不許可を設定する。On
にするとアクセスを許可する。

Submit 有線LAN設定を確定する。

転送設定「Upload Settings」

項目 内容
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自動転送のON/OFFについて

Auto uploadがOnでインターネット接続状態
の場合、記録を終了するとUpload Settingで
デフォルト設定されたサーバーに対して、自
動的にプロキシファイルを送信します。
初期値としてサーバーに「Sony Ci」が設定
されています。
「Sony Ci」とは、Sony が提供するMedia 
Cloud Servicesです。ソニーのクラウドサー
ビス「Sony Ci」へ転送することができます。

ご注意
• 一部対応していない地域があります。
•「Sony Ci」をお使いになる場合は、別途契約が
必要です。詳細は、www.SonyMCS.com/
wirelessをご覧ください。
また、Sony Ciのプライバシーポリシーについ
ては、以下のサイトを参照してください。
- 利用規約

https://www.sonymcs.com/terms/

- 使用ポリシー
https://www.sonymcs.com/use/

- プライバシーポリシー
https://www.sonymcs.com/privacy/

• 転送先のフォルダー名は、「Destination 
Directory」で設定したフォルダー名になりま
す。未設定の場合には、当日の日付がフォル
ダーになります。フォルダー名を変更について
は「登録済みのサーバーの設定を変更するに
は」（132ページ）を参照してください。

Sony Ciの登録方法は次のとおりです。

1 Upload Settings画面で「Sony Ci」が
表示されていることを確認し、Editを
タップする。
「Sony Ci」設定用の画面が表示されま
す。

2 Userにユーザー名、Passwordにパ
スワードを入力する。
詳細は、www.SonyMCS.com/wireless
をご覧ください。

3 Linkをタップする。
しばらくすると完了のメッセージが表
示されます。

「Link」はユーザーと本機を関連付ける
操作となります。「Link」を実行するに
はインターネットの接続が必要です。

4 「OK」をタップする。
「Sony Ci」登録後は、設定画面に
「Unlink」が表されます。タップすると
ユーザーアカウントを解除し、他の
ユーザーアカウントでリンクすること
もできます。

新しく転送先のサーバーを登録す
るには

Create Newをタップすると、設定用の画面
が表示されます。
 

設定後にOKをタップすると設定を反映し、
Cancelをタップすると、設定を中止しま
す。

項目 内容
Default Server Onにすると、ファイルの転

送先をデフォルト設定する。
（ファイル転送時の転送先リ
ストに優先的に表示される。）

Display Name リストに表示されるサーバー
名を入力する。

Service サーバーの種類を表示する。
「FTP」：FTP サーバー

Host Name サーバーのアドレスを入力す
る。

ご注意
デフォルトのポート番号
「21」以外を使用する場合
は、アドレスの後に「:と
ポート番号」を付加してくだ
さい。
例）:123

User ユーザー名を入力する。
Password パスワードを入力する。
PASV Mode PASV モードのON/OFFを行

う。
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ご注意
FTPによる通信は暗号化されません。FTPSの使用
をおすすめします。

登録済みのサーバーの設定を変更
するには

Upload Settings画面で設定を変更したい
サーバー名を選んでEditをタップします。
設定変更画面が表示されたら、必要に応じ
て設定を変更します。
◆設定項目、内容については「新しく転送先
のサーバーを登録するには」（131ページ）
をご覧ください。

登録したサーバーを削除するには

Upload Settings画面で削除したいサーバー
名を選んでDeleteをタップします。確認画
面が表示されますので、OKを選択すると
サーバーを削除した後、元の画面に戻りま
す。

転送中のファイルや転送ファイルのリスト
の確認をしたり、転送するファイルの中止、
再開、削除などを行うことができます。
本機はFTPレジューム機能（転送途中から
のファイルの再転送機能）に対応していま
す。
 

ファイルの転送中止、再開、転送
リストからファイルを削除するに
は

1 ファイルを選ぶ。

2 画面右上の をタップする。
以下の項目を選びます。
• Abort selected：転送を中止します。
• Delete from list：転送リストからファ
イルを削除します。

• Start selected：ファイルの転送を開
始します。

• Select All : リストを全選択します。
• Clear completed：転送済みファイル
リストを全削除します。

Destination 
Directory

転送先のディレクトリーを指
定する。

ご注意
ディレクトリー名として不正
な文字が入力された場合は、
ディレクトリーを生成せず、
転送先ディレクトリー直下に
転送します。

Using Secure 
Protocol

セキュアなFTP転送を行うか
どうかを設定する。

Load Certification 中間CA証明書を読み込みま
す。
Using Secure ProtocolをOn
にすると、表示されます。

ご注意
• FTPによる通信は暗号化さ
れません。FTPSの使用を
おすすめします。

• ルート証明書を含んだ中間
CA証明書が必要です。

• 読み込む証明書はPEM形
式で、SDカードのルート
ディレクトリーに
certification.pemのファイ
ル名であらかじめ書き込ん
でおいてください。

Clear Certification CA証明書をクリアする。

項目 内容 ファイル転送の確認をする
「Job List」

項目 内容
Total 転送する全ファイルの進捗状

況
Status 転送中のファイルの進捗状況
Remain time 予想残り転送時間表示
Transfer data rate 転送レート表示
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E-E／再生モード時にTHUMBNAILボタンを
押すと、「サムネイル画面」が表示され、
SxSメモリーカードに収録されているク
リップの代表画がサムネイル（縮小画）と
して一覧表示されます。
サムネイル画面では、任意のクリップを選
択し（134ページ参照）、そのクリップから
再生を開始する（135ページ参照）ことが
できます。

またサムネイル画面で任意のクリップにク
リップフラグを付けることにより、フラグ
によるクリップの絞り込みを行うことがで
きます。またサムネイル画面をエッセンス
マークサムネイル画面に切り換えて、ク
リップの任意のフレームにエッセンスマー
ク（ショットマークなど）を付けることも
できます。

5章 クリップ操作

サムネイル画面でのクリップ操作について

サムネイル画面の構成

OK S

カーソル
（黄色）
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a サムネイル（縮小画）
記録時にはクリップの先頭フレームが自動
的にクリップの代表画として表示されます。
代表画は変更することができます（142
ページ）。

b 選択されているメディアのアイコン／
メディアの状態

メディアがプロテクトされていると が表
示されます。
SxSメモリーカードが2枚装着されている場
合、SLOT SELECTボタンを押して切り換え
ると、メディアのアイコンも切り替わりま
す。

c クリップ番号／クリップ総数

d バッテリー／電圧状態

e 再生不可状態

f クリップ状態
クリップの状態をアイコンで表示します。

g サムネイル情報
サムネイルの情報が表示されます。表示内
容はCustomize Viewの設定により異なりま
す（143ページ参照）。

h クリップ選択チェックボックス
クリップ（サムネイル）選択時にチェック
が付きます。

i クリップ名／タイトル
選択されているクリップのクリップ名また
はタイトルが表示されます。

j 記録時のビデオフォーマット

k 特殊記録撮影情報
特殊記録モード（スロー＆クイックモー
ション）で記録されたクリップの場合は、
そのモードが表示されます。
スロー＆クイックモーション記録されたク
リップの場合は、右に[撮影フレームレート
／再生フレームレート]が表示されます。

l クリップの収録時間（Duration）

m 作成日時

サムネイル画面を消すには

THUMBNAILボタンを押します。

クリップのサムネイルを選択する
には

以下のいずれかの操作により、選択したい
サムネイルに黄色いカーソルを合わせます。
• 矢印（J、j、K、k）ボタンを押す。
• MENUつまみを回す。
• PREVまたはNEXTボタンを押す。

先頭のサムネイルを選択するには
F REVボタンを押したままPREVボタンを押
します。

最終のサムネイルを選択するには
F FWDボタンを押したままNEXTボタンを押
します。

アイコン 意味
S、OK、NG、
KPアイコン

クリップに付けられたエッセンス
マークまたはクリップフラグ

錠アイコン クリップブロック（保護）中

クリップを再生する
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選択したクリップ以降のクリップ
を連続再生するには

1 再生を開始したいクリップのサムネイ
ルを選択する。

2 PLAY/PAUSEボタンを押す。
選択したクリップの先頭から再生が始
まります。

選択したクリップ以降のすべてのクリップ
を連続再生します。
最後のクリップの再生が終わると、カメラ
撮像画面または外部入力状態になります。
THUMBNAILボタンを押すと、サムネイル
画面に戻ります。

ご注意
• 記録フォーマットが異なるクリップが混在記録
されているSxSメモリーカードでは、すべての
クリップを連続して再生できない場合がありま
す。

• サムネイル画面で再生不可状態表示（134ペー
ジ参照）のクリップは再生されません。該当ク
リップをスキップして連続再生されます。

• クリップとクリップの境界では、一時的に画像
が乱れたり、静止画になる場合があります。ま
たこの間は、再生コントロールボタンや
THUMBNAILボタンは操作できません。

• サムネイル画面でクリップを選択して再生を開
始すると、クリップの先頭部分の再生映像が乱
れる場合があります。クリップの先頭から乱れ
のない映像で再生するには、一度再生モードに
した後で一時停止にし、PREVボタンを押して
クリップの先頭に戻して再生を行ってくださ
い。

再生を一時停止するには
PLAY/PAUSEボタンを押します。
一時停止中はPLAY/PAUSEインジケーター
が点滅します。
もう一度押すと再生モードに戻ります。

高速再生するには
F FWDボタン（20ページ参照）または
F REVボタン（20ページ参照）を押します。
標準再生に戻るには、PLAY/PAUSEボタン
を押します。

再生を終了するには
STOPボタンを押す：再生が停止し本機は

E-Eモードになります。
THUMBNAILボタンを押す：再生が停止し、
ビューファインダー画面にサムネイル
画面（133ページ参照）が表示されま
す。

再生中にメモリーカードを取り出した場合
も、再生が停止し、ビューファインダー画
面にカメラ画が表示されます。

頭出しするには

現在のクリップの先頭に戻るには
PREVボタンを押します。
• 再生中に押すと、現在のクリップの先頭
にジャンプして再生を開始します。

• F FWD中に押すと、現在のクリップの先
頭にジャンプして一時停止します。

• F REV中または一時停止中に押すと、現在
のクリップの先頭にジャンプして静止画
を表示します。

• 続けて押すと、押すたびに1つずつ前のク
リップに移動します。

最初のクリップの先頭から再生するに
は
PREVボタンとF REVボタンを同時に押す
と、SxSメモリーカードの最初に記録され
たクリップの先頭にジャンプします。

後ろのクリップの先頭にジャンプする
には
NEXTボタンを押します。
• 再生中に押すと、次のクリップの先頭に
ジャンプして再生を開始します。

• F FWD中に押すと、次のクリップの先頭
にジャンプして一時停止します。最終ク
リップの操作中は、クリップの最終に
ジャンプして一時停止します。

• F REV中または一時停止中に押すと、次の
クリップの先頭にジャンプして静止画を
表示します。

• 続けて押すと、押すたびに1つずつ後ろの
クリップに移動します。
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最後のクリップにジャンプするには
F FWDボタンとNEXTボタンを同時に押す
と、SxSメモリーカードの最後に記録され
たクリップの最終画にジャンプします。

再生中にショットマークを追加す
るには

記録時と同じ操作で（83ページ参照）、再生
中のクリップにショットマークを追加する
ことができます。

ご注意
SxSメモリーカードがプロテクトされている場合
にはショットマークは記録できません。

クリップの保護／削除、詳細情報の確認、
クリップへのクリップフラグやクリップの
フレームへのエッセンスマークの付加／削
除などの操作にはThumbnailメニューを使
用します。

Thumbnailメニューを表示するに
は

1 THUMBNAILボタンを押す。
サムネイル画面が表示されます。

2 MENU ON/OFFスイッチをONにす
るかMENUボタンを押す。
メニュー画面が表示されます。

3 MENUつまみを回してThumbnailを
選択し、MENUつまみを押す。
J、jボタンを押してThumbnailを選択
し、SETボタンを押して表示することも
できます。

Thumbnailメニューを消すときは、もう一
度THUMBNAILボタンを押します。

メニュー項目／細目を選択するに
は

次のいずれかの操作を行います。
• MENUつまみを回して項目／細目を選択
し、つまみを押す。

• 矢印（J、j、K、k）ボタンを押して
項目／細目を選択し、SETボタンを押す。
選択したメニュー項目／細目に応じて、選
択リストまたはクリップの詳細情報画面
（139ページ参照）が表示されます。
MENU CANCEL/PRST/ESCAPEスイッチを
ESCAPE側に押し下げると、1つ上の階層に
戻ります。

ご注意
• SxSメモリーカードがプロテクトされていると
きは、クリップのコピー・削除、代表画の変
更、クリップフラグ・ショットマークの付加／
削除はできません。

• メニューを表示させたときの状態によって選択
できない項目があります。

◆Thumbnailメニュー構成は「Thumbnailメ
ニュー構成」（142ページ）をご覧ください。

Thumbnailメニューの基本操作
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特定のクリップまたはすべてのクリップを
保護して、クリップを削除できない状態に
することができます。
保護されたクリップのサムネイルには が
付きます。
クリップの保護操作は、サムネイル画面ま
たはフィルタードクリップサムネイル画面
（140ページ）で行います。

ご注意
ファイルシステムがFATに設定されているとき、
この機能は使用できません。

特定のクリップを保護するには

1 メニューのThumbnail >Lock/Unlock 
Clip >Select Clipを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップの選択画面が表示されます。

3 MENUつまみを回して保護するク
リップを選択し、つまみを押す。
選択したクリップにチェックマークが
付きます。

4 SHIFTボタンを押しながらSETボタ
ンを押す。
確認画面が表示されます。

5 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップが保護され、完了メッセージ
が表示されます。

6 MENUつまみを押してメッセージを
消す。

すべてのクリップを保護するには

1 メニューのThumbnail >Lock/Unlock 
Clip >Lock All Clipsを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
すべてのクリップが保護され、完了
メッセージが表示されます。

4 MENUつまみを押してメッセージを
消す。

すべてのクリップの保護を解除す
るには

1 メニューのThumbnail >Lock/Unlock 
Clip >Unlock All Clipsを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
すべてのクリップの保護が解除され、
完了メッセージが表示されます。

4 MENUつまみを押してメッセージを
消す。

クリップを別のSxSメモリーカードにコ
ピーすることができます。
コピー先のSxSメモリーカードには同じク
リップ名でコピーされます。

ご注意
• コピー先のSxSメモリーカードに同名のク
リップが存在している場合は、オリジナ
ルのクリップ名に1桁の括弧数字を付加し
たクリップ名でコピーされます。
括弧数字は、コピー先に存在しない最小
値になります。
例:
ABCD0002→ABCD0002(1)
ABCD0002(1)→ABCD0002(2)
ABCD0005(3)→ABCD0005(4)

クリップを保護する

クリップをコピーする
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• コピー回数が1000回を超えた場合など、
括弧数字(1)～(999)がすでに存在するカー
ドには、それ以上コピーできません。

• コピー先のSxSメモリーカードの残量が不
足しているときはメッセージが表示され
ますので、コピー先のSxSメモリーカード
を交換してください。

• コピー元のSxSメモリーカードに複数のク
リップが記録されている場合は、コピー
先のSxSメモリーカードが同じ容量であっ
ても、使用条件やメモリーの特性などに
より、すべてのクリップを最後までコ
ピーできない場合があります。

特定のクリップをコピーするには

1 メニューのThumbnail >Copy Clip 
>Select Clipを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップの選択画面が表示されます。

3 MENUつまみを回してコピーするク
リップを選択し、つまみを押す。
選択したクリップにチェックマークが
付きます。

4 SHIFTボタンを押しながらSETボタ
ンを押す。
確認画面が表示されます。

5 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップがコピーされ、完了メッセー
ジが表示されます。

6 MENUつまみを押してメッセージを
消す。

クリップを一括コピーする

同じSxSメモリーカードに記録されている
クリップを、別のSxSメモリーカードにま
とめてコピーすることができます。

1 メニューのThumbnail >Copy Clip 
>All Clipsを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
すべてのクリップがコピーされ、完了
メッセージが表示されます。

4 MENUつまみを押してメッセージを
消す。

SxSメモリーカードからクリップを削除す
ることができます。クリップの保護操作は、
サムネイル画面またはフィルタードクリッ
プサムネイル画面（140ページ）で行いま
す。

1 メニューのThumbnail >Delete Clip 
>Select Clipを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップの選択画面が表示されます。

3 MENUつまみを回して削除するク
リップを選択し、つまみを押す。
選択したクリップにチェックマークが
付きます。

4 SHIFTボタンを押しながらSETボタ
ンを押す。
確認画面が表示されます。

5 MENUつまみを回してExecuteを選
択し、つまみを押す。
クリップが削除され、完了メッセージ
が表示されます。

6 MENUつまみを押してメッセージを
消す。

サムネイル画面では、削除したクリップの
次以降が1つずつ繰り上がります。

クリップを削除する
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クリップを一括削除するには

同じSxSメモリーカードに記録されている
クリップをまとめて削除することができま
す。

ご注意
• 削除したクリップを復元することはできませ
ん。

• メディアやクリップが保護されている場合は、
この機能を使用することはできません。

1 メニューのThumbnail >Delete Clip 
>All Clipsを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
すべてのクリップが削除され、完了
メッセージが表示されます。

4 MENUつまみを押してメッセージを
消す。

メニューのThumbnail >Display Clip Propertiesを選択すると、選択しているクリップの詳細情
報画面が表示されます。

a 現在のクリップ画像
選択しているクリップの代表画とクリップ
の状態が表示されます。

b タイムコード表示
TC Index：表示されている画像のタイム
コード

Start：記録開始点のタイムコード
End：記録終了点のタイムコード
Duration：収録時間

c 収録日時と変更日時

d クリップ名

e 記録フォーマット
Video Codec：ビデオコーデック
Size：画サイズ
FPS：フレームレート
Audio Codec：音声コーデック
Ch/Bit：音声記録チャンネル／音声記録
ビット数

クリップの詳細情報を表示する

OK S
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f 特殊記録撮影情報

g 収録機器名

クリップの詳細情報画面を消すに
は

次のいずれかの操作を行います。
RESET/RETURNボタンを押す：

Thumbnailメニュー画面に戻ります。
THUMBNAILボタンを押す：本機はE-E
モードになり、カメラ画が表示されま
す。

PLAY/PAUSEボタンを押す：選択されてい
るクリップから再生が始まります。

クリップにクリップフラグ（OK、NG、KP
マーク）を付けると、クリップフラグを基
準にクリップを絞り込んで表示することが
できます。この操作は、サムネイル画面ま
たはフィルタードクリップサムネイル画面
（140ページ）で行います。

ご注意
ファイルシステムがFATに設定されているとき、
この機能は使用できません。

クリップフラグを付けるには

1 クリップフラグを付けたいクリップの
サムネイルを選択し、メニューの
Thumbnail >Set Clip Flagを選択す
る。

2 MENUつまみを回してクリップフラ
グを選択し、つまみを押す。

選択したクリップのサムネイルにクリップ
フラグが付けられます。

クリップフラグ機能を割り当てたアサイナ
ブルスイッチ使用してクリップフラグを付
けることもできます（189ページ参照）。

クリップフラグを削除するには

1 クリップフラグを削除したいクリップ
のサムネイルを選択し、メニューの
Thumbnail >Set Clip Flag >Delete 

Clip Flagを選択する。
クリップフラグが削除されます。

ご注意
ファイルシステムがFATに設定されているとき、
この機能は使用できません。

1 メニューのThumbnail >Filter Clipsを
選択する。

2 MENUつまみを回して絞り込み対象
のクリップフラグを選択し、つまみ
を押す。

選択したクリップフラグで絞り込まれ
たクリップ画面が表示されます。この
画面をフィルタードクリップ画面と呼
びます。

クリップの任意の位置のフレームにエッセ
ンスマーク（ショットマーク、レックス

クリップにクリップフラグを付
ける／削除する

設定値 付加されるクリップフラグ
Add OK OK

Add NG NG

Add KEEP KP

フィルタードクリップ画面で表
示するクリップを絞り込む

設定値 絞り込み対象のクリップフラグ
OK OK

NG NG

KEEP KP

None なし（絞り込まない）

クリップにエッセンスマークを
付ける／削除する
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タートマーク）を付加／削除することがで
きます。エッセンスマークの付加／削除は、
エッセンスマークサムネイル画面で行いま
す。

ご注意
ファイルシステムがFATに設定されているとき、
この機能は使用できません。

ショットマークを付けるには

1 メニューのThumbnail >Thumbnail 
View >Essence Mark Thumbnailを選
択する。

2 MENUつまみを回してAllを選択し、
つまみを押す。

3 エッセンスマークサムネイル画面で
ショットマークを付けるフレームの
サムネイルを選択し、メニューの
Thumbnail >Set Shot Markを選択す
る。

4 MENUつまみを回して次のいずれか
を選択し、つまみを押す。

選択したフレームにショットマークが
付けられます。

ショットマークを削除するには

1 メニューのThumbnail >Thumbnail 
View >Essence Mark Thumbnailを選
択する。

2 削除するショットマークの種類を選
択する。

3 エッセンスマークサムネイル画面で
ショットマークを削除するフレーム
のサムネイルを選択し、メニューの
Thumbnail >Set Shot Markを選択す
る。

4 MENUつまみを回して次のいずれか
を選択し、つまみを押す。

選択したフレームのショットマークが
削除されます。

エッセンスマークサムネイル画面は、ク
リップに1つ以上のエッセンスマークが記録
されている場合に、エッセンスマークの付
加されているフレームだけをサムネイル形
式で表示します。サムネイル画面を表示し
て、ESSENCE MARKボタン（22ページ参
照）を押すか、次の手順で表示することが
できます。

ご注意
ファイルシステムがFATに設定されているとき、
この機能は使用できません。

1 メニューのThumbnail >Thumbnail 
View >Essence Mark Thumbnailを選
択する。

2 MENUつまみを回して絞り込み対象
のエッセンスマークを選択し、つま
みを回す。

設定値 動作
Add Shot Mark1 Shot Mark1を付ける
Add Shot Mark2 Shot Mark2を付ける

設定値 動作
Delete Shot Mark1 Shot Mark1を削除する
Delete Shot Mark2 Shot Mark2を削除する

エッセンスマークサムネイル画
面でクリップ（フレーム）を絞
り込む

設定値 内容
All エッセンスマークが付いた

すべてのフレームが対象
Rec Start レックスタートマークがつ

いているフレームおよび先
頭フレームにレックスター
トマークが付いていないク
リップの先頭フレームが対
象

Shot Mark0～
Shot Mark9

各ショットマークが付いた
フレームが対象
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選択したエッセンスマークで絞り込ま
れたエッセンスマークサムネイル画面
が表示されます。

ショットマーク0～ショットマーク9の名前
を定義したプランニングメタデータを使用
してクリップを記録した場合は、リストの
選択項目が定義した名前になります。

エッセンスマークサムネイル画面で選択し
たフレームをクリップの代表画にすること
ができます。
代表画にしたいフレームのサムネイルを選
択し、Thumbnail >Set Index Pictureで選択
したフレームがクリップの代表画に設定さ
れます。

太字で表示されている設定値は、出荷時の設定です。

クリップの代表画を変更する

Thumbnailメニュー構成

Thumbnail

項目 細目と設定値 内容
Display Clip Properties ― クリップの詳細情報を表示する（139ページ参

照）。
Set Index Picture ― クリップの代表画フレームを設定・変更する

（142ページ参照）。
Thumbnail View
表示するサムネイル画面
を変更します。

Essence Mark Thumbnail
All/Rec Start/Shot Mark1/
Shot Mark2/Shot Mark3/
Shot Mark4/Shot Mark5/
Shot Mark6/Shot Mark7/
Shot Mark8/Shot Mark9/
Shot Mark0

エッセンスマークでクリップを絞り込んだエッ
センスマークサムネイル画面を表示する（141
ページ参照）。

Clip Thumbnail サムネイル画面（クリップサムネイル画面）を
表示する（133ページ参照）。

Set Shot Mark
ショットマークの付加／
削除を行います。

Add Shot Mark1 フレームにショットマーク1を付ける（141
ページ参照）。

Delete Shot Mark1 ショットマーク1を削除する（141ページ参
照）。

Add Shot Mark2 フレームにショットマーク2を付ける（141
ページ参照）。

Delete Shot Mark2 ショットマーク2を削除する（141ページ参
照）。

Set Clip Flag
クリップフラグの付加／
削除を行います。

Add OK クリップにOKフラグを付ける（140ページ参
照）。

Add NG クリップにNGフラグを付ける（140ページ参
照）。

Add KEEP クリップにKP（KEEP）フラグを付ける（140
ページ参照）。

Delete Clip Flag クリップフラグを削除する（140ページ参照）。
Lock/Unlock Clip
クリップの保護／保護解
除を行います。

Select Clip 設定対象のクリップを選択する（137ページ参
照）。

Lock All Clips メディアのすべてのクリップを保護する（137
ページ参照）。

Unlock All Clips メディアのすべてのクリップの保護を解除する
（137ページ参照）。
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Copy Clip
クリップのコピーを行い
ます。

Select Clip コピー対象のクリップを選択する（138ページ
参照）。

All Clips メディアのすべてのクリップをコピーする
（138ページ参照）。

Delete Clip
クリップの削除を行いま
す。

Select Clip 削除対象のクリップを選択する（138ページ参
照）。

All Clips メディアのすべてのクリップを削除する（139
ページ参照）。

Filter Clips
クリップフラグでクリッ
プ表示を絞り込みます。

OK OKフラグでクリップ表示を絞り込む（140
ページ参照）。

NG NGフラグでクリップ表示を絞り込む（140
ページ参照）。

KEEP KP（KEEP）フラグでクリップ表示を絞り込む
（140ページ参照）。

None 絞り込みを行わない（140ページ参照）。
Customize View Thumbnail Caption

Date Time/Time Code/
Duration/Sequential 
Number

サムネイルのクリップ直下の情報表示選択す
る。
Date Time：日時時刻を表示する。
Time Code：タイムコードを表示する。
Duration：クリップの収録時間を表示する。
Sequential Number：クリップの通し番号を
表示する。

Thumbnail

項目 細目と設定値 内容
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本機では、ビューファインダー画面に表示
されるセットアップメニューを使用して、
撮影や再生に必要な各種の設定を行います。
セットアップメニューは、外部ビデオモニ
ターに表示する（204ページ参照）ことも
できます。

ユーザーがセットアップメニューを任意の
順番で配置するときに使用するメニューで
す。（150ページ参照）

撮影に関する設定（画質関連以外）をする
ときに使用するメニューです。

画質に関する設定をするときに使用するメ
ニューです。

6章 メニュー表示と詳細設定

セットアップメニュー
の構成

Userメニュー

Operationメニュー

項目 概要 参照先
Format システム設定 153

Format Media メディアフォーマッ
ト

154

Input/Output 入出力信号設定 155

Super Impose スーパーインポーズ
設定

155

LCD LCDモニター設定 156

Rec Function 特殊記録モード設定 156

Proxy Recording 
Mode

プロキシデータ設定 157

Assignable 
Switch

アサイナブルスイッ
チへの機能割り当て

157

VF Setting ビューファインダー
設定

158

Marker マーカー表示 158

Gain Switch ゲイン値設定 159

Auto Iris オートアイリス設定 159

Zebra ゼブラ設定 160

Display On/Off ビューファインダー
表示項目設定

160

"!"LED ビューファインダー
"!"設定

162

White Setting ホワイトバランス設
定

162

Offset White オフホワイト設定 163

Shutter シャッター設定 163

Slow Shutter スローシャッター設
定

163

Time Zone 時差設定 163

Clip クリップ設定 163

Update Media メディア管理情報
アップデート

164

GPS 測位情報（GPS）設
定

164

Planning 
Metadata

プランニングメタ
データ設定

164

Paintメニュー

項目 概要 参照先
Switch Status 補正機能、テスト信

号ON/OFF設定
166

White 色温度設定 166

Black ブラックレベル設定 166

Flare フレア補正設定 167

Gamma ガンマ補正設定 167

Black Gamma ブラックガンマ補正
設定

168

Knee ニー補正設定 168

White Clip ホワイトクリップ設
定

168

Detail(HD) ディテール設定 169

項目 概要 参照先
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クリップのサムネイルに関する設定をする
ときに使用するメニューです。（142ページ
参照）

ご注意
Thumbnailメニューは、サムネイル画面（133ペー
ジ参照）を表示しているときのみ使用できます。サ
ムネイル画面を表示していないときは無効です。

本機のメンテナンスやシステム管理関連の
設定をするときに使用するメニューです。

各種ファイル操作をするときに使用するメ
ニューです。

Detail(SD) ディテール設定 169

Aperture アパーチャー補正設
定

169

Skin Detail スキンディテール補
正設定

170

Matrix マトリクス補正設定 170

Multi Matrix マルチマトリクス補
正設定

171

V Modulation Vモジュレーション
シェーディング補正
設定

171

Low Key 
Saturation

ローキーサチュレー
ション補正設定

171

Saturation Mode サチュレーション補
正設定

171

Noise 
Suppression

ノイズサプレス設定 171

Thumbnailメニュー

Maintenanceメニュー

項目 概要 参照先
White Shading ホワイトシェーディ

ング補正設定
172

Black Shading ブラックシェーディ
ング補正設定

172

Battery バッテリー設定 173

DC Voltage Alarm 外部DC電源電圧ア
ラーム設定

173

Audio オーディオ設定 173

WRR Setting ワイヤレスチュー
ナー設定

175

Time Code タイムコード設定 176

Essence Mark エッセンスマーク設
定

176

Camera Config カムコーダー動作設
定

177

項目 概要 参照先
Preset White プリセットホワイト

設定
178

White Filter フィルター設定 178

DCC Adjust DCC設定 179

Genlock ゲンロック設定 179

Auto Shading オートブラック
シェーディング補正
設定

179

APR APR設定 179

Basic 
Authentication

Basic認証設定 179

Network ネットワーク接続設
定

180

Network Client 
Mode

ネットワーククライ
アントモード設定

182

File Transfer Wi-Fi転送設定 182

Streaming ストリーミング設定 183

Clock Set 内蔵時計設定 183

Language メッセージ表示言語
設定

184

Hours Meter デジタル時計設定 184

Network Reset ネットワークリセッ
ト

184

Fan Control ファン制御設定 184

VF Display 
Setting

ビューファインダー
表示設定

184

Option ソフトウェアオプ
ション設定

184

Version バージョン設定 184

Fileメニュー

項目 概要 参照先
User Menu Item User Menu Item設定 185

User File ユーザーファイル設
定

185

All File ALLファイル設定 186

Scene File シーンファイル設定 186

Reference File リファレンスファイ
ル設定

186

Lens File レンズファイル設定 187

User Gamma ガンマファイル設定 188

項目 概要 参照先
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セットアップメニューを表示する
には

MENU ON/OFFスイッチをONにするか
MENUボタンを押します。
本機がメニューモードになり、画面にメ
ニューリストが表示されます。

例：Operationメニューにカーソルがあ
る場合

ご注意
拡大フォーカス（Focus Mag）モードになってい
ると、セットアップメニューは操作できません。
Focus Magが割り当てられているアサイナブルス
イッチで拡大フォーカスモードを解除してくださ
い。

メニューを設定するには

1 MENUつまみを回すか、J、jボタン
を押して、設定したいメニューにカー
ソルを合わせる。
メニューリスト右のメニュー項目選択
エリアに、選択できるメニュー項目が
表示されます。

2 MENUつまみまたはSETボタンを押
す。
メニュー項目選択画面が表示されます。
kボタンを押してメニュー項目選択画
面を表示することもできます。
• メニュー項目選択エリアは最大7行表
示です。選択できる項目が一度に表
示できない場合は、カーソルを上下
に移動すると表示がスクロールしま
す。

セットアップメニュー
の基本操作

メニュー項目項目選択エリア

メニューリスト

メニュー表示選択エリア
• 選択した項目に細目がある場合は、右に細
目が表示されます。

• 細目がない場合は、右に現在の設定値が表
示されます。

• Backを選択すると一つ上の階層に戻ります。

メニュー項目がまだ下にある
ときに表示されます。
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3 MENUつまみを回すか、J、jボタン
を押して、設定したいメニュー項目
にカーソルを合わせ、MENUつまみ
またはSETボタンを押して決定する。
メニュー項目選択エリアの右に設定エ
リアが表示され、カーソルが先頭の細
目に移動します。

4 MENUつまみを回すか、J、jボタン
を押して、設定したい細目にカーソ
ルを合わせ、MENUつまみまたは
SETボタンを押して決定する。
選択した細目の選択肢が表示され、現
在選択されている値にカーソルが移動
します。

• 選択肢エリアは最大9行表示です。選
択肢が一度に表示できない場合は、
カーソルを上下に移動すると表示が
スクロールします。

• 選択肢の範囲が大きい項目の場合
（例：–99～+99）は、選択肢エリア
は表示されません。文字がハイライ
ト表示になり設定変更が可能な状態
であることを示します。

5 MENUつまみを回すか、J、jボタン
を押して、設定したい値を選び、
MENUつまみまたはSETボタンを押
して決定する。
設定が変更され、変更後の状態が表示
されます。
実行項目でExecuteを選択した場合は、
対応する機能が実行されます。

実行前に確認が必要な項目では
手順3で、実行前に確認が必要な項目を選択
すると、いったんメニューが消え、確認
メッセージが表示されます。メッセージに
従って、実行するかキャンセルするかを選
択してください。

文字列を入力するには

ファイル名など、文字列を設定する項目を
選択した場合は、文字列の入力画面が表示
されます。

1 MENUつまみを回して入力したい文字
タイプを選択して、MENUつまみまた
はSETボタンを押す。
ABC：英大文字
abc：英小文字
123：数字
!#$：特殊文字

設定エリア
• 細目と現在の設定値が表示されます。
• Backを選ぶかKボタンを押す、また
はMENU CANCEL/PRST/ESCAPEス
イッチをESCAPE側に押し下げると一
つ上の階層に戻ります。

選択肢エリア
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2 選択した文字タイプから文字を選択
し、決定する。
カーソルが次の欄に移動します。
Space：カーソルの位置にスペースを
入力します。

←/→：カーソル位置を移動します。
BS：カーソルの左の文字を削除しま
す。

3 入力が終わったら、Doneを選択し、
決定する。
文字列が確定され、入力画面が消えま
す。

設定変更を取り消すには

1 MENU CANCEL/PRST/ESCAPEス
イッチをESCAPE側に押し下げる。

メニュー操作を終了するには

1 MENU ON/OFFスイッチをOFFにす
るかMENUボタンを押す。
通常のカメラ画に戻ります。

メニュー操作を終了するには

MENU ON/OFFスイッチをOFFにする
かMENUボタンを押す。
通常のカメラ画に戻ります。

メニューのロックと解除

セットアップメニューの表示をロックして、
Userメニューだけを表示させることができ
ます。

メニューをロックする

1 MENUつまみを押しながら、MENU 
ON/OFFスイッチを押し下げて、セッ
トアップメニューを表示する。

2 メニューのMaintenance >Camera 
Config >User Menu with Lockを表示
する。

ご注意
• MENUつまみを押しながら、MENU ON/

OFFスイッチを押し下げると、Camera 
Config >User Menu OnlyがUser Menu 
with Lockに切り換わります。

• MENUつまみを押さずにMENU ON/OFFス
イッチを押し下げる、またはMENUボタン
を押してメニュー表示した場合は、
Camera Config >User Menu with Lockは
表示されません。

3 Onを選択してMENUつまみを押す。
ビューファインダー画面表示が、暗証
番号入力画面に切り換わります。

4 任意の暗証番号を入力する。
入力できる数値は4桁の0000～9999に
なります。初期値は0000です。
数値を入力してMENUつまみを押すと、
カーソルが次の桁に移動します。
すべての桁を入力したら、Setにカーソ
ルが移動します。

5 Setにカーソルがある状態で、MENU
つまみを押す。
入力が確定します。
設定が完了したメッセージが表示され、
Userメニューだけのメニュー表示に切
り換わります。

ご注意
• 下表に示すセットアップメニューをUserメ
ニューに登録しないでロックすると、そのセッ
トアップメニューと同じ機能をアサイナブルス
イッチに割り当てできなくなります。

• 下表に示す機能をアサイナブルスイッチに割り
当てている状態で、その機能と同じセットアッ
プメニューをロックすると、アサイナブルス
イッチに割り当てた機能の設定は強制的にOffに
なります。

セットアップメニュー アサイナブルスイッ
チへの割り当て可能
機能

Operation >Rec Function 
>Picture Cache Rec

Picture Cache Rec

Operation >Rec Function 
>Clip Continuous Rec

Clip Continuous Rec
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メニューのロックを解除する

1 MENUつまみを押しながら、MENU 
ON/OFFスイッチを押し下げて、セッ
トアップメニューを表示する。

2 メニューのUser >Camera Config 
>User Menu with Lockを表示する。

ご注意
• MENUつまみを押しながら、MENU ON/

OFFスイッチを押し下げると、Camera 
Config >User Menu OnlyがUser Menu 
with Lockに切り換わります。

• MENUつまみを押さずにMENU ON/OFFス
イッチを押し下げる、またはMENUボタン
を押してメニュー表示した場合は、
Camera Config >User Menu with Lockは
表示されません。

3 Offを選択してMENUつまみを押す。
ビューファインダー画面表示が、暗証
番号入力画面に切り換わります。

4 メニューをロックしたときの暗証番
号を入力する。
入力できる数値は4桁の0000～9999で
す。

数値を入力してMENUつまみを押すと、
カーソルが次の桁に移動します。
すべての桁を入力したら、Setにカーソ
ルが移動します。

5 Setにカーソルがある状態で、MENU
つまみを押す。
入力が確定します。
メニューをロックしたときの暗証番号
と入力した番号が一致した場合、ロッ
クが解除できたことのメッセージが表
示され、全メニュー表示に切り換わり
ます。

ご注意
• メニューをロックしたときの暗証番号と入
力した番号が不一致の場合は、ロックを解
除できません。

• 暗証番号は、忘れたときのために、手元に
記録を残すことをおすすめします。忘れた
ときは、サービス窓口にお問い合わせくだ
さい。

Operation >Rec Function 
>Slow & Quick Motion

Slow & Quick Motion

Operation >VF Setting 
>Color Mode

VF Mode

Operation >Display On/
Off >Video Signal 
Monitor

Video Signal
Monitor

Operation >Display On/
Off >Lens Info

Lens Info

Operation >Auto Iris 
>Mode

Spotlight

Backlight

Operation >Marker 
>Setting

Marker

Maintenance >Audio 
>Front MIC Select

Front MIC

Maintenance >Network 
Client Mode >Setting

Network Client
Mode

Maintenance >File 
Transfer >Auto 
Upload(Proxy)

Auto Upload(Proxy)

セットアップメニュー アサイナブルスイッ
チへの割り当て可能
機能
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UserメニューのEdit User Menuで項目の追
加や削除、順番の入れ換えなどを行い、
Userメニューをより使いやすく編集するこ
とができます。
Operationメニュー、Paintメニュー、
Maintenanceメニューの任意の項目、およ
び一部のFileメニューの項目を選択して、
Userメニューに追加することができます。
Userメニューには項目を20個まで登録でき
ます。工場出荷時には6項目登録されていま
すが、そのうちの1項目は削除できないた
め、新規に19個まで項目を追加できます。

ご注意
メニューロック中は編集できません。

Userメニューの編集はEdit User Menu画面
で行います。

1 MENUつまみを回してメニューのUser 
>Edit User Menuを選択し、つまみを
押す。

Edit User Menu画面が表示されます。

1 MENUつまみを回してEdit User 
Menu >Add Itemを選択し、つまみを
押す。
追加が可能な項目が表示されます。

2 MENUつまみを回して追加する項目
を選択し、つまみを押す。
追加する細目を選択する画面が表示されま
す。

3 MENUつまみを回して追加する細目
を選択し、つまみを押す。
すべての細目を追加する場合はAllに
チェックを付けます。
追加する細目を指定する場合は、追加する
細目にチェックを付けます。

4 MENUつまみを回してOKを選択し、
つまみを押す。
項目／細目の追加が完了します。

ご注意
同じ項目／細目を2回登録することはできません。
また追加した項目／細目の名称を変更することは
できません。

表示する項目を任意に設定することができ
ます。

1 Edit User Menuを表示する。

2 MENUつまみを回して編集する項目
を選択し、つまみを押す。
編集機能リストが表示されます。

Userメニューの編集

Edit User Menu画面を表示する

項目／細目を追加する

項目の細目を編集する
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3 MENUつまみを回して編集機能リス
トのEdit Sub Itemを選択し、つまみ
を押す。

Edit Sub Item画面が表示されます。

最初に開いたときは、すべての細目に
チェックが付いています（すべての細目が
表示される状態）。
細目のチェックを外すとUserメニューに
表示されなくなります。

4 MENUつまみを回してOKを選択し、
つまみを押す。
編集が完了します。

1 Edit User Menuを表示する。

2 MENUつまみを回して編集する項目
を選択し、つまみを押す。
編集機能リストが表示されます。

3 MENUつまみを回して編集機能リス
トのDeleteを選択し、つまみを押す。

項目が削除されます。

1 Edit User Menuを表示する。

2 MENUつまみを回して移動する項目
を選択し、つまみを押す。
編集機能リストが表示されます。

3 MENUつまみを回して編集機能リス
トのMoveを選択し、つまみを押す。

移動する項目がハイライトされ、移動先を
示す三角マークと線が表示されます。

4 MENUつまみを回して三角マークと
線を移動先に合わせ、つまみを押す。
項目が移動します。

項目を削除する

項目を移動する

移動先を示す三角マークと線
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1 MENUつまみを回してEdit User 
Menu >Customize Resetを選択し、
つまみを押す。
Customize Reset画面が表示されます。

2 MENUつまみを回してResetを選択
し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。
Userメニューが工場出荷時の状態に戻
ります。

Userメニューを工場出荷時の状
態に戻す
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工場出荷時のUserメニューには以下の項目が含まれています。
• Format Media（154ページ参照）
• Rec Function（156ページ参照）
• Input/Output（155ページ参照）
• Clip（163ページ参照）
• Assignable Switch1)（157ページ参照）
• Camera Config2)（177ページ参照）

1)細目<0>を除く
2)細目はUser Menu Onlyのみ

Userメニューの編集については、「Userメニューの編集」（150ページ）をご覧ください。

太字で表示されている設定値は、出荷時の設定です。

メニュー一覧

Userメニュー（工場出荷時の構成）

Operationメニュー

Operation

項目 細目と設定値 内容
Format
使用するシステム周波数、
ファイルシステム、記録
フォーマット、記録アス
ペクトを設定します。

Frequency
59.94/50/29.97/25/23.98

システム周波数を選択する（Executeで実行）。

File System
exFAT/UDF/FAT

ファイルシステムをexFATとUDFで切り換える
（Executeで実行）。

Rec Format
システム周波数の設定に応
じて変わる。

記録フォーマットを選択する（Executeで実
行）。

XAVC-I 1080P
XAVC-I 1080i
XAVC-I 720P
XAVC-L 50 1080P
XAVC-L 50 1080i
XAVC-L 50 720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HD422 50 720P
HQ 1920x1080i
HQ 1440x1080i
HQ 1280x720P
SStP SR-Lite 422
DNxHD 220 x 1080i
DNxHD 145 1080i
ProRes 422 HQ 1080i 
ProRes 422 1080i 
MPEG IMX 50
DVCAM

ファイルシステムがexFAT、システム周波数が
59.94または50のとき
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Format
使用するシステム周波数、
ファイルシステム、記録
フォーマット、記録アス
ペクトを設定します。

XAVC-I 1080P
XAVC-L 50 1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P
HQ 1920x1080P
SStP SR-Lite 422
DNxHD 220 x 1080P
DNxHD 145 1080P
ProRes 422 HQ 1080P
ProRes 422 1080P

ファイルシステムがexFAT、システム周波数が
29.97、25または23.98のとき

HD422 50 1080i
HD422 50 720P
HQ 1920x1080i
HQ 1440x1080i
HQ 1280x720P
MPEG IMX 50
DVCAM

ファイルシステムがUDF、システム周波数が
59.94または50のとき

HD422 50 1080P
HD422 50 720P
HQ 1920x1080P

ファイルシステムがUDF、システム周波数が
29.97、25または23.98のとき

HQ 1920x1080i
HQ 1440x1080i
HQ 1280x720P
SP 1440x1080i

ファイルシステムがFAT、システム周波数が
59.94または50のとき

HQ 1920x1080P ファイルシステムがFAT、システム周波数が
29.97、25または23.98のとき

Aspect Ratio (SD)
16:9/4:3

SDモードのアスペクト比を選択する。

Audio Length
24bit/16bit

IMXフォーマット時のオーディオ記録のビット
数を選択する。

Format Media
メディアをフォーマット
します。

Media(A)
Execute/Cancel

スロットAのSxSメモリーカードを初期化する
（Executeで実行）。

Media(B)
Execute/Cancel

スロットBのSxSメモリーカードを初期化する
（Executeで実行）。

SD Card(Utility)
Execute/Cancel

UTILITY SDカードスロットのSDカードを初期
化する（Executeで実行）。

SD Card(Proxy)
Execute/Cancel

PROXY SDカードスロットのSDカードを初期
化する（Executeで実行）。

Operation

項目 細目と設定値 内容
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Input/Output
入／出力信号を設定しま
す。

Output Format
システム周波数の設定に応
じて変わる。

出力フォーマットを選択する（Executeで実
行）。
記録フォーマットにより設定値が異なる（52
ページ参照）。

Source Select
Camera/External

ビデオ入力ソースをカメラ画（Camera）にす
るかSDI IN端子からの入力信号にするかを選択
する。

SDI Out1 Output
On/Off

SDI OUT1端子からの出力信号をオン／オフす
る。

SDI Out2 Output
On/Off

SDI OUT2端子からの出力信号をオン／オフす
る。

HDMI Output
On/Off

HDMI端子からの出力信号をオン／オフする。

SDI Out2/HDMI Super
Off/On

SDI OUT2端子からの文字情報（スーパーイン
ポーズ）出力をオン／オフする。

Video Out Super
Off/On

VIDEO OUT端子からの文字情報（スーパーイ
ンポーズ）出力をオン／オフする。

Down Converter
Edge Crop/Letter Box/
Squeeze

SD信号を出力するときの信号変換モードを選
択する。
Edge Crop：16:9画像の両端をカットして4:3
画像として出力する。

Letter Box：4:3画像の上下をマスクして、画
面中央に16:9映像を表示する。

Squeeze：16:9画像を左右方向に縮小して4:3
画像として出力する。

Wide ID
Through/Auto

SD出力信号にワイド識別信号を付加するかど
うかを選択する。
Through：ワイド識別信号を付加せずにその
まま出力する。

Auto：ワイド識別信号がSqueezeのとき、ビ
デオ信号にワイド識別信号を付加して出力
する。

Wide Mode(Ext.)
Auto/16:9

入力信号がSDのとき、ワイド画面情報の判定
方法を設定する。
Auto：入力信号のワイド画面情報がSqueeze
のとき、アスペクト比を16:9として記録す
る。それ以外は、4:3として記録する。

16:9：常にアスペクト比を16:9として記録す
る。

HD SDI Return Input
Enable/Disable

HD SDIリターン入力信号を受け付ける／受け
付けないを設定する（213ページ）。
Enable：HD SDIリターン入力信号を受け付け
る。
Disable：HD SDIリターン入力信号を受け付
けない。
Source SelectでExternalを選択すると、自動
的にDisableに設定されます。

Super Impose
スーパーインポーズされ
る文字情報／マーカーを
設定します。

Super(VF Display)
On/Off

Input/Output >SDI Out2/HDMI Superまたは
Input/Output >Video Out SuperがOnのとき
に、SDI OUT端子またはVIDEO OUT端子から
の出力にスーパーインポーズされる文字情報
を、項目ごとにオン／オフする。

Super(Menu)
On/Off

Super(Marker)
On/Off

Input/Output >Video Out SuperがOnのときに
VIDEO OUT端子からの出力に、Input/Output 
>SDI Out2/HDMI SuperがOnのときにSDI 
OUT端子からの出力にスーパーインポーズさ
れるマーカー表示をオン／オフする。

Operation
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LCD
LCDモニターを設定しま
す。

LCD Color
－99～±0～+99

LCDモニター画面の色の濃さを調整する。

LCD Marker&Zebra
On/Off

LCDモニターのマーカー表示とゼブラ表示を
オン／オフする。

Rec Function
特殊記録モードを設定し
ます。

Slow & Quick Motion
On/Off

スロー＆クイックモーションモードをオン／オ
フする。（この設定をOnにすると、他の特殊記
録モードの設定がOffになる。）

Frame Rate
記録フォーマットの設定に
応じて変わる。

Slow & Quick Motion設定がOnの場合に、ス
ロー＆クイックモーション撮影時のフレーム
レートを選択する。

1～60/72/75/80/90/96/100/
110/120

記録フォーマットがXAVC Intra、XAVC Long
のとき

1～30 記録フォーマットがMPEG HD 422 50M
（1920x1080）、29.97P/23.98Pのとき

1～25 記録フォーマットがMPEG HD 422 50M
（1920x1080）、25Pのとき

Clip Continuous Rec
On/Off

クリップコンティニュアスレックモードをオン
／オフする。（この設定をOnにすると、他の特
殊記録モードの設定がOffになる。）

Picture Cache Rec
On/Off

ピクチャーキャッシュレックモードをオン／オ
フする
（この設定をOnにすると、他の特殊記録モード
の設定がOffになる。）

Cache Rec Time
記録フォーマットの設定に
応じて変わる。

Picture Cache Recの設定がOnの場合に、ピク
チャーキャッシュレック時間を選択する。
◆詳しくは付録の「ピクチャーキャッシュ
レックモード設定」（244ページ）をご覧く
ださい。

Interval Rec On/Off インターバルレックモードをオン／オフする。
（この設定をOnにすると、他の特殊記録モード
の設定がOffになる。）

Number of 
Frames

Format 
>Frequencyの設
定に応じて変わ
る。

Interval Recの設定がOnの場合に、インターバ
ル撮影時の1回の記録フレーム数を設定する。

2frames/
6frames/
12frames

記録フォーマットのフレームレートが50P、
59.94Pのとき

1frame/3frames/
6frames/
9frames

記録フォーマットのフレームレートが23.98P、
25P、29.97P、50i、59.94iのとき

Interval 
Time

1/2/3/4/5/6/7/8/
9/10/15/20/30/
40/50 (sec)1/2/
3/4/5/6/7/8/9/10/
15/20/30/40/50/ 
(min)1/2/3/4/6/
12/24 (hour)

Interval Recの設定がOnの場合に、インターバ
ル撮影時の録画間隔（インターバル）を設定す
る。

Pre-Lighting Off/2sec/5sec/
10sec

インターバルレック撮影開始時にビデオライト
を点灯させる場合は何秒前に点灯させるかを選
択、点灯させない場合はOffを選択する。

Simul Rec
On/Off

Aスロット＆Bスロットへの同時記録機能をオ
ン／オフする。

Operation
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Proxy Recording Mode
プロキシ記録を設定しま
す。

Setting
On/Off

Proxy記録をオン／オフする。

Size
HD Auto(9Mbps)/
HD Auto(6Mbps)/
1280x720(9Mbps)/
1280x720(6Mbps)/
640x360(3Mbps)/
480x270(1Mbps)/
480x270(0.5Mbps)

プロキシ記録フォーマットのサイズを選択す
る。

Frame Rate
23.98fps/25fps/29.97fps/
50fps/59.94fps

プロキシ記録フォーマットのフレームレートを
表示する。

Bit Rate
9Mbps/6Mbps/3Mbps/
1Mbps/0.5Mbps

プロキシ記録フォーマットのビットレートを表
示する。

Audio Channel
CH1/CH2/CH3/CH4

プロキシデータに記録するオーディオチャンネ
ルを選択する。

Assignable Switch
アサイナブルスイッチに
機能を割り当てます。
◆機能の割り当てについ
て詳しくは、「アサイナ
ブルスイッチに機能を
割り当てる」（189ペー
ジ）をご覧ください。

<0>
189ページ参照

ASSIGN. 0スイッチに機能を割り当てる。

<1>
190ページ参照

ASSIGN. 1スイッチに機能を割り当てる。

<2>
190ページ参照

ASSIGN. 2スイッチに機能を割り当てる。

<3>
190ページ参照

ASSIGN. 3スイッチに機能を割り当てる。

<4>
190ページ参照

ASSIGNABLE 4スイッチに機能を割り当てる。

<5>
190ページ参照

ASSIGNABLE 5スイッチに機能を割り当てる。

Lens RET
192ページ参照

レンズのRETボタンに機能を割り当てる。

Color Temp.
190ページ参照

COLOR TEMP.ボタンに機能を割り当てる。

Zoom Speed
0～20～99

ASSIGNABLE 4または5スイッチにZoomを割
り当てた場合の動作速度を設定する。

Operation
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VF Setting
ビューファインダー画面
を設定します。

Color
－99～±0～＋99

ビューファインダー映像の色の濃さを調整す
る。

Color Mode
Color/B&W

ビューファインダーの表示モードを選択する
（CBK-VF02使用時）。
Color：カラー
B&W：白黒

Peaking Type ピーキングの種類を選択する（CBK-VF02使用
時）。
Normal：通常のピーキング
Color：カラーピーキング

Peaking Frequency
Normal/High

Peaking Typeの設定がNormalの場合に、ピー
キング周波数を標準（Normal）にするか高く
（High）するかを選択する（CBK-VF02使用
時）。

Peaking Color
B&W/Red/Yellow/Blue

Peaking Typeの設定がColorの場合に、ピーキ
ングの色を選択する（CBK-VF02使用時）。
B&W：白黒
Red：赤
Yellow：黄
Blue：青

VF Detail Level
－99～±0～+99

カムコーダー側で付けるビューファインダーの
ディテールレベルを設定する（HDVF-20A使用
時）。

Marker
ビューファインダー画面
のマーカー表示を設定し
ます。

Setting
On/Off

すべてのマーカー表示をオン／オフする。

ご注意
ASSIGN. 2にMarkerを割り当てている場合、
この設定は無効です。

Color
White/Yellow/Cyan/Green/
Magenta/Red/Blue

マーカーの表示色を選択する。

Center Marker
1/2/3/4/Off

センターマーカーを表示する場合はその種類を
選択、表示しない場合はOffを選択する。

Safety Zone
On/Off

セーフティーゾーンの表示をオン／オフする。

Safety Area
80%/90%/92.5%/95%

セーフティーゾーンの範囲を選択する。

Aspect Marker
Line/Mask/Off

アスペクトマーカーを表示する場合は表示方法
を選択、表示しない場合はOffを選択する。
Line：白線で表示する。
Mask：マーカー範囲外のビデオ信号レベルを
下げて表示する。

Aspect Select
15:9/14:9/13:9/4:3/1.66:1/
1.85:1/2.35:1/2.4:1

マーカーのアスペクト比を選択する。

Aspect Mask
0%～12%～15％

Aspect MarkerがMaskの場合に、マーカー範
囲内のビデオ信号レベルに対するマーカー範囲
外のビデオ信号レベルを設定する。

Aspect Safety Zone
On/Off

アスペクトセーフティーゾーンマーカーをオン
／オフする。

Aspect Safety Area
80%/90%/92.5%/95%

アスペクトセーフティーゾーンマーカーの大き
さ(画面全体に対する比率)を選択する。

100% Marker
On/Off

100%のセーフティーゾーンマーカーの表示を
オン／オフする。

User Box
On/Off

ボックスカーソルの表示をオン／オフする。

Operation
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Marker
ビューファインダー画面
のマーカー表示を設定し
ます。

User Box Width
40～500～999

ボックスカーソルの幅（中心から左右端までの
距離）を設定する。

User Box Height
70～500～999

ボックスカーソルの高さ（中心から上下端まで
の距離）を設定する。

User Box H Position
－479～0～479

ボックスカーソルの中心の水平位置を設定す
る。

User Box V Position
－464～0～464

ボックスカーソルの中心の垂直位置を設定す
る。

Gain Switch
ゲイン値の切り換え設定
をします。

Gain<L>
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

GAINスイッチの設定がLの場合のゲイン値を
選択する。

Gain<M>
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

GAINスイッチの設定がMの場合のゲイン値を
選択する。

Gain<H>
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

GAINスイッチの設定がHの場合のゲイン値を
選択する。

Gain <Turbo>
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB//18dB/
24dB/30dB/36dB/42dB

Turbo Gain機能を割り当てたアサイナブルス
イッチをオンにしたときのゲイン値を選択す
る。

Shockless Gain
On/Off

ショックレスゲイン（ゲイン切り換え時にス
ムーズに値が切り替わる機能）をオン／オフす
る。

Auto Iris
オートアイリスを設定し
ます。

Iris Override
On/Off

絞りを開きぎみまたは閉じぎみにする設定をオ
ン／オフする。

Mode
Backlight/Standard/
Spotlight

オートアイリスの制御モードを選択する。
Backlight： バックライトモード（中心となる
被写体が逆光のとき、黒沈みを軽減する
モード）

Standard： 標準モード（オプションのリモコ
ン接続時は選択できません。）

Spotlight： スポットライトモード（中心とな
る被写体にスポットライトがあたっている
とき、白潰れを軽減するモード）

Level
－99～±0～＋99

収束目標レベルを設定する（値が大きいほど明
るめになる）。

Speed
－99～±0～＋99

制御スピード（映像の変化に対する反応速度）
を設定する（値が大きいほど反応は速くなる）。

Clip High light
On/Off

高輝度部の検出を無視して、高輝度に対する反
応を鈍くさせる機能をオン／オフする。

Detect Window
1/2/3/4/5/6/Var

オートアイリス検出ウィンドウの種類を選択す
る。
Var：可変

Detect Window Indication
On/Off

オートアイリス検出ウィンドウの枠をマーカー
で表示する機能をオン／オフする。

Iris APL Ratio
－99～±0～＋99

Auto IrisのModeがStandard の場合に、オート
アイリス検出値のピークと平均値の混合比を設
定する。

Iris Var Width
40～500～999

Iris WindowがVarの場合に、ウィンドウの幅を
設定する。

Operation
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Auto Iris
オートアイリスを設定し
ます。

Iris Var Height
70～500～999

Iris WindowがVarの場合に、ウィンドウの高さ
を設定する。

Iris Var H Position
－479～0～479

Iris WindowがVarの場合に、ウィンドウの水平
方向の位置を設定する。

Iris Var V Position
－464～0～464

Iris WindowがVarの場合に、ウィンドウの垂直
方向の位置を設定する。

Zebra
ゼブラ表示を設定します。

Zebra Select
1/2/Both

ゼブラ表示の種類（ゼブラ1、ゼブラ2、また
は両方）を選択する。

Zebra1 Level
50%～70%～107%

ゼブラ1を表示するレベルを設定する。

Zebra1 Aperture Level
1～10%～20%

ゼブラ1のアパーチャーレベルを設定する。

Zebra2 Level
52%～100%～109%

ゼブラ2を表示するレベルを設定する。

Display On/Off
ビューファインダー画面
に表示する項目を設定し
ます。

Video Level Warning
On/Off

映像が明るすぎる場合または暗すぎる場合の警
告表示をオン／オフする。

Shutter Setting
On/Off

シャッターモードとシャッタースピードの表示
をオン／オフする。

ND Filter Position
On/Off

NDフィルター設定の表示をオン／オフする。

Gain Setting
On/Off

ゲイン設定表示をオン／オフする。

Rec /Play Status
On/Off

記録、再生状態の表示をオン／オフする。

Color Temp.
On/Off

色温度表示をオン／オフする。

Frame Rate/Interval
On/Off

特殊記録モード表示をオン／オフする。

Battery Remain
Auto/Voltage/Off

バッテリー残量／入力電圧表示を設定する。
Auto：バッテリー種別に応じた残量を表示
Voltage：バッテリー種別に関わらず入力電圧
値を表示

Off：表示オフ
Timecode

On/Off
タイムデータ（タイムコード、ユーザービッ
ト、デュレーション）表示をオン／オフする。

Audio Level Meter
On/Off

オーディオレベルメーターの表示をオン／オフ
する。

Media Status
On/Off

メディア状態の表示をオン／オフする。

SD Card(Utility) 
On/Off

SDカード（Utility）状態表示をオン／オフす
る。

Focus Position
Meter/Feet/Off

レンズのフォーカスポジションを表示するかど
うかと表示単位を選択する。

Iris Position
On/Off

レンズのアイリスポジション表示をオン／オフ
する。

Zoom Position
On/Off

レンズのズームポジション表示をオン／オフす
る。

Extender
On/Off

レンズおよびエクステンダーの表示をオン／オ
フする。

ALAC
On/Off

収差補正の表示をオン／オフする。

AE Mode
On/Off

AEのモードと現在のAEレベルの設定値の表示
をオン／オフする。

Operation
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Display On/Off
ビューファインダー画面
に表示する項目を設定し
ます。

White Balance Mode
On/Off

ホワイトバランスモード表示をオン／オフす
る。

CC5600K
On/Off

CC5600Kの表示をオン／オフする。

Rec Format
On/Off

記録フォーマットの表示をオン／オフする。

Gamma
On/Off

選択されているGammaの種類の表示をオン／
オフする。

Timecode Lock
On/Off

タイムコードの表示をオン／オフする。

Network Condition
On/Off

ネットワーク接続状態の表示をオン／オフす
る。

Proxy Status
On/Off

プロキシ状態の表示をオン／オフする。

NW Client Mode Status
On/Off

ネットワーククライアントモード表示をオン／
オフする。

Streaming Status
On/Off

ストリーミング状態の表示をオン／オフする。

GPS
On/Off

GPS受信状態の表示をオン／オフする。

Video Signal Monitor
Off/Waveform/Vector/
Histogram

出力映像信号の状態表示のオン／オフ、および
表示するビデオ信号の種類を選択する（34
ページ）。

ご注意
次の場合は表示されません。
• メニューのOperation >Input/Output >SDI 

Out1 SelectとSDI Out2 Selectが両方ともOff
のとき。 

• メニューのOperation >Input/Output 
>Output Formatの設定が720x480Pまたは
720x576Pのとき。

Clip Name
On/Off

クリップ名の表示をオン／オフする。

Focus Assist Indicator
On/Off

フォーカスアシストの表示をオン／オフする。

Focus Area Marker
On/Off

フォーカスエリアマーカーの表示をオン／オフ
する。

Lens Info
Meter/Feet/Off

写界深度を表示するかどうかと表示単位を選択
する。

WRR RF Level
On/Off

ワイヤレスレシーバーの受信状態の表示をオン
／オフする。

Clip Number
On/Off

クリップ情報の表示をオン／オフする。

Operation
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"!"LED
ビューファインダーの"!"
表示を設定します。
（HDVF-20A使用時に有効
な設定です。）

Gain <!>
On/Off

ゲインが0dB以外に設定されている場合に、
！ランプを点灯させる機能をオン／オフする。

Shutter <!>
On/Off

SHUTTERスイッチがONに設定されている場
合に、！ランプを点灯させる機能をオン／オフ
する。

White Preset <!>
On/Off

WHITE BALスイッチがPRSTに設定されている
場合に、！ランプを点灯させる機能をオン／オ
フする。

ATW Run <!>
On/Off

ATWが使用されている場合に、！ランプを点
灯させる機能をオン／オフする。

Extender <!>
On/Off

デジタルエクステンダー機能、またはレンズの
エクステンダーが使用されている場合に、！ラ
ンプを点灯させる機能をオン／オフする。

Filter <!>
On/Off

NDフィルターが1以外に設定されている場合
に、！ランプを点灯させるか機能をオン／オフ
する。

Iris Override <!>
On/Off

オートアイリスオーバーライドが標準値以外に
設定されている場合に、！ランプを点灯させる
機能をオン／オフする。

White Setting
ホワイトバランス調整に
関する設定をします。

White Switch<B>
Memory/ATW

WHITE BALスイッチの設定がBの場合の動作
モードを設定する。
Memory：オートホワイトバランス
ATW：自動追尾ホワイトバランス

Shockless White
Off/1/2/3

WHITE BALスイッチ切り換え時の切り替わり
遷移時間を選択する（1が最も速い）。

ATW Speed
1/2/3/4/5

ATW(自動追尾ホワイトバランス)の遷移スピー
ドを選択する（1が最も速い）。

ATW Mode
Natural/Pure

ATW（自動追尾ホワイトバランス）の動作を
設定する。
Natural：シーンの明るさに応じて、自然な雰
囲気になるようにATWを自動調整する。

Pure：青みや赤みの色を残さずに、より原色
に近づけるようにATWを自動調整する。

AWB Fixed Area
On/Off

画面中央部でAWB（オートホワイトバランス）
を実行する。

Filter White Memory
On/Off

White BalanceがPresetまたはATWのときに、
FILTERつまみのポジション番号ごとにホワイ
トバランスのメモリー領域を設定する。
• AssignボタンにElectrical CC を割り当てて
いるときは、Electrical CCのA、B、C、Dに
それぞれ独立のホワイトのメモリー領域を設
定する。

• AssignボタンにElectrical CC を割り当てて
いないときは、FILTERつまみのポジション
番号ごとにホワイトバランスのメモリー領域
を設定する。

Operation

項目 細目と設定値 内容
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Offset White
ホワイトバランスオフ
セット値に関する設定を
行います。

Offset White<A>
On/Off

メモリー Aのホワイトバランスにオフセット値
を付加する（On）か付加しないか（Off）を選
択する。

Warm Cool <A>
目安の色温度を表示
（約1600K～3200K～
16000K程度）

Offset White<A>がOnの場合に、メモリー Aの
ホワイトバランスに付加するオフセットを色温
度で設定する（オフセットの色温度が高いと誤
差が大きくなるため実際の映像を見ながら調
整）。

Warm Cool Balance<A>
－99～±0～＋99

Warm Cool <A>の設定で希望の映像が得られ
なかった場合に、さらに細かく色温度を設定す
る。

Offset White <B>
On/Off

Onにするとここで調整したオフセットがB
チャンネルのホワイトバランスに付加される。

Warm Cool <B>
目安の色温度を表示
（約1600K～3200K～
16000K程度）

Offset White<B>がOnの場合に、メモリー Aの
ホワイトバランスに付加するオフセットを色温
度で設定する（オフセットの色温度が高いと誤
差が大きくなるため実際の映像を見ながら調
整）。

Warm Cool Balance<B>
－99～±0～＋99

Warm Cool <B>の設定で希望の映像が得られ
なかった場合に、さらに細かく色温度を設定す
る。

Shutter
シャッターの動作モード
を設定します。

Mode
Speed/Angle

電子シャッターの動作モードを選択する。
Speed：シャッタースピードを時間（秒単位）
で設定する。

Angle：シャッタースピードを角度（度単位）
で設定する。

Slow Shutter
スローシャッターを設定
します。

Setting
On/Off

スローシャッター機能をオン／オフする。

Number of Frames
2/3/4/5/6/7/8/16

スローシャッター機能の蓄積フレーム数を設定
する。

Time Zone
時差を設定します。

Time Zone
UTC +14:00～UTC 
Greenwich～UTC -12:00 
（30分単位）

UTC（グリニッジ標準時）からの時差を30分
単位で選択する。

Clip
クリップの名称や管理に
関する設定をします。

ご注意
クリップ名の最初の文字
を「.」の記号にしないで
ください。クリップ名の
最初の文字が「.」になっ
ているクリップは、コン
ピューター上のアプリ
ケーションソフトウェア
で閲覧できません。

Clip Naming
Title/Plan

クリップ名の設定方法を選択する。
Title：Title Prefixで任意に設定する。
Plan：プランニングメタデータで設定した名
称にする（プランニングメタデータで設定
した名称がない場合は、Title Prefixで設定し
た名称にする）。

Title Prefix
文字入力

文字列の入力画面でクリップ名のタイトル部分
（4～46文字の英数字）を設定する（147ページ
参照）。

Number Set
Clip Namingの選択により
変わる（「内容」欄参照）

クリップ名の番号部分を設定する。
Clip Namingの設定がTitleのとき：

0001～9999
Clip Namingの設定がPlanでプランニングメタ
データがロードされているとき：
00001～99999

Operation

項目 細目と設定値 内容
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Update Media
メディア内管理ファイル
を更新します。

ご注意
ファイルシステムがFAT
に設定されているとき、
この機能は使用できませ
ん。

Media(A)
Execute/Cancel

スロットAのSxSメモリーカードの管理情報を
更新する（Executeで実行）。

Media(B)
Execute/Cancel

スロットBのSxSメモリーカードの管理情報を
更新する（Executeで実行）。

GPS
測位情報（GPS）をオン
／オフします。

GPS
On/Off

GPS機能をオン／オフする。

Planning Metadata
プランニングメタデータ
の操作に関する設定をし
ます。

Load Media(A)
Execute/Cancel

Slot(A)のSxSメモリーカードからプランニング
メタデータをロードする。
Executeを選択するとSlot(A)のSxSメモリー
カードに保存されているプランニングメタデー
タのファイルが一覧表示される。ファイルを選
択すると、詳細画面が表示される。

ご注意
ファイルシステムがFATに設定されていると
き、この項目は表示されません。

Load Media(B)
Execute/Cancel

Slot(B)のSxSメモリーカードからプランニング
メタデータをロードする。
Executeを選択するとSlot(B)のSxSメモリー
カードに保存されているプランニングメタデー
タのファイルが一覧表示される。ファイルを選
択すると、詳細画面が表示される。

ご注意
ファイルシステムがFATに設定されていると
き、この項目は表示されません。

Properties
Execute/Cancel

本機にロードされているプランニングメタデー
タの内容を表示する（Executeで実行）。

Clear Memory
Execute/Cancel

本機にロードされているプランニングメタデー
タを消去する（Executeで実行）。

Clip Name Disp
Title1(ASCII)/Title2(UTF-8)

プランニングメタデータでクリップ名を設定す
る場合の表示形式を選択する（94ページ参
照）。

Operation

項目 細目と設定値 内容
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USB 
SxSカードスロットに挿
入された記録メディア内
のクリップをUSBメディ
アにコピーするときの操
作に関する設定をします。

Select Folder USBメディア内のフォルダーを選択する。
USBメディア内に新しいフォルダーを作成す
る。

View Clip List USBメディア内のクリップ一覧を表示する。
Rename Folder USBメディア内のフォルダー名を編集する。
Error Check

On/Off
SxSカードスロットに挿入された記録メディア
内のクリップをUSBメディアへコピーすると
きに、エラーチェックを行うかどうかを選択す
る。

Format USB
Execute/Cancel

USBメディアを初期化する（Executeで実行）。

Copy to USB
Media(A) to USB/
Media(B) to USB/
Media(A)(B) to USB

SxSカードスロット内のすべてのクリップを一
括コピーするとき、対象のスロットを選択す
る。
Media(A) to USB：スロットAに挿入されてい

る記録メディアのすべてのクリップを
USBメディアにコピーする。

Media(B) to USB：スロットBに挿入されてい
る記録メディアのすべてのクリップを
USBメディアにコピーする。

Media(A)(B) to USB：スロットA、およびス
ロットBに挿入されている記録メディア
のすべてのクリップをUSBメディアにコ
ピーする。

Media Remain
（空き容量：数値表示）
（バー表示）

USBメディアの空き容量を表示する。

Operation

項目 細目と設定値 内容
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太字で表示されている設定値は、出荷時の初期設定値です。

Paintメニュー

Paint

項目 細目と設定値 内容
Switch Status
各種補正機能とテスト信
号をオン／オフします。

Gamma
On/Off

ガンマ機能をオン／オフする。

Black Gamma
On/Off

ブラックガンマ機能をオン／オフする。

Matrix
On/Off

マトリクス機能をオン／オフする。

Knee
On/Off

ニー機能をオン／オフする。

White Clip
On/Off

ホワイトクリップ機能をオン／オフする。

ご注意
Offに設定しても、電源再投入後はOnに戻りま
す。

Detail
On/Off

ディテール機能をオン／オフする。

Aperture
On/Off

アパーチャー機能をオン／オフする。

Flare
On/Off

フレア補正機能をオン／オフする。

Test Saw
On/Off

テスト信号をオン／オフする。

White
色温度を設定して、手動
でホワイトバランス調整
を行います。

Color Temp <A>
1500K～3200K～50000K

メモリー Aに保存されたホワイトバランスの色
温度を表示する。

Color Temp Balance <A>
－99～±0～＋99

メモリー Aに保存されたホワイトバランスのゲ
イン値（Rゲイン、Bゲイン連動）を設定する。

R Gain <A>
－99～±0～＋99

メモリー Aに保存されたホワイトバランスのR
ゲイン値を設定する。

B Gain <A>
－99～±0～＋99

メモリー Aに保存されたホワイトバランスのB
ゲイン値を設定する。

Color Temp <B>
1500K～3200K～50000K

メモリー Bに保存されたホワイトバランスの色
温度を表示する。

Color Temp Balance <B>
－99～±0～＋99

メモリー Bに保存されたホワイトバランスのゲ
イン値（Rゲイン、Gゲイン連動）を設定する。

R Gain <B>
－99～±0～＋99

メモリー Bに保存されたホワイトバランスのR
ゲイン値を設定する。

B Gain <B>
－99～±0～＋99

メモリー Bに保存されたホワイトバランスのB
ゲイン値を設定する。

Black
ブラックレベル（光があ
たっていないときの映像
のレベル）を設定します。
ブラックレベルを調整し
て、黒を浮かせる、黒を
沈めるといった絵作りが
可能です。

Master Black
－99～±0～＋99

マスターブラックレベルを設定する。

R Black
－99～±0～＋99

Rブラックレベルを設定する。

B Black
－99～±0～＋99

Bブラックレベルを設定する。
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Flare
フレア補正に関する設定
を行います。
フレアは、画面上の明る
い部分の影響を受けて映
像のレベル全体が上がっ
てしまい、黒い部分が明
るくなる現象で、レンズ
内部での光の乱反射によ
り発生します。

Setting
On/Off

フレア補正機能をオン／オフする。

Master Flare
－99～±0～＋99

マスターフレア補正レベルを設定する。

R Flare
－99～±0～＋99

Rフレア補正レベルを設定する。

G Flare
－99～±0～＋99

Gフレア補正レベルを設定する。

B Flare
－99～±0～＋99

Bフレア補正レベルを設定する。

Gamma
ガンマ補正に関する設定
を行います。
ガンマ補正により、画面
のコントラストを調整し
て、映像の印象を大きく
変えることができます。

Setting
On/Off

ガンマ補正機能をオン／オフする。

Step Gamma
0.35～0.45～0.90
（0.05ステップ）

ガンマ補正値を0.05ステップで設定する。

Master Gamma
－99～±0～＋99

マスターガンマレベルを設定する。

R Gamma
－99～±0～＋99

Rガンマレベルを設定する。

G Gamma
－99～±0～＋99

Gガンマレベルを設定する。

B Gamma
－99～±0～＋99

Bガンマレベルを設定する。

Gamma Category
STD/HG/User

ガンマカテゴリーを選択する。
STD：ビデオ信号用の通常のガンマカーブ
HG：フィルムで撮影したような階調や色再現
に似せたガンマカーブ

User：ユーザーがCvpFileEditorTM V4.2で作
成したガンマカーブ

Gamma Select
Gamma Categoryの選択に
より変わる（「内容」欄参
照）

ガンマ補正に使用するガンマテーブルを選択す
る。

Gamma CategoryがSTDの場合
STD1 DVW：DVWカムコーダー相当
STD2 x4.5：×4.5ゲイン
STD3 x3.5：×3.5ゲイン
STD4 240M：SMPTE-240M相当
STD5 R709：ITU-R709相当（初期設定）
STD6 x5.0：×5.0ゲイン

Gamma CategoryがHGの場合
HG1 3250G36：325%のビデオ入力を100%の
ビデオ出力に圧縮する

HG2 4600G30：460%のビデオ入力を100%の
ビデオ出力に圧縮する

HG3 3259G40：325%のビデオ入力を109%の
ビデオ出力に圧縮する

HG4 4609G33：460%のビデオ入力を109%の
ビデオ出力に圧縮する（初期設定）

Gamma CategoryがUserの場合
User 1：User1に登録されたガンマテーブル
（初期設定）

User 2：User2に登録されたガンマテーブル
User 3：User3に登録されたガンマテーブル
User 4：User4に登録されたガンマテーブル
User 5：User5に登録されたガンマテーブル

Paint

項目 細目と設定値 内容
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Black Gamma
ブラックガンマ補正に関
する設定を行います。
ブラックガンマ補正によ
り、映像の黒または黒に
近い（暗い）部分の階調
や色合いが再現すること
ができます。

Setting
On/Off

ブラックガンマ補正機能をオン／オフする。

ご注意
ブラックガンマ機能を有効にするには
Saturation ModeをLow Keyに設定してくださ
い。

Range
Low/L.Mid/H.Mid

ブラックガンマ補正の有効範囲を選択する。
Low：0～3.6 %
L.Mid：0～7.2%
H.Mid：0～14.4 %

Master Black Gamma
－99～±0～＋99

マスターブラックガンマレベルを設定する。

Knee
ニー補正に関する設定を
行います。
ニー補正は、映像の明る
い部分を記録／出力する
映像のダイナミックレン
ジの上限に応じて圧縮し、
白つぶれを防ぐ処理です。
ニーをかけ始める信号レ
ベルを「ニーポイント」、
ニーによる圧縮の傾きを
「ニースロープ」と呼びま
す。

Setting
On/Off

ニー補正機能をオン／オフする。

Point
75%～95%～109%

DCC機能がオフのとき、ニーポイントを設定
する。

Slope
－99～±0～＋99

DCC機能がオフのとき、ニースロープを設定
する。

Knee Saturation
On/Off

ニーサチュレーション機能をオン／オフする。

ご注意
ニーサチュレーション機能を有効にするには
Saturation ModeをKneeに設定してください。

Knee Saturation Level
－99～±0～＋99

ニーサチュレーションレベルを設定する。

White Clip
ホワイトクリップ調整に
関する設定を行います。
ホワイトクリップは、ビ
デオ出力信号の最大レベ
ルに制限をかける処理で
す。ビデオ出力信号の最
大値を「ホワイトクリッ
プレベル」と呼びます。

Setting
On/Off

ホワイトクリップ調整機能をオン／オフする。

Level
90.0%～109.0%
出荷時の設定はシステム周
波数の設定により変わる
（「内容」欄参照）

ホワイトクリップレベルを設定する。
初期設定は、システム周波数が59.94、29.97、
24、23.98のときは108.0%、50.25のときは
105.0%

Paint

項目 細目と設定値 内容
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Detail(HD)/Detail(SD)
HDモード時またはSD
モード時のディテール調
整に関する設定を行いま
す。
ディテール調整は、被写
体の輪郭部分にディテー
ル信号を加えて輪郭を強
調し、クリアな映像を作
成する処理です。

Setting
On/Off

ディテール調整機能をオン／オフする。

Level
－99～±0～＋99

ディテールレベルを設定する。

H/V Ratio
－99～±0～＋99

HディテールレベルとVディテールレベルの
ミックス比を設定する。

Crispening
－99～±0～＋99

クリスプニングレベルを設定する。

Level Depend
On/Off

レベルディペンド調整機能をオン／オフする。

Level Depend Level
－99～±0～＋99

レベルディペンドレベルを設定する。

Frequency
－99～±0～＋99

Hディテール信号の中心周波数を設定する（値
を大きくするほどディテールは細くなる）。

Knee Aperture
On/Off

ニーアパーチャー補正機能をオン／オフする。

Knee Aperture Level
－99～±0～＋99

ニーアパーチャーレベルを設定する。

Limit
－99～±0～＋99

白側、黒側両方向のディテールリミッターを設
定する。

White Limit
－99～±0～＋99

白側のディテールリミッターを設定する。

Black Limit
－99～±0～＋99

黒側のディテールリミッターを設定する。

V Black Limit
－99～±0～＋99

黒側のVディテールリミッターを設定する。

V Detail Creation
NAM/Y/G/G+R

Vディテール信号を生成するためのソース信号
を選択する。
NAM：R信号から作られたVディテール信号と

G信号から作られたVディテール信号とB信
号から作られたVディテール信号のうち最も
レベルの高い信号

Y：Y信号
G：G信号
G＋R：G信号とR信号を1：1で合成した信号

Cross Color Suppress
（SDモード時）
－99～±0～＋99

ディテールのクロスカラー抑圧レベルを設定す
る。

ご注意
ディテール調整機能Offの場合や、メニューの
Operation >Format >Frequencyが50または25
の場合、この設定は無効です。

Aperture
アパーチャー補正に関す
る設定を行います。
アパーチャー補正は、ビ
デオ信号に、高周波数の
アパーチャー信号を加え
て周波数特性による劣化
を補正し、解像度を高め
る処理です。

Setting
On/Off

アパーチャー補正機能をオン／オフする。

Level
－99～±0～＋99

アパーチャーレベルを設定する。

Paint

項目 細目と設定値 内容
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Skin Detail
スキンディテール補正に
関する設定を行います。
スキンディテール補正は、
人物の肌をきれいに見せ
るなどの目的で、特定の
色の範囲を選んでディ
テールレベルを増減させ
る処理です。

Setting
On/Off

スキンディテール補正機能をオン／オフする。

Area Detection
Execute/Cancel

スキンディテール補正の対象となる色を検出す
る色検出画面が表示される（Executeで実行）。

Area Indication
On/Off

スキンディテール補正の対象となる色のエリア
にゼブラを表示する機能をオン／オフする。

Level
－99～±0～＋99

スキンディテールレベルを設定する。

Saturation
－99～±0～＋99

スキンディテール補正の対象となる色の飽和度
（サチュレーション）を設定する。

Hue
0～359

スキンディテール補正の対象となる色の色相
（ヒュー）を設定する。

Width
0～40～90

スキンディテール補正の対象となる色の色相の
範囲を設定する。

Matrix
マトリクス補正に関する
設定を行いますマトリク
ス補正により、映像の色
味、鮮やかさを調整する
ことができます。
「プリセットマトリクス」
としてあらかじめ用意さ
れたパラメーターセット
から目的に合うマトリク
スを選択できます。また
自分でパラメーターを任
意に設定して「ユーザー
マトリクス」を作成する
こともできます。「アダプ
ティブマトリクス」はマ
トリクスの効き具合を抑
制する機能です。

Setting
On/Off

マトリクス補正機能をオン／オフする。

Adaptive Matrix
On/Off

アダプティブマトリクス機能をオン／オフす
る。

Preset Matrix
On/Off

プリセットマトリクス機能をオン／オフする。

Preset Select
1：SMPTE240M/
2：ITU-709/3：SMPTE 
Wide/4：NTSC/5：EBU/
6：PAL

プリセットマトリクスを選択する。
1：SMPTE240M：SMPTE-240M相当
2：ITU-709：ITU-709相当
3：SMPTE Wide：SMPTE WIDE相当
4：NTSC：NTSC相当
5：EBU：EBU相当
6：PAL：PAL相当

User Matrix
On/Off

ユーザーマトリクス補正機能をオン／オフす
る。

Level
－99～±0～＋99

映像全域の色の濃さ（Saturation）を設定す
る。

Phase
－99～±0～＋99

映像全域の色合い(Phase)を設定する。

User Matrix　R-G
－99～±0～＋99

R-Gのユーザーマトリクスを任意に設定する。

User Matrix　R-B
－99～±0～＋99

R-Bのユーザーマトリクスを任意に設定する。

User Matrix　G-R
－99～±0～＋99

G-Rのユーザーマトリクスを任意に設定する。

User Matrix　G-B
－99～±0～＋99

G-Bのユーザーマトリクスを任意に設定する。

User Matrix　B-R
－99～±0～＋99

B-Rのユーザーマトリクスを任意に設定する。

User Matrix　B-G
－99～±0～＋99

B-Gのユーザーマトリクスを任意に設定する。

Paint
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Multi Matrix
マルチマトリクス補正に
関する設定を行います。
マルチマトリクス補正は、
16軸の色相（Hue）空間
で飽和度（Saturation）を
設定します。

Setting
On/Off

マルチマトリクス補正機能をオン／オフする。

Area Indication
On/Off

マルチマトリクス補正の対象となる色のエリア
にゼブラを表示する機能をオン／オフする。

Color Detection
Execute/Cancel

マルチマトリクス補正の対象となる色を検出す
る色検出画面が表示される（Executeで実行）。

Reset
Execute/Cancel

各軸の[Hue]と[Saturation]をすべて初期値にす
る（Executeで実行）。

Axis
B/B+/MG－/MG/MG+/R/
R+/YL－/YL/YL+/G－/G/
G+/CY/CY+/B－

マルチマトリクス補正の対象となる色（16軸
モード）を設定する。

Hue
－99～±0～＋99

マルチマトリクス補正の対象となる色の色相
（ヒュー）を16軸モードごとに設定する。

Saturation
－99～±0～＋99

マルチマトリクス補正の対象となる色の飽和度
（サチュレーション）を16軸モードごとに設定
する。

V Modulation
Vモジュレーションシェー
ディング補正に関する設
定を行います。
レンズとプリズムの関係
で発生する垂直方向の感
度の傾きを補正します。

Setting
On/Off

Vモジュレーションシェーディング補正機能を
オン／オフする。

Master V Modulation
－99～±0～＋99

マスター Vモジュレーションレベルを設定す
る。

R V Modulation
－99～±0～＋99

R信号のVモジュレーションレベルを設定する。

G V Modulation
－99～±0～＋99

G信号のVモジュレーションレベルを設定する。

B V Modulation
－99～±0～＋99

B信号のVモジュレーションレベルを設定する。

Low Key Saturation
ローキーサチュレーショ
ン補正に関する設定を行
います。
映像の暗い部分の色の濃
さだけを補正できます。

Setting
On/Off

ローキーサチュレーション補正機能をオン／オ
フする。

ご注意
ローキーサチュレーション機能を有効にするに
はSaturation ModeをLow Keyに設定してくだ
さい。

Level
－99～±0～＋99

低輝度エリアの色の飽和度（サチュレーショ
ン）を設定する。

Range
Low/L.Mid/H.Mid

ローキーサチュレーション補正を有効にする輝
度レベルを選択する。

Saturation Mode
サチュレーション補正に
関する設定を行います。

Saturation Mode
Knee/Low Key

サチュレーション機能をレベルが高いところ
（Knee）で働かせるか低いところ（Low Key）
で働かせるかを選択する。

Knee Saturation
On/Off

ニーサチュレーション機能をオン／オフする。

Black Gamma
On/Off

ブラックガンマ補正機能をオン／オフする。

Low Key Saturation
On/Off

ローキーサチュレーション機能をオン／オフす
る。

Noise Suppression
ノイズサプレス（ノイズ
圧縮）機能に関する設定
を行います。
被写体の細かなエッジ成
分を残しつつ、ノイズ成
分を効果的に抑制するこ
とができます。

Setting
On/Off

ノイズサプレス機能をオン／オフする。

Level
Low/Mid/High

ノイズサプレスのレベルを選択する。

Paint
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太字で表示されている設定値は、出荷時の初期設定値です。

Maintenanceメニュー

Maintenance

項目 細目と設定値 内容
White Shading
ホワイトシェーディング
補正に関する設定を行い
ます。
ホワイトシェーディング
はレンズの特性により発
生する明るい部分の輝度
ムラや色ムラで、レンズ
ごとに補正が必要です。

Channel Select
Red/Green/Blue

ホワイトシェーディング補正の対象を選択す
る。

White H Saw
－99～±0～＋99

水平方向のSAWホワイトシェーディング補正
値を設定する。

White H Para
－99～±0～＋99

水平方向のパラボラホワイトシェーディング補
正値を設定する。

White V Saw
－99～±0～＋99

垂直方向のSAWホワイトシェーディング補正
値を設定する。

White V Para
－99～±0～＋99

垂直方向のパラボラホワイトシェーディング補
正値を設定する。

White Saw/ Para
On/Off

ホワイトシェーディングのSAW／パラボラ補
正機能をオン／オフする。

Black Shading
ブラックシェーディング
補正に関する設定を行い
ます。

Channel Select
Red/Green/Blue

ブラックシェーディング補正の対象を選択す
る。

Black H Saw
－99～±0～＋99

水平方向のSAWブラックシェーディング補正
値を設定する。

Black H Para
－99～±0～＋99

水平方向のパラボラブラックシェーディング補
正値を設定する。

Black V Saw
－99～±0～＋99

垂直方向のSAWブラックシェーディング補正
値を設定する。

Black V Para
－99～±0～＋99

垂直方向のパラボラブラックシェーディング補
正値を設定する。

Black Saw/Para
On/Off

ブラックシェーディングのSAW／パラボラ補
正機能をオン／オフする。

Master Black
－99～±0～＋99

マスターのブラックレベルを設定する。

Master Gain (TMP)
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

一時的にマスターゲインの値を設定する。
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Battery
バッテリーに関する設定
を行います。

Near End:Info Battery
5%/10%/15%...95%/100%

バッテリーパックBP-GL65A/GL95A使用時に
「Battery Near End」を表示するしきい値を設
定する。

End:Info Battery
0%/1%/2%/3%/4%/5%

バッテリーパックBP-GL65A/GL95A使用時に
「Battery End」を表示するしきい値を設定す
る。

Near End:Sony Battery
11.5V～17V
（0.1Vステップ）

バッテリーパックBP-L60S/L80S使用時に
「Battery Near End」を表示するしきい値を設
定する。

End:Sony Battery
11.0V～11.5V
（0.1Vステップ）

バッテリーパックBP-L60S/L80S使用時に
「Battery End」を表示するしきい値を設定す
る。

Near End:Other Battery
11.5V～11.8V～17.0V
（0.1Vステップ）

ソニー製以外のバッテリーパック使用時に
「Battery Near End」を表示するしきい値を設
定する。

End:Other Battery
11.0V～14.0V
（0.1Vステップ）

ソニー製以外のバッテリーパック使用時に
「Battery End」を表示するしきい値を設定す
る。

Detected Battery
Sony Info Battery/
Sony Battery/Other Battery/
DC IN

バッテリーの種類を自動判別した結果を表示す
る。

DC Voltage Alarm
外部DC電源電圧に関する
アラームを設定します。

DC Low Voltage1
11.5V～17V
（0.1Vステップ）

DC IN端子に外部電源を接続している場合に
「Battery Near End」を表示するしきい値を設
定する。

DC Low Voltage2
11.0V～14.0V
（0.1Vステップ）

DC IN端子に外部電源を接続している場合に
「Battery End」を表示するしきい値を設定す
る。」

Audio
オーディオに関する設定
を行います。

Front MIC Select
Mono/Stereo

フロントマイクをモノラル（Mono）にする
か、ステレオ（Stereo）にするかを選択する。

Rear XLR Auto
On/Off

後面のAUDIO IN CH-1/CH-2端子にケーブルが
接続されているかどうかを自動的に検出する機
能をオン／オフする。

Front MIC CH1 Ref
－70dB/－60dB/－50dB/
－40dB/－30dB

フロントマイクのチャンネル1の基準入力レベ
ルを選択する。

Front MIC CH2 Ref
－70dB/－60dB/－50dB/
－40dB/－30dB

フロントマイクのチャンネル2の基準入力レベ
ルを選択する。

Rear MIC CH1 Ref
－70dB/－60dB/－50dB/
－40dB/－30dB

AUDIO IN CH1スイッチの設定がMICの場合の
基準入力レベルを選択する。

Rear MIC CH2 Ref
－70dB/－60dB/－50dB/
－40dB/－30dB

AUDIO IN CH2スイッチの設定がMICの場合の
基準入力レベルを選択する。

Line Input Ref
＋4dB/0dB/－3dB/EBUL

AUDIO IN CH1/CH2スイッチの設定がLINEの
場合の基準入力レベルを選択する。

Min Alarm Volume
Off/Set

ALARMつまみを絞りきったときの音量を選択
する。
Off：ほぼ聞こえない
Set：ある程度は聞こえる

Speaker Attenuate
Off/3dB/6dB/9dB/12dB

モニタースピーカーからの音量を選択する（イ
ヤホンの音量には影響しない）。

Headphone Out
Mono/Stereo

イヤホンをモノラル（Mono）にするか、ステ
レオ（Stereo）にするかを選択する。

Maintenance
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Audio
オーディオに関する設定
を行います。

Reference Level
－20dB/－18dB/－16dB/
－12dB/EBUL

基準入力レベルを設定する。合わせて、1 kHz
テスト信号の出力レベルを設定する。

Reference Out
0dB/＋4dB/－3dB/EBUL

基準入力レベルに対する出力レベルを設定す
る。

CH1&2 AGC Mode
Mono/Stereo

チャンネル1、2に記録するアナログオーディ
オ信号の入力レベルの自動調整を、各チャンネ
ルで独立して行うか（Mono）、ステレオモー
ドで行うか（Stereo）を選択する。

CH3&4 AGC Mode
Mono/Stereo

チャンネル3、4に記録するアナログオーディ
オ信号の入力レベルの自動調整を、各チャンネ
ルで独立して行うか（Mono）、ステレオモー
ドで行うか（Stereo）を選択する。

AGC Spec
－6dB/－9dB/－12dB/
－15dB/－17dB

AGCの特性（飽和レベル）を選択する。

Limiter Mode
Off/－6dB/－9dB/－12dB/
－15dB/－17dB

オーディオ入力レベルの手動調整時、大きな入
力信号に対するリミッター特性（飽和レベル）
を選択する。リミッターを使用しない場合は
Offを選択する。

Output　Limiter
On/Off

オーディオ出力リミッターをオン／オフする。

CH1 Wind Filter
On/Off

チャンネル1の風音低減フィルターをオン／オ
フする。

CH2 Wind Filter
On/Off

チャンネル2の風音低減フィルターをオン／オ
フする。

CH3 Wind Filter
On/Off

チャンネル3の風音低減フィルターをオン／オ
フする。

CH4 Wind Filter
On/Off

チャンネル4の風音低減フィルターをオン／オ
フする。

1kHz Tone on Color Bars
On/Off/Auto

カラーバーモード時に1kHzのテスト信号を出
力するか（On）出力しないか（Off）を設定す
る。
Auto：AUDIO SELECT CH1スイッチの設定が

AUTOの場合のみテスト信号を出力する。
MIC　CH1 Level

Side1/Front/Front+Side1
フロントマイクの入力音声をチャンネル1に記
録する場合に、どのつまみで音声レベルを調節
するかを選択する。
Side1：サイドパネルのLEVELつまみ（左）
Front：フロントパネルのMICLEVELつまみ
Front+Side1：LEVELつまみ（左）とMIC 

LEVELつまみを連動させる
MIC　CH2 Level

Side2/Front/Front+Side2
フロントマイクの入力音声をチャンネル2に記
録する場合に、どのつまみで音声レベルを調節
するかを選択する。
Side2：サイドパネルのLEVELつまみ（右）
Front：フロントパネルのMIC LEVELつまみ
Front+Side2：LEVELつまみ（右）とMIC 

LEVELつまみを連動させる
Rear1/WRR Level

Side1/Front/Front+Side1
ワイヤレスマイクとリアパネルのAUDIO IN 
CH-1端子に接続した機器をどのつまみで音声
レベルを調節するかを選択する。
Side1：サイドパネルのLEVELつまみ（左）
Front：フロントパネルのMIC LEVELつまみ
Front+Side1：LEVELつまみ（左）とMIC 

LEVELつまみを連動させる

Maintenance
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Audio
オーディオに関する設定
を行います。

Rear2/WRR Level
Side2/Front/Front+Side2

ワイヤレスマイクとリアパネルのAUDIO IN 
CH-2端子に接続した機器をどのつまみで音声
レベルを調節するかを選択する。
Side2：サイドパネルのLEVELつまみ（右）
Front：フロントパネルのMICLEVELつまみ
Front+Side2：LEVELつまみ（右）とMIC 

LEVELつまみを連動させる
Audio CH3 Level

Side3/Front/Front+Side3
チャンネル3に記録される音声レベルをどのつ
まみで調節するかを選択する。
Side3：サイドパネルのLEVELつまみ
Front：フロントパネルのMIC LEVELつまみ
Front+Side3：LEVELつまみとMIC LEVELつ
まみを連動させる

Audio CH4 Level
Side4/Front/Front+Side4

チャンネル4に記録される音声レベルをどのつ
まみで調節するかを選択する。
Side4：サイドパネルのLEVELつまみ
Front：フロントパネルのMIC LEVELつまみ
Front+Side4：LEVELつまみとMIC LEVELつ
まみを連動させる

WRR Setting
ワイヤレスチューナーに
関する設定を行います。

WRR Valid CH Sel
All/CH1

ワイヤレスレシーバーのチャンネル1、2とも
有効にするか（All）、チャンネル1のみを有効
にするか（CH1）を選択する。

WRR CH Select
TX1/TX2

内容をメニューに表示する受信チャンネルを選
択する。
TX1：チャンネル1の内容を表示する。
TX2：チャンネル2の内容を表示する。

WRR Delay Comp
On/Off

ワイヤレス入力音声の遅延補正機能を有効にす
るか（On）無効にするか（Off）を選択する
（Onを選択するとすべてのE-E出力の音声が約
8ms遅延する）。

TX
---

WRR CH Selectで選択したチャンネルで受信
している送信機の名前を表示する。

TX Audio Peak
---/Peak

WRR CH Selectで選択したチャンネルで受信
している送信機のAFレベルがピークオーバー
かどうかを表示する。

TX Input Level 
---/Mic/Line

WRR CH Selectで選択したチャンネルで受信
している送信機の入力レベルがマイク（Mic）
とライン（Line）のどちらに設定されているか
を表示する。

TX ATT Level
---

WRR CH Selectで選択したチャンネルで受信
している送信機のATTレベルを設定する(設定
値の可変範囲は、受信している送信機によって
異なる場合がある)。

TX LCF Frequency
---

WRR CH Selectで選択したチャンネルで受信
している送信機のローカットフィルター周波数
を設定する（設定値の可変範囲は、受信してい
る送信機によって異なる場合がある）。

TX System Delay
Auto/0.0ms～8.0ms

音声の遅延量を設定する。
Auto：ワイヤレスレシーバーから送られてく
る音声の遅延量が0になるように自動的に遅
延量を補正する。

0.0ms～8.0ms：オーディオミキサーなどを介
して複数のワイヤレスシステムを使用して
いる場合に、予測されるワイヤレスシステ
ムの遅延量を設定する。

Maintenance

項目 細目と設定値 内容



176

WRR Setting
ワイヤレスチューナーに
関する設定を行います。

TX RF Power
High（Power値）mW/
Mid（Power値）mW/
Low（Power値）mW

WRR CH Selectで選択されたチャンネルで通
信している送信機のRF Power Levelを設定す
る（設定値の可変範囲は、受信している送信機
によって異なる場合がある）。

TX Power Save
Active/Sleep

WRR CH Selectで選択されたチャンネルで受
信している送信機のパワーセーブモードを設定
する。
Active：送信機を起動モードにする。
Sleep：送信機をパワーセーブモードにする。

TX-Cam Power Sync  
Off/On

送信機のパワーセーブ状態を本機のPOWERス
イッチと同期して切り替えるかどうかを設定す
る。

Time Code
タイムコードに関する設
定を行います。

TC Out 
Auto/Generator

タイムコード出力を選択する。
Auto：記録時はタイムコードジェネレーター
の値を出力し、再生時はタイムコードリー
ダーの値を出力する

Generator：記録時、再生時ともタイムコード
ジェネレーターの値を出力する

DF/NDF
DF/NDF

ドロップフレームモード（DF）またはノンド
ロップフレームモード（NDF）を選択する。

LTC UBIT
Fix/Time

LTCのユーザービットに記録するデータを設定
する。
Fix：ユーザーが設定したデータを記録する
Time：現在の時刻を記録する

Counter Display 
Counter/Duration

ビューファインダーに表示されるカウンター値
のリセットの方法を選択する。
Counter：RESETボタンを押すまで積算され
る。

Duration：記録開始ごとにリセットされる。
Essence Mark
エッセンスマークに関す
る設定を行います。

Find Mode
Clip/Rec Start

NEXT/PREVボタンを押したときの動作を設定
する。
Rec Start：次または1つ前のレックスタート
マークに移動する。

Clip：NEXTボタンを押すと、次のクリップの
先頭へ移動する。PREVボタンを押すと、現
在のクリップの先頭に移動する（クリップ
の先頭でPREVボタンを押すと1つ前のク
リップの先頭に移動する）。

Maintenance
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Camera Config
カムコーダーの各種動作
に関する設定を行います。

HD SDI Remote I/F
Off/Characters/
Green Tally/Red Tally

本機のSDI OUT 1/2端子（HD SDI出力）に接
続された外部機器に対する記録動作制御機能を
使用するかどうか設定する。使用する場合、外
部機器が記録状態であることの表示方法を選択
する。
Off：記録動作制御機能を使用しない。
Chara：ビューファインダー画面上の状態表示
の外部機器制御表示で表示する。

G-Tally：ビューファインダー内のTALLY（グ
リーンタリー）ランプで表示する。

R-Tally：ビューファインダー内のREC（記
録・レッドタリー）ランプで表示する。

Color Bars Select
ARIB/100%/75%/SMPTE

カラーバーの種類を選択する。

User Menu Only
On/Off

メニューを表示したときに、Userメニューだ
けを表示するか（On）、メニューリストを表示
するか（Off）を選択する。

User Menu with Lock
On/Off

メニュー表示にロックをかけて、Userメ
ニューだけの表示にするかどうかを選択する。
On：任意の暗証番号を入力し、メニュー表示
にロックをかける。（Userメニューだけの表
示になります。）

Off：Onしたときに入力した任意の暗証番号を
入力し、ロックを解除する。（解除すると、
通常のメニューリスト表示に切り換わりま
す。）

ご注意
通常のメニュー表示操作では、表示されませ
ん。
メニュー表示操作方法は、148ページをご覧く
ださい。

RM Common Memory
On/Off

リモートコントロールユニット接続時とローカ
ル操作時で設定を共有するか（On）共有しな
いか（Off）を選択する。

RM Rec Start
RM/Camera/PARA

リモートコントロールユニット接続時にどちら
の記録開始／停止ボタンを有効にするかを設定
する。
RM：リモートコントロールユニット
Camera：カムコーダー
PARA：両方

SET Key on Thumbnail
Pause/Play

ひとつのサムネイルを選択した状態でMENUつ
まみを押したときの動作を選択する。
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Camera Config
カムコーダーの各種動作
に関する設定を行います。

ALAC
Auto/Off

ALAC（倍率色収差補正）を自動的に実行する
かどうかを設定する。
Auto：ALACに対応しているレンズが取り付け
られ、ALACが有効になっていると、自動的
にALACを実行する。

Off：実行しない。

ご注意
収差補正対応レンズによっては、本項目が
Autoに設定されていても電源投入直後に収差
補正機能が動作しない（ビューファインダー画
面上に「ALAC」と表示されない）ことがあり
ます。このようなときは、レンズのズームリン
グとフォーカスリングをいったん端まで動かし
て、ビューファインダー画面上に「ALAC」の
表示が出ることを確認してから使用してくださ
い。
◆収差補正対応レンズについては、ソニーの
サービス担当者または営業担当者にお問い合
わせください。

Preset White
ホワイトバランスのプリ
セット値に関する設定を
行います。

Color Temp <P>
1500K～3200K～50000K

ホワイトバランスのプリセット値を設定する。

Color Temp Balance<P>
－99～±0～＋99

Color Temp<P>で希望の映像が得られなかっ
た場合に、さらに細かく色温度を設定する。

R Gain <P>
－99～±0～＋99

Rゲインのプリセット値を設定する。

B Gain <P>
－99～±0～＋99

Bゲインのプリセット値を設定する。

AWB Enable <P>
On/Off

WHITE BALスイッチがPRSTのとき、AWB
（オートホワイトバランス）を実行する機能を
オン／オフする

White Filter
フィルターに関する設定
を行います。

ND Filter C.Temp
On/Off

電気的CCフィルターをNDフィルターに割り当
てる機能をオン／オフする。

ND FLT C.Temp<1>
3200K/4300K/5600K/
6300K

電気的CCフィルターをNDフィルターに割り当
てるときの色温度を選択する（フィルター 1
用）。

ND FLT C.Temp<2-4>
3200K/4300K/5600K/
6300K

電気的CCフィルターをNDフィルターに割り当
てるときの色温度を選択する（フィルター 2～
4用）。

Electrical CC<A>
3200K/4300K/5600K/
6300K

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。

Electrical CC<B>
3200K/4300K/5600K/
6300K

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。

Electrical CC<C>
3200K/4300K/5600K/
6300K/---

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。Cを使わないときは----を選択する。

Electrical CC<D>
3200K/4300K/5600K/
6300K/---

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。Dを使わないときは----を選択する。
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DCC Adjust
DCC（ダイナミックコン
トラストコントロール）
に関する設定を行います。

DCC Function Select
DCC/Fix

OUTPUT/DCCスイッチをCAM、DCC：ONに
したときのニーポイントの設定方法を選択す
る。
DCC：ニーポイントを被写体の輝度に合わせ
て自動調整する。

Fix：ニーポイントを固定値にする。
DCC D Range

400%/450%/500%/550%/
600%

OUTPUT/DCCスイッチをCAM、DCC：ONに
したときのダイナミックレンジを設定する。

DCC Point
－99～±0～＋99

DCCの最小ニーポイントを設定する。

DCC Gain
－99～±0～＋99

DCCの検出値に対するゲイン値を設定する。

DCC Delay Time
－99～±0～＋99

DCCの制御スピード（映像の変化に対する反
応速度）を設定する。

DCC Peak Filter
－99～±0～＋99

DCCの検出値のピークに対する応答感度を調
整する。

Genlock
ゲンロックに関する設定
を行います。

Genlock
On/Off

ゲンロック機能オン／オフする。

Reference
Internal/External(HD)/
External(SD)/SDI IN/CA

本機が使用している基準信号の種類を表示す
る。

Auto Shading
オートブラックシェー
ディング補正を実行しま
す。

Auto Black Shading
Execute/Cancel

オートブラックシェーディング補正を実行する
（Executeで実行する）。

Reset Black Shading
Execute/Cancel

ブラックシェーディング補正値をクリアする
（Executeで実行する）。

Master Gain (TMP)
－6dB/－3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

一時的にマスターゲインの値を設定する
（GAINスイッチの設定値と同じ値になる）。

APR
自動ピクセルノイズリダ
クション補正に関する設
定を行います。

APR
Execute/Cancel

自動欠陥補正（自動ピクセルノイズリダクショ
ン）機能を実行し、SLSモード時の白点を軽減
する（Executeで実行する）。

Reset
Execute/Cancel

APRおよびブラックバランスの自動調整の実行
によって、追加登録された白点データを削除す
る（Executeで実行する）。

Basic Authentication
Basic認証に関する設定を
行います。

User Name
(現在のユーザー名を表示)

任意のユーザー名を設定する（Basic認証用）。
出荷時はadminに設定されています。

Password
*******

パスワードを設定する（Basic認証用）。出荷
時はpxw-x500に設定されています。
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Network
ネットワーク接続に関す
る設定と表示を行います。

Setting
On/Off

ネットワーク機能をオン／オフする。

Wi-Fi Mode
Wi-Fi Access Point/Wi-Fi 
Station/Off

ワイヤレスLAN接続の動作モードを設定する。

WPS
Execute/Cancel

Wi-Fi Protected Setup（=WPS）を開始する
（Executeで実行する）。

Channel
Auto(5GHz)/Auto/CH1/
CH2/CH3/CH4/CH5/CH6/
CH7/CH8/CH9/CH10/
CH11

ワイヤレスLANのチャンネルを設定する。

ご注意
• 本バージョンでは、CH12とCH13は使用で
きません。

• Auto(5GHz)は、ご使用のワイヤレスLANモ
ジュールによっては、表示されない場合があ
ります。

SSID & Password
（SSID表示）
（Password表示）

SSIDとパスワードを表示する。

SSID
（SSID表示）

Wi-Fi Station Modeでの接続先アクセスポイン
トのSSIDを表示する。

Wi-Fi Station Detail Settings Wi-Fi Stationモード時のネットワーク詳細を設
定する。

Scan Networks
Execute/Cancel

接続先ネットワーク自動検出を開始する
（Executeで実行する）。

SSID（アクセスポイントの
SSID）

Wi-Fi Stationモードでの接続先アクセスポイン
トのSSIDを入力する。

Password（アクセスポイン
トのパスワード）

Wi-Fi Stationモードでの接続先アクセスポイン
トのパスワードを入力する。

DHCP
On/Off

Onにすると、自動的に本機にIPアドレスを割
り当てる。
手動で本機のIPアドレスを入力する場合は、
Offにする。

IP Address
（DHCP/On：自動取得
DHCP/Off：
192.168.1.50）

本機のIPアドレスを入力する。DHCPがOffの
ときに有効。

Subnet Mask
（DHCP/On：自動取得
DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

Gateway
（DHCP/On：自動取得
DHCP/Off：0.0.0.0）

アクセスポイントのゲートウェイを入力する。
DHCPがOffのときに有効。

DNS Auto
On/Off

DNS自動取得を設定する。
Onにすると、自動的にDNSサーバーのアドレ
スを取得する。

Primary DNS Server
（DNS Auto/On：自動取
得
DNS Auto/Off：0.0.0.0）

ルーターのプライマリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。

Secondary DNS Server
（DNS Auto/On：自動取
得
DNS Auto/Off：0.0.0.0）

ルーターのセカンダリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。
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Network
ネットワーク接続に関す
る設定と表示を行います。

Device Name(Wi-Fi) USBワイヤレスLANモジュール用端子に装着
されているネットワーク機器の名称を表示す
る。

IP Address(Wi-Fi) 本機のIPアドレスを表示する。
Subnet Mask(Wi-Fi) サブネットマスクを表示する。
MAC Address(Wi-Fi) 本機に搭載されているUSB Wireless LAN 

ModuleのMACアドレスを表示する。
Regenerate Password

Execute/Cancel
パスワードを再生成する（Executeで実行す
る）。

Modem
On/Off

3G/4Gモデムによるネットワーク接続の有効／
無効を設定する。

Wired LAN
Enable/Disable

有線LAN接続の有効／無効を設定する。

Wired LAN Remote
On/Off

LANケーブルでネットワーク接続したときに、
Wi-Fiリモコン、Webメニュー、「Content 
Browser Mobile」アプリケーションからの操
作を有効にする。

Wired LAN Detail Settings 有線LAN接続時のネットワーク詳細を設定す
る。

DHCP
On/Off

Onにすると、自動的に本機にIPアドレスを割
り当てる。手動で本機のIPアドレスを入力する
場合は、Offにする。

IP Address
（DHCP/On：自動取得
DHCP/Off：
192.168.1.50）

本機のIPアドレスを入力する。DHCPがOffの
ときに有効。

Subnet Mask
（DHCP/On：自動取得
DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。DHCPが
Offのときに有効。

Gateway
（DHCP/On：自動取得
DHCP/Off：0.0.0.0）

アクセスポイントのゲートウェイを入力する。
DHCPがOffのときに有効。

DNS Auto
On/Off

DNS自動取得を設定する。Onにすると、自動
的にDNSサーバーのアドレスを取得する。

Primary DNS Server
（DNS Auto/On：自動取
得
DNS Auto/Off：0.0.0.0）

ルーターのプライマリー DNSサーバーを入力
する。DNS AutoがOffのときに有効。

Secondary DNS Server
（DNS Auto/On：自動取
得
DNS Auto/Off：0.0.0.0）

ルーターのセカンダリー DNSサーバーを入力
する。DNS AutoがOffのときに有効。
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Network Client Mode
ネットワーククライアン
トモードに関する設定を
行います。

Setting
On/Off

ネットワーククライアントモードをオン／オフ
する。

ご注意
Onにすると、ファームウェアのバージョン
アップはできません。

Preset Select
Preset1/Preset2/Preset3

ネットワーククライアントモードの接続設定を
あらかじめ設定したプリセット設定（Preset 1/
Preset 2/Preset 3）から選択する。

Preset1
（プリセット名の表示） プリセット名を入力する。
CCM Address 接続先CCMのアドレスを設定する。ホスト名

またはIPアドレス
CCM Port（1～65535
（8443）)

接続先CCMのポート番号を設定する。

User Name 接続先CCMの認証用ユーザー名を設定する。
Password 接続先CCMのパスワードを設定する。
NCM with Proxy（Enable/
Disable）

Enable：CCM接続時のプロキシ記録を有効に
する。

Disable：CCM接続時のプロキシ記録を無効に
する。

Camera Control（Enable/
Disable）

CCM接続時のカメラコントロール操作の許可
／不許可を設定する。

Camera Setting（Always/
Onetime/Off）

CCM接続時のALLファイル操作の許可／不許
可を設定する。
Always：常にALLファイルの操作を許可する
Onetime：1回だけALLファイルの操作を許可
する

Off：ALLファイルの操作を許可しない
Preset 2 Preset 1と同じ
Preset 3 Preset 1と同じ

File Transfer
本機のSxSメモリーカー
ドのデータのネットワー
ク転送に関する設定を行
います。

File Transfer
Execute/Cancel

転送モードへ移行する（Executeで実行する）。

Remote File Transfer
Enable/Disable 

本機で記録したオリジナルファイル転送時、転
送モードへの移行をネットワークからのリモー
ト操作で許可する／許可しないを設定する。
Enable：ネットワークからのリモート操作で、
転送モードへの移行を許可する。
Maintenance >File Transferで転送を実行す
る必要はありません。

Disable：ネットワークからのリモート操作
で、転送モードへの移行を許可しない。
Maintenance >File Transferで転送を実行す
る必要があります。

Auto Upload (Proxy)
Off/On 

プロキシファイルの自動転送をオン／オフする。
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Streaming
ストリーミングに関する
設定を行います。

Setting
On/Off

ストリーミング伝送をオン／オフする。

ご注意
• この設定は、本機の電源を入れなおしたとき
にOffにリセットされます。

• Onにすると、モニタリング機能は使えませ
ん。

• Onにすると、ファームウェアのバージョン
アップはできません。

Preset Select
Preset 1/Preset 2/Preset 3

ストリーミングのプリセット項目を選択する。
設定項目はPreset 1/Preset 2/Preset 3で共通で
す。各設定項目については、以下を参照してく
ださい。

Size
HD Auto/
1280x720/
640x360/
480x270/
320x180

ストリーミング用の映像のサイズを設定する。
HD Autoを選択した場合、SxSに記録される記
録フォーマットの設定や、再生するクリップの
フォーマットに基づいて、サイズが1920×
1080か1280×720に設定されます。

Bit Rate
9Mbps/
6Mbps/
3Mbps/
2Mbps/
1Mbps/
0.5Mbps/
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

ストリーミング用の映像のビットレートを設定
する。
選択できるビットレートはSizeの設定値により
異なります。

ご注意
• インターネット経由で映像／音声データをそ
のまま送信します。そのためデータが漏えい
する可能性があります。送信先がストリーミ
ングデータを受信できていることを確認して
ください。

• アドレスの設定ミスなどにより意図しない相
手にデータを送信してしまう可能性がありま
す。

• ネットワークの状況により、すべてのフレー
ムを再生できない場合があります。

• 動きの激しいシーンでは、画質が悪くなりま
す。

• ストリーミングを大きなサイズで小さいビッ
トレートに設定した場合、すべてのフレーム
が再生できない場合があります。この現象を
軽減させるためにはSizeでより小さいサイズ
を選んでください。

Type
MPEG-2 TS/UDP/MPEG-2 
TS/RTP

ストリーミング用の映像の種類を選択する。

Destination Address
文字列(0.0.0.0）

ストリーミングデータの伝送先サーバーのアド
レスを入力する。

Destination Port
1～65545(1234）

伝送先サーバーの、ストリーミングに使用する
ポート番号を入力する。

Audio Channel 
CH1/CH2/CH3/CH4

ストリーミング出力に乗せるAudio Channelを
選択する。

Clock Set
内蔵時計を設定します。

Date Mode
YYMMDD/MMDDYY/
DDMMYY

年月日の表示方式を選択する。

12H/24H
12H/24H

時刻の表示形式を選択する。

Date 日付設定画面を表示する。
Time 時刻設定画面を表示する。
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Language
メッセージの表示言語を
選択します。

Select
English/中文( )/日本語/
Español/

メッセージの表示言語を選択する。

Hours Meter
デジタル時間計に関する
設定を行います。

Hours (System)
xxxxH
（xxxxは時間）

積算使用時間（リセット不可）を表示する。

Hours (Reset)
xxxxH
（xxxxは時間）

積算使用時間（リセット可）を表示する。

Reset
Execute/Cancel

Hours（Reset）表示を0にリセットする
（Executeで実行する）。

Network Reset
ネットワーク関連設定を
工場出荷状態に戻します。

Reset
Execute/Cancel

ネットワーク関連の設定を初期化する
（Executeで実行する）。

Fan Control
ファンの制御モードを設
定します。

Setting
Auto/Minimum/Off in Rec

ファンの制御モードを選択する。

VF Display Setting
ビューファインダーの表
示に関する設定を行いま
す。

Chara/Marker Brightness
5/4/3/2/1

ビューファインダーの映像に重畳するキャラク
ター、アイコン、マーカーの明るさを設定す
る。

Option
ソフトウェアオプション
の確認や操作を行います。

Type
オプションのモデル名

インストールされているオプションのモデル名
（PXWK-501、PXWK-502、PXWK-503）が1行
ごとに表示されます。

Install Option
Execute/Cancel

オプションのインストール画面を表示する
（Executeで実行する）。

Remove Option オプションのリムーブ画面を表示する。
Version
本機のバージョン表示お
よびバージョンアップを
実行します。

Number 本機のソフトウェアバージョンを表示する
（Vx.xx）。

Version Up
Execute/Cancel

UTILITY SDカードスロットを使用し、本機の
ソフトウェアをバージョンアップする
（Executeで実行する）。
以下のSDカードが使用できます。
• SDHCメモリーカード（Speed Class：4以
上/UHS非対応／容量：4～32 GB）

ご注意
バージョンアップデータのSDカードが挿入さ
れていないとき、またはMaintenanceメニュー
のNetwork Client Mode >SettingがOnのとき
は選択できません。

Net-Func Version Number 本機のワイヤレスLAN接続機能のバージョンを
表示する（Vx.xx）。

ご注意
OperationメニューのProxy Recording Mode 
>SettingがOff、かつMaintenanceメニューの
Network >SettingがOffのときは表示されませ
ん。
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太字で表示されている設定値は、出荷時の初期設定値です。

Version
本機のバージョン表示お
よびバージョンアップを
実行します。

Net-Func Ver.Up
Execute/Cancel

PROXY SDカードスロットを使用し、本機のワ
イヤレスLAN接続機能のソフトウェアをバー
ジョンアップする（Executeで実行する）。
以下のSDカードが使用できます。
• SDHCメモリーカード（Speed Class：4以
上/UHS非対応／容量：4～32 GB）

• SDXCメモリーカード（Speed Class：4以
上/UHS非対応／容量：64～256 GB）

ご注意
MaintenanceメニューのNetwork Client Mode 
>SettingがOnのときは選択できません。
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File

項目 細目と設定値 内容
User Menu Item
User Menu Itemの操作に
関する設定を行います。

Load SD Card User Menu Itemの設定をSDカードから呼び出
す画面を表示する。

Save SD Card User Menu Itemの設定をSDカードへ保存する
画面を表示する。

File ID User Menu ItemのFile ID表示と編集を行う画
面を表示する。

User File
ユーザーファイルの操作
に関する設定を行います。

Load SD Card ユーザーファイルの設定をSDカードから呼び
出す画面を表示する。

Save SD Card ユーザーファイルの設定をSDカードへ保存す
る画面を表示する。

File ID ユーザーファイルのFile ID表示と編集を行う画
面を表示する。

Recall User Preset
Execute/Cancel

Userメニューに登録されているメニュー項目
の値をプリセット値に戻す（Executeで実行）。

Store User Preset
Execute/Cancel

Userメニューに登録されているメニュー項目
の値をプリセット値として保存する（Execute
で実行）。

Clear User Preset
Execute/Cancel

Userメニューに登録されているメニュー項目
の現在の設定値およびプリセット値を工場出荷
値に戻す（Executeで実行）。

Load Customize Data
On/Off

［Load SD Card］の実行時にUserメニューの
構成カスタマイズ情報を読み込むかどうかを設
定する。

Load White Data
On/Off

［Load SD Card］の実行時にホワイトバランス
情報を読み込むかどうかを設定する。
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All File
ALLファイルの操作に関
する設定を行います。

Load SD Card All Fileの設定をSDカードから呼び出す画面を
表示する。

Save SD Card All Fileの設定をSDカードへ保存する画面を表
示する。

File ID All FileのFile ID表示と編集を行う画面を表示す
る。

All Preset
Execute/Cancel

すべての項目をプリセット値に戻す（Execute
で実行する）。

Store All Preset
Execute/Cancel

すべての項目について現在の設定値をプリセッ
ト値として保存する（Executeで実行する）。

Clear All Preset
Execute/Cancel

All Fileの対象のメニュー項目の現在の設定値お
よびプリセット値を工場出荷値に戻す
（Executeで実行する）。

3Sec Clear Preset
On/Off

MENU CANCEL/PRST/ESCAPEスイッチを
CANCEL/PRST側に3秒間押し上げたままにす
ると項目ごとに現在の設定値とプリセット値が
クリアされる機能をオン／オフする。

Scene File
シーンファイルの操作に
関する設定を行います。

Recall Internal Memory 内蔵メモリーからシーンファイルを呼び出す画
面を表示する。

Store Internal Memory 内蔵メモリーにシーンファイルを保存する画面
を表示する。

Load SD Card SDカードからシーンファイルを呼び出す画面
を表示する。

Save SD Card SDカードにシーンファイルを保存する画面を
表示する。

File ID シーンファイルのFile ID表示と編集を行う画面
を表示する。

Scene White Data
On/Off

シーンファイルを呼び出す場合に、シーンファ
イルのホワイトバランスデータを反映させるか
どうかを設定する。

Reference File
リファレンスファイルの
操作に関する設定を行い
ます。

Store Reference
Execute/Cancel

リファレンスファイルの対象メニュー項目の現
在の設定値をプリセット値に保存する
（Executeで実行）。

Clear Reference
Execute/Cancel

リファレンスファイルの対象メニュー項目の現
在の設定値およびプリセット値を工場出荷値に
戻す（Executeで実行）。

Load Reference(SD Card)
Execute/Cancel

SDカードからリファレンスファイル設定値を
呼び出し、プリセット値に設定する（Execute
で実行）。

Save Reference(SD Card)
Execute/Cancel

リファレンスファイルの対象メニュー項目のプ
リセット値をSDカードに保存する（Execute
で実行）。

File ID リファレンスファイルのFile ID表示と編集を行
う画面を表示する。

File

項目 細目と設定値 内容
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Lens File
レンズファイルの操作に
関する設定を行います。

Display Mode
Model Name/Lens ID

保存や呼び出し時に表示されるリストボックス
に表示する項目を選択する。

Recall Internal Memory 内蔵メモリーからレンズファイルを呼び出す画
面を表示する。

Store Internal Memory 内蔵メモリーにレンズファイルを保存する画面
を表示する。

Load SD Card SDカードからレンズファイルを呼び出す画面
を表示する。

Save SD Card SDカードにレンズファイルを保存する画面を
表示する。

File ID レンズファイルのFile ID表示と編集を行う画面
を表示する。

File Source 選択しているファイルの番号が表示される。
Clear Lens Offset

Execute/Cancel
レンズファイルをクリアする（Executeで実行
する）。

Lens Auto Recall
Off/On(Lens Name)/
On(Serial Number)

シリアル通信対応レンズ装着時に、該当するレ
ンズファイルを自動的に呼び出すかどうかを設
定する。

Lens Serial Number 装着されたシリアル通信対応レンズのシリアル
ナンバーが表示される（対応レンズのみ）。

Lens Name 装着されたシリアル通信対応レンズの機種名が
表示される（対応レンズのみ）。

Lens Manufacturer 装着されたシリアル通信対応レンズのメーカー
名が表示される（対応レンズのみ）。

Master V Modulation
－99～±0～＋99

レンズファイルに垂直方向のSAWシェーディ
ング補正値を設定する。

Lens Center H
－40～±0～+40

レンズファイルにセンターマーカーの水平位置
を設定する。

Lens Center V
－40～±0～+40

レンズファイルにセンターマーカーの垂直位置
を設定する。

R Flare
－99～±0～＋99

レンズファイルにRフレアレベルを設定する。

G Flare
－99～±0～＋99

レンズファイルにGフレアレベルを設定する。

B Flare
－99～±0～＋99

レンズファイルにBフレアレベルを設定する。

White Offset R
－99～±0～＋99

レンズファイルにレンズによるホワイトバラン
スオフセットのRch補正値を設定する。

White Offset B
－99～±0～＋99

レンズファイルにレンズによるホワイトバラン
スオフセットのBch補正値を設定する。

Shading Ch Select
Red/Green/Blue

ホワイトシェーディング補正の対象を選択す
る。

Shading H SAW
－99～±0～＋99

レンズファイルに水平方向のSAWホワイト
シェーディング補正値を設定する。

Shading H PARA
－99～±0～＋99

レンズファイルに水平方向のパラボラホワイト
シェーディング補正値を設定する。

Shading V SAW
－99～±0～＋99

レンズファイルに垂直方向のSAWホワイト
シェーディング補正値を設定する。

Shading V PARA
－99～±0～＋99

レンズファイルに垂直方向のパラボラホワイト
シェーディング補正値を設定する。

File

項目 細目と設定値 内容
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User Gamma
User Gammaに関する設
定を行います。

Current Settings ユーザーガンマファイルの現在の設定（ファイ
ル名）リスト画面を表示する。

Load SD Card User Gammaの設定をSDカードから呼び出す
画面を表示する。

Reset
1/2/3/4/5/All

設定をリセットするユーザーガンマファイルを
選択し、Executeで実行する。
Allを選択するとすべてのユーザーガンマファ
イルがリセットされる。

File

項目 細目と設定値 内容
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OperationメニューのAssignable Switchで、ASSIGN. 0～3スイッチ、ASSIGNABLE 4/5スイッ
チとCOLOR TEMP.ボタン、レンズのRETボタンに任意の機能を割り当てることができます。
工場出荷時には、それぞれ下表に示す機能が割り当てられています。

アサイナブルスイッチに機能を割り当てる

スイッチ／ボタン 機能 Assignable Switchの
設定

ASSIGN. 0スイッチ 未設定 Off

ASSIGN. 1スイッチ 未設定 Off

ASSIGN. 2スイッチ 未設定 Off

ASSIGN. 3スイッチ 未設定 Off

ASSIGNABLE 4スイッチ 未設定 Off

ASSIGNABLE 5スイッチ 未設定 Off

RETボタン レックレビュー（再生可能な場合） Lens RET

COLOR TEMP.ボタン ホワイトバランスを5600Kのプリセット値でホワ
イトバランス調整を行う

Color Temp SW 5600K

ASSIGN. 0スイッチに割り当て可能な機能

Assignable Switchの
設定

機能 電源再投入時の状態

Off 未設定 －
Marker すべてのマーカー表示をオン／オフする 設定を保持する
ATW Hold ATW（自動追尾ホワイトバランス）によるホワイトバ

ランス設定値を保持する
－

Picture Cache Rec ピクチャーキャッシュレックモードをオン／オフする 設定を保持する
Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
Zebra ゼブラ表示をオン／オフする 設定を保持しない
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
OK Mark OKマークを記録／削除する －
Clip Flag OK 記録または再生中のクリップに対してOKフラグを設定

／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラグを設定
／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP（Keep）フ
ラグを設定／解除する

設定を保持しない
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ご注意
ASSIGN. 2スイッチに機能を割り当てた直後と記録フォーマットの切り換え直後は、その時点のスイッチの
設定と本機の状態が一致しないことがあります。機能の割り当て後にASSIGN. 2スイッチを切り換えるか、
電源を再投入すると一致します。

ご注意
a)Picture Cache Recを割り当てると、メニューのOperation >Rec Functionは無効（グレー表示）になり、
設定できなくなります。

ASSIGN. 2スイッチに割り当て可能な機能

Assignable Switchの
設定

機能

Off 未設定
Front Mic ステレオマイク接続時、ステレオ／モノラルを切り換える
Marker すべてのマーカー表示をオン／オフする
Picture Cache Rec a) ピクチャーキャッシュレックモードをオン／オフする
Zebra ゼブラ表示をオン／オフする
Clip Continuous Rec クリップコンティニュアスレックモードをオン／オフする
Rec Source 記録する信号をカメラ画または外部入力に切り換える（記録／再生中に操作す

ると、記録／再生が終了してから切り換えが実行される）
Digital Extender ×2 画面拡大（2倍）機能をオン／オフする
Digital Extender ×3 画面拡大（3倍）機能をオン／オフする
Digital Extender ×4 画面拡大（4倍）機能をオン／オフする
TX Power Save ワイヤレス送信機のパワーセーブモードを切り換える

ASSIGN. 1/3スイッチ、ASSIGNABLE 4/5スイッチとCOLOR TEMP.
ボタンに割り当て可能な機能

Assignable Switchの
設定

機能 電源再投入時の状態

Off 未設定 －
Front Mic ステレオマイク接続時、ステレオ（オン）／モノラル

（オフ）を切り換える
設定を保持する

Marker すべてのマーカー表示をオン／オフする 設定を保持する
ATW ATW（自動追尾ホワイトバランス）モードをオン／オ

フする
設定を保持しない

ATW Hold ATWによるホワイトバランス設定値を保持する －
Turbo Gain Operation >Gain Switch >Gain Turboの設定に基づいて

ターボゲインを実行する
設定を保持しない

Rec Review レックレビューを実行する －
Rec 記録開始／停止を実行する －
Network Client Mode ネットワーククライアントモードをオン／オフする。 設定を保持する
Streaming ストリーミング伝送をオン／オフする。 設定を保持しない
Auto Upload(Proxy) プロキシファイルの自動転送のオン／オフを設定する

（<1>、<3>、COLOR TEMP.の設定時のみ表示する）
設定を保持する

Picture Cache Rec ピクチャーキャッシュレックモードをオン／オフする 設定を保持する
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Spotlight オートアイリスモードをスポットライトに設定／解除す
る

設定を保持する

Backlight オートアイリスモードをバックライトに設定／解除する 設定を保持する
VF Mode ビューファインダー画面の白黒（オン）／カラー（オ

フ）を切り換える
設定を保持する

Video Signal Monitor ビデオ信号モニター表示機能を切り換える 設定を保持する
Lens Info 被写界深度表示のオフ、メーター表示、フィート表示を

切り換える
設定を保持する

Zoom Tele/Wide シリアル通信対応レンズ使用時に、ASSIGNABLE 4に
Zoom Tele機能を、ASSIGNABLE 5にZoom Wide機能
をそれぞれ割り当てる（<4>、<5>の設定時のみ表示す
る）

ご注意
プロキシ単独記録中に割り当て設定を変更しないでくだ
さい。

－

Zoom Wide/Tele シリアル通信対応レンズ使用時に、ASSIGNABLE 4に
Zoom Wide機能を、ASSIGNABLE 5にZoom Tele機能
をそれぞれ割り当てる（<4>、<5>の設定時のみ表示す
る）

ご注意
プロキシ単独記録中に割り当て設定を変更しないでくだ
さい。

－

Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
Zebra ゼブラ表示をオン／オフする 設定を保持しない
Lens RET リターンビデオ信号を表示する

カメラエクステンションユニットを接続していない場合
は、レックレビュー（再生可能な場合）

－

Return Video リターン1ビデオ信号を表示する －
Return Video2 リターン2ビデオ信号を表示する －
Return Video3 リターン3ビデオ信号を表示する －
Return Video4 リターン4ビデオ信号を表示する －
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
OK Mark OKマークを記録／削除する －
Clip Flag OK 記録または再生中のクリップに対してOKフラグを設

定／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラグを設
定／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP（Keep）フラ
グを設定／解除する

設定を保持しない

Color Temp　SW 3200K ホワイトバランスを3200Kのプリセット値でホワイトバ
ランス調整を行う

設定を保持する

Color Temp　SW 4300K ホワイトバランスを4300Kのプリセット値でホワイトバ
ランス調整を行う

設定を保持する

Color Temp　SW 5600K ホワイトバランスを5600Kのプリセット値でホワイトバ
ランス調整を行う

設定を保持する

Color Temp　SW 6300K ホワイトバランスを6300Kのプリセット値でホワイトバ
ランス調整を行う

設定を保持する

Assignable Switchの
設定

機能 電源再投入時の状態
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Electrical CC ホワイトバランス調整値に対して電気的CCフィルター
を切り換える（3200K/4300K/5600K/6300K）機能
スイッチ／ボタンを押すたびに
3200Kt4300Kt 5600Kt6300Kと切り替わる
Menu設定で変更可能（Electrical CC<A><B><C> 
<D>で設定）

ご注意
メニューのMaintenance >White Filter >ND Filter 
C.TempがOnの場合は設定できません。
機能を割り当てたあとでND Filter C.TempをOnすると、
そのアサイナブルスイッチは機能しなくなります。

設定を保持する

CC5600K ホワイトバランス調整値に対して5600Kの電気的CC
フィルターをかける

設定を保持する

Clip Continuous Rec クリップコンティニュアスレックモードをオン／オフす
る

設定を保持しない

Slow & Quick Motion スロー＆クイックモーションをオン／オフする 設定を保持する
Slot Select スロットAとBの両方に記録メディアが装着されている

とき、使用する記録メディアを切り換える
－

Digital Extender ×2 画面拡大（2倍）機能をオン／オフする 設定を保持しない
Digital Extender ×3 画面拡大（3倍）機能をオン／オフする 設定を保持しない
Digital Extender ×4 画面拡大（4倍）機能をオン／オフする 設定を保持しない
Digital Extender
×2×3×4

画面拡大機能の倍率を切り換える
機能スイッチ／ボタンを押すたびにOff→2倍→3倍→
4倍→Offと切り替わる

設定を保持しない

TX Power Save ワイヤレス送信機のパワーセーブモードを切り換える 設定を保持しない
Proxy Rec Start/Stop プロキシ記録を開始／停止する 設定を保持しない
Proxy Recording Mode プロキシデータ記録機能をオン／オフする 設定を保持する

Assignable Switchの
設定

機能 電源再投入時の状態

レンズのRETボタンに割り当て可能な機能

Assignable Switchの
設定

機能 電源再投入時の状態

Off 未設定 －
Lens RET カメラエクステンションユニットを接続時またはHD 

SDI Return Inputの設定がEnableでSDI入力端子に適切
な信号を入力している時は、リターンビデオ信号を表示
する
それ以外の場合は、レックレビュー（再生可能な場合）

－

Return Video リターンビデオ信号を表示する －
Rec Review レックレビューを実行する －
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
Clip Flag OK 記録または再生中のクリップに対してOKフラグを設定

／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラグを設定
／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP（Keep）フラ
グを設定／解除する

設定を保持しない

Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
Digital Extender ×2 画面拡大（2倍）機能をオン／オフする 設定を保持しない
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Digital Extender ×3 画面拡大（3倍）機能をオン／オフする 設定を保持しない
Digital Extender ×4 画面拡大（4倍）機能をオン／オフする 設定を保持しない
Digital Extender
×2×3×4

画面拡大機能の倍率を切り換える
機能スイッチ／ボタンを押すたびにOff→2倍→3倍→
4倍→Offと切り替わる

設定を保持しない

Proxy Rec Start/Stop プロキシ記録を開始／停止する 設定を保持しない

Assignable Switchの
設定

機能 電源再投入時の状態
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セットアップメニューの設定内容は、本機
の内蔵メモリーまたはSDカードに保存する
ことができます。このデータを使って、適
切なセットアップ状態をすばやく再現でき
ます。
設定データは、次のように分類されて保存
されます。
ユーザーファイル：カスタマイズしたUser
メニューの設定項目と設定データを保
存します。SDカードに64個まで保存す
ることができます。このファイルを本
機のメモリーに読み込むことにより、
Userメニューをカスタマイズした状態
にセットアップすることができます。

User Menu Itemファイル：Userメニュー
の設定項目を保存します。SDカードに
64個まで保存することができます。

ALLファイル：全メニューの設定データを
保存します。SDカードに64個まで保存
することができます。

ご注意
機器固有のデータ（機器ごとに調整が必要な
シェーディングや出力レベルなど）は保存さ
れません。

シーンファイル：撮影シーンに合わせて設
定したペイント項目の設定値を保存し
ます。本機の内蔵メモリーに5個、SD
カードに64個まで保存することができ
ます。

リファレンスファイル：シーンファイルの
基準設定（File IDがStandard）の設定
値を保存します。本機の内蔵メモリー
とSDカードに1個ずつ保存することが
できます。

レンズファイル：レンズ固有の特性を補正
する設定データ（フレア、ホワイト
シェーディング、ホワイトバランス、
センターマーカー）を保存します。本
機の内蔵メモリーに32個、SDカードに
64個まで保存することができます。

ガンマファイル：ユーザーが作成したガン
マテーブルデータ（User Gamma Data 
File）を本機の内部メモリーに5個まで
保存することができます。

各ファイルに保存される設定値については、
「ユーザーデータに保存される項目」（228
ページ）をご覧ください。

7章 ユーザー設定データの保存と呼び出し

設定の保存と呼び出し
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あらかじめ、書き込み可能なSDカード（77
ページ参照）をUTILITY SDカードスロット
に挿入しておきます。

1 メニューのFile >User File >Save SD 
Cardを選択する。
ユーザーファイルの保存先画面が表示
されます。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo Fileの行にファイルを保存
することができます。File IDにFile IDが
記載されている行を選択すると、その
ファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

File IDを変更するには

1 メニューのFile >User File >File IDを
選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

1 メニューのFile >User File >Load SD 
Cardを選択する。
ユーザーファイル一覧画面が表示され
ます。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

ご注意
設定データを呼び出すと、本機は自動的に再起動
されます。

ユーザーファイルの保
存と呼び出し

ユーザーファイルを保存する

ユーザーファイルを呼び出す
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あらかじめ、書き込み可能なSDカード（77
ページ参照）をUTILITY SDカードスロット
に挿入しておきます。

1 メニューのFile >User Menu Item 
>Save SD Cardを選択する。
User Menu Itemファイルの保存先画面
が表示されます。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo Fileの行にファイルを保存
することができます。File IDにFile IDが
記載されている行を選択すると、その
ファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

File IDを変更するには

1 メニューのFile >User Menu Item 
>File IDを選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

1 メニューのFile >User Menu Item 
>Load SD Cardを選択する。
User Menu Itemファイル一覧画面が表
示されます。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

User Menu Itemファ
イルの保存と呼び出し

User Menu Itemファイルを保存
する

User Menu Itemファイルを呼び
出す
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あらかじめ、書き込み可能なSDカード（77
ページ参照）をUTILITY SDカードスロット
に挿入しておきます。

1 メニューのFile >All File >Save SD 
Cardを選択する。
ALLファイルの保存先画面が表示されま
す。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo Fileの行にファイルを保存
することができます。File IDにFile IDが
記載されている行を選択すると、その
ファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

ファイルの保存が実行されないときは
操作中または操作後に「File Access / NG」
が表示された場合、ファイルの保存はでき
ません。

File IDを変更するには

1 メニューのFile >All File >File IDを選
択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

1 メニューのFile >All File >Load SD 
Cardを選択する。
ALLファイル一覧画面が表示されます。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

ご注意
• SDカードからファイルを呼び出すと、本機内部
に保存されているデータは上書きされます。

• ファイルを保存した機器より古いバージョンの
機器では呼び出しをしないでください。故障の
原因となることがあります。

• 設定データを呼び出すと、本機は自動的に再起
動されます。

ファイルの呼び出しが実行されないと
きは
操作中または操作後に「File Access / NG」
が表示された場合、ファイルの呼び出しは
できません。

本書では、ユーザーが最初に設定／保存し
たセットアップメニューの設定内容を「プ
リセット値」と表記します。
ファイルを呼び出して本機をセットアップ
し、さらに設定変更を行った状態で元の
ファイルを上書き保存した場合でも、プリ
セット値を復活させることにより、ファイ
ルの内容をリセットすることができます。

1 メニューのFile >All File >All Presetを
選択する。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

ALLファイルの保存と
呼び出し

設定データをALLファイルとし
て保存する

設定データを呼び出す

現在の設定値をすべてプリセッ
ト値に戻す
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1 メニューのFile >All File >Store All 
Presetを選択する。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

1 メニューのFile >All File >Clear All 
Presetを選択する。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

ご注意
実行後、本機は自動的に再起動されます。

次のデータをシーンファイルに保存できま
す。
• Paintメニューを使用して設定した値
• 標準モードおよびECSモードでのシャッ
タースピードの設定

• ホワイトバランスのデータ
保存されるデータおよび呼び出される
データは、メニューのFile >Scene File 
>Scene White Dataの設定によって異なり
ます。

シーンファイルは本機の内蔵メモリーまた
はSDカードに保存することができます。
また保存したシーンファイルを呼び出すこ
ともできます。
あらかじめ、書き込み可能なSDカード（77
ページ参照）をUTILITY SDカードスロット
に挿入しておきます。

シーンファイルを内蔵メモリーに
保存するには

1 メニューのFile >Scene File >Store 
Internal Memoryを選択する。
シーンファイル一覧画面が表示されま
す。
File IDがStandardの保存先にはあらか
じめ標準設定が保存されています。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
選択した保存先にシーンファイルが上
書き保存されます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

現在の設定値をすべてプリセッ
ト値として保存する

現在のすべての設定値とプリ
セット値を工場出荷値に戻す

シーンファイルの保存
と呼び出し

シーンファイルを保存する



199

シーンファイルをSDカードに保存
するには

1 メニューのFile >Scene File >Save 
SD Cardを選択する。
シーンファイル保存先画面が表示され
ます。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo Fileの行にファイルを保存
することができます。File IDにFile IDが
記載されている行を選択すると、その
ファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

File IDを変更するには

1 メニューのFile >Scene File >File ID
を選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

シーンファイルを内蔵メモリーか
ら呼び出すには

1 メニューのFile >Scene File >Recall 
Internal Memoryを選択する。
シーンファイル一覧画面が表示されま
す。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

シーンファイルをSDカードから呼
び出すには

1 メニューのFile >Scene File >Load 
SD Cardを選択する。
シーンファイル一覧画面が表示されま
す。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

シーンファイルを呼び出す
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リファレンスファイルは本機の内蔵メモ
リーまたはSDカードに保存することができ
ます。
SDカードを使用する場合は、あらかじめ、
書き込み可能なSDカード（77ページ参照）
をUTILITY SDカードスロットに挿入してお
きます。

現在の設定値をプリセット値とし
て保存するには

1 メニューのFile >Reference File 
>Store Referenceを選択する。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

現在の設定値をプリセット値とし
てSDカードに保存するには

1 メニューのFile >Reference File 
>Save Reference(SD Card)を選択す
る。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

File IDを変更するには

1 メニューのFile >Reference File >File 
IDを選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

1 メニューのFile >Reference File 
>Load Reference(SD Card)を選択す
る。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

1 メニューのFile >Reference File 
>Clear Referenceを選択する。
確認画面が表示されます。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。

リファレンスファイル
の保存と呼び出し

リファレンスファイルを保存す
る

リファレンスファイルをSDカー
ドから呼び出す

現在のすべての設定値とプリ
セット値を工場出荷値に戻す
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あらかじめ、書き込み可能なSDカード（77
ページ参照）をUTILITY SDカードスロット
に挿入しておきます。

レンズファイルは、メニューのFile >Lens 
Fileで設定します。
以下のデータを設定し、レンズファイルと
して保存できます。

レンズファイルを内蔵メモリーに
保存するには

1 メニューのFile >Lens File >Store 
Internal Memoryを選択する。
レンズファイル一覧画面が表示されま
す。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo offsetの行にファイルを保
存することができます。File IDにFile ID
が記載されている行を選択すると、そ
のファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

レンズファイルをSDカードに保存
するには

1 メニューのFile >Lens File >Save SD 
Cardを選択する。
レンズファイル保存先画面が表示され
ます。

2 MENUつまみを回して保存先を選択
し、つまみを押す。
File IDがNo Fileの行にファイルを保存
することができます。File IDにFile IDが
記載されている行を選択すると、その
ファイルに上書きされます。
File IDは自動的に付けられますが、変
更することもできます。

3 MENUつまみを回して確認画面の
Executeを選択し、つまみを押す。

File IDを変更するには

1 メニューのFile >Lens File >File IDを
選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUつまみを回してDoneを選択
し、つまみを押す。
File IDの変更が完了します。

レンズファイルの保存
と呼び出し

レンズファイルを設定する

設定データ 細目
Vモジュレーションシェー
ディング補正値

M V Modulation

センターマーカーの位置 Lens Center H
Lens Center V

フレアレベル R Flare
G Flare
B Flare

ホワイトバランス補正値 White Offset R
White Offset B

ホワイトシェーディング補
正値

Shading Ch Select
Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

レンズファイルを保存する
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レンズファイルを内蔵メモリーか
ら呼び出すには

1 メニューのFile >Lens File >Recall 
Internal Memoryを選択する。
レンズファイル一覧画面が表示されま
す。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

レンズファイルをSDカードから呼
び出すには

1 メニューのFile >Lens File >Load SD 
Cardを選択する。
レンズファイル一覧画面が表示されま
す。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

シリアル通信対応レンズを使用していると
きは、レンズの設定に対応するレンズファ
イルを自動的に呼び出して、本機をセット
アップすることができます（Lens Auto 
Recall機能）。
Lens Auto Recall機能を使用するときは、
Fileメニューの >Lens File >Lens Auto 
Recallを以下のいずれかに設定します。
Off：機能を使用しない
On(Lens Name)：レンズ機種名に対応する
レンズファイルを呼び出す

On(Serial Number)：レンズ機種名とシリ
アル番号に対応するレンズファイルを
呼び出す（シリアル番号の通信が可能
なレンズの場合）

シリアル番号の通信に対応していないレン
ズを使用している場合は、On(Serial 
Number)の設定でも、レンズ機種名に対応
するレンズファイルを呼び出します。

レンズファイルを呼び出す レンズファイルを自動で呼び出
す
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1 メニューのFile >User Gamma 
>Current Settingsを選択する。
現在設定されているユーザーガンマ
ファイル一覧画面が表示されます。

1 メニューのFile >User Gamma >Load 
SD Cardを選択する。
ユーザーガンマファイル一覧画面が表
示されます。

2 MENUつまみを回して呼び出すファ
イルを選択し、つまみを押す。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

CvpFile EditorTM V4.3で作成し
たユーザーガンマファイルを使用
するには

作成したユーザーガンマファイルはSDカー
ドの「PRIVATE/SONY/PRO/CAMERA/
HD_CAM」ディレクトリーに保存して、呼
び出し操作を行ってください。

1 メニューのFile >User Gamma 
>Resetを選択する。
リセットするガンマファイルの番号画
面が表示されます。

2 MENUつまみを回してリセットする
ガンマファイルの番号（1～5）を選
択する。
すべてのガンマファイルをリセットす
る場合はAllを選択します。
確認画面が表示されます。

3 MENUつまみを回してExecuteを選
択し、つまみを押す。

ガンマファイルの確認
と呼び出し

ガンマファイルの現在の設定
（ファイル名）を確認する

SDカードからユーザーガンマ
ファイルを呼び出す

変更されたファイルの内容を初
期状態にリセットする
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本機は、リモートコントロールユニットRM-B170やリモートコントロールパネルRCP-1001/
1501などのコントロールユニットを使用して操作することもできます。コントロールユニッ
トの接続や操作については、「REMOTE端子を介して操作する」（97ページ）をご覧ください。

本機の出力信号を選択し、接続するモニターに応じた接続ケーブルを使用してください。

HD信号／SD信号を問わず、外部モニター
にビューファインダー画面と同様の各種ス
テータス情報やメニューなどを表示させる
ことができます。

ご注意
SD信号のダウンコンバート出力は、メニューの
Operation >Input/Output >Output Formatの設定
が720x486i 720x576iのときに行うことができま
す。

8章 外部機器の接続

外部モニターを接続する

BNCケーブル（別売）

BNCケーブル
（別売）
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SDI OUT端子（BNC型）

SDI OUT端子には、SDI対応のモニター、
スイッチャーやVTRなどの記録装置を接続
することができます。
本端子からの出力信号は、メニューの
Operation >Input/Output >SDI Out1 

Output/SDI Out2 Output（155ページ参照）
でオン／オフすることができます。
接続には、別売のBNCケーブルを使用しま
す。

VIDEO OUT端子

VIDEO OUT端子には、アナログコンポジッ
ト対応のモニターやVTRなどの記録装置を
接続することができます。
出力信号は、メニューのOperation >Input/
Output >Output Formatの設定に連動して
変わります。
アナログコンポジット対応機器に信号を入
力するには、必要に応じて、VIDEO OUT端
子からのアナログコンポジット信号の設定
に合わせて、アナログコンポジット対応機
器側の入力信号設定を変更します。
モニターやVTRなどの記録装置に音声を入
力する場合は、AUDIO OUT端子からの音声
出力とモニターやVTR側のオーディオ入力
を接続します。
接続には、別売のBNCケーブルを使用しま
す。

HDMI OUT端子（Type Aコネク
ター）

本端子からの出力信号は、メニューの
Operation >Input/Output >HDMI Outputで
オン／オフすることができます。
出力信号のフォーマットは、メニューの
Operation >Input/Output >Output Format

で設定します。
接続には、市販のHDMI接続ケーブルを使用
します。

本機でSxSメモリーカードに記録したク
リップを、コンピューター上で管理したり、
別売のノンリニア編集ソフトで編集するこ
とができます。
SxSメモリーカードをコンピューターに直
接装着したり、SxSメモリーカードUSB
リーダー／ライター SBAC-US30（別売）
をコンピューターに接続して、本機で記録
したクリップを管理・編集する方法を説明
します。
また外部機器接続端子にポータブルスト
レージ／USBメディアを接続すれば、SxS
メモリーカード内のクリップをポータブル
ストレージ／USBメディアにコピーするこ
とができます。

ExpressCard/34またはExpressCard/54ス
ロットがあるコンピューターの場合は、本
機でクリップを記録したSxSメモリーカー
ドを直接挿入して、ファイルにアクセスす
ることができます。

ご注意
• SxSデバイスドライバーソフトウェアをダウン
ロードしてインストールする必要があります。
ソフトウェアのダウンロードについては、「ソ
フトウェアのダウンロードについて」（12ペー
ジ）をご覧ください。

• すべてのパソコンについて、動作を保証するも
のではありません。
◆SxSデバイスドライバーソフトウェアのサ
ポート関連情報については、下記URLをご
覧ください。

http://www.sony.net/SxS-Support/

コンピューターでク
リップを管理・編集す
る

コンピューターのExpressCard
スロットを使う
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Windowsの場合
マイコンピューターにリムーバブルディス
クが追加されていることを確認してくださ
い。追加されていれば正常に動作していま
す。

Macintoshの場合
メニューバーにアイコンが表示されます。

SxSメモリーカードを取り外すに
は

Windowsの場合

1 コンピューターのタスクバーに表示さ
れている「ハードウェアの取り外しま
たは取り出し」アイコンをクリックす
る。

2 表示されたメニューから「SxS 
Memory Card －ドライブ（X:）を安
全に取り外します」を選択する。

3 安全に取り外すことができることを
知らせるメッセージが表示されたら、
カードを抜く。

Macintoshの場合
デスクトップにあるSxSメモリーカードの
アイコンを「ゴミ箱」（イジェクトアイコ
ン）にドラッグします。
ファインダー上にSxSメモリーカードのア
イコンがある場合は、横のイジェクトアイ
コンをクリックしてください。

準備

本機を別売のUSBケーブルを使ってコン
ピューターに接続すると、スロットに装着
されたメモリーカードがコンピューターの
拡張ドライブとして認識されます。
本機の場合、2枚のメモリーカードが挿入さ
れているときは、コンピューターでは2つの
ドライブとして認識されます。

ご注意
• 本機の電源をオンにして、画面に映像や情報が
表示されてから、本機にUSBケーブルを接続し
てください。

• コンピューターに接続するときは、USBコネク
ターの形と向きに注意してください。

• 本機はコンピューターからのバスパワーでは動
作しません。

USB接続を開始するには

PC接続端子とコンピューターを別売のUSB
ケーブルを使って接続したとき、USB接続
を有効にするか、無効にするかを確認する
「Connect USB Now?」のメッセージが表示
されます。

SxS PRO   8
GB

ExpressCard
スロットへ

SxSメモリーカード SxSデバイスドライバー
ソフトウェアを
インストールした
コンピューター

コンピューターとUSB接続する

USBケーブル
（別売）
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「Cancel」を選択したり、MENU CANCEL/
PRST/ESCAPEスイッチをESCAPE側に押
し下げた場合、またはUSBケーブルを抜い
た場合は、「Connect USB Now?」のメッ
セージが消え、元の画面に戻ります。
「Execute」を選択し、MENUつまみを押す
と、USB接続が有効になり、本機はコン
ピューターの拡張ドライブとして認識され
ます。
記録／再生動作中にUSB接続を許可した場
合は、動作を停止し「USB Connecting
（USB接続中）」をビューファインダー画面
に表示します。
このとき、VIDEO OUT端子、SDI OUT 1/2
端子からの出力信号は黒画となります。

ご注意
• USB接続中は、本機で記録／再生などの操作は
できません。

• コンピューターから本機の記録メディアにアク
セス（読み書き）しているときは以下の操作を
行わないでください。
- 本機の操作（電源のオン／オフ、モード切り
換えなど）

- アクセス中の記録メディアを抜き差し
- USB接続ケーブルの抜き差し

USB接続の解除方法
USB接続の解除は、コンピューターのデバ
イス取り外し手順に従って操作します。
USBを再接続するときは、一度USBケーブ
ルを抜いたあとに再度接続してください。
再び「Connect USB Now?」のメッセージ
が表示されます。

SxSメモリーカードを取り外すに
は

Windowsの場合

1 コンピューターのタスクバーに表示さ
れている「ハードウェアの取り外しま
たは取り出し」アイコンをクリックす
る。

2 表示されたメニューから「SxS 
Memory Card －ドライブ（X:）を安
全に取り外します」を選択する。

3 安全に取り外すことができることを
知らせるメッセージが表示されたら、
カードを抜く。

Macintoshの場合
デスクトップにあるSxSメモリーカードの
アイコンを「ゴミ箱」（イジェクトアイコ
ン）にドラッグします。
ファインダー上にSxSメモリーカードのア
イコンがある場合は、横のイジェクトアイ
コンをクリックしてください。

アプリケーションソフトウェアを
使うには

コンピューターのローカルディスクにク
リップをコピーする場合などは、専用のア
プリケーションソフトウェアをダウンロー
ドし、インストールして使用します。ソフ
トウェアのダウンロードについては、「ソフ
トウェアのダウンロードについて」（12ペー
ジ）をご覧ください。
記録した素材は、情報が複数のファイル、
複数のフォルダーにまたがって置かれてい
ますが、専用アプリケーションソフトウェ
アでは、これらの情報やディレクトリー構
造を、ユーザーが意識することなく、容易
に扱えるようになっています。

ご注意
Explorer（Windows環境）やFinder（Mac環境）
を使用して、SxSメモリーカード内のクリップの
コピーなどを行うと、クリップが持つ情報を保持
できなくなることがあります。
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ノンリニア編集システムを使うに
は

ノンリニア編集システムには、本機で記録
したフォーマットに対応した編集ソフト
ウェア（別売）が必要です。
付属の専用アプリケーションソフトウェア
を使って、あらかじめコンピューターの
HDDに編集したいクリップを保存しておき
ます。
使用する編集ソフトによっては正しく動作
しない場合があります。ご使用になる前に、
必ず本機で記録したフォーマットに対応す
ることをご確認ください。

本機の外部機器接続端子にポータブルスト
レージやUSBメディアを接続しているとき
は、SxSカードスロットに挿入されている
記録メディアのクリップをポータブルスト
レージやUSBメディアにコピーすることが
できます。

1 メニューのOperation >USB >Select 
Folderでクリップのコピー先フォル
ダーを指定する。
画面のNewを選択して、新しいフォル
ダーを任意に作成することもできます。

ご注意
フォルダーを指定しない場合は、コピーする
クリップの先頭クリップの撮影日時をフォル
ダー名とするフォルダーが自動的に作成さ
れ、クリップはそのフォルダーにコピーされ
ます。

2 メニューのOperation >USB >Copy 
to USBを選択する。

3 画面からコピー対象の記録メディア
が挿入されているスロットを選択す
る。
Media(A) to USB：スロットAに挿入さ
れている記録メディアのすべての

クリップをUSBメディアにコピー
する。

Media(B) to USB：スロットBに挿入さ
れている記録メディアのすべての
クリップをUSBメディアにコピー
する。

Media(A)(B) to USB：スロットA、お
よびスロットBに挿入されている記
録メディアのすべてのクリップを
USBメディアにコピーする。

ご注意
手順1でコピー先フォルダーを指定して、
Media(A)(B) to USBを選択した場合、スロッ
トAのクリップは、指定先のフォルダーにコ
ピーされます。スロットBのクリップは、ク
リップの先頭クリップの撮影日時をフォル
ダー名として自動的に作成されるフォルダー
にコピーされます。

4 MENUつまみを回してExecuteを選
択し、つまみを押す。
対象の記録メディアのクリップがすべ
てUSBメディアにコピーされます。

ご注意
コピーするクリップと同じファイル名のク
リップがコピー先フォルダーに既存の場合、
そのクリップはコピーされません。

ポータブルストレージ／USBメ
ディア内のクリップを一覧表示す
る

メニューのOperation >USB >View Clip List
でポータブルストレージ／USBメディア内
のクリップを一覧表示することができます。

ポータブルストレージ／USBメ
ディア内のフォルダー名を変更す
る

メニューのOperation >USB >Rename 
Folderでフォルダー名を変更することがで
きます。

ポータブルストレージ／USBメ
ディアを接続する
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1 メニューのOperation >USB 
>Rename Folderを選択する。

2 変更するフォルダーを選択し、SET
ボタンを押す。
ファイル名の入力画面が表示されます。

3 フォルダー名を入力し、画面のDone
を選択する。
フォルダー名が変更されます。

コピーのリードチェックエラーを
行う

メニューのOperation >USB >Error Check
をOnにすると、クリップの書き込み後、
リードチェックエラーを行うことができま
す。

ポータブルストレージ／USBメ
ディアを初期化する

メニューのOperation >USB >Format USB
でポータブルストレージ／USBメディアを
初期化（exFATでフォーマット）すること
ができます。

1 メニューのOperation >USB >Format 
USBを選択する。

2 MENUつまみを回してExecuteを選
択し、つまみを押す。
初期化（フォーマット）が開始されま
す。

3 初期化完了のメッセージが表示され
たら、画面のOKを選択する。

ポータブルストレージ／USBメ
ディアの空き容量を確認する

ポータブルストレージ／USBメディアの空
き容量は、メニューのOperation >USBを選
択したときに表示される画面のMedia 
Remainの行にGB単位で表示されます。

ポータブルストレージ／USBメ
ディアへの電源供給について

外部機器出力端子からポータブルストレー
ジ／USBメディアへの電源供給は、メ
ニューのOperation >USBのメニュー操作を
行うと自動的に開始されます。
ただし、以下の表に示す状態ではメニュー
のOperation >USBのメニュー操作を行って
も、電源供給は開始されません。電源供給
を開始するには、表に示す対策を行ってく
ださい。

ご注意
• ポータブルストレージやUSBメディアのクリッ
プをSxSカードスロットに挿入されている記録
メディアにコピーすることはできません。

• 外部機器出力端子への電源供給中は、クリップ
記録はできません。クリップ記録を開始する場
合は、メニューのOperation >USBのメニュー
操作を終了してください。

状態 対策
クリップ記録中、再生
中、サムネイル表示中、
プロキシ記録中、スト
リーミング中、プロキ
シ転送中、本線転送
モード中

左記操作を終了する。

Network Client Modeが
On

Network Client Modeを
Offにする。

カメラアダプター接続
中

カメラアダプターの接
続を解除する。
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本機にHDカメラアダプター CA-FB70/TX70をマウントしてCCU（Camera Control Unit）と接
続することができます。
これにより、複数のカムコーダーやカメラエクステンションユニット、リモートコントロール
ユニットと撮影／収録システムを構成することができます。
◆CA-FB70およびCA-TX70について詳しくは、それぞれの取扱説明書をご覧ください。

ご注意
• 本機をこのシステムで使う場合、本機にビデオライトを接続しないでください。
• XAVC、MPEG HD記録にのみ対応しています。
• プロキシ記録、ワイヤレスLAN接続機能には対応していません。

システムを構築したときのタリーやコール表示を示します。

ご注意
カメラアダプター CA-FB70/TX70を接続中は、警告表示に記載しているタリーランプによるアラーム表示
は行いません。

撮影／収録システムを構成する

タリーとコールの表示

システムからの受信データ HDVFの LED表示 ビューファインダー画面内キャラク
ターによる表示

Tally Green 

Tally
CAの
Call

CA以外
の Call

REC/

TALLY 

LED

GREEN 

TALLY 

LED

“●”
(赤 )表示

“●”
(緑 )表示

“CALL”表示

OFF OFF OFF OFF 消灯 消灯 非表示 非表示 非表示
OFF OFF OFF ON 点灯 消灯 “●”(赤) 非表示 “CALL”(赤)
OFF OFF ON OFF 消灯 消灯 非表示 非表示 “CALL”(赤)
OFF OFF ON ON 点灯 消灯 “●”(赤) 非表示 “CALL”(赤)
OFF ON OFF OFF 消灯 点灯 非表示 “●”(緑) 非表示
OFF ON OFF ON 点灯 点灯 “●”(赤) “●”(緑) “CALL”(赤)
OFF ON ON OFF 消灯 点灯 非表示 “●”(緑) “CALL”(赤)
OFF ON ON ON 点灯 点灯 “●”(赤) “●”(緑) “CALL”(赤)
ON OFF OFF OFF 点灯 消灯 “●”(赤) 非表示 非表示
ON OFF OFF ON 消灯 消灯 非表示 非表示 “CALL”(赤)
ON OFF ON OFF 点灯 消灯 “●”(赤) 非表示 “CALL”(赤)
ON OFF ON ON 消灯 消灯 非表示 非表示 “CALL”(赤)
ON ON OFF OFF 点灯 点灯 “●”(赤) “●”(緑) 非表示
ON ON OFF ON 消灯 点灯 非表示 “●”(緑) “CALL”(赤)
ON ON ON OFF 点灯 点灯 “●”(赤) “●”(緑) “CALL”(赤)
ON ON ON ON 消灯 点灯 非表示 “●”(緑) “CALL”(赤)
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撮影／収録システム構成時の対応フォーマットと動作制限

本機とカメラアダプター、カメラコントロールユニットを接続して撮影／収録システムを構成
する場合の対応フォーマット、および動作制限を下表に示します。

メニューの Operation カメラアダプター／
カメラコントロール
ユニットのシステム
フォーマット

カムコーダー
の動作制限

Format Input / Output リターン
ビデオの
表示

Frequency Rec Format Output Format
SDI

59.94 XAVC-I 1080P 1920×1080i 1920×1080 59.94i ×
XAVC-L 50 1080P

XAVC-L 35 1080P

XAVC-I 1080i 1920×1080i 1920×1080 59.94i ○
XAVC-L 50 1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920×1080i

HQ 1440×1080i

SP 1440×1080i
XAVC-I 720P 1280×720P 1280×720 59.94P ○
XAVC-L 50 720P

HD422 50 720P

HQ 1280×720P
29.97 XAVC-I 1080P 1920×1080PsF 1920×1080 29.97PsF a)

1920×1080 59.94i
○

XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 59.94P ×

23.98 XAVC-I 1080P 1920×1080i 
(2-3PD)

1920×1080 59.94i ×
XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P
HD422 50 720P 1280×720P 

(2-3PD)
1280×720 59.94P ×
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a)カメラアダプタCA-TX70接続時はPsF設定を推奨します。

ご注意
撮影／収録システム構成時はプロキシ記録、ワイヤレスLAN接続機能、およびスロー＆クイッ
クモーションなどの特殊記録機能を同時に使用することはできません。

50 XAVC-I 1080P 1920×1080i 1920×1080 50i ×
XAVC-L 50 1080P

XAVC-L 35 1080P

XAVC-I 1080i 1920×1080i 1920×1080 50i ○
XAVC-L 50 1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920×1080i

HQ 1440×1080i

SP 1440×1080i
XAVC-I 720P 1280×720P 1280×720 50P ○
XAVC-L 50 720P

HD422 50 720P

HQ 1280×720P
25 XAVC-I 1080P 1920×1080PsF 1920×1080 25PsF a)

1920×1080 50i
○

XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 50P ×

メニューの Operation カメラアダプター／
カメラコントロール
ユニットのシステム
フォーマット

カムコーダー
の動作制限

Format Input / Output リターン
ビデオの
表示

Frequency Rec Format Output Format
SDI
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本機のSDI IN端子に接続した機器からのSDI
信号を記録およびリターン表示することが
できます。

カメラ画の代わりに入力信号を出力／記録
するには、メニューのOperation >Input/
Output >Source SelectをExternalに設定し
ます。
HD SDIリターン信号を受け付けるには、メ
ニューのOperation >Input/Output >HD SDI 
Return InputをEnableに設定します。
対応するフォーマットについては、（214
ページ）を参照してください。

ご注意
• 外部入力信号を、スロー＆クイックモーション
モードで記録することはできません。スロー＆
クイックモーションのいずれかの記録モードを
選択しているときに、メニューのOperation 
>Input/Output >Source SelectをExternalに設
定すると、上記の記録モードは解除されます。

• オートブラックバランスなどの自動調整機能の
実行中や、再生／レックレビュー／サムネイル
表示中にメニューのOperation >Input/Output 
>Source SelectをExternalに設定すると、実行
中の調整および操作が終了し、本機が停止状態
になってからカメラ画を外部入力に切り換えま
す。

• 外部入力の記録中に入力信号が乱れたときに
は、記録が停止する場合があります。入力信号
が正常に戻ると、記録は自動で再開します。

• プロキシ記録、ワイヤレスLAN接続機能には対
応していません。

外部入力信号の記録と
リターン表示
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外部入力可能信号フォーマットおよびリターン表示可能フォーマットと本
機の記録フォーマットの関係

HD/

SD
メニューの
Operation 

>Format 

>Rec Format

の設定

メニューの
Operation 

>For.mat 

>Frequency

の設定

外部入力が可能な
信号フォーマット

外部入力が可能な HD SDI

リターン信号フォーマット

HD XAVC-I 
1080P

59.94 HD 1920×1080 59.94P Level-A
HD 1920×1080 59.94P Level-B

－

50 HD 1920×1080 50P Level-A
HD 1920×1080 50P Level-B

－

XAVC-I 
1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i

XAVC-I 
720P

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1280×720 50P

XAVC-L 50 
1080P

59.94 HD 1920×1080 59.94P Level-A
HD 1920×1080 59.94P Level-B

－

50 HD 1920×1080 50P Level-A
HD 1920×1080 50P Level-B

－

XAVC-L 50 
1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i

XAVC-L 50 
720P

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1280×720 50P

HD422 50 
1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i

HD422 50 
720P

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1280×720 50P

HQ 
1920×1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i

HQ 
1440×1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i
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HD SP 
1440×1080i

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1920×1080 29.97PsF/59.94i

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1920×1080 25PsF/50i

HD HQ 
1280×720P

59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD 1280×720 50P

SD MPEG IMX 50 59.94 SD 486 59.94i －
50 SD 576 50i －

DVCAM 59.94 SD 486 59.94i －
50 SD 576 50i －

HD/

SD
メニューの
Operation 

>Format 

>Rec Format

の設定

メニューの
Operation 

>For.mat 

>Frequency

の設定

外部入力が可能な
信号フォーマット

外部入力が可能な HD SDI

リターン信号フォーマット
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撮影に出発する前に点検を行い、システム
が正常に動作することを確認してください。
実際に記録／再生を行って映像や音声の
チェックをすることをおすすめします。

筒部内のCRTスクリーンやミラーの表面か
らほこりを除去するには、ブロアーをお使
いください。
レンズとプロテクトフィルターのクリーニ
ングには、市販のレンズクリーナーをお使
いください。

ご注意
シンナーなどの溶剤は一切使わないでください。

アイピース部を分解するには
（HDVF-20Aの例）

9章 保守・点検

撮影前の点検 保守

ビューファインダーをクリーニ
ングする

1筒部
2アイカップホルダー
3プロテクトフィルター
4パッキング
5アイカップ
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1 ビューファインダーの筒部からアイ
ピース部を取り外す。
◆取り外しかたについては、「 アイピース
部を取り外す」 （39ページ）をご覧く
ださい。

2 アイカップホルダーからアイカップ
を外す。

3 アイカップホルダー内から、プロテ
クトフィルターをパッキングごと外
す。

4 パッキングからプロテクトフィル
ターを外す。

防曇フィルターについて

撮影場所の温湿度条件によっては、呼吸や
水蒸気によってプロテクトフィルターが曇
り、ビューファインダー内が見にくくなる
ことがあります。プロテクトフィルターの
代わりに、別売の防曇フィルター（サービ
スパーツ番号：1-547-341-11）を使用する
と、くもりの発生を防ぐことができます。

防曇フィルターを取り付けるには

プロテクトフィルターをパッキングリング
から外し、代わりに防曇フィルターをパッ
キングリングにはめ込みます。
アイピース部の防滴性を損なわないように、
防曇フィルター、パッキングリングおよび
アイカップは確実に組み立ててください。

ご注意
防曇フィルターをクリーニングする際は、防曇効
果を損なわないように、柔らかい布でから拭きし
てください。

機器に搭載されているバッテリー端子
（バッテリーパックやACアダプターとの接
点部分）は消耗品です。 
振動や衝撃によって端子が変形したり、曲
がったり、あるいは長期の屋外での使用な
どによって表面が腐食したりすると、本体
に電源が供給されなくなります。
長期間機器を使用していただくために、定
期点検を実施することをお願いします。点
検につきましては、ソニーのサービス担当
者または営業担当者にご相談ください。

バッテリー端子に関するご注意
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本機では警告、注意、動作確認が必要な状況を、ビューファインダー画面のメッセージ表示、各
種ランプの点滅、および警告音でお知らせします。
警告音の音量はALARMつまみで調整できます。ALARMつまみを最小にすると、警告音は聞こ
えなくなります。

次のような表示が出た場合は、本機は動作を停止します。

次のような表示が出た場合は、メッセージに従って対策してください。

エラー／警告システム

エラー表示

エラーメッセージ 警告音
WARNING
ランプ

タリー／
RECランプ 原因と対策

E＋エラーコード 連続音 ― 高速点滅 本機の異常の可能性があり
ます。
電源を切り、接続している
機器やケーブル類、メディ
アに異常がないか確認して
ください。
（POWERスイッチをOFF
にしても電源が切れない場
合は、バッテリーパックま
たはAC電源を外してくだ
さい。）
再度電源を入れてもエラー
が継続する場合は、ソニー
のサービス担当者にご連絡
ください。

警告表示

警告メッセージ 警告音
WARNING
ランプ

タリー／
RECランプ 原因と対策

メディア残量がわずかです
Media Near Full

断続音 点滅 点滅 SxSメモリーカードの残量
が少なくなっています。
早い機会に交換してくださ
い。

メディア残量がありません
Media Full

連続音 点灯 高速点滅 SxSメモリーカードの残量
がないため、記録、コ
ピー、クリップ分割はでき
ません。
交換してください。

バッテリー残量がわずかです
Battery Near End

断続音 点滅 点滅 バッテリーパックの残量が
少なくなっています。
早い機会に充電してくださ
い。
（ビューファインダー画面
のバッテリー表示も点滅し
ます。）
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バッテリー残量がありません
Battery End

連続音 点灯 高速点滅 バッテリーパックが消耗し
ました。
記録はできません。
DC INに電源をつなぐか、
いったん操作を中止し、
バッテリーパックを充電し
てください。
（ビューファインダー画面
のバッテリー表示も点滅し
ます。）

警告温度になりました
Temperature High

断続音 点滅 点滅 内部温度が上昇しました。
いったん電源を切り、温度
が下がるまで使用を中止し
てください。

電源電圧が低下しています
Voltage Low

断続音 点滅 点滅 DC IN電圧が低くなってい
ます（段階1）。
供給電源を確認してくださ
い。

電源電圧が不足しています
Insufficient Voltage

連続音 点灯 高速点滅 DC IN電圧が低すぎます
（段階2）。
記録はできません。
他の電源に接続し直してく
ださい。
（ビューファインダー画面
のバッテリー表示も点滅し
ます。）

クリップ数が上限です
Clips Full

連続音 点灯 高速点滅 SxSメモリーカードに記録
できるクリップ数の上限に
達しました。これ以上記録
やコピーはできません。交
換してください。

最終クリップ記録中
Last Clip Recording

断続音 点滅 点滅 記録中のクリップの記録を
完了すると、記録可能なク
リップ数の上限に達しま
す。
新しいSxSメモリーカード
をご用意ください。

クリップ数上限近くです
Clips Near Full

断続音 点滅 点滅 SxSメモリーカードに記録
できる残りのクリップ数が
少なくなっています。
早い機会に交換してくださ
い。

Media(Proxy)残量なし
Media(Proxy) Full

連続音 点灯 高速点滅 プロキシデータ記録用SD
カードの残量がないため、
プロキシデータ記録はでき
ません。交換してくださ
い。

Proxyクリップ数が上限です
Clips(Proxy) Full

連続音 点灯 高速点滅 プロキシデータ記録用SD
カードに記録できるクリッ
プ数の上限に達しました。
これ以上記録はできませ
ん。交換してください。

Media(Proxy)残量わずか
Media(Proxy) Near Full

断続音 点滅 点滅 プロキシデータ記録用SD
カードの残量が少なくなっ
ています。
早い機会に交換してくださ
い。

警告メッセージ 警告音
WARNING
ランプ

タリー／
RECランプ 原因と対策
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1)スロットBに入れたカードの場合は(B)

画面中央部分に次のような注意・動作確認表示が現れることがあります。この場合は次表に従っ
て対処してください。

Proxy最終クリップ記録中
Last Clip(Proxy) Rec

断続音 点滅 点滅 記録中のプロキシデータの
記録を完了すると、記録可
能なクリップ数の上限に達
します。
新しいプロキシデータ記録
用SDカードをご用意くだ
さい。

Proxyクリップ数上限近く
Clips(Proxy) Near Full

断続音 点滅 点滅 プロキシデータ記録用SD
カードに記録できる残りの
クリップ数が少なくなって
います。早い機会に交換し
てください。

Media(A)1)残量がありません
Media(A)1) Full

連続音 点灯 高速点滅 同時記録機能使用時

Media(A)1) クリップ数上限
Media(A)1) Clips Full

連続音 点灯 高速点滅 同時記録機能使用時

Media(A)1)残量がわずかです
Media(A)1) Near Full

断続音 点滅 点滅 同時記録機能使用時

Media(A)1) 最終Clip記録中
Media(A)1) Last Clip Rec

断続音 点滅 点滅 同時記録機能使用時

注意・動作確認表示

表示内容 原因と対策
このバッテリーは使用できません
交換してください
Battery Error
Please Change Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

バックアップ電池残量がありません
交換してください
Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を交換してください。

メディア(A)1)は使用できません
交換してください
Unknown Media(A)1)

Please Change

• パーテーションが切られているメモリーカードや、本機で扱
えるクリップ数を超えて記録されたメモリーカードが挿入さ
れました。

• ファイルシステムがFATのときにSxSカードを挿入しました。
• ファイルシステムがexFATまたはUDFのときにSDHCカード
を挿入しました。

本機では使用できませんので、交換してください。
メディアエラーが発生しました
メディア(A)1)は修復が必要です
Media Error
Media(A)1) Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態になりまし
た。
メモリーカードを一度抜いてから再挿入して、カードの修復を
行ってください。

メディアエラーが発生しました
メディア(A)1)は記録できません
Media Error
Cannot Record to Media(A)1)

メモリーカードが故障して、記録ができなくなりました。
再生は可能ですので、コピーを取るなどして、新しいメモリー
カードに交換することをお勧めします。

警告メッセージ 警告音
WARNING
ランプ

タリー／
RECランプ 原因と対策
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1)スロットBに入れたカードの場合は(B)

メディアエラーが発生しました
メディア(A)1)は使用できません
Media Error
Cannot Use Media(A)1)

メモリーカードが故障して記録も再生もできなくなりました。
本機では扱えませんので、他のカードに交換してください。

メディア(A)1)は使用できません
ファイルシステムが異なります
Cannot Use Media(A)1)

Unsupported File System

ファイルシステムの異なるカードまたはフォーマットされてい
ないカードが挿入されました。
本機では使用できませんので、交換または本機でフォーマット
してください。

メディア(A)1)にエラーが発生しました。
再生を停止しました
Media(A)1) Error
Playback Halted

メモリーカードからの読み出しにエラーが発生したため、再生
を続けられません。
頻繁に起きる場合には、コピーを取るなどをして、メモリー
カードを交換してください。

メディア(A)1)にエラーが発生しました
Media(A)1) Error

メモリーカードに異常が発生したため、記録できません。
頻繁に起きる場合には、メモリーカードを交換してください。

異なるメディアが挿入されました
メディア(A)1)は使用できません
Different Media is Inserted
Cannot Use Media(A)1)

異なる種類のカードが挿入されました。後から挿入したカード
を前に挿入したカードと同じ種類のカードに交換してくださ
い。

表示内容 原因と対策
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ボタン、スイッチ、つまみなどを操作したときに表示されるメッセージとその意味を以下に示
します。

ご注意
• 操作と発生原因が一致したときに表示されるメッセージだけを記載しています。
• メニュー項目が選択できない状態（グレーアウト状態）で操作を行ったときに表示されるメッセージは
記載していません。

付録

操作時に表示されるメッセージ

操作 メッセージ メッセージの意味／発生要因
RECボタンを押したとき Media not exist SxSカードスロットに記録メディアが挿入されていな

いため記録ができない。
Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

プロキシデータ記録モードはOnに設定されている
が、プロキシ記録用SDカードが挿入されていないた
めプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy) Error

プロキシ記録用SDカードのメディア異常により書き
込みができないためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy): Write 
Protected

プロキシ記録用SDカードが書き込み禁止のためプロ
キシデータが記録できない。

Media(Proxy)
Cannot Record
NG: Preparing

プロキシデータ記録回路が準備完了前のためプロキ
シデータが記録できない。

Proxy Rec Start/Stopを割
り当てたアサイナブルス
イッチを操作したとき

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

プロキシ記録用SDカードが挿入されていないためプ
ロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy) Error

プロキシ記録用SDカードのメディア異常により書き
込みができないためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy): Write 
Protected

プロキシ記録用SDカードが書き込み禁止のためプロ
キシデータが記録できない。

Media(Proxy)
Cannot Record
NG: Preparing

プロキシデータ記録回路が準備完了前のためプロキ
シデータが記録できない。

PREVボタンを押したとき First Clip Top! 再生開始位置が先頭クリップの先頭フレームにある
ため実行できない。

F REVボタンを押したと
き

First Clip Top! 再生開始位置が先頭クリップの先頭フレームにある
ため実行できない。

PREV+F REVボタンを押
したとき

First Clip Top! 再生開始位置が先頭クリップの先頭フレームにある
ため実行できない。
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PLAYボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにある
ため実行できない。

NEXTボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにある
ため実行できない。

F FWDボタンを押したと
き

Last Clip End! 再生開始位置が最終クリップの最終フレームにある
ため実行できない。

NEXT+F FWDボタンを押
したとき

Last Clip End! 再生開始位置が最終クリップの最終フレームにある
ため実行できない。

メディアスロット切り替
え操作したとき

Cannot Switch Slots 再生中のためスロットを切り替えできない。

記録メディアを抜いたと
き

Media removed 記録メディアへの読み書き動作中（ACCESSランプ
点灯中)にメディアが抜かれた。

GAINスイッチを切り替え
たとき

Gain: xxdB
（「xx」は、ゲイン値）

ゲインの設定が変更になった。

DCCスイッチを操作した
とき

DCC:On DCCがOnになった。
DCC:Off DCCがOffになった。
Fixed By Hyper 
Gamma !

Gamma CategoryがHGまたはUserに設定されている
ためDCCをOnにできない。

ホワイトバランススイッ
チを操作したとき

White: Preset xxxxK
（「xxxx」は色温度値）

ホワイトバランスがPresetの値に変更された。

White: A xxxxK 
（「xxxx」は色温度値）

ホワイトバランスがAメモリーの値に変更された。

White: B xxxxK 
（「xxxx」は色温度値）

ホワイトバランスがBメモリーの値に変更された。

White: ATW xxxxK 
（「xxxx」は色温度値）

ホワイトバランスモードがATWに変更された。

SHUTTERスイッチを切り
替えたとき

Shutter: 1/xxxx
（「xxxx」はシャッター
値）

シャッタースピードが変わった（標準、Speedモー
ド設定時）。

Shutter: xxx
（「xxxx」はシャッター
値）

シャッタースピードが変わった（標準、Angleモード
設定時）。

ECS: xxxxHz
（「xxxx」は周波数）

シャッタースピードが変わった（ECSモード時）。

メニューつまみを回した
とき

ECS: xxxxHz
（「xxxx」は周波数）

シャッタースピードが変わった（ECSモード時）。

Iris Override: +x.xx
（「xxxx」は数値）

アイリスオーバーライド量が変わった。

オートブラックスイッチ
を操作したとき

Color Bars
Cannot Proceed

カラーバー信号を出力しているため実行できない。

Test Saw
Cannot Proceed

テスト信号を出力しているため実行できない。

Not Available
Recording

記録中のため実行できない。

Not Available
Playing back

再生中のため実行できない。

Not Available
Displaying Thumbnails

サムネイル表示中のため実行できない。

操作 メッセージ メッセージの意味／発生要因
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オートホワイトスイッチ
を操作したとき

Color Bars
Cannot Proceed

カラーバー信号を出力しているため実行できない。

Not Available
Playing back

再生中のため実行できない。

Not Available
Displaying Thumbnails

サムネイル表示中のため実行できない。

White Balance Preset ホワイトバランスがPreset値固定であるため実行で
きない。

ATW Hold機能を割り当て
たアサイナブルスイッチ
を操作したとき

ATW Hold ATWのHold機能が有効になった。
ATW Hold Off ATWのHold機能が解除になった。

Clip Continuous Recを割
り当てたアサイナブルス
イッチを操作したとき

Cannot Proceed
Recording

記録中のため実行できない。

Cannot Proceed カメラアダプター CA-FB70/TX70とCCUが接続され
ているため実行できない。

Picture Cache Recを割り
当てたアサイナブルス
イッチを操作したとき

Cannot Proceed
Recording

記録中のため実行できない。

Cannot Proceed 以下のいずれかの条件により実行できない。
• 再生中
• サムネイル表示中
• カメラアダプター CA-FB70/TX70とCCUが接続さ
れている

Streamingを割り当てたア
サイナブルスイッチを操
作したとき

Cannot Proceed
Network Client Mode 
Setting is “On”

ネットワーククライアントモードが有効であるため
実行できない。

Cannot Proceed
Network Function is 
Disabled

ネットワーク接続設定がOffであるため実行できな
い。

Cannot Proceed
Network Client Mode 
Setting is “On”
Network Function is 
Disabled

ネットワーククライアントモードはOnに設定されて
いるが、ネットワーク未接続であるため実行できな
い。

Cannot Start Streaming
Streaming Disabled 
Temporarily

以下のいずれかの条件により実行できない。
• プロキシデータ再生中
• 記録フォーマット設定が1920×1080のときに

1280×720クリップを再生中
• 記録フォーマット設定が1280×720のときに

1920×1080クリップを再生中
Cannot Start Streaming
Please stop Recording 
or Playback

ワイヤレス機能回路起動中に記録・再生（サムネイ
ル表示を含む）を開始したため実行できない。
記録・再生（サムネイル表示を含む）を停止すると
実行できる。

操作 メッセージ メッセージの意味／発生要因
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ネットワーククライアン
トモード有効時に
Streamingを割り当てたア
サイナブルスイッチを操
作したとき

Cannot Proceed
Streaming Setting is 
“On”

ストリーミング中のため設定できない。

Cannot Connect to 
CCM
Network Function is 
Disabled

ネットワーク未接続であるためConnection Control 
Managerに接続できない。

Cannot Record Proxy メニューのMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3のNCM with 
ProxyがDisableに設定されているため、プロキシ
データ記録開始の操作をしても記録ができない。

Proxy Recoding will be 
Stopped

メニューのMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3のNCM with 
ProxyがDisableに設定されているため、プロキシ
データ記録が停止する。

Cannot Connect to 
CCM
Cannot Record Proxy

• ネットワーク未接続であるためConnection Control 
Managerに接続できない。

• メニューのMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3のNCM with 
ProxyがDisableに設定されているため、プロキシ
データ記録開始の操作をしても記録できない。

Cannot Connect to 
CCM
Proxy Recoding will be 
Stopped

• ネットワーク未接続であるためConnection Control 
Managerに接続できない。

• メニューのMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3のNCM with 
ProxyがDisableに設定されているため、プロキシ
データ記録が停止する。

Cannot Connect to 
CCM
Invalid User Name or 
Password

Connection Control Managerの認証がエラーになっ
た。

Cannot Connect to 
CCM
Invalid Address or Port 
Number

Connection Control Managerのアドレス、または
ポートナンバーの設定間違いのため、Connection 
Control Managerに接続できない。

Auto Upload(Proxy)を割
り当てたアサイナブルス
イッチを操作したとき

Cannot Proceed
Network Function is 
Disabled

プロキシデータ記録回路、およびワイヤレス機能回
路が起動完了前のため実行できない。

ONLINEボタンを長押し
操作したとき

Cannot Proceed ワイヤレス機能回路が起動遷移中、または電源断遷
移中のため実行できない。

Zebraを割り当てたアサ
イナブルスイッチを操作
したとき、またはビュー
ファインダーのZEBRAス
イッチを切り替えたとき

Zebra: On ゼブラがOnになった。
Zebra: Off ゼブラがOffになった。

ビューファインダーの
ZEBRAスイッチを操作し
たとき

Zebra: On ゼブラがOnになった。
Zebra: Off ゼブラがOffになった。

Makerを割り当てたアサ
イナブルスイッチを操作
したとき

Marker: On マーカーがOnになった。
Marker: Off マーカーがOffになった。

Peakingを割り当てたアサ
イナブルスイッチを操作
したとき

Peaking: On ピーキングがOnになった。
Peaking: Off ピーキングがOffになった。

操作 メッセージ メッセージの意味／発生要因
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Video Signal Monitorを割
り当てたアサイナブルス
イッチを操作したとき

Cannot Proceed 以下のいずれかの条件により実行できない。
• メニューのOperation >Input/OutputのSDI Out1 

SelectとSDI Out2 Selectが両方ともOffに設定
• メニューのOperation >Input/OutputのOutput 

Formatが、720×480Pまたは、720×576Pに設定
OUTPUTスイッチを
BARS位置（カラーバー表
示）へ操作したとき

Not Available
S&Q Motion: On

S&Qモーション記録モードが有効中のため表示でき
ない。

デジタルエクステンダー
を割り当てたアサイナブ
ルスイッチを操作したと
き

Cannot Proceed 以下のいずれかの条件により実行できない。
• 再生中
• サムネイル表示中
• 外部入力状態
• カラーバーやテスト信号を出力中

NDフィルターを切り替え
たとき

2: 1/4ND  xxxxK
（「2: 1/4ND」はND種
類、「xxxx」は色温度
値）

NDフィルターが切り替わった。

ND:3 CC: x  xxxxK
（「ND:3」は選ばれてい
るNDフィルター種類、
「CC: x  xxxxK」は選ば
れているCCフィルター
と電気色温度変換を
行った後の色温度値）

ND Filter C.TempがOffで、いずれかのアサイナブル
スイッチにElectrical CCを割り当てた状態でNDフィ
ルターが切り替わった。

Color Temp SW 3200Kを
割り当てたアサイナブル
スイッチを操作したとき

Color Temp SW 3200K Color Temp SW 3200Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.Temp]がOnのため変更できない。

Color Temp SW 4300Kを
割り当てたアサイナブル
スイッチを操作したとき

Color Temp SW 4300K Color Temp SW 4300Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Color Temp SW 5600Kを
割り当てたアサイナブル
スイッチを操作したとき

Color Temp SW 5600K Color Temp SW 5600Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Color Temp SW 6300Kを
割り当てたアサイナブル
スイッチを操作したとき

Color Temp SW 6300K Color Temp SW 6300Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Electrical CCを割り当て
たアサイナブルスイッチ
を操作したとき

ND:3 CC: x  xxxxK
（「ND:3」は選択されて
いるNDフィルター種
類、「CC: x  xxxxK」は
選択されているCCフィ
ルターと電気色温度変
換を行った後の色温度
値）

Electrical CCフィルターが切り替わった。

Cannot Proceed ND Filter C.TempがOnのため変更できない。
CC5600Kを割り当てたア
サイナブルスイッチを操
作したとき

CC 5600K 5600Kに設定された。
Cannot Proceed 以下のいずれかの条件により実行できない。

• ND Filter C.TempがOn
• いずれかのアサイナブルスイッチにElectrical CC
を割り当ててあるが、Electrical CCに5600Kを割
り当てていない

操作 メッセージ メッセージの意味／発生要因
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Shot Mark1を割り当てた
アサイナブルスイッチを
操作したとき

Shot Mark1
（Planning Metadata適
用時は、任意文字列）

ショットマーク1が付加された。

Cannot Record 
Essence Mark
Reached Essence 
Mark Limit

エッセンスマーク数の上限に達しているため付加で
きない。

Cannot Proceed 以下のいずれかの条件により付加できない。
• クリップが記録されているメディアに書き込み禁
止などの理由で書き込みできない

• ピクチャーキャッシュレック機能がOn
• インターバルレック記録中
• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Shot Mark2を割り当てた
アサイナブルスイッチを
操作したとき

Shot Mark2
(Planning Metadata適
用時は、任意文字列）

ショットマーク2が付加された。

Cannot Record 
Essence Mark
Reached Essence 
Mark Limit

エッセンスマーク数の上限に達しているため実行で
きない。

Cannot Proceed 以下のいずれかの条件により付加できない。
• クリップが記録されているメディアに書き込み禁
止などの理由で書き込みできない

• ピクチャーキャッシュレック機能がOn
• インターバルレック記録中
• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag OKを割り当て
たアサイナブルスイッチ
を操作したとき

OK Clip Flag クリップフラグ（OKマーク）が付加された。
Delete Clip Flag クリップフラグ（OKマーク）が削除された(スイッチ

2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag NGを割り当て
たアサイナブルスイッチ
を操作したとき

NG Clip Flag クリップフラグ（NGマーク）が付加された。
Delete Clip Flag クリップフラグ（NGマーク）が削除された (スイッ

チ2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag Keepを割り当
てたアサイナブルスイッ
チを操作したとき

KEEP Clip Flag クリップフラグ（KEEPマーク）が付加された。
Delete Clip Flag クリップフラグ（KEEPマーク）が削除された(ス

イッチ2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

SLOT SELECTボタンを操
作したとき

Switched Slot 使用する記録メディアが切り替わった。

スロー＆クイックモー
ションに対応しない記録
フォーマット設定で、
Slow & Quick Motionを割
り当てたアサイナブルボ
タンを操作したとき

Cannot Proceed
S&Q Unsupported Rec 
Format

Slow & Quick Motionに対応していないフォーマット
のため実行できない。

操作 メッセージ メッセージの意味／発生要因
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表凡例
○： 保存する
×： 保存しない
―： 保存しない（一時的動作メニュー）
Default： リファレンスファイルには保存されない項目ですが、メニューのFile >Referenceを実行すると

メニューの初期値としてプリセット層に保存されます。

ユーザーデータに保存される項目

Userメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

Edit User Menu ○ × × ×

Operationメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

Format Frequency ○ × × ×
File System ○ × × ×
Rec Format ○ × × ×
Aspect Ratio (SD) ○ × × ×
Audio Length (IMX) ○ × × ×

Input/Output Output Format ○ × × ×
Source Select ○ × × ×
SDI Out1 Output ○ × × ×
SDI Out2 Output ○ × × ×
HDMI Output ○ × × ×
SDI Out2/HDMI Super ○ × × ×
Video Out Super ○ × × ×
Down Converter ○ × × ×
Wide ID ○ × × ×
Wide Mode(Ext.) ○ × × ×
HD SDI Return Input ○ × × ×

Super Impose Super(VF Display) ○ × × ×
Super(Menu) ○ × × ×
Super(Marker) ○ × × ×

LCD LCD Color ○ × × ×
LCD Marker&Zebra ○ × × ×
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Rec Function Slow & Quick Motion ○ × × ×
Frame Rate ○ × × ×
Clip Continuous Rec ○ × × ×
Picture Cache Rec ○ × × ×
Cache Rec Time ○ × × ×
Interval Rec × × × ×
Number of Frames ○ × × ×
Interval Time ○ × × ×
Pre-Lighting ○ × × ×
Simul Rec ○ × × ×

Proxy Recording 
Mode

Setting ○ × × ×
Size ○ × × ×
Frame Rate – – – –

Bit Rate – – – –

Audio Channel ○ × × ×
Assignable 
Switch

<0> ○ × × ×
<1> ○ × × ×
<2> ○ × × ×
<3> ○ × × ×
<4> ○ × × ×
<5> ○ × × ×
Lens RET ○ × × ×
Color Temp. ○ × × ×
Zoom Speed ○ × × ×

VF Setting Color ○ × × ×
Color Mode ○ × × ×
Peaking Type ○ × × ×
Peaking Frequency ○ × × ×
Peaking Color ○ × × ×
VF Detail Level ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Marker Setting ○ × × ×
Color ○ × × ×
Center Marker ○ × × ×
Safety Zone ○ × × ×
Safety Area ○ × × ×
Aspect Marker ○ × × ×
Aspect Select ○ × × ×
Aspect Mask ○ × × ×
Aspect Safety Zone ○ × × ×
Aspect Safety Area ○ × × ×
100% Marker ○ × × ×
User Box ○ × × ×
User Box Width ○ × × ×
User Box Height ○ × × ×
User Box H Position ○ × × ×
User Box V Position ○ × × ×

Gain Switch Gain<L> ○ × × ×
Gain<M> ○ × × ×
Gain<H> ○ × × ×
Gain <Turbo> ○ × × ×
Shockless Gain ○ × × ×

Auto Iris Iris Override ○ × × ×
Mode ○ × × ×
Level ○ × × ×
Speed ○ × × ×
Clip High light ○ × × ×
Detect Window ○ × × ×
Detect Window Indication × × × ×
Iris APL Ratio ○ × × ×
Iris Var Width ○ × × ×
Iris Var Height ○ × × ×
Iris Var H Position ○ × × ×
Iris Var V Position ○ × × ×

Zebra Zebra Select ○ × × ×
Zebra1 Level ○ × × ×
Zebra1 Aperture Level ○ × × ×
Zebra2 Level ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Display On/Off Video Level Warning ○ × × ×
Shutter Setting ○ × × ×
ND Filter Position ○ × × ×
Gain Setting ○ × × ×
Rec/Play Status ○ × × ×
Color Temp. ○ × × ×
Frame Rate / Interval ○ × × ×
Battery Remain ○ × × ×
Timecode ○ × × ×
Audio Level Meter ○ × × ×
Media Status ○ × × ×
SD Card(Utility) ○ × × ×
Focus Position ○ × × ×
Iris Position ○ × × ×
Zoom Position ○ × × ×
Extender ○ × × ×
ALAC ○ × × ×
AE Mode ○ × × ×
White Balance Mode ○ × × ×
CC5600K ○ × × ×
Rec Format ○ × × ×
Gamma ○ × × ×
Timecode Lock ○ × × ×
Network Condition ○ × × ×
Proxy Status ○ × × ×
NW Client Mode Status ○ × × ×
Streaming Status ○ × × ×
GPS ○ × × ×
Video Signal Monitor ○ × × ×
Clip Name ○ × × ×
Focus Assist Indicator ○ × × ×
Focus Area Marker ○ × × ×
Lens Info ○ × × ×
WRR RF Level ○ × × ×
Clip Number ○ × × ×

“!” LED Gain <!> ○ × × ×
Shutter <!> ○ × × ×
White Preset <!> ○ × × ×
ATW Run <!> ○ × × ×
Extender <!> ○ × × ×
Filter <!> ○ × × ×
Iris Override <!> ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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White Setting White Switch<B> ○ × × ×
Shockless White ○ × × ×
ATW Speed ○ × × ×
ATW Mode ○ × × ×
AWB Fixed Area ○ × × ×
Filter White Memory ○ × × ×

Offset White Offset White<A> ○ × × ×
Warm Cool  <A> ○ × × ×
Warm Cool Balance<A> ○ × × ×
Offset White <B> ○ × × ×
Warm Cool <B> ○ × × ×
Warm Cool Balance<B> ○ × × ×

Shutter Mode ○ ○ × ×
Slow Shutter Setting ○ ○ × ×

Number of Frames ○ ○ × ×
Time Zone Time Zone ○ × × ×
Clip Clip Naming ○ × × ×

Title Prefix ○ × × ×
Number Set × × × ×

GPS GPS ○ × × ×
Planning 
Metadata

Load Media(A) – – – –

Load Media(B) – – – –

Properties – – – –

Clear Memory – – – –

Clip Name Disp ○ × × ×
USB Select Folder – – – –

View Clip List – – – –

Rename Folder – – – –

Error Check ○ × × ×
Format USB – – – –

Copy to USB – – – –

Media Remain – – – –

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Paintメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

Switch Status Gamma ○ ○ Default ×
Black Gamma ○ ○ ○ ×
Matrix ○ ○ ○ ×
Knee ○ ○ ○ ×
White Clip × ○ × ×
Detail ○ ○ Default ×
Aperture ○ ○ Default ×
Flare ○ ○ Default ×
Test Saw ○ × × ×

White Color Temp <A> ○ ○ ○ ×
Color Temp Balance <A> ○ ○ ○ ×
R Gain <A> ○ ○ ○ ×
B Gain <A> ○ ○ ○ ×
Color Temp <B> ○ ○ ○ ×
Color Temp Balance <B> ○ ○ ○ ×
R Gain <B> ○ ○ ○ ×
B Gain <B> ○ ○ ○ ×

Black Master Black ○ ○ ○ ×
R Black ○ ○ ○ ×
B Black ○ ○ ○ ×

Flare Setting ○ ○ Default ×
Master Flare ○ ○ ○ ×
R Flare ○ ○ ○ ×
G Flare ○ ○ ○ ×
B Flare ○ ○ ○ ×

Gamma Setting ○ ○ Default ×
Step Gamma ○ ○ ○ ×
Master Gamma ○ ○ ○ ×
R Gamma ○ ○ ○ ×
G Gamma ○ ○ ○ ×
B Gamma ○ ○ ○ ×
Gamma Category ○ ○ ○ ×
Gamma Select ○ ○ ○ ×

Black Gamma Setting ○ ○ ○ ×
Range ○ ○ ○ ×
Master Black Gamma ○ ○ ○ ×

Knee Setting ○ ○ ○ ×
Point ○ ○ ○ ×
Slope ○ ○ ○ ×
Knee Saturation ○ ○ ○ ×
Knee Saturation Level ○ ○ ○ ×

White Clip Setting × ○ × ×
Level ○ ○ ○ ×
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Detail(HD) Setting ○ ○ Default ×
Level ○ ○ ○ ×
H/V Ratio ○ ○ ○ ×
Crispening ○ ○ ○ ×
Level Depend ○ ○ ○ ×
Level Depend Level ○ ○ ○ ×
Frequency ○ ○ ○ ×
Knee Aperture ○ ○ ○ ×
Knee Aperture Level ○ ○ ○ ×
Limit ○ ○ ○ ×
White Limit ○ ○ ○ ×
Black Limit ○ ○ ○ ×
V Black Limit ○ ○ ○ ×
V Detail Creation ○ ○ ○ ×

Detail(SD) Setting ○ ○ Default ×
Level ○ ○ ○ ×
H/V Ratio ○ ○ ○ ×
Crispening ○ ○ ○ ×
Level Depend ○ ○ ○ ×
Level Depend Level ○ ○ ○ ×
Frequency ○ ○ ○ ×
Knee Aperture ○ ○ ○ ×
Knee Aperture Level ○ ○ ○ ×
Limit ○ ○ ○ ×
White Limit ○ ○ ○ ×
Black Limit ○ ○ ○ ×
V Black Limit ○ ○ ○ ×
V Detail Creation ○ ○ ○ ×
Cross Color Suppress ○ ○ ○ ×

Aperture Setting ○ ○ Default ×
Level ○ ○ ○ ×

Skin Detail Setting ○ ○ ○ ×
Area Detection – – – –

Area Indication × × × ×
Level ○ ○ ○ ×
Saturation ○ ○ ○ ×
Hue ○ ○ ○ ×
Width ○ ○ ○ ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Matrix Setting ○ ○ ○ ×
Adaptive Matrix ○ ○ ○ ×
Preset Matrix ○ ○ ○ ×
Preset Select ○ ○ ○ ×
User Matrix ○ ○ ○ ×
Level ○ ○ ○ ×
Phase ○ ○ ○ ×
User Matrix R-G ○ ○ ○ ×
User Matrix R-B ○ ○ ○ ×
User Matrix G-R ○ ○ ○ ×
User Matrix G-B ○ ○ ○ ×
User Matrix B-R ○ ○ ○ ×
User Matrix B-G ○ ○ ○ ×

Multi Matrix Setting ○ ○ ○ ×
Area Indication × × × ×
Color Detection – – – –

Reset – – – –

Axis × × × ×
Hue ○ ○ ○ ×
Saturation ○ ○ ○ ×

V Modulation Setting ○ × Default ×
Master V Modulation ○ ○ Default ×
R V Modulation ○ ○ Default ×
G V Modulation ○ ○ Default ×
B V Modulation ○ ○ Default ×

Low Key 
Saturation

Setting ○ ○ ○ ×
Level ○ ○ ○ ×
Range ○ ○ ○ ×

Saturation Mode Saturation Mode ○ ○ ○ ×
Knee Saturation ○ ○ ○ ×
Black Gamma ○ ○ ○ ×
Low Key Saturation ○ ○ ○ ×

Noise 
Suppression

Setting ○ ○ ○ ×
Level ○ ○ ○ ×

Thumbnailメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

Display Clip 
Properties

– – – –

Set Index 
Picture

– – – –

Thumbnail View Essence Mark Thumbnail – – – –

Clip Thumbnail – – – –

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Set Shot Mark Add Shot Mark1 – – – –

Delete Shot Mark1 – – – –

Add Shot Mark2 – – – –

Delete Shot Mark2 – – – –

Set Clip Flag Add OK – – – –

Add NG – – – –

Add KEEP – – – –

Delete Clip Flag – – – –

Lock/Unlock 
Clip

Select Clip – – – –

Lock All Clips – – – –

Unlock All Clips – – – –

Copy Clip Select Clip – – – –

All Clips – – – –

Delete Clip Select Clip – – – –

All Clips – – – –

Filter Clips OK – – – –

NG – – – –

KEEP – – – –

None – – – –

Customize View Thumbnail Caption ○ ○ × ×

Maintenanceメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

White Shading Channel Select ○ × Default ×
White H Saw × × × ×
White H Para × × × ×
White V Saw × × × ×
White V Para × × × ×
White Saw/ Para ○ × Default ×

Black Shading Channel Select ○ × Default ×
Black H Saw × × × ×
Black H Para × × × ×
Black V Saw × × × ×
Black V Para × × × ×
Black Saw/Para ○ × Default ×
Master Black ○ ○ ○ ×
Master Gain (TMP) – – – –

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Battery Near End:Info Battery ○ × × ×
End:Info Battery ○ × × ×
Near End:Sony Battery ○ × × ×
End:Sony Battery ○ × × ×
Near End:Other Battery ○ × × ×
End:Other Battery ○ × × ×
Detected Battery – – – –

DC Voltage 
Alarm

DC Low Voltage1 ○ × × ×
DC Low Voltage2 ○ × × ×

Audio Front MIC Select ○ × × ×
Rear XLR Auto ○ × × ×
Front MIC CH1 Ref ○ × × ×
Front MIC CH2 Ref ○ × × ×
Rear MIC CH1 Ref ○ × × ×
Rear MIC CH2 Ref ○ × × ×
Line Input Ref ○ × × ×
Min Alarm Volume ○ × × ×
Speaker Attenuate ○ × × ×
Headphone Out ○ × × ×
Reference Level ○ × × ×
Reference Out ○ × × ×
CH1&2 AGC Mode ○ × × ×
CH3&4 AGC Mode ○ × × ×
AGC Spec ○ × × ×
Limiter Mode ○ × × ×
Output Limiter ○ × × ×
CH1 Wind Filter ○ × × ×
CH2 Wind Filter ○ × × ×
CH3 Wind Filter ○ × × ×
CH4 Wind Filter ○ × × ×
1kHz Tone on Color Bars ○ × × ×
MIC CH1 Level ○ × × ×
MIC CH2 Level ○ × × ×
Rear1/WRR Level ○ × × ×
Rear2/WRR Level ○ × × ×
Audio CH3 Level ○ × × ×
Audio CH4 Level ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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WRR Setting WRR Valid CH Sel ○ × × ×
WRR CH Select × × × ×
WRR Delay Comp ○ × × ×
TX – – – –

TX Audio Peak – – – –

TX Input Level – – – –

TX ATT Level – – – –

TX LCF Frequency – – – –

TX System Delay ○ × × ×
TX RF Power – – – –

TX Power Save – – – –

TX-Cam Power Sync ○ × × ×
Timecode TC Out ○ × × ×

DF/NDF ○ × × ×
LTC UBIT ○ × × ×
Counter Display ○ × × ×

Essence Mark Find Mode ○ × × ×
Camera Config HD SDI Remote I/F ○ × × ×

Color Bars Select ○ × × ×
User Menu Only ○ × × ×
User Menu with Lock × × × ×
RM Common Memory ○ × × ×
RM Rec Start ○ × × ×
SET Key on Thumbnail ○ × × ×
ALAC ○ × × ×

Preset White Color Temp <P> ○ × × ×
Color Temp Balance <P> ○ × × ×
R Gain <P> ○ × × ×
B Gain <P> ○ × × ×
AWB Enable <P> × × × ×

White Filter ND Filter C.Temp ○ × × ×
ND FLT C.Temp<1> ○ × × ×
ND FLT C.Temp<2-4> ○ × × ×
Electrical CC<A> ○ × × ×
Electrical CC<B> ○ × × ×
Electrical CC<C> ○ × × ×
Electrical CC<D> ○ × × ×

DCC Adjust DCC Function Select ○ × × ×
DCC D Range ○ × × ×
DCC Point ○ × × ×
DCC Gain ○ × × ×
DCC Delay Time ○ × × ×
DCC Peak Filter ○ × × ×

Genlock Genlock ○ × × ×
Reference – – – –

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Auto Shading Auto Black Shading – – – –

Reset Black Shading – – – –

Master Gain (TMP) – – – –

APR APR – – – –

Reset – – – –

Basic 
Authentication

User Name × × × ×
Password × × × ×

Network Setting ○ × × ×
Wi-Fi Mode ○ × × ×
WPS – – – –

Channel ○ × × ×
SSID & Password – – – –

SSID – – – –

Wi-Fi Station Detail Settings Scan 
Networks

– – – –

SSID × × × ×
Password × × × ×
DHCP ○ × × ×
IP Address ○ × × ×
Subnet Mask ○ × × ×
Gateway ○ × × ×
DNS Auto ○ × × ×
Primary DNS 
Server

○ × × ×

Secondary 
DNS Server

○ × × ×

Device Name (Wi-Fi) – – – –

IP Address (Wi-Fi) – – – –

Subnet Mask (Wi-Fi) – – – –

MAC Address (Wi-Fi) – – – –

Regenerate Password – – – –

Modem ○ × × ×
Wired LAN ○ × × ×
Wired LAN Remote ○ × × ×
Wired LAN Detail Settings DHCP ○ × × ×

IP Address ○ × × ×
Subnet Mask ○ × × ×
Gateway ○ × × ×
DNS Auto ○ × × ×
Primary DNS 
Server

○ × × ×

Secondary 
DNS Server

○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Network Client 
Mode

Setting ○ × × ×
Preset Select ○ × × ×
Preset 1 Display Name ○ × × ×

CCM Address ○ × × ×
CCM Port ○ × × ×
User Name × × × ×
Password × × × ×
NCM with 
Proxy

○ × × ×

Camera 
Control

○ × × ×

Camera 
Setting

○ × × ×

Preset 2 Preset 1と同じ
Preset 3 Preset 1と同じ

File Transfer File Transfer – – – –

Remote File Transfer ○ × × ×
Auto Upload (Proxy) ○ × × ×

Streaming Setting × × × ×
Preset Select ○ × × ×
Preset1 Size ○ × × ×

Bit Rate ○ × × ×
Type ○ × × ×
Destination 
Address

○ × × ×

Destination 
Port

○ × × ×

Preset2 Size ○ × × ×
Bit Rate ○ × × ×
Type ○ × × ×
Destination 
Address

○ × × ×

Destination 
Port

○ × × ×

Preset3 Size ○ × × ×
Bit Rate ○ × × ×
Type ○ × × ×
Destination 
Address

○ × × ×

Destination 
Port

○ × × ×

Audio Channel ○ × × ×
Clock Set Date Mode ○ × × ×

12H/24H ○ × × ×
Date – – – –

Time – – – –

Language Select ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens



241

Hours Meter Hours (System) – – – –

Hours (Reset) – – – –

Reset – – – –

Network Reset Reset – – – –

Fan Control Setting ○ × × ×
VF Display 
Setting

Chara/Marker Brightness ○ × × ×

Option Type 1 – – – –

Type 2 – – – –

Type 3 – – – –

Install Option – – – –

Remove Option – – – –

Version Number – – – –

Version Up – – – –

Net-Func Version Number – – – –

Net-Func Ver.Up – – – –

Fileメニュー

項目 細目 保存先ファイル
ALL Scene Reference Lens

User Menu Item Load SD Card – – – –

Save SD Card – – – –

File ID × × × ×
User File Load SD Card – – – –

Save SD Card – – – –

File ID × × × ×
Recall User Preset – – – –

Store User Preset – – – –

Clear User Preset – – – –

Load Customize Data ○ × × ×
Load White Data ○ × × ×

All File Load SD Card – – – –

Save SD Card – – – –

File ID ○ × × ×
All Preset – – – –

Store All Preset – – – –

Clear All Preset – – – –

3Sec Clear Preset × × × ×
Scene File Recall Internal Memory – – – –

Store Internal Memory – – – –

Load SD Card – – – –

Save SD Card – – – –

File ID × ○ × ×
Scene White Data ○ × × ×

項目 細目 保存先ファイル
ALL Scene Reference Lens
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Reference File Store Reference – – – –

Clear Reference – – – –

Load Reference(SD Card) – – – –

Save Reference(SD Card) – – – –

File ID × × ○ ×
Lens File Display Mode × × × ×

Recall Internal Memory – – – –

Store Internal Memory – – – –

Load SD Card – – – –

Save SD Card – – – –

File ID × × × ○
File Source – – – –

Clear Lens Offset – – – –

Lens Auto Recall ○ × × ×
Lens Serial Number – – – –

Lens Name – – – –

Lens Manufacturer – – – –

Master V Modulation × × × ○
Lens Center H × × × ○
Lens Center V × × × ○
R Flare × × × ○
G Flare × × × ○
B Flare × × × ○
White Offset R × × × ○
White Offset B × × × ○
Shading Ch Select ○ × × ×
Shading H SAW × × × ○
Shading H PARA × × × ○
Shading V SAW × × × ○
Shading V PARA × × × ○

User Gamma Current Settings – – – –

Load SD Card – – – –

Reset – – – –

項目 細目 保存先ファイル
ALL Scene Reference Lens



243

*1) 対応している画サイズ、フレームレート、および機能詳細は「応用操作」（83ページ）をご覧ください。
*2) Slow&Quick Option PXWK-503（有償オプション）が必要です。

フォーマット別の特殊記録対応

フォーマット 通常記録 特殊記録1)

ピクチャー
キャッシュ
レック

インター
バルレッ
ク

スロー＆ク
イックモー
ション

クリップ
コンティ
ニュアス
レック

2スロット
同時記録

HD SStP SR-Lite 4:2:2 exFAT ○ － － － － －
ProRes (Option) ○ － － － － －
DNxHD (Option) ○ － － － － －
XAVC-I HD ○ ○ ○ ○*2) ○ ○
XAVC-L422 HD 50 ○ ○ ○ ○*2) ○ ○
XAVC-L422 HD 35 ○ ○ ○ ○*2) ○ ○
XAVC-L422 HD 25 ○ ○ ○ － ○ ○
MPEG HD422 exFAT ○ ○ ○ ○ ○ ○

UDF ○ ○ ○ ○ ○ －
MPEG HD420 HQ exFAT ○ ○ － － － ○

UDF ○ ○ － － － －
FAT ○ ○ － － － －

MPEG HD420 SP FAT ○ ○ － － － －
SD MPEG IMX 50 exFAT ○ ○ － － － －

UDF ○ ○ － － － －
DVCAM exFAT ○ － － － － －

UDF ○ － － － － －
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ピクチャーキャッシュレックモード設定

メニューのOperation >Format Cache Rec Time

Frequency Rec Format
0-2
sec

2-4
sec

4-6
sec

6-8
sec

8-10
sec

10-12
sec

12-14
sec

13-15
sec

59.94
50

XAVC-I 1920x1080P ○ ○ － － － － － －

XAVC-I 1920x1080i ○ ○ ○ ○ － － － －

XAVC-I 1280x720P ○ ○ ○ ○ － － － －

XAVC-L 50/35/25 ○ ○ ○ ○ ○ ○ ○ ○

MPEG HD422 ○ ○ ○ ○ ○ ○ ○ ○

MPEG HD420 HQ/SP ○ ○ ○ ○ ○ ○ ○ ○

MPEG IMX50 ○ ○ ○ ○ ○ ○ ○ ○

DVCAM － － － － － － － －

29.97
25
23.98

XAVC-I 1920x1080P ○ ○ ○ ○ － － － －

XAVC-L 50/35 ○ ○ ○ ○ ○ ○ ○ ○

MPEG HD422 ○ ○ ○ ○ ○ ○ ○ ○

MPEG HD420 HQ ○ ○ ○ ○ ○ ○ ○ ○
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ファン、バッテリーは有寿命部品として定
期的な交換が必要です。
常温でのご使用の場合、5年を目安に交換し
てください。ただし、交換時期は目安であ
り、部品の寿命を保証するものではありま
せん。交換の際はお買い上げ店 にご相談く
ださい。

ACアダプターと電解コンデンサの寿命は約
5年です。
（常温で1日に8時間、1カ月で25日間、通常
に使用すると想定した場合）
従って、使用時間が上記より長い場合は、
その分寿命は短くなります。

取り扱い・保管上のご注意

強い衝撃を与えない
• 内部構造や外観の変形などの損傷を受け
ることがあります。

• アクセサリーシューに装着した部品に強
い衝撃が与えられた場合、アクセサリー
シューが損傷する場合があります。この
場合は使用を中止し、ソニーのサービス
担当者、または営業担当者にご相談くだ
さい。

動作中は布などで包まないでください
内部の温度が上がり、好ましくありません。

使い終わったら
POWERスイッチをOFFにしてください。

長時間使わないときは
バッテリーを外しておいてください。

輸送
• 記録メディアは必ず取り出しておいてく
ださい。

• トラック、船、航空機など、本機を貨物
として扱う輸送では、お買い上げ時の梱
包材をご使用ください。

お手入れ
レンズや光学フィルターの表面に付着した
ゴミやほこりは、ブロアーで吹き払います。
ブロワ―によるカメラ内部の掃除は行わな
いでください。空気中に含まれるほこり等
が部品に入り込み、故障の原因となること
があります。
外装の汚れは、乾いた柔らかい布で拭き取
ります。ひどい汚れは、中性洗剤液を少し
含ませた布で拭いた後、から拭きします。
アルコール、ベンジン、シンナーなどの薬
品類は、表面が変質したり、塗料がはげる
ことがありますので、使わないでください。

万一、異常が生じたときは
ソニーのサービス担当者、または営業担当
者にご相談ください。

使用場所・保管場所

水平な場所、空調のある場所に保管してく
ださい。
次のような場所での使用・保管は避けてく
ださい。
• 極端に寒い所、暑い所（使用温度は－5℃
～+40℃）
真夏、窓を閉め切った自動車内は50℃を
越えることがあります。

• 湿気・ほこりの多い所
• 雨があたる所
• 激しく振動する所
• 強い磁気を発生するものの近く
• 強力な電波を発生するテレビやラジオの
送信所の近く

• 直射日光が長時間当たる場所や暖房器具
の近く

携帯電話などによる電波障害を防止す
るために
携帯電話などを本機の近くで使用すると、
誤動作を引き起こしたり、映像、音声など
に影響を与えることがあります。

使用上のご注意
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本機の近くでは、携帯電話などの電源はで
きるだけ切ってください。

レーザービームについてのご注意

レーザービームはCCDイメージセンサーに
損傷を与えることがあります。レーザー
ビームを使用した撮影環境では、CCDイ
メージセンサー表面にレーザービームが照
射されないよう、またその反射光や散乱光
にも充分注意してください。

結露について

本機を寒いところから急に暖かいところに
持ち込んだときなど、機器表面や内部に水
滴がつくことがあります。これを結露とい
います。結露が起きたときは電源を切り、
結露がなくなるまで放置し、結露がなく
なってからご使用ください。結露時のご使
用は機器の故障の原因となる場合がありま
す。

ズームレンズの取り付け

ズームレンズの取り付けかたを誤ると損傷
することがあります。必ず「レンズの取り
付けと調整」（41ページ）をご覧ください。

ビューファインダーについて

ビューファインダーの接眼レンズを太陽に
向けて放置しないでください。
太陽光が接眼レンズを通して内部に焦点を
結び、ビューファインダー内部を溶かすこ
とがあります。

LCD（液晶）画面について

本機のLCD（液晶）パネルは有効画素99.99％
以上の非常に精密度の高い技術で作られて
いますが、画面上に黒い点が現れたり（画
素欠け）、常時点灯している輝点（赤、青、
緑など）や滅点がある場合があります。ま
た、LCD（液晶）パネルの特性上、長期間
ご使用の間に画素欠けが生じることもあり
ます。これらの現象は故障ではありません
ので、ご了承の上本機をお使いください。
なお、これらの点が記録されることはあり
ません。

撮像素子特有の現象

ご注意
撮影画面に出る下記の現象は、撮像素子特
有の現象で、故障ではありません。

白点
撮像素子は非常に精密な技術で作られてい
ますが、宇宙線などの影響により、まれに
画面上に微小な白点が発生する場合があり
ます。
これは撮像素子の原理に起因するもので故
障ではありません。
また、下記の場合、白点が見えやすくなり
ます。
• 高温の環境で使用するとき
• ゲイン（感度）を上げたとき
• スローシャッターのとき

スミア現象
強いスポット光やフラッシュ光などを撮影
したときに、画面上に縦線や画乱れが発生
することがあります。

モニター画面
縦に薄く尾を引いたような
画像になる。

高輝度の被写体（強い
スポット光、強い反射光、
フラッシュ光、太陽など）
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折り返しひずみ
細かい模様、線などを撮影すると、ギザギ
ザやちらつきが見えることがあります。

ファイルの断片化について

画像が正しく記録・再生されないときは記
録メディアをフォーマット（初期化）して
ください。
長期間、映像の記録・クリップの消去を繰
り返していると、記録メディア内のファイ
ルが断片化（フラグメンテーション）して、
映像が正しく記録・保存できなくな る場合
があります。このような場合は、クリップ
のバックアップを取ったあと、メニューの
Operation >Format Media（154ページ参
照）で記録メディアのフォーマット（初期
化）を行ってください。

セキュリティに関するご注意

• 通信を行う機器でセキュリティ対策を行
わなかった結果、または、通信仕様上の、
やむを得ない事情により、データ漏洩等、
セキュリティ上の問題が発生した場合、
弊社ではそれによって生じたあらゆる損
害に対する責任を負いかねます。

• 使用環境によってはネットワーク上の意
図せぬ第三者から製品にアクセスされる
可能性があります。本機をネットワーク
に接続する際には、セキュアなネット
ワークであることをご確認の上ご使用く
ださい。

• 利用者が気付かないうちに、電波が届く
ところから意図せぬ第三者に通信内容を
盗み見られてしまうおそれがあります。 無
線LAN通信を利用する際は、通信内容を
保護するために、適切なセキュリティ対
策をしてください。

• セキュリティの面から、製品をネット
ワークに接続してご使用になる際は、ブ
ラウザでコントロール画面にアクセスし、
アクセス制限設定を工場出荷時の設定値
から変更して設定することを強く推奨し
ます。（128ページ）

また、定期的にパスワードを変更するこ
とを推奨します。

• 設定作業中または設定作業後のブラウザ
で他のサイトを閲覧しないでください。
ブラウザにログインした状態が残ります
ので、意図しない第三者の使用や悪意の
あるプログラムの実行を防ぐために、設
定作業が完了したら必ずブラウザを終了
してください。

GPSについて

GPS（Global Positioning System）とは、
米国の高精度な航空衛星を利用した、地球
上のどこにいても自分の正確な位置を知る
ことができるシステムです。
GPS衛星は、高度20,000kmの6つの軌道上
に各4個、24個以上が設置されています。
GPS衛星からの電波を受信し、衛星の軌道
情報（アルマナックデータ）と電波の伝播
時間のデータなどから自分の位置を計算し
ます。
位置を計算することを測位と呼び、衛星を3
機以上受信できれば、経度、緯度がわかり
ます。
• GPS衛星の配置は常に変化しているため、
ご使用になる場所や時刻などの条件に
よっては測位に時間がかかったり、測位
できないことがあります。

• GPSは衛星から電波を受信し、測位する
システムです。ビルや木立の陰など、電
波を遮断・反射してしまう場所を避け、
できるだけ上空の開けた場所でご使用く
ださい。

• GPS衛星からの電波が届かない以下のよ
うな場所や状況では、測位情報を記録で
きないことがあります。
- トンネルの中・屋内やビルの陰
- 高層ビルの間・建物の間の狭い道路
- 地下・密集した樹木の間・高架の下・高
圧電線など、近くに磁気を発生するもの
がある場合

- 1.5GHz帯の携帯電話など、近くに同じ
周波数帯の電波を発生するものがある場
合



248

• GPSがOnの状態で撮影した画像をイン
ターネットに公開、共有すると、意図せ
ずに撮影場所が第三者に知られる場合が
あります。その場合はGPSをOffにして撮
影してください（164ページ）。

誤差について
• GPSをOnにした直後に移動すると、移動
しなかった場合に比べて、測位までの時
間が長くなることがあります。

• GPS衛星自体による誤差
本機は、3個以上のGPS衛星からの電波を
受信すると自動的に現在地を測位します。
GPS衛星自体による誤差は、約10m程度
ですが、測位する周辺の環境によっては
さらに大きな誤差を生じることがありま
す。このような場合は、実際に居た場所
と地図上での位置が異なることがありま
す。また、GPS衛星は米国国防省により
管理されており、意図的に精度が変更さ
れることがあります。

• 測位時間による誤差
本機では、測位中に測位情報を定期的に
取得しています。

規制について
使用する国や地域の規制に従ってGPS機能
をお使いください。

測地系について
本機では、測地系として、「WGS-84」を採
用しています。

本機内に内蔵時計用のリチウム電池が装着
されています。ビューファインダー画面に
“BackUp Battery End”の表示が出たら電
池の交換が必要ですので、ソニーのサービ
ス担当者、または営業担当者にご相談くだ
さい。

内蔵時計用電池の交換
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質量 約3.8 kg（本体のみ）
外形寸法 （単位：mm、突起部含まず、本

体のみ）1)

1)寸法は概算値です。

電源電圧 DC 12 V（11 V～17.0 V）
消費電力 約35 W（本体のみ、XAVC記録

時、LCDモニター点灯時）
約37 W（ビューファインダー

CBK-VF02、マニュアルレ
ンズ、マイク装着、XAVC
記録時、LCDモニター点灯
時）

ご注意
• 消費電力が50 Wより大きいビデオライトを接続
しないでください。

• バッテリー使用時、周辺機器を装着して使用す
る場合は、周辺機器の消費電力の合計が40 W以
内になるようにしてください。

• AC-DN10使用時、周辺機器を装着して使用する
場合は、周辺機器の消費電力の合計が50 W以内
になるようにしてください。

• AC-DN2B使用時、周辺機器を装着して使用す
る場合は、周辺機器の消費電力の合計が85 W以
内になるようにしてください。

• DC OUT端子には消費電流が1.8 A以下の機器を
接続してください。

動作温度 －5℃～＋40℃
保存温度 －20℃～＋60 ℃
ファイルシステム

exFAT、UDF、FAT
連続操作時間

約110分（BP-FLX75使用時）
記録フォーマット（ビデオ）

SR SStP
MPEG-4 Simple Studio 
Profile、SR-Lite 422

Apple ProRes（PXWK-501 
Option適用時）
ProRes 422 HQ、
ProRes 422

Avid DNxHD®（PXWK-502 
Option適用時）
DNxHD 220x（10bit 4:2:2）、
DNxHD 145（8bit 4:2:2）

XAVC Intra
XAVC-I モード：CBG、
最大222 Mbps、MPEG-4 
AVC/H.264

XAVC Long
XAVC-L 50モード：VBR、
最大50 Mbps、MPEG-4 
AVC/H.264
XAVC-L 35モード：VBR、
最大35 Mbps、MPEG-4 
AVC/H.264
XAVC-L 25モード：VBR、
最大25 Mbps、MPEG-4 
AVC/H.264

MPEG-2 Long GOP
MPEG HD422モード：
CBR、50 Mbps、MPEG-2 
422P@HL
MPEG HD420 HQモード：
VBR、最大35 Mbps、
MPEG-2 MP@HL
MPEG HD420 SPモード：
CBR、25 Mbps、MPEG-2 
MP@H-14

MPEG IMX
CBR、50 Mbps

主な仕様

一般

332

26
9

15
0
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DVCAM
CBR、25 Mbps

Proxy
AVC/H.264 Main Profile 
4:2:0 Long GOP
1280×720/9 Mbps、
640×360/3 Mbps、
480×270/1 Mbps、
500 Kbps (VBR)

記録フォーマット（オーディオ）
SR SStP

LPCM 24ビット、48 kHz、
4チャンネル

Apple ProRes（PXWK-501 
Option適用時）
LPCM 24ビット、48 kHz、
4チャンネル

Avid DNxHD®（PXWK-502 
Option適用時）
LPCM 24ビット、48 kHz、
4チャンネル

XAVC Intra
LPCM 24ビット、48 kHz、
4チャンネル

XAVC Long
LPCM 24ビット、48 kHz、
4チャンネル

MPEG-2 Long GOP
MPEG HD422 モード：
LPCM 24ビット、48 kHz、
4チャンネル
MPEG HD420 HQ モード：
LPCM 16ビット、48 kHz、
4チャンネル

MPEG IMX
LPCM 16/24ビット、
48 kHz、4チャンネル

DVCAM
LPCM 16ビット、48 kHz、
4チャンネル

Proxy
AAC-LC、128 kbps、
2チャンネル

記録・再生時間
SStP SR-Lite 422
　59.94i/29.97P
約30分：SBP-64D/SBS-
64G1B（64GB）使用時

　50i/25P/23.98P
約35分：SBP-64D/SBS-
64G1B（64GB）使用時

Apple ProRes 422 HQ（PXWK-
501 Option適用時）

　59.94i/29.97P
約25分：SBP-64D/SBS-
64G1B（64GB）使用時

　50i/25P/23.98P
約35分：SBP-64D/SBS-
64G1B（64GB）使用時

Apple ProRes 422（PXWK-501 
Option適用時）

　59.94i/29.97P
約40分：SBP-64D/SBS-
64G1B（64GB）使用時

　50i/25P/23.98P
約50分：SBP-64D/SBS-
64G1B（64GB）使用時

Avid DNxHD® 220x（PXWK-
502 Option適用時）

　59.94i/29.97P
約30分：SBP-64D/SBS-
64G1B（64GB）使用時

　50i/25P/23.98P
約35分：SBP-64D/SBS-
64G1B（64GB）使用時

Avid DNxHD® 145（PXWK-
502 Option適用時）

　59.94i/29.97P
約45分：SBP-64D/SBS-
64G1B（64GB）使用時

　50i/25P/23.98P
約55分：SBP-64D/SBS-
64G1B（64GB）使用時

XAVC Intra
　XAVC-I モード
　59.94P/50P
約30分：SBP-64D使用時

　59.94i/29.97P/50i/25P
約60分：SBP-64D/SBS-
64G1B（64GB）使用時

　23.98P
約70分：SBP-64D/SBS-
64G1B（64GB）使用時

XAVC Long
　XAVC-L 50モード
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約120分：SBP-64D/SBS-
64G1B（64GB）使用時

　XAVC-L 35モード
約170分：SBP-64D/SBS-
64G1B（64GB）使用時

　XAVC-L 25モード
約220分：SBP-64D/SBS-
64G1B（64GB）使用時

MPEG-2 Long GOP
　MPEG HD422 モード
約120分：SBP-64D/SBS-
64G1B（64GB）使用時

　MPEG HD420 HQ モード
約180分：SBP-64D/SBS-
64G1B（64GB）使用時

　MPEG HD420 SP モード
約240分：SBP-64D/SBS-
64G1B（64GB）使用時

MPEG IMX
約120分：SBP-64D/SBS-
64G1B（64GB）使用時

DVCAM
約220分：SBP-64D/SBS-
64G1B（64GB）使用時

ご注意
記録・再生時間は、1クリップとして連続記録し
たときのものです。記録するクリップ数によって
は記載の時間より短くなる場合があります。

記録フレームレート
SR SStP

1920×1080/59.94i、50i、
29.97P、23.98P、25P

Apple ProRes（PXWK-501 
Option適用時）
1920×1080/59.94i、50i、
29.97P、23.98P、25P

Avid DNxHD®（PXWK-502 
Option適用時）
1920×1080/59.94i、50i、
29.97P、23.98P、25P

XAVC Intra
　XAVC-I モード

1920×1080/59.94P、50P、
59.94i、50i、29.97P、
23.98P、25P
1280×720/59.94P、50P

XAVC Long
　XAVC-L 50モード

1920×1080/59.94P、50P、
59.94i、50i、29.97P、
23.98P、25P
1280×720/59.94P、50P

　XAVC-L 35モード
1920×1080/59.94P、50P、
59.94i、50i、29.97P、
23.98P、25P

　XAVC-L 25モード
1920×1080/59.94i、50i

MPEG-2 Long GOP
　MPEG HD422 モード

1920×1080/59.94i、50i、
29.97P、23.98P、25P
1280×720/59.94P、50P、
29.97P、23.98P、25P

　MPEG HD420 HQ モード
1920×1080/59.94i、50i、
29.97P、23.98P、25P
1440×1080/59.94i、50i
1280×720/59.94P、50P

　MPEG HD420 SP モード
1440×1080/59.94i、50i

MPEG IMX
720×486/59.94i
720×576/50i

DVCAM
720×480/59.94i
720×576/50i

Proxy
本線 1920×1080時 : 
29.97P、25P、23.98P
本線 1280×720時 : 59.94P、
50P、29.97P、25P、23.98P

入力
GENLOCK IN：

BNC型、1.0 Vp-p、75 Ω、
不平衡

TC IN： BNC型、0.5 V～18 Vp-p、
10 kΩ 

AUDIO IN CH1/CH2：
XLR型、3ピン、凹

入出力部
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LINE / AES/EBU / MIC / 
MIC+48V切り換え可能

LINE：+4、0、－3 dBu
AES/EBU：AES3準拠
MIC：－70～－30 dBu

MIC IN： XLR型、5ピン、凹、
－70～－30 dBu

WRR： D-sub 15ピン
アナログ CH1：－40 dBu
デジタル CH1/CH2：
－40 dBFS

SDI IN： SMPTE ST292-1/259規格準拠
オーディオ4チャンネル

出力
VIDEO OUT：

BNC型、SDアナログコンポ
ジット/HD-Y切り換え

SDI OUT 1/2：
BNC型、0.8 Vp-p、不平衡
（3G HD/1.5G HD/SD切り換
え）

SMPTE ST424/425 Level-A/B、
ST292-1/259規格準拠

オーディオ4チャンネル
AUDIO OUT：

XLR型、5ピン、凸、
+4/0/－3dBu（平衡）

TC OUT： BNC型、1.0 Vp-p、50 Ω
EARPHONE（ステレオミニジャック）：

－11 dBu (基準レベル出力、
モニターボリューム最大、
16 Ω負荷時)

HDMI： TypeA、19ピン

その他
DC IN： XLR型、4ピン、凸、

DC 11 V～17 V
DC OUT： 丸型4ピン、DC 11 V～17 V、

最大定格電流、1.8 A
LENS： 12ピン、レンズへの電源供給

（DC 11 V～17 V、最大定格
電流 1.0 A）

REMOTE：8ピン
LIGHT： 2ピン
USB： 4ピン（Aタイプ）×2、4ピン

（Bタイプ）
VF： 角型26ピン、丸型20ピン

撮像素子 2/3型、CCD有効画素数 
1920（H）×1080（V）

方式 RGB 3板方式
分光系 F1.4プリズム方式
NDフィルター

1：クリア
2：1/4ND
3：1/16ND
4：1/64ND

感度 F11（システム周波数：59.94i）
F12（システム周波数：50i）
（Typical）

（2000 lx、反射率89.9%、
3200K）

最低被写体照度
0.016 lx（F1.4、＋42 dB、

16フレーム蓄積）
映像S/N 60 dB（Noise Suppression On）

（Typical）
水平解像度 1000TV本以上
変調度 45%以上（27.5 MHz、画面中

央）
黒レベル 3±1%（メニューのBlackを

［±0］に設定したとき）
シャッタースピード

59.94i/P、50i/P：1/60 ～ 
1/2000秒

29.97P：1/40～1/2000秒
25P：1/33～1/2000秒
23.94P：1/32～1/2000秒

スローシャッター
2 ～ 8、16フレーム

ダイナミックレンジ
600%
460%（1080/29.97P、

1080/25P、1080/23.98P）
スミア －135 dB

サンプリング周波数
48 kHz

量子化特性
16/24ビット

カメラ部

オーディオ部
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ヘッドルーム
20 dB（工場出荷時）（20、18、

16、12 dB）、EBUL
周波数特性

20 Hz～20 kHz（±3 dB以内）
ダイナミックレンジ

90 dB（Typical）
ひずみ率 0.08%以下（入力レベル

－40 dBu時）
内蔵スピーカー

モノラル、出力：300 mW

LCDモニター
画面サイズ
対角8.8 cm （3.5型）

アスペクト比
16:9

画素数
960（H）×540（V）

SxSカードスロット
形状：Express Card34
スロット数：2
端子：PCMCIA Express Card
準拠

書き込みレート：50 Mbps以上
読み出しレート：50 Mbps以上

SDカードスロット
Proxy用×1、Utilty用×1

ショルダーベルト（1）
コールドシューキット（1式）
レンズマウントキャップ
USBワイヤレスLANモジュール
（IFU-WLM3）
保護キャップ（2）
ガード（1）
オペレーションガイド（1）
オペレーションマニュアル（CD-ROM）（1）

オプションキー

PXWK-501/502（Codec Option）
PXWK-503（Slow&Quick Option）

電源関連

ACアダプター
AC-DN10/DN2B

バッテリーパック
BP-FLX75

バッテリーチャージャー
BC-L70/L90/L70A

レンズ、ビューファインダーおよ
び関連機器

レンズ 2/3型バヨネットマウントレン
ズにのみ対応

ビューファインダー
HDVF-20A/L750/EL20/EL30
CBK-VF02

ビューファインダー回転収納機構
BKW-401

リモートコントロール用機器

リモートコントロールユニット
RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501

ご注意
コマンドネットワークユニット（CNU）には対応
していません。

表示部

メディア部

付属品

関連機器
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HDカメラアダプター

CA-FB70/TX70

ご注意
CA-FB70装着時にSDIOUT2と併用する場合は、L
字アングルの変換アダプターを使用してください。

メディアアダプター

MEAD-SD02（SDカード用）

XQD ExpressCardアダプター

QDA-EX1（XQDメモリーカード用）

記録メディア

SxSメモリーカード
SxS PRO+シリーズ
SxS PROシリーズ
SxS-1シリーズ

オーディオ機器

マイクロホン
ECM-678/674/673/680S

マイクホルダー
CAC-12

デジタルワイヤレスレシーバー
DWR-S01D/S02DN

UHFシンセサイザーチューナーユニット
WRR-855S
URX-S03D

その他の周辺機器

三脚アタッチメント
VCT-14/U14

ビデオライト
UC-D200A（日本ビデオシステ
ム社製）

ウルトラライト（アントンバウ
アー社製）

パッド ソフトタイプショルダーパッド
CBK-SP01

ワイヤレスLANアダプター
CBK-WA02

ネットワークアダプター
CBK-NA1

保守用製品、操作／取り扱いを容
易にするための製品

アタッチメント金具
A-2092-367-A

ハードキャリングケース
LC-H300

ソフトキャリングケース
LC-DS300SFT

メンテナンスマニュアル

仕様および外観は、改良のため予告なく変
更することがありますが、ご了承ください。

• 必ず事前に記録テストを行い、正常に記
録されていることを確認してください。
本機や記録メディア、外部ストレージな
どを使用中、万一これらの不具合により
記録されなかった場合の記録内容の補償
については、ご容赦ください。

• お使いになる前に、必ず動作確認を行っ
てください。故障その他に伴う営業上の
機会損失等は保証期間中および保証期間
経過後にかかわらず、補償はいたしかね
ますのでご了承ください。

• 本製品を使用したことによるお客様、ま
たは第三者からのいかなる請求について
も、当社は一切の責任を負いかねます。

• 本機内、記録メディア、外部のストレー
ジ等に記録されたデータの損失、修復、
複製の責任は負いかねます。

• 諸事情による本製品に関連するサービス
の停止、中断について、一切の責任を負
いかねます。
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周辺機器・アクセサリー一覧図

a)レンズおよびマイクロホンを装着したままでも収納できます。ただし、それぞれの装着時
の長さがカムコーダー本体の前面端から25cmを超える場合は取り外してください。

マイクロホン
ECM-680S/
678/674/673

マイクホルダー
CAC-12

HDモニター／SDモニター

XDCAM HDシリーズレコーダー
PDW-F1600/HD1500、PDW-F75

HDCAMシリーズレコーダー
HDW-2000シリーズ、HDW-S280

PXW-X500 a) 

リモートコント
ロールユニット
RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501

三脚
アタッチメント
VCT-14

三脚

ソフトキャ
リングケース
LC-DS300SFT a)

ACアダプター
AC-DN10/DN2B

UHFシンセサイザーチューナーユニット
WRR-855S
URX-S03D
デジタルワイヤレスレシーバー
DWR-S02D

バッテリー
チャージャー
BC-L70A

バッテリーパック
BP-FLX75

SxSメモリーカード
SBS-32G1B、SBS-64G1B、SBS-128G1B、
SBS-64D、SBS-128D、SBS-256D

ハードキャリング
ケース
LC-H300

ビューファインダー
CBK-VF02

HDカメラアダプター CA-TX70

メディアアダプター MEAD-SD02

ビューファインダー
HDVF-20A/L750/
EL20/EL30

XQD ExpressCardアダプター QDA-EX1

HDカメラアダプター CA-FB70
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本製品は、MPEG LA, LLC.がライセンス活
動を行っているMPEG-4 Visual Patent 
Portfolio Licenseの下、次の用途に限りライ
センスされており、その他の用途に関して
はライセンスされていません。
（i）消費者が個人的、非営利の使用目的
で、MPEG-4 Visual規格に合致した
ビデオ信号（以下、MPEG-4 Video
といいます）にエンコードすること。

（ii）MPEG-4 Video（消費者が個人的に
非営利目的でエンコードしたもの、
もしくはMPEG LAよりライセンスを
取得したプロバイダーがエンコード
したものに限られます）をデコード
すること。

プロモーション、営利目的に利用すること
に関する詳細な情報につきましては、
MPEG LA, LLC.のホームページ
<http://www.mpegla.com>を参照してくだ
さい。

MPEG LAは、(i) MPEG-4 Visualビデオ情報を記録
した媒体（PACKAGED MEDIA）を製造し、販売
する行為、(ii) MPEG-4 Visualビデオ情報を何らか
の方法(オンラインビデオ配信サービス、インター
ネット放送、TV放送など)で配信・放送する行為
について、ライセンスを提供しています。その他
の使用方法につきましても、MPEG LAからのライ
センス取得が必要な場合があります。
詳しくは、MPEG LAにお問い合わせください。
MPEG LA. L.L.C., 250 STEELE STREET, SUITE 
300, DENVER, COLORADO 80206

ホームページ：http://www.mpegla.com

IMPORTANT: 
BEFORE USING THE SOFTWARE 
CONTAINED IN THE CAMCORDER, 
PLEASE READ THIS END USER LICENSE 
AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE 
ACCEPTING THE TERMS OF THIS EULA. IF 
YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE 
SOFTWARE.

This EULA is a legal agreement between you 
and Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding the 
software of SONY and/or its third party licensors 
(including SONY’s affiliates) and their 
respective affiliates (collectively, the “THIRD-
PARTY SUPPLIERS”) contained in the 
camcorder, together with any updates/ upgrades 
provided by SONY, any printed, on-line or other 
electronic documentation for such software, and 
any data files created by operation of such 
software (collectively, the “SOFTWARE”). 

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user 
license agreement (including, but not limited to, 
GNU General Public license and Lesser/Library 
General Public License) shall be covered by such 
applicable separate end user license agreement in 
lieu of the terms of this EULA to the extent 
required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” incorporated into the 

MPEG-4 Visual 
Patent Portfolio 
Licenseについて

END USER LICENSE 
AGREEMENT
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SOFTWARE) is owned by SONY or one or 
more of the THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the 
camcorder and only for your individual use. 
SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that 
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or 
create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital 
rights management functionality of the 
SOFTWARE. You may not bypass, modify, 
defeat or circumvent any of the functions or 
protections of the SOFTWARE or any 
mechanisms operatively linked to the 
SOFTWARE. You may not separate any 
individual component of the SOFTWARE for 
use on more than one camcorder unless expressly 
authorized to do so by SONY. You may not 
remove, alter, cover or deface any trademarks or 
notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer 
or sell the SOFTWARE. The software, network 
services or other products other than 
SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). 
SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or 
other products will continue to be available, or 
will operate without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN 
SOURCE COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 

Components”), which means any software 
licenses approved as open source licenses by the 
Open Source Initiative or any substantially 
similar licenses, including but not limited to any 
license that, as a condition of distribution of the 
software licensed under such license, requires 
that the distributor make the software available 
in source code format. If and to the extent 
disclosure is required, please visit 
www.sony.com/linux or other SONY-designated 
web site for a list of applicable OPEN SOURCE 
COMPONENTS included in the SOFTWARE 
from time to time, and the applicable terms and 
conditions governing its use. Such terms and 
conditions may be changed by the applicable 
third party at any time without liability to you. 
To the extent required by the licenses covering 
EXCLUDED SOFTWARE, the terms of such 
licenses will apply in lieu of the terms of this 
EULA. To the extent the terms of the licenses 
applicable to EXCLUDED SOFTWARE 
prohibit any of the restrictions in this EULA with 
respect to such EXCLUDED SOFTWARE, such 
restrictions will not apply to such EXCLUDED 
SOFTWARE. To the extent the terms of the 
licenses applicable to Open Source Components 
require SONY to make an offer to provide source 
code in connection with the SOFTWARE, such 
offer is hereby made.

USE OF SOFTWARE WITH 
COPYRIGHTED MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are 
not limited to, counting the frequency of your 
backup and restoration through certain 
SOFTWARE features, refusal to accept your 
request to enable restoration of data, and 
termination of this EULA in the event of your 
illegitimate use of the SOFTWARE.
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CONTENT SERVICE
PLEASE ALSO NOTE THAT THE 
SOFTWARE MAY BE DESIGNED TO BE 
USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU 
DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE 
LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties 
over which SONY has no control. USE OF THE 
CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT 
SERVICE MAY BE DISCONTINUED AT 
ANY TIME.

INTERNET CONNECTIVITY AND 
THIRD PARTY SERVICES
You acknowledge and agree that access to 
certain SOFTWARE features may require an 
Internet connection for which you are solely 
responsible. Further, you are solely responsible 
for payment of any third party fees associated 
with your Internet connection, including but not 
limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be 
limited or restricted depending on the 
capabilities, bandwidth or technical limitations 
of your Internet connection and service. The 
provision, quality and security of such Internet 
connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of the 
area or country in which you reside, and not to 
transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or 
otherwise in violation of any such restrictions or 
regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, 

aircraft navigation or communication systems, 
air traffic control, direct life support machines, or 
weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal 
injury, or severe physical or environmental 
damage (“HIGH RISK ACTIVITIES”). SONY, 
each of the THIRD-PARTY SUPPLIERS, and 
each of their respective affiliates specifically 
disclaim any express or implied warranty, duty 
or condition of fitness for HIGH RISK 
ACTIVITIES. 

EXCLUSION OF WARRANTY ON 
SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, 
SONY and each of the THIRD-PARTY 
SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE. SONY DOES NOT 
WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE 
SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF 
ANY OF THE SOFTWARE WILL BE 
CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT 
THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, 
NETWORK SERVICES (INCLUDING THE 
INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS 
WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, 
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ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN 
AUTHORIZED REPRESENTATIVE OF 
SONY SHALL CREATE A WARRANTY, 
DUTY OR CONDITION OR IN ANY WAY 
INCREASE THE SCOPE OF THIS 
WARRANTY. SHOULD THE SOFTWARE 
PROVE DEFECTIVE YOU ASSUME THE 
ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. 
SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, 
SONY and each of the THIRD-PARTY 
SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY 
EXPRESS OR IMPLIED WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR UNDER ANY 
OTHER LEGAL THEORY RELATED TO THE 
SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING 
OUT OF LOSS OF PROFITS, LOSS OF 
REVENUE, LOSS OF DATA, LOSS OF USE 
OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’S 
TIME, EVEN IF ANY OF THEM HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN ANY CASE, EACH AND ALL 
OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE 
LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION 
OR LIMITATION MAY NOT APPLY TO 
YOU.

CONSENT TO USE OF NON-
PERSONAL INFORMATION, 
LOCATION DATA, DATA SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but 
not limited to information about (i) the 
SOFTWARE and (ii) the software applications, 
contents and peripheral devices that interact with 
your camcorder and the SOFTWARE 
(“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your 
camcorder and its components; (2) performance 
of the camcorder, the SOFTWARE and their 
components; (3) configurations of your 
camcorder, the SOFTWARE and the software 
applications, contents and peripheral devices that 
interact with the camcorder and the 
SOFTWARE; (4) use and frequency of use of the 
functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral 
devices that interact with the SOFTWARE; and 
(5) location data, as indicated below. SONY and 
its affiliates, partners and agents may use and 
disclose Information subject to applicable laws 
in order to improve its products and services or 
to provide products or services to you. Such uses 
include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to 
improve, service, update or upgrade the 
SOFTWARE; (c) improving, developing and 
enhancing the current and future products and 
services of SONY and other parties; (d) to 
provide you with information about the products 
and services offered by SONY and other parties; 
(e) complying with applicable laws or 
regulations; and (f) to the extent offered, 
providing you with location-based services of 
SONY and other parties, as indicated below. In 
addition, SONY retains the right to use 
Information to protect itself and third parties 
from illegal, criminal or harmful conduct.

Certain services available through the 
SOFTWARE may rely upon location 
information, including, but not limited to, the 
geographic location of the camcorder. You 
acknowledge that for the purpose of providing 
such services, SONY, the THIRD-PARTY 
SUPPLIERS or their partners may collect, 
archive, process and use such location data, and 
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that such services are governed by the privacy 
policies of SONY or such third party. By using 
any such services, you agree that you have 
reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally 
identify the owner or user of the SOFTWARE 
without your knowledge or consent. Any use of 
Information will be in accordance with the 
privacy policies of SONY or such third party. 
Please contact applicable contact address of each 
area or country for SONY’s current privacy 
policy.

Please contact applicable third parties for privacy 
policies relating to personally identifiable and 
other information you provide when you use or 
access third party software or services.

Information may be processed, stored or 
transferred to SONY, its affiliates or agents 
which are located in countries outside of your 
country of residence. Data protection and 
information privacy laws in certain countries 
may not offer the same level of protection as 
your country of residence and you may have 
fewer legal rights in relation to Information 
processed and stored in, or transferred to, such 
countries. SONY will use reasonable efforts to 
take appropriate technical and organizational 
steps to prevent unauthorized access to or 
disclosure of Information, but does not warrant it 
will eliminate all risk of misuse of such 
Information.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-
PARTY SUPPLIERS may automatically update 
or otherwise modify the SOFTWARE, including, 
but not limited to, for purposes of enhancement 
of security functions, error correction and 
improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may 
delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities may 
occur at SONY’s sole discretion and that SONY 
may condition continued use of the SOFTWARE 

upon your complete installation or acceptance of 
such update or modifications. Any updates/
modifications shall be deemed to be, and shall 
constitute part of, the SOFTWARE for purposes 
of this EULA. By acceptance of this EULA, you 
consent to such update/ modification. 

ENTIRE AGREEMENT, WAIVER, 
SEVERABILITY 
This EULA and SONY’s privacy policy, each as 
amended and modified from time to time, 
together constitute the entire agreement between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not 
constitute a waiver of such right or provision. If 
any part of this EULA is held invalid, illegal, or 
unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to 
maintain the intent of this EULA, and the other 
parts will remain in full force and effect. 

GOVERNING LAW AND 
JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply to 
this EULA. This EULA shall be governed by the 
laws of Japan, without regards to conflict of laws 
provisions. Any dispute arising out of this EULA 
shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or non-compliance 
with this EULA by you will cause irreparable 
harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that 
SONY deems necessary or appropriate in such 
circumstances. SONY may also take any legal 
and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not 
limited to, immediate termination of your use of 
the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to 
violate this EULA. These remedies are in 
addition to any other remedies SONY may have 
at law, in equity or under contract.
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TERMINATION
Without prejudice to any of its other rights, 
SONY may terminate this EULA if you fail to 
comply with any of its terms. In case of such 
termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE 
ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY 
PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, 
you should promptly contact SONY for 
instructions. Your continued use of the 
SOFTWARE after the effective date of any such 
notice shall be deemed your agreement to be 
bound by such amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended third-party beneficiary of, and shall 
have the right to enforce, each provision of this 
EULA with respect to the SOFTWARE of such 
party.

Should you have any questions concerning this 
EULA, you may contact SONY by writing to 
SONY at applicable contact address of each area 
or country.

Copyright © 2012 Sony Corporation.

本製品には、弊社がその著作権者とのライ
センス契約に基づき使用しているソフト
ウェアが搭載されています。
当該ソフトウェアの著作権者の要求に基づ
き、弊社はこれらの内容をお客様に通知す
る義務があります。
ライセンスの内容に関しては、付属の
CDROMに収録されている「License」フォ
ルダー内の「License1.pdf」をご覧くださ
い。

オープンソースソフト
ウェアのライセンスに
ついて
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•“XDCAM”はソニー株式会社の商標です。
•“XAVC”および はソニー株式会社の
登録商標です。

•“XQD”はソニー株式会社の登録商標です。
• Android 、Google Chrome は、Google 

Inc. の商標または登録商標です。
• Microsoft、Windowsは、米国Microsoft 

Corporation の米国及びその他の国におけ
る登録商標です。

• Apple、Macintosh、Safari およびiPhone 
の名称およびそのロゴは、米国Apple Inc. 
の米国およびその他の国における商標ま
たは登録商標です。

• HDMI、High-Definition Multimedia 
Interface、およびHDMIロゴは、米国およ
びその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商
標です。

• Wi-Fi、Wi-Fiロゴ、Wi-Fi Protected Setup
はWi-Fi Allianceの商標または登録商標で
す。

• その他、本書で登場するシステム名、製
品名は、一般に各開発メーカーの登録商
標あるいは商標です。なお、本文中で®、
™マークは明記しておりません。

商標について



このマニュアルに記載されている事柄の
著作権は当社にあり、説明内容は機器購
入者の使用を目的としています。
従って、当社の許可なしに無断で複写し
たり、説明内容（操作、保守等）と異な
る目的で本マニュアルを使用することを
禁止します。



Sony CorporationPXW-X500
(SYM)
4-548-602-08 (1) © 2014
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